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1 Welcome to PlantStar 

 

SYSCON-PlantStar produces four levels of shop floor data collection systems. These 
systems are sized and targeted to meet customer's needs. For additional information about 
these levels see on line help. 

The goal of your PlantStar system is to provide you with a data collection and monitoring 
apparatus that enables you to make informed decisions on the factory floor in Real-Time. It 
defines the shop floor, schedules jobs on the floor, and monitors those jobs. 

There are a number of PlantStar applications within your system: 

· Shop Floor Configuration - The Shop Floor Configuration program enables you to 
define the physical descriptions of machines on the shop floor in terms of down 
reasons, reject reasons, assist reasons, display groups, and data collection modules 
(DCMs). Once defined, these shop floor characteristics provide the foundation upon 
which jobs are scheduled. The Shop Configuration program also lets you define 
users, their privileges and passwords. 

· Shop Floor Monitor - The Shop Floor Monitor program provides information on 
current shop floor activity. Within Monitor, real-time monitoring is presented as a 
"moving window" of recent events. Information on the current shift, the current job, 
or the most recent machine cycle is presented in a variety of windows. A scheduling 
component, accessible through the SCHEDULE menu, utilizes the Shop 
Configuration program's definitions in order to facilitate planning activities. These 
planning activities take the form of job scheduling. Jobs, their priorities and 
placement in a job queue, provide the work schedule for the shop floor. 

· Browser Interface - All the shop-floor information is available throughout the plant 
(and even the world, if so configured) through any computer with a Firefox browser 
and a network connection. This functionality gives end users the ability to monitor 
specific machines from remote locations. It also enables machine operators to 
access multiple machines from a single location. 

· Label Printing - A PlantStar system (option for Snapshot and above) configured with 
the print option can be used to create and print labels at the production machine. 

· Voice Output - A PlantStar system (option for Snapshot and above) configured with 
the Voice Output Option is able to broadcast messages relating to currently monitored 
exception conditions such as Down, Idle, Fast, Slow, and Production Exception. 
These messages can be heard on speakers or public address systems. 

· Family Molding - A PlantStar system (option for Snapshot and above) configured 
with the Family Molding software can add to your ability to track multiple cavity jobs 
or other parallel processes. 

· Process Journal - A PlantStar system (option for Snapshot and above) configured 
with the Process Journal software can track any changes made to the system on the 
shop floor. Supports 21CFR1 1 data recording. 

· View and Print - The View and Print program provides up-to-date shift and job 
history information in the form of on-line and paper-generated reports. Your system 
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provides a variety of pre-existing reports from which to choose. 

· Design Manager - The Design Manager program is an add-on feature for your 
system that enables you to create your own reports. The Custom Reports 
Manager program transfers custom reports designed in Crystal Reports into 
PlantStar. It provides editing capabilities for these reports, deletion capabilities, 
and provides for the selection of report search criteria. 

 

1.1 Getting Started 

The goal of your PlantStar system is to provide you with a data collection and monitoring 
apparatus that enables you to make informed decisions on the factory floor in Real-Time. It 
defines the shop floor, schedules jobs on the floor, and monitors those jobs. 

What do you want to know about? 

 System Overview  

 Logging into your PlantStar system 

 Setting up your System  

 Shop Floor Configuration  

 Shift Scheduling Concepts  

 Job Scheduling Concepts  

 Monitoring Concepts  

 Material Lot Tracking Concepts  

 Technical Support  

 FAQ 
 

1.2 PlantStar Products 

SYSCON-PlantStar produces four levels of shop floor data collection systems. Two of these 
systems support plant floor production information and two support both production and 
process information. These systems are sized and targeted to meet customer's needs. 

QUICKSHOT – a basic system that supports 12 to 48 production machines; used by 
manufacturers interested in basic shop-floor metrics; twenty pre-configured reject and down 
reasons; very limited upgrade capability. 

SNAPSHOT - an upgradeable, mid-entry level system for shop-floor production information 
commonly used as a starting point by many manufacturers interested in basic shop floor data 
metrics. 

PORTRAIT - our medium-sized company product; an expansion to the SnapShot 
environment that incorporates many new functions not available in SnapShot such as 
SPC data collection. 

PANORAMA - our enterprise level product that is commonly used to integrate multi-site, multi-
process environments; used by manufacturers to organize all of their world wide manufacturing 
assets under one system. 
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Our contact information is: 

 
SYSCON-PlantStar 
1108 South High Street 
South Bend, IN 46601 USA 

Phone - 574-232-3900 
FAX - 574-287-5916 
For more information visit us on the web at www.plantstar.org. 

 
1.3 System Overview 

The goal of your PlantStar system is to provide you with a data collection and monitoring 
apparatus that enables you to make informed decisions on the factory floor in Real-Time. It 
defines the shop floor, schedules jobs on the floor, and monitors those jobs. 

PlantStar Applications 

There are five primary PlantStar applications within your system: 

· Shop Floor Configuration - The Shop Floor Configuration program enables you to 
define the physical descriptions of machines in terms of down reasons, reject reasons, 
assist reasons, boot sets, display groups, DCMs, and communications processors. Once 
defined, these shop floor characteristics provide the foundation upon which jobs are 
scheduled. The Shop Floor Configuration program also lets you define users, their 
privileges and passwords. 

· Shop Floor Monitor - The Shop Floor Monitor program provides information on current 
shop floor activity. Within Monitor, real-time monitoring is presented as a "moving window" 
of recent events. Information on the current shift, the current job, or the most recent 
machine cycle is presented in a variety of windows. A scheduling component, accessible 
through the Schedule menu, utilizes the Shop Floor Configuration program's definitions 
in order to facilitate planning activities. These planning activities take the form of job 
scheduling. Jobs, their priorities and placement in a job queue, provide the work schedule 
for the shop floor. 

· Voice Output - A PlantStar system configured with the Voice Output option is able to 
broadcast messages relating to currently monitored exception conditions such as Down, 
Idle, Fast, Slow, and Production Exception. These messages can be heard on speakers 
or public address systems. 

· Print and View Reports - The Print and View Reports program provides up-to-date 
shift and job history information in the form of on-line and paper-generated reports. Your 
system provides a variety of pre-existing reports from which to choose. 

· Design Manager - The Design Manager program is an add-on feature for your system, 
which enables you to create your own reports. The Custom Reports Manager program 
transfers custom reports designed in Crystal Reports into PlantStar. It provides editing 
capabilities, deletion capabilities, and provides for the selection of report search criteria. 

Each of these components includes numerous windows that display and manipulate 

http://www.plantstar.org
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shop floor information. 

 
1.4 System Features 

There are many features included within your system. Some systems have optional 
features configured at the time of purchase. Most of these options can be added to any of 
our process-level products: Portrait or Panorama. The descriptions that follow are brief 
summaries. Within the operational sections of this document, you'll find more detail on how 
the specifics of the optional feature works in your system. 

High Speed Profile - HSPO 
This option allows collection and display of high speed process variable profiles. These 
profiles are displayed in line graph format. Up to four profiles can be displayed 
simultaneously. This allows analysis of interdependent process phenomena and analysis 
of potential to optimize the process. 

Statistical Process Control - SPC 
A simple to use analytical tool is available in this option. It allows process variable 
summary display (average, last, low values), process variable history display (table, graph, 
X bar & R bar charts), averages and exceptions. A more advanced third party SPC 
package is an available option. 

Sound Track Automated Public Address - VOO 
Sound Track alarms and events to be announced automatically over the plant public address 
system. Messages are custom recorded by the system owner and can be tailored to the 
operations and terminology used in the plant. Voice PC not included. 

Single Material Lot Tracking - MATL-LOT/S 
Single Material Lot Tracking allows tracking of consumption of one material per machine 
using the operator input at a touch screen DCM. The lot number identifies the material. 
Consumption tracking, is supported and forecasting is enabled as well. 

Multiple Material Tracking - MULT-MTL 
Multiple materials (up to four) can be tracked with this option. Use of each material can be 
tracked and forecasting of material demand is supported to improve operations and control. 

Multiple Material/Multiple Lot Tracking - MAT-LOT/M 
Up to four component materials and four lot numbers can be tracked with this option. Use of 
each material and lot can be tracked and forecasting of material demand is supported to 
improve operations and control. 

Labor Tracking - LBR-TRKG 
Labor tracking is designed to forecast, collect, and report labor hours by machine, job, shift 
or employee. Labor is collected and tracked by personnel logging in and out at a DCM. 
Login/logout can be; RFID, barcode, or manual touch screen entry. The same person or 
people may be logged onto one or many machines at the same time depending on the work 
being done. For these reasons, it is not a time and attendance system. It will provide a 
window to where and how labor is used on the shop floor. It can also report time spent at the 
machine by support personnel. As a job history is developed the job history labor reports can 
be used to forecast staffing requirements on a shift or weekly basis. 

Process Journals - PRO-JOURN 
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This feature adds to our already extensive web browser interface to allow operators and 
shop floor people to record problems and corrective actions. This feature is used in 
conjunction with our labor tracking option. The data is time-stamped and associated with an 
individual job, shift and employee. It also has an all browser based user interface so anyone 
on your network will be able to view the data. 

Machine Control Data Interface - (MODL)-I/F 
This option provides a special data interface between a machine equipped with a data port 
from the control system to the DCM. The DCM, depending on the capabilities of the 
machine's control system to generate the data, can collect temperatures and other process 
parameters. Additional sensors are not required for monitoring purposes for the parameters 
delivered by the machine's serial data port. Currently, SYSCON-PlantStar has interfaces for 
Allen Bradley PLC5, Advantech DL06, Arburg Selogica, Cincinnati Camac VLC/VEL, 
Cincinnati Camac VSX Century Controller/486/ XLT, Cincinnati Camac XTA, Cincinnati 
Milacron Roboshot (SPI or OPC), Cincinnati Milacron Xtreem/Mosaic , Van Dorn CRT-C, 
Engel CC-80/CC-90/EC-88/CC-100, HPM CMD-III/CMD-90, Husky OI TCP/IP, JSWuPACS-
3000/uPACS-5000, Maco 4000, 6000, Maco 8000, Netstal Sylink (Sijaard card), Nissei 
NC9300T, OPC Clients, SPI interface, Van Dorn Pathfinder (Siemens 1 15u), RKC 
F900/F400, Square D Powerlogic Series 2000 SY/Max 802.3 Protocol, TI 545, Toshiba 
Injectvisor 5 series/10 series, Toshiba V10.V21/V30, Toyo PLCS Part-6, Battenfeld Unilog 
9000 B, Kawaguchi B & B2, Hekuma, and more are added regularly. 

Gauge Interface - GAGE-I/F 
Currently, SYSCON-PlantStar has interfaces for A&D Companies EK-G or EW-G series 
scales, AC 9000, Beta Tech MiniMUX, Branson, Kaman Kuda, Ohaua Trooper, Peet 
Brothers Ultimeter 2100, Sartorius QC series The DCM can be equipped with serial 
communications compatible with a wide variety of digital gage equipment. Measurements 
can be made with the gauge and tabulated by the system allowing reports and analysis of 
dimensional data along with process variable measurements. 

Printer Interface – 
Currently, SYSCON-PlantStar has interfaces for Zebra tote label printers, HP laser 
printers, and all printers supported by T-Former software.  

Scale Interface - SCALE-I/F 
The DCM can be equipped with serial communications compatible with a wide variety of 
digital weigh scale equipment. Measurements can be made with the weigh scale and 
tabulated by the system allowing reports and analysis of part weight data along with process 
variable measurements. 

Other Interface 
Interfaces to moisture meters, humidity sensors, etc. also have been written. 

Set-Up Sheet Software - SET-UP 
Hard copy set up sheets can be replaced by this software option. The option allows set-up 
instructions to be typed into the system and displayed at a touch screen DCM for each job to 
be run at a specific machine. Questions about how to set up specific jobs will be put to an 
end. 

Bar Code Interface - BAR-COD 
The interface between the DCM and bar code printer is enabled by this option. Labels can 
be printed out by the system according to a variety of requirements. Integration of the 
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TFORMer runtime package allows for rapid development of customized labels. Separate 
purchase of the Windows- based TFORMer Designer package gives the user the ability to 
create label templates for use with PlantStar, and to print labels independently. A Bar Code 
printer may be connected to the DCM by either a serial or USB port. Bar Code Printer not 
included. 

Interface to DataStream MP2 Software - MP2 I/F 
Interface enabling data exchange between the system and DataStream MRP2 production 
planning software. A fully integrated system that enables both production monitoring and 
production planning is ensured with this option and the emplacement of the DataStream 
software. 

Remote Modem and Set-Up Service - REMOTE-ACC 
To provide remote data access or remote log-on, this option can be selected. It consists of 
two modems and set-up service from SYSCON-PlantStar. Minimum personal computer 
configuration requirements apply and the customer must provide direct telephone line 
access to the modem at the plant site. 

Shot Tracker - SHOT-TRACK-2 
Shot by shot archiving of all data collected for every shot. This feature does not provide tools 
to sort or analyze the data collected. The user must use a database tool such as ACCESS to 
analyze the collected data. 

Host E-mail capabilities – 
We have added a new feature to our host that allows the system to send e-mails from most 
programs running on the PlantStar server. We can configure this program to send information 
to any e-mail address in your domain. The e-mails that can be sent include success/failure of 
any automated tasks like backups, imports, and exports. We can, if requested, have an e-mail 
address created so these messages can be forwarded to PlantStar customer support. Our 
support department can use this information about your server status to provide you more 
timely and proactive system support. 

Backup 
The system is normal backed up by FTP transferring of files to a customer supplied file server. 
Optionally a CD or CDRW drive can be supplied with the PlantStar host for backup purposes. 
 

 
1.5 Features Summary 
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1.6 What’s new in PlantStar 4.20 

PlantStar 4.20 has incorporated many new features including: 

· Process Journaling - This feature adds to our already extensive web browser interface to 
allow operators and shop floor people to record problems and corrective actions. This 
feature is used in conjunction with our labor tracking option. The data is time-stamped and 
associated with an individual job, shift and employee. It also has a totally browser-based 
user interface. So anyone on your network will be able to view the data. 

· RTLDCM Flash Drives - The RTL based data collection modules now come in a diskless 
version. This feature uses flash memory cards instead of a hard drive. Hard drives are 
susceptible to mechanical failure and we have eliminated the problem of hard drive 
failure by removing the hard drive. The flash drive allows for thousands of read/writes 
before needing replacement. In addition, replacement flash cards can be made for a 
fraction of the cost of a hard drive. 

· Journaling File System - The structure of the data contained on the flash/hard drive 
has, in the past, been prone to data corruption. We have found that in almost all cases 
the corruption can be traced to a power failure or inappropriate shutdown of the data 
collection module. We have converted from the Linux based EXT2 file system to the 
newer Reiser journal file system. This new file system will automatically restore itself to 
its previous state in the event of an uncontrolled shutdown. 

· Host E-mail capabilities - We have added a new feature to our host that allows us to send 
e-mails from most programs running on the PlantStar server. We can configure this 
program to send information to any e-mail address in your domain. The e-mails that can be 
sent include success/failure of any automated tasks like backups, imports, and exports. We 
can, if requested, have an e-mail address created to forward these messages to PlantStar 
customer support. Our support department can use this information about your server 
status to provide you more timely and proactive system support. 

· Import/Export Options - PlantStar has extended its options for importing and exporting 
data to ERP systems. We now provide multiple machine specific standards to be imported 
in any one import file. Our end-of-shift export utility can now notify you of any machines that 
have failed to report the end-of-shift event. This is usually a sign of network problems 
between the host and the data collection module. In conjunction with the previous feature, 
we can export only data for late reporting machines. So once the initial communications 
problem has been resolved, the data that was missed in the first end-of-shift will be 
exported. Our export utility can now be set to perform an incremental export. That is, 
instead of one export per shift, it can now do an export on a set interval. This will allow your 
ERP system to more accurately reflect the current production status of your shop floor. 

· Automated Archiving - The archiver program can now be automated to perform an 
archive at set interval. For instance you can maintain a six-month record active in the 
PlantStar database by setting the archiver to run once a month. The archiver program will 
store the archived data on the PlantStar server or FTP it to a location of your choice. 
Eliminating the delay associated with archiving multiple months worth of data after a 
performance decrease has been noted. 

· Labor Required Displayed on the Schedule Board - If you have purchased the labor 
tracking option, the total labor hours required for a given shift can be displayed on the 
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Job Schedule Board. This option can be enabled from the User Preferences screen 
in the Monitor program. 

· Maco 6000 Host Interface - PlantStar has expanded its already extensive collection of 
machine interfaces by providing support for the Maco 6000 host interface. The protocol 
uses 485 based serial communications to collect process data direct from the machine's 
controller. 

· International Support - The date, currency, and decimal numeric fields used for input 
and display in all PlantStar monitor screens and reports now use the locale settings that 
have been configured in Windows control panel. 

· Crystal Reports v11.0 - All PlantStar reports have been updated to the latest version 
of Crystal Reports. This makes integrating your own custom reports even easier. 

· Voice Program - PlantStar's voice program has been modified to eliminate delays in 
making announcements. Now when any event occurs that requires a voice announcement, 
the response will be immediate. 

 
1.7 What's new in PlantStar 4.10 

PlantStar 4.10 has many new and exciting features, including: 

· Family Tooling - Family Tooling is designed to allow the collection and tracking of data 
by child job. Management will receive a much more detailed picture of production, rejects, 
history, and pieces made for each family job. Family Tooling allows up to twelve child 
jobs running, at one time, on a machine. 

· Labor Tracking - Labor Tracking is designed to forecast, collect, and report labor hours 
by machine, job, shift, or employee. Labor is collected and tracked by personnel logging in 
and out at a DCM. The same person or people can be logged onto one or many machines 
at the same time depending on the work being done. For this reason, it is not a time and 
attendance system. It will provide a window to where and how labor is used on the shop 
floor. It can also report time spent at the machine support personnel. As a job history is 
developed the job history labor reports can be used to forecast staffing requirements on a 
shift or weekly basis. 

· Shot Tracker - PlantStar is pleased to introduce Shot Tracker. This new 
tracking feature timestamps and logs information for each cycle of the machine. 

· OPC Client - PlantStar has joined the OPC era with the introduction of an OPC client. This 
client will connect to any OPC certified server to deliver data to the PlantStar system. 

· Increased Performance - Because of PlantStar improved capabilities; retrieval of job data 
is more robust than previous versions. The most noticeable areas are the loading of the Job 
Schedule Board and retrieval of Product Standards. 

· Improved Job Editing Capabilities - All job editing screens (Job Schedule Board, 
Current/Queue Jobs, Work Orders, and Product Standards) have been recreated. The 
result has given a more powerful job editor. A partial list of features includes: enhanced field 
editing, pop up date calendars, integrated job list, and family tooling capabilities. 

· Column Resizing - Most PlantStar screens now allow you to resize the columns the 



34 SYSCON-PlantStar Help System 

 

 

way that you see fit. 

· Column Sorting - Some of the Shop Floor Monitor screens now allow the sorting of the 
columns of data. This can be achieved by clicking the column heading you wish to sort. 
The following screens have column sorting capabilities: 

 Material Lot Tracking  

 Material Lot Detail  

 Labor Status  

 Labor Forecasting  

· Job Queue Editing - Queue jobs can now be edited from the Current/Queue Job 
window, as well as the Job Schedule Board. Previous versions only allowed 
editing, of queue jobs, from the Job Schedule Board. 

· Case Insensitive Search - Searches no longer require the search criteria to match the 
case of the expected result. This is most noticeable in the Job Schedule Board, 
Product Standards, and the Material Lot Tracking screens. 

· Job Schedule Board Search - The search capabilities within the Job Schedule 
Board have been expanded to search on more fields. Now all the available fields from 
the filtering function are included in the search function. 

· HTML Help - Previous versions of PlantStar used Win Help. 
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2 Shop Floor Configuration 

There are numerous steps to setting up and defining a shop floor. Each step entails providing 
specific information. The information on one element of the shop floor directly relates to and is 
associated with a second element. Communication Processor information, for example, 
needs boot set information. Machine definitions need Communications Processor and Data 
Collection Module (DCM) information. Changes to some shop floor definitions force a re-
initialization of a DCM. This, in turn, affects the currently running job. 

The following sections discuss some basic relationships between specific shop floor 
components. These relationships are presented here to facilitate the entering of 
information. 

What do you want to know about? 

 User Defined Labels  
 Reason Sets  
 Work Centers  

 Display Groups  

 Labor Categories  

 Communications Processors DCMs  
 Machines  

 Process Variables  
 

2.1 File Menu 
2.1.1 Save Session 

Defining and updating your shop floor definitions is an extremely important part of PlantStar. 
When shop floor definitions change, the new information is loaded down to a DCM and the 
database. 

Many shop floor characteristics are inter-related. Communications Processor information 
needs boot set information. Machine definitions need Communications Processor and 
DCM information. Since changes that you make to shop floor definitions are so inter-
related and immediate, PlantStar provides a feature to edit multiple shop floor 
characteristics before you send them down, all at once, to the shop floor. 

The Save Session menu command under the File menu lets you decide when new or 
updated shop floor definitions should be sent to a DCM. You can edit any number of setup 
windows. No action is taken with regard to actually sending information to the shop floor 
until you click the Save Session menu item. 

 

2.1.2 Restore Session 

The Restore Session command button restores any changes that have been made on 
the following windows to the way it was before you started editing. These windows 
include: 

 Assist Reason Sets  

 Down Reason Sets  

 Reject Reason Sets  

 Boot Sets  
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 Work Center Setup  

 Display Group Setup  

 Labor Setup  

 Comm Processor Setup 

 DCM Setup  

 Machine Setup  

 REU Setup  

To restore your information, click on the Restore Session command under the File menu. 

 
2.1.3 User Preferences 

 

 

 
The User Preference window enables you to customize the PlantStar environment in terms of: 

 Font Size -- Changing Text Sizes sets the font size for all PlantStar windows. 

 Job Primary Label -- The label to use for all jobs displayed on the Job Schedule Board 
window can be selected. The job label field lists all jobs on the Gantt chart by job name. 
The product label shows all jobs by product name. 

 Default When Moving a Job - You can select what will happen by default when moving 
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work orders or jobs from one machine to another on the Job Schedule window. 

 Screen Load Behavior - This option enables the quick loading of screens. When the 
quick load option is enabled, a screen is loaded without retrieving the data for the 
selection criteria. Data is loaded after window is opened and selection is made. 

 Search Criteria - The search method used on the Job Schedule Board window can be 
selected. There are three search methods: left, embedded, and exact. Left matching 
searches for records that start with a specified text. Embedded matching finds all 
occurrences of a text wherever it is located. Exact matching finds exact matches only. 
(Specific examples are provided under each method's field help topics.) 

 Show labor Hours – This displays the total number of man-hours required for each shift. 

 Language - This allows the users to select their language preference. 

These preferences are saved from session to session and will not change until the next 
modification.  

Where can you find it? 

· Choose the File menu on the Monitor window. 
· Choose the User Preference option. 

What do you want to know about? 

 Changing Preferences 

 Saving Your Changes 

 Undoing Your Changes 

 Closing the Window 

 
2.1.4 Logout 

The Logout menu option closes all the current opened PlantStar windows and returns you 
to the main Login window. 

 
2.1.5 Exit 

To exit the program, choose one of the following methods: 

· Select the Exit option under the File menu 
· Click your mouse button while it is positioned over the 'x' in the upper right hand 

corner of the window. 

NOTE: You must have the “Exit Panorama” privilege to exit the Monitor program. 
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2.2 User Menu 

 
2.2.1 User Accounts 

 

 

The User Accounts window lets you add, change or delete users and their privileges. This 
window is one of the primary security features within PlantStar. There are three levels of 
privileges which can be granted to users: no access, view only, or full access. 

 No Access - Does not allow the user to open the specified window. 

 View Only - Allows a user to view any PlantStar window associated with the granted 
privilege 

 Full Access - Enables the user to add, delete and edit all information associated 
with the granted privilege. 

All known PlantStar users are displayed upon the opening of this window. If you want to 
change a user's information, place your mouse pointer over the user's name or the 
relevant field. 

NOTE: If you do not have administrator privileges, then only your name appears in the user 
name list. You cannot view other people's privileges. You can change your password but not 
your assigned privileges. 
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Where can you find it? 

 Choose the User menu on the main Shop Configuration window. 

 Choose the User Accounts option. 

What do you want to know about? 

 Selecting Users  

 Adding Users  

 Updating Users  

 Deleting Users  

 Changing Passwords  

 Saving your Changes 

 Undoing your Changes 

 Closing the Window  

 
2.2.2 User Defined Labels 

 

The User Defined Labels window lets you customize the title of a free text field. Up to four 
free text fields appear on the Product Standard, Work Order, Current/Queued Jobs, and 
Material Lot Tracking windows within the Monitor program and related reports. These 
fields can be used as customized searching keys or site-specific pieces of information. 

The top field on this window displays the free text field selected. Below it is the title currently 
displaying on the above-mentioned windows. This second field is editable. 

Where can you find it? 

 Choose the User menu on the main Shop Configuration window. 

 Choose the User Defined Labels option. 

What do you want to know about? 

 Selecting a Free Text Field 

 Changing User-Defined Labels  

 Setting User-Defined Labels to Default 

 Saving your Changes 
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 Undoing your Changes  

 Closing the Window 

 
2.3 Sets Menu 

 
2.3.1 Down Reason Sets 

 

 

The Down Reason Sets window lets you add, change or delete a down reason set. 
Defining down reason sets enables PlantStar to report a machine's down time and down 
frequency by a defined reason. Down time statistics are collected using shift-to-date data 
for a current job or historical job. Down reason sets are associated with a machine from 
the Machine Setup window. 

You can define up to twenty (20) down reasons for each down set. Down reason number one 
and two are pre-defined by PlantStar in terms of what they do and mean. 

NOTE: An extended down and reject reason option can be purchased from PlantStar. 
This will extended the down/reject limit to one hundred and sixty (160) down/reject 
reasons for each set. 

Down Reason One: The first reason is the default down reason. Time is accrued to this 
reason when a machine is down and the operator has not selected a specific reason. A post-
down delay period can be set, though, from the Machine Setup window that delays the 
accruing of "unspecified" down time to Down Reason #1. 

Down Reason Two: The second down reason clocks actual setup time. PlantStar compares 
this time with a job's standard setup time. 

NOTE: A machine is considered down under the following conditions: 

· The machine is cycling so slowly that the actual cycle time is longer than the down time 
threshold specified in the current job. 
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· The operator has selected a down reason that 'forces' the machine into a down state. 

Where can you find it? 

 Choose the Sets menu on the main Shop Configuration window. 

 Choose the Down Reason Sets option. 

What do you want to know about? 

 Selecting Reason Sets 

 Creating Reason Sets  

 Renaming a Reason Set  

 Deleting Reason Sets  

 Saving Reason Sets  

 Undoing Your Changes  

 Setting Down Reason Flags 

 
2.3.2 Assist Reason Sets 

 

The Assist Reason Sets window lets you add, change or delete an assist reason set. 
Defining assist reasons enables PlantStar to report a machine's assist time and assist 
frequency by each defined reason. Assist time statistics are collected using shift-to-date 
data for a current jobs or historical jobs. 

A list of defined assist reason sets is displayed upon the opening of this window. The first 
defined reason set and its reason definitions are visible initially. You can define up to 
twenty (20) assist reasons for each set. Reason sets are assigned to a machine from the 
Machine Setup window. 

Where can you find it? 
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 Choose the Sets menu on the main Shop Configuration window. 

 Choose the Assist Reason Sets option. 

What do you want to know about? 

 Selecting Reason Sets 

 Creating Reason Sets 

 Renaming a Reason Set 

 Deleting Reason Sets 

 Saving Reason Sets 

 ·Undoing Your Changes 

 
2.3.3 Reject Reason Sets 

 

The Reject Reason Sets window lets you add, change or delete a reject reason set. Defining 
reject reason sets enable PlantStar to report on the number of rejects for a machine. It also is 
able to calculate reject percentages for each defined reject reason. Reject counts are 
collected using shift-to-date data of a current job or historical job. 

You can define up to twenty (20) reject reasons for each reason set. The first defined 
reason set and its reason definitions are visible initially. Reason sets are attached to a 
machine from the Machine Setup window. 

NOTE: An extended down and reject reason option can be purchased from PlantStar. 
This will extend the down/reject limit to one hundred and sixty (160) down/reject 
reasons for each set. 

NOTE: Reject Reason number two has a special meaning attached to it. PlantStar uses the 
second reject reason to accumulate the difference between gross and net pieces when Net 
Parts Counting is in effect. 
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Where can you find it? 

 Choose the Sets menu on the main Shop Configuration window. 

 Choose the Reject Reason Sets option. 

What do you want to know about? 

 Selecting Reason Sets 

 Creating Reason Sets  

 Renaming a Reason Set 

 Deleting Reason Sets  

 Undoing Your Changes 

 
2.3.4 Boot Sets 

 

 

The Boot Sets window lets you add, change or delete a boot set. Defining boot sets 
enables PlantStar to start-up and load information into a communications processor 
or a DCM. 

Defining boot sets for Communications Processors and DCMs are mandatory. A boot set 
lists the files that are downloaded to a Communications Processor or DCM. These files are 
required for communication and data collection. The boot set must correspond to your 
hardware configuration. A boot set is assigned to a Communications Processor or a DCM 
from the Comm Processors Setup or the DCM Setup windows. 

A list of defined boot sets is displayed upon the opening of this window. The boot files included 
in each boot set are marked by a check box to the left of their file name. You may use the 
default boot sets provided or create your own boot sets. 
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Where can you find it? 

 Choose the Sets menu on the main Shop Configuration window. 

 Choose the Boot Sets option. 

What do you want to know about? 

 Selecting Reason Sets 

 Creating Reason Sets 

 Renaming a Reason Set 

 Deleting Reason Sets 

 Saving Reason Sets 

 Undoing Your Changes 

 Including Boot Files from a Boot Set 

 
2.4 Groups Menu 

 
2.4.1 Work Center Setup 

 

The Work Center Setup window lets you add, change or delete a work center. Defining work 
centers is optional although this parameter offers you a way to group your machines into 
logical work groups. 
It is important to note that shift schedules are created for and assigned to individual work 
centers. 

All defined work centers are displayed upon the opening of this window. If there is no work 
center defined, the window appears with the default 'All' work center. This work center 
includes all defined machines. 

Machines are assigned to a work center from the Machine Setup window. A machine can 
belong to one and only one work center. 
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Where can you find it? 

 Choose the Groups menu on the main Shop Configuration window. 

 Choose the Work Center Setup option. 

What do you want to know about? 

 Changing Work Centers  

 Creating Work Centers  

 Deleting Work Centers  

 Changing An Existing Work Center's Name 

 Saving your Changes  

 Undoing your Changes  

 Closing the Window  
 

2.4.2 Display Group Setup 

 

The Display Group Setup window lets you add, change or delete display groups. Defining 
display groups is optional although this parameter offers you a way to group your machines 
into logical work groups for later monitoring and selection on multi-machine windows within 
PlantStar Monitor (for example, the Exception Summary window). 

Display groups are defined by work centers. Work centers define the shift schedule that a 
machine follows. Therefore, each machine within a display group has the same shift 
schedule. 

Existing display groups are displayed upon the opening of this window. On the right-hand side 
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is a list of machines currently assigned to the "group" visible in the Display Group field. On 
the left-hand side of the window is a list of existing machines within the selected work center. 
Any of the machines in this list can be added to the current display group. The up and down 
arrows on the window move a highlighted machine up or down the list, changing the order in 
which machines are displayed on all multi-machine windows. 

NOTE: A machine can exist in multiple display groups in any one work center. 

Where can you find it? 

 Choose the Groups menu on the main Shop Configuration window. 

 Choose the Display Group Setup option. 

What do you want to know about? 

 Changing Display Groups  

 Creating Display Groups  

 Deleting Display Groups  

 Adding Machines to a Display Group  

 Removing Machines from a Display Group 

 Ordering Machines in the List 

 Saving your Changes  

 Undoing your Changes  

 Closing the Window  
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2.5 Labor Menu 
 
2.5.1 Labor Setup 

 

 

The Labor Setup window lets you add, change or delete Labor Categories and Employees 
for a given work center. Defining Labor Categories is optional although this parameter offers 
you a way to group labor requirements for Labor Forecasting. 

Defining an Employee is necessary before that employee can be logged in and out. 

Where can you find it? 

 Choose the Labor menu on the main Shop Configuration window. 

 Choose the Labor Setup option. 

What do you want to know about? 

 Changing Work Centers  

 Editing Labor Categories  

 Editing Employee Records 

 Saving Your Changes  

 Undoing Your Changes  

 Closing the Window  
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2.6 Shop Floor Menu 
 
2.6.1 Comm Processor Setup 

 
The Comm Processor Setup window lets you add, change or delete a Communications 
Processor (Comm Processor) definition. The Comm Processor is the link between a 
DCM on the production floor and the PlantStar host computer. At least one Comm 
Processor must be defined. 

It is recommended that the shop floor be configured in the following sequence: 

 Set up the Comm Processor. 

 Set up DCMs. 

 Set up Down, Reject or Assist reasons. 

 Set up Work Centers. 

 Set up Machines. 

Each DCM must be associated with a Comm Processor. This is done from the DCM 
Setup and Machine Setup windows. 

Where can you find it? 

 Choose the Shop Floor menu on the main Shop Configuration window. 

 Choose the Comm Processor Setup option. 

What do you want to know about? 

 Selecting a Comm Processor 

 Creating a Comm Processor 

 Deleting a Comm Processor 

 Updating a Comm Processor 

 Changing a Comm Processor's Name 
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 Saving your Changes  

 Undoing Your Changes  

 Closing the Window 

 

2.6.2 DCM Setup 
 

 

The DCM Setup window lets you add, change or delete DCM information. This window 
configures a DCM to suit the shop floor environment. The software configuration must match 
the physical components within the unit. For instance, a DCM can only be configured for 16 
analog channels if the optional analog board was purchased and installed. This window also 
allocates the on-board memory (RAM Size). 

At least one DCM must be defined for your plant. All defined DCMs are displayed upon the 
opening of this window. If no DCMs have been defined, then the window appears blank. 

NOTE: Machines are assigned to DCMs from the Machine Setup window. 

Where can you find it? 

 Choose the Shop Floor menu on the main Shop Configuration window. 

 Choose the DCM Setup option. 
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What do you want to know about? 

 Selecting a DCM to View 

 Adding a DCM  

 Updating a DCM  

 Deleting a DCM  

 Enable a DCM  

 ColdStart a DCM  

 Changing General DCM Settings 

 Changing COM Port Settings  

 Changing Contact Input Settings  

 Changing RIO Settings  

 Saving your Changes  

 Undoing Your Changes  

 Closing the Window  
 
 

2.6.3 Machine Setup 

 

The Machine Setup window lets you add, change or delete a machine definition. It is 
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used to configure a machine to match a unique monitoring environment. Down reason 
sets, assist reason sets, and reject reason sets are assigned, along with analog inputs 
and digital inputs. 

Monitoring machines in Real-Time is the primary goal of PlantStar. Machines are the main 
data collection point. In order to create work orders and scheduled jobs, at least one 
machine must be already defined and its information downloaded to the shop floor. 

A list of defined machines is displayed upon the opening of this window. If no machines 
have been defined, the window appears blank. If machines have been defined, they can be 
selected for viewing from the machine field in the upper left corner. Once selected, a 
machine's general parameters, as well as its process variables and profiles appear. The 
process variables and profiles are located on the bottom portion of the window. 

Where can you find it? 

 Choose the Shop Floor menu on the main Shop Configuration window. 

 Choose the Machine Setup option. 

What do you want to know about? 

 Changing a Machine's Name 

 Creating Machines  

 Deleting Machines  

 Updating Machines  

 Editing Process Variables  

 Creating Process Variables  

 Deleting Process Variables  

 Changing Process Variables Name 

 Saving Process Variables  

 Editing Profile Variables  

 Creating Profile Variables  

 Deleting Profile Variables  

 Changing Profile Variables Name 

 Saving Profile Variables  

 Saving your Changes  

 Undoing Your Changes 

 Closing the Window  

 Undoing your Changes 
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2.6.4 REU Setup 

 

NOTE: REU’s are not supported in the current release of PlantStar. This window is only 
available for the deletion of REU's. 

Upon the opening of this window, a list of existing REU's is displayed -- along with 
its list of corresponding machines. 

Where can you find it? 

 Choose the Shop Floor menu on the main Shop Configuration window. 

 Choose the REU Setup option. 

What do you want to know about? 

 Selecting a REU 

 Deleting REU's  

 Saving your Changes  

 Undoing Your Changes 

 Closing the Window 
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2.7 Window Menu 
 
2.7.1 Arrange Icons 

To arrange the iconized windows into straight rows or columns, select the Window menu 
on the main menu bar. Choose the Arrange Icons option. 

 
2.7.2 Arrange Windows 

The windows can be arranged in three ways 

 
 

  Cascading: 
 
 
 
  Vertical Tiles: 
 
 
 
  Horizontal Tiles: 
 
 
 

To choose one of these styles, select the Window menu from the main system window. Select 
one of the options displayed 

 
2.8 Help Menu 

 
2.8.1 Help Contents 

General content help provides a table of contents for virtually all topics within this 
application. The Contents window can be used to jump to topics that explain various 
windows or how to get quick access to key reference topics. This help is available by 
selecting the Contents on the Help menu item. 

Use the scroll bar to the right side of the Help window to view the next page of the Table of 
Contents. 

 
2.8.2 Help Index 

The Index list is directly accessible from the Index on the Help menu item or from the Index 
tab within the on-line help utility. Index terms consist of: 

 Definitions 

 Formulas, if applicable 

 Recommended values, if applicable. 
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To access an item from the Index list: 

 Use the scroll bar on the right hand side to scroll the window to the desired item. 

 Point to the term or phase desired. 

 Double-click on the highlighted word to open. 

-Or- 

 Use the keyword field to search for the desired item. 

 Once found, double-click on the highlighted word to open. 

 
2.8.3 Help Search 

Another method to find a particular topic in Help is to use the Search option. To display the 
Search window, either choose Search from the Help menu on the application window or 
click the Search tab on the Help topic screen. 

Select a topic by: 
· Use the keyword field to search for the desired item. 
· Click on the List Topics button to search on the keyword entered 
· A list of related topics then appears on the screen. 
· Once found, double-click on the highlighted topic to open. 

 
2.8.4 Help Active Window 

Window level help provides information on the display that currently has focus. Information 
for each window includes: 

· Purpose of the window 
· Specific field descriptions 
· Window button explanations 

This type of help is available by selecting and opening a desired window. Once opened, 
select the Help-Active Window menu on the application window or press the F1 key. 

NOTE: If there are currently no PlantStar windows open, this menu item will not display any 
help. 

 
2.8.5 About PlantStar 

For up-to-date resource information, the application provides a window with the following 
information: 

· PlantStar Software Version 
· PlantStar Copyright Date 
· Microsoft Windows Version 
· Amount of free memory 

To see this information: 

· Select the Help menu on the main menu. 
· Choose the About PlantStar menu item. 
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3 Shop Floor Monitor 
PlantStar's goal is to provide you with a data collection and monitoring apparatus that 
enables you to make informed decisions on the factory floor in real-time. It defines the shop 
floor, schedules jobs on the floor, and monitors those jobs. 

The Monitor program provides information on current shop floor activity. Within Monitor, 
real-time monitoring is presented as a "moving window" of recent events. Information on 
the current shift, the current job, or the most recent machine cycle is presented in a variety 
of windows. A scheduling component, accessible through the Schedule menu, utilizes the 
Shop floor Configuration program's definitions in order to facilitate planning activities. 
These planning activities take the form of job scheduling. Jobs, their priorities and 
placement in a job queue, provide the work schedule for the shop floor. 

What do you want to know about? 

 Machine States  

 Shift Scheduling  

 Creating Work Orders  

 Creating Work Orders from a Standard Job Scheduling  

 Process and Production Monitoring Displaying SPC Statistics  

 Material Lot Tracking  
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3.1 File Menu 
 
3.1.1 User Preference 

 

 

The User Preference window enables you to customize the PlantStar environment in terms 
of: 

 Font Size - Changing Text Sizes sets the font size for all PlantStar windows. 

 Job Primary Label - The label to use for all jobs displayed on the Job Schedule Board 
window can be selected. The job label field lists all jobs on the Gantt chart by job 
name. The product label shows all jobs by product name. 

 Default When Moving a Job - You can select what will happen by default when moving 
work orders or jobs from one machine to another on the Job Schedule window. 

 Screen Load Behavior - This option enables the quick loading of screens. When the 
quick load option is enabled, a screen is loaded without retrieving the data for the 
selection criteria. Data is loaded after window is opened and selection is made. 

 Search Criteria - The search method used on the Job Schedule Board window can 
be selected. There are three search methods: left, embedded, and exact. Left 
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matching searches for records that start with a specified text. Embedded matching 
finds all occurrences of a text wherever it is located. Exact matching finds exact 
matches only. (Specific examples are provided under each method's field help 
topics.) 

 Show labor hours displays the total number of man hours required for each shift. 

 Language - This allows the users to select their language preference. 

These preferences are saved from session to session and will not change until the next 
modification.  

Where can you find it? 

 Choose the File menu on the Monitor window. 

 Choose the User Preference option. 

What do you want to know about? 

 Changing Preferences  

 Saving Your Changes 

 Undoing Your Changes 

 Closing the Window  

 
3.1.2 Logout 

The Logout menu option closes all the current opened PlantStar windows and returns you to 
the main Login window. 

 
3.1.3 Exit 

To exit the program, choose one of the following methods: 

 Select the Exit option under the File menu 

 Click your mouse button while it is positioned over the 'x' in the upper right hand 
corner of the window. 

NOTE: You must have the Exit Panorama privilege to exit the Monitor program. 
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3.2 Monitor Menu 
 
3.2.1 Display Group Status 

 

 

The Display Group Status window contains a rectangle for each defined display group. For 
each display group, the percent of machines in a down state, percent of machines in 
process exception, and the percent of machines in a production exception are calculated. 
Your system computes these percent values using current shift or job-to-date data or data 
collected during recent shifts. The color of the box reflects the display group's machine 
state. The machine with the highest priority state is reflected for the display group. See the 
Machine State Colors on-help section for further information. 

Where can you find it? 

 Choose the Monitor menu on the main your system window. 

 Choose the Display Group Status option. 

What do you want to know about? 

 Toggling Auto Size and Normal Size 

 Viewing Machine Status  

 Closing the Window  
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3.2.2 Machine Status 
 

 

The Machine Status window contains a rectangle for each machine in a selected display 
group. If you have not selected a display group, the initial default group 'All' is displayed. 
The machine name appears in the upper left hand corner of the rectangle. Below the 
machine is the product being produced. The standard multiplier and actual multiplier for 
the current job are located in the upper right corner. The number of net pieces, reject 
percent, and actual rate for each job on a machine is calculated using current shift or job-
to-date data or data collected during recent shifts. 

The color of the box reflects the machine's state. See the Machine State Colors on-help 
section for further information. 

NOTE: If the machine displayed is running a family job, the data displayed is one of the 
child jobs running. The child job displayed rotates to the next child job after each 
machine cycle. 

Where can you find it? 

 Choose the Monitor menu on the main your system window. 

 Choose the Machine Status option. 

What do you want to know about? 

 Viewing Machine Detail  

 Toggling Auto Size and Normal Size 

 Changing Display Group  

 Closing the Window  
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3.2.3 Labor Status 
 

 

The Labor Status window allows the viewing of any employee’s labor record for the current 
shift or any historical shift for the selected work center. It is also possible for employees to 
login or logout from this window. 

NOTE: You must have the proper privileges in order to view this window. See your 
System Administrator if you do not have the Labor viewing privilege. 

Where can you find it? 

 Choose the Monitor menu on the main your system window. 

 Choose the Labor Status option. 

What do you want to know about? 

 Changing Work Centers  

 Changing Shifts  

 Logging in an Employee  

 Logging out an Employee 

 Exporting Data  

 Refreshing the display  

 Sorting Columns  

 Resizing Columns  

 Closing the Window  
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3.2.4 Exception Summary 
 

 

The Exception Summary window highlights machines that are experiencing performance 
problems. These are machines that are in an exception state for the selected display group. 
There is one line of information for each machine within a display group. The color of the line 
reflects the machine's running state. See the Machine State Colors on-line help section for 
further information. 

If a machine is in exception, the applicable column information is displayed. For example, if a 
machine is in process exception, the process variable column displays the variable in 
violation. If a machine is in assist state, the assist reason displays in the Assist Reason 
column. 

NOTE: More than one type of exception can be displayed at one time. The "Machine" and 
"Exception Since" columns both display the highest priority machine running state. 

Highlighted exception states are: 

 Down state  

 Idle state  

 Off-line state  

 Process exception  

 Production exception  

 Assist state  

Where can you find it? 

 Choose the Monitor menu on the main your system window. 

 Choose the Exception Summary option. 



64 SYSCON-PlantStar Help System 

 

 

What do you want to know about? 

 Changing Display Groups  

 Changing View Options  

 Viewing Machine Exceptions 

 Closing the Window  

 
3.2.5 Production Summary 

 

 

The Production Summary window provides information on the selected display group's 
current production on each machine. Production information is described in terms of machine 
performance and progress toward completion of any current jobs. There is one line of 
information for each job running on each machine within the display group. If there are 
multiple jobs running on a machine (i.e. family job), there will be multiple lines displayed for 
each child job. 

The color of the line reflects the machine's running state. See the Machine State Colors 
on-line help section for further information. PlantStar computes all statistics using shift-to-
date data for all current jobs. 

Where can you find it? 

 Choose the Monitor menu on the main your system window. 

 Choose the Production Summary option. 

What do you want to know about? 

 Changing Display Groups 

 Changing View Options  

 Exporting Data  

 Closing the Window  
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3.2.6 Job Summary 
 

 

The Job Summary window displays current shift and historical shift information for a 
selected job running on a machine. 

The first row of the table provides shift-to-date information for the current shift and job. The 
middle rows display shift data for up to four completed shifts, depending upon how long a job 
has been running. The next row provides shift totals for the last four shifts available. Job-to-
date totals for all columns are then calculated in the last row of the table. The color of the 
window background reflects the machine's running state. See the Machine State Colors on-
line help section for further information. 

NOTE: If the job is a non-family job, the child job selection will display "No Family Jobs 
Defined" and the child job selection would be disabled. If the machine selected is running a 
family job, the child job selection will be enabled and the user can select from one of the 
child jobs running. 

Where can you find it? 

 Choose the Monitor menu on the main your system window. 

 Choose the Job Summary option. 

What do you want to know about? 

 Changing Display Groups  

 Changing Machines  
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 Changing Jobs  

 Changing Child Jobs  

 Changing Number of Shifts 

 Exporting Data  

 Closing the Window 

 
3.2.7 Material Usage 

 

 

The Material Usage window provides a summary of the amount of material used, excess 
material, and material requirements for each material component of a job. All calculations are 
based upon the current job. Material usage statistics are primarily based upon net pieces or 
gross pieces, part weight, and a job's standard multiplier. The handling of reject parts, 
whether runners are re-fed, determines whether usage and excess material calculations must 
take shot size into consideration. 

There is one line of information for each material component attached to the current 
running job on a machine. The window’s information can be filtered by display group, 
machine state, and material component. The color of each line reflects machine states. See 
the Machine State Colors on-line help section for color-coding. 

Where can you find it? 

 Choose the Monitor menu on the main your system window. 

 Choose the Material Usage option. 

What do you want to know about? 

 Changing Display Groups  

 Changing View Options  
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 Changing Material Components 

 Closing the Window  
 

3.2.8 Pareto/Pie Charts 

 
3.2.8.1 Down Pareto / Pie 

 

 

The Down Pareto/Pie window displays an ordered histogram of the down time for a selected 
shift, job, and child job. There is one vertical bar per down reason. Bar height represents the 
down time displayed. Bars are displayed from left to right in descending order, in effect 
highlighting the main causes of any down time. The Y-axis represents down time in terms of 
hours or minutes. The X-axis lists the down reasons as previously stated. 

Where can you find it? 

 Choose either the Monitor or History menu items on the main system window. 

 Chose the Pareto/Pie Charts option. 

 Choose the Down Pareto/Pie option. 

What do you want to know about? 

 Changing Display Groups  

 Changing Machines  

 Changing Jobs  

 Changing Child Jobs  

 Changing Shifts  
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 Changing Graph Types  

 Changing Number of Reasons Displayed  

 Scrolling the view 

 Viewing Next Shift 

 Viewing Previous Shift 

 Closing the Window  
 

3.2.8.2 Assist Pareto / Pie 

 

 

The Assist Pareto/Pie window displays an ordered histogram of the assist time for the 
selected shift, job, and child job. The X-axis lists the assist reasons as defined for a machine. 
There is one vertical bar per assist reason. Bar height represents the assist time displayed. 
Bars are displayed from left to right in descending order, in effect highlighting the main 
causes of any assist time. The Y-axis represents the amount of assist time in hours and 
minutes. 

The color of the bars reflects the current machine state of the selected machine. 
See the Machine State Colors on-help section for further information. 

Where can you find it? 

 Choose either the Monitor or History menu items on the main system window. 

 Chose the Pareto/Pie Charts option. 

 Choose the Assist Pareto/Pie option. 
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What do you want to know about? 

 Changing Display Groups  

 Changing Machines  

 Changing Jobs  

 Changing Child Jobs  

 Changing Shifts  

 Changing Graph Types  

 Changing Number of Reasons Displayed  

 Scrolling the view 

 Viewing Next Shift 

 Viewing Previous Shift 

 Closing the Window  
 
3.2.8.3 Reject Pareto / Pie 

 

 

The Reject Pareto/Pie window displays an ordered histogram of the reject counts for the 
selected shift, job, and child job. The X-axis lists the reject reasons as defined for a machine. 
There is one vertical bar per reject reason. Bar height represents the number of rejected 
parts. Bars are displayed from left to right in descending order, in effect highlighting the main 
causes of rejects. The Y-axis represents the number of rejects. The color of the bars reflects 
the current machine state of the job running on a selected machine. See the Machine State 
Colors on-help section for further information. 
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The window's scroll bars shift the view of the Pareto chart, allowing you to see all reject 
reasons defined for a machine. Click on the scroll bar to view reasons not immediately 
visible. 

NOTE: If the job selected is a non-family job, the child job selection will display "No Family 
Jobs Defined" and the child job selection would be disabled. If the machine selected is 
running a family job, the child job selection will be enabled and the user can select from one 
of the child jobs running. 

Where can you find it? 

 Choose either the Monitor or History menu items on the main system window. 

 Chose the Pareto/Pie Charts option. 

 Choose the Reject Pareto/Pie option. 

What do you want to know about? 

 Changing Display Groups  

 Changing Machines  

 Changing Jobs  

 Changing Child Jobs  

 Changing Shifts  

 Changing Graph Types  

 Changing Number of Reasons Displayed  

 Scrolling the View 

 Viewing Next Shift 

 Viewing Previous Shift 

 Closing the Window  
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3.2.9 Machine Performance 
 

 

The Machine Performance window provides a summary of a selected display group's 
performance over time as it pertains to currently running jobs. There is one line of 
information for each machine within the display group. The color of the line reflects the 
machine's running state. See the Machine State Colors on-line help section for further 
information. 

Where can you find it? 

 Choose the Monitor menu on the main PlantStar window. 

 Choose the Machine Performance option. 

What do you want to know about? 

 Changing Display Groups 

 Changing View Options  

 Closing the Window  
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3.2.10 Machine Exception 
 

 

The Machine Exception window provides a greater detailed description of a selected 
machine's running state than the Exception Summary window. Any running state of the 
machine is displayed along with an exception time. If a process variable is in exception, this 
window shows whether it is a result of a higher limit or lower limit violation. Also, this window is 
color-coded according to your system Machine State Colors. 

NOTE: The Machine Exception window can also be accessed from the Exception 
Summary window. While on the Exception Summary window, click on a machine's row of 
information. Exception information for the selected machine appears. 

Where can you find it? 

 Choose the Monitor menu on the main your system window. 

 Choose the Machine Exception option. 

What do you want to know about? 

 Changing Display Groups 

 Changing Machines  

 Closing the Window  



Shop Floor Monitor 73 

 

 

3.2.11 Machine Usage 
 

 

The Machine Usage window displays the machine usage and scheduled machine 
usage over a selected time period. 

Also, the Machine Usage window provides a detailed description of the selected machine's 
running state. Any running state that the machine is in is displayed along with an exception 
time. If a process variable is in exception, this window shows whether it is a result of a higher 
limit or lower limit violation. Also, this window is color-coded according to the system Machine 
State Colors. 

NOTE: For job-to-date calculations the current shift totals are also included. 

Where can you find it? 

 Choose the Monitor menu on the main your system window. 

 Choose the Machine Usage option. 

What do you want to know about? 

 Changing Start Date  

 Changing End Date  

 Rebuilding the Display  

 Printing 

 Changing Display Groups 

 Changing View Options  

 Closing the Window 
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3.2.12 Machine Log 
 

 

The Machine Log window displays a list of the most recent 1000 events relating to a 
selected machine. These events are recorded at the DCM. Event types include: 

 Job Related Events - start/end of a job or a job change; 

 Shift Related Events - start of a new shift or a shift idle period; 

 Down Events - start and end of down time periods; 

 Assist Events - start and end of assist time periods; 

 Process Alarm Events - time of a process exception, the actual "exception" value, 
and the limit it violated. Process exceptions are only logged, though, if the machine 
is not in a down state. If a process exception begins while a machine is down, the 
exception events are not logged for the machine. 

 Labor Events - login and logout of users on the selected machine 

 Material Events - material changes on the selected machine 

For process alarms, the specific process variables that display on this window depend upon 
how a machine is defined. The process log field on the Machine Setup window controls 
which variables are included. There are three process log options: 

 All - Include all process variables for a machine 

 None - do not include any process variables 

 Critical - Include critical process variables only. 

NOTE: The Machine Log window only updates if the scroll box is at the very bottom of the 
scroll bar. Events are updated every 60 seconds. 

Where can you find it? 

 Choose the Monitor menu on the main your system window. 

 Choose the Machine Log option. 
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What do you want to know about? 

 Changing Display Groups  

 Changing Machines  

 Changing Event Types 

 Exporting Data  

 Closing the Window  

 
3.2.13 Overlay Profile 

 

 

Profiles must be setup in the machine configuration before this graft is available. 
 
The Overlay Profile window displays the current behavior of a profile for a selected machine, 
overlays that profile on top of another profile or cross plots the profile with another profile. It 
also allows you to zoom in on sections of a profile. 

The window's graph area is blank until a profile is selected. Each profile is a collection of 
points. Each point represents a value that was collected during a machine cycle. Up to 500 
points may be shown. Actual values are plotted against the Y-axis. The X-axis represents the 
time when the actual values were taken relative to the start time. The start time is always 
zero, which is the point at which the collection of the profile began. 

NOTE: Each profile consumes a considerable amount of system resources. For that reason, 
only ten profiles may be displayed on the system at a given time. 

Special graph controls are available for manipulating and tailoring the profiles: 
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Freeze the profile 

Store the profile 

   Clip the profile 

   Manual scaling option 

    Auto scale once option 

    Auto scale every cycle option 

    Overlay selected profiles 

   Cross plot selected profiles 

The color of the window background reflects the machine’s running state. See the Machine 
State Colors in the on-line help section for further information. All profiles are plotted using 
the color code designated by the colored box to the left of each profile’s name. 

Where can you find it? 

 Choose the Monitor menu on the main system window. 

 Choose the Overlay Profile option. 

What do you want to know about? 

General Functions: 

 Changing Display Groups  

 Changing Machines 

 Selecting Profiles 

 Exporting Data 

 Closing the Window  
 

Graph Functions: 

 Clipping the graph 

 Freezing Profiles 

 Changing Profile Graph Modes 

 Changing Rescaling Options 

 Storing Profiles 

 Viewing Actual Values 

 Viewing Maximum and Minimum Values 

 Zooming Selected Profiles 
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3.2.14 Process Trend / SPC 

 

The Process Trend/SPC window graphically displays the behavior of any defined process 
variable for a machine. The selected number of most recent values for a variable is plotted. 

Specific points to note are: 

 The X-axis is the cycle number. The most recent cycle is 1. 

 The Y-axis is the actual process variable value. The rightmost point is the most recent 
value. For each machine cycle update, the new value enters from the right, moving the 
older values to the left. Undefined values show up as blank spaces in the graph. 

 The dashed, colored lines represent the higher limit and lower limit for the variable. The 
higher limit is red and the lower limit is blue. 

The color of the window background reflects the machine's running state. See the 
Machine State Colors on-help section for further information. 

Where can you find it? 

· Choose the Monitor menu on the main your system window. 

· Choose the Process Trend/SPC option. 

The Process Trend/SPC window can also be accessed from the Process Summary 
window. While on the Process Summary window, click on a process variable's row of 
information. A trend graph appears for the selected process variable and machine. 
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What do you want to know about? 

General Functions:  

 SPC Statistics Concepts  

 Changing Display Groups  

 Changing Machines  

 Selecting Process Variables 

 Displaying Standard SPC Statistics Exporting Data  

 Closing the Window  

Graph Functions:  

 Clipping the Graph  

 Changing the X-axis  

 Clearing Process History Information 

 Changing Rescaling Options  

 Viewing Actual Values 

 Viewing Maximum and Minimum Values 
 

3.2.15 Process Summary 
 

 

The Process Summary window displays the high value and low value for a 
machine's process variables measured during the last fifty complete machine 
cycles. 
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The Process Summary window provides quick access to the Process Trend/SPC window 
for a specified machine and process variable. To view a process trend graph, click on a 
process variable name or any place on its row of information. A trend graph appears for the 
selected process variable and machine. 

If a process variable is above the higher limit or below the lower limit, that process 
variable is highlighted according to the following default color scheme: 

 Red - value is above the higher limit 
 Blue - value is below the lower limit 

There is one line of information in the table for each process variable defined. The color of 
the window background reflects the machine's running state. See the Machine State Colors 
on-help section for further information. 

Where can you find it? 

 Choose the Monitor menu on the main your system window. 

 Choose the Process Summary option. 

What do you want to know about? 

 Changing Display Groups  

 Changing Machines  

 Closing the Window 
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3.3 Schedule Menu 
 
3.3.1 Job Schedule Board 

 

 

In order to collect process variables and production data for a machine, a job must be 
assigned on that machine. The process of scheduling or queuing jobs is handled through 
the Job Schedule window. 

The Job Schedule window consists of a Gantt style scheduling board. Calendar time is 
shown on the X-axis. Machines within a selected display group are shown on the Y-axis. 
Each row represents a machine's job queue and each rectangular block is a scheduled job. 
The first rectangular block for each machine is its current job. The block length indicates the 
expected run time for the job. Block labels are selectable. The caption display on the block 
labels can be either the job or product names for the selected job. 

NOTE: If the job scheduled is a family job, the block length indicates the expected run 
time of the longest running child job. 

A job is scheduled by selecting a work order and placing it in the job queue of a given 
machine. By default, jobs are scheduled sequentially from left to right. There are two 
scheduling methods available within your system: 

· Schedule jobs by earliest start date (default) 
· Schedule jobs by required by (due date) 

The default method on the Job Schedule window is for jobs to run immediately following 
the completion of previously-queued jobs. The estimated completion time of a job becomes 
the starting time for the next queued job. Under this method, jobs that are expected to be 
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completed on time are shown in green. A red rectangular block indicates that a job will not 
complete by its estimated completion date. The default method is active unless the second 
scheduling method has been activated and/or saved during a previous session. 

The second method is to schedule jobs by required by due date. This method places a 
selected job (or jobs) on the job board at the latest possible time which allows it to be 
completed by its due date. Specifically, a job's required by date is used as the starting point. 
The length of time to run a job is then used to walk backwards through the shift schedule to 
estimate the start date. Using this method, gaps may occur between a job's starting time and 
a previous job's ending time. These "gaps" are represented on the job board by gray blocks 
and indicate slack time where new jobs can be scheduled. Under this method, jobs that are 
expected to be completed on time are shown in green. If this method causes a subsequent 
job to become late, the late job's rectangular block is colored orange. 

The     marker, located along the top of the job board area, indicates which jobs are 
scheduled according to their due dates. All jobs to the left of this marker are scheduled 
according to the earliest possible start -- a job starts immediately upon completion of the 
previous job (method one). All jobs to the right of this marker are displayed on the job board 
according to their due dates (method two). 

(For more detailed explanations refer to the field help provided on the          icon.) 
 
The Job Schedule window also enables you to edit a work order, current job, or queued job. 

NOTE: You must have the proper privileges in order to schedule jobs. See your System 
Administrator if you do not have the scheduling privilege. 

Where can you find it? 

 Open the Schedule menu within Monitor. 

 Click on the Job Schedule window. 

What do you want to know about? 

General Topics: 
 Job Schedule Board Overview 

 Job Scheduling Concepts 

 Creating Work Orders 

 Loading a Product Standard onto a Job 

 Saving Jobs as a Standard 

Work Order Functions: 

 Creating Work Orders 

 Customizing the Work Order List 

 Refreshing the Work Order List 

Job Functions: 

 Selecting Jobs from the Schedule Board 

 Editing Jobs from the Schedule Board   

 Deleting Jobs from the Schedule Board   

 Searching for a Job  

 Viewing Job Summary Information  
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Scheduling Functions: 

 Moving Jobs Around the Schedule Board  

 Selecting a Time Scale  

 Selecting Display Groups from the Schedule Board 

 Scheduling Jobs by Earliest Start Date  

 Scheduling Jobs by Due Date  

 Viewing Production Hours  

 Viewing the Shift Schedule  

 Identifying Machines with Job Standards Committing a Schedule  
 Discarding a Schedule  

 
3.3.2 Current / Queue Jobs 

 

 

The Current/Queue Jobs window provides three functions: 

 Job parameters for a current job can be changed. 

 Job parameters for a queued job can be changed. 

 The current job and any queued jobs can be saved as product standards. 

A list of existing jobs is displayed on the left side of the window and job parameters are on 
the right. Additionally, the process variable, profile, setup sheets, and manning factor 
parameters are available from the Limits, Setup Sheet, and Labor tabs, located in the top 
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portion of the window. 

NOTE: 
· Current and Queued Jobs can also be created and edited from the Job Schedule 

Board window. 
· Access to this window is limited. You must have the Edit Current Job or 

Scheduling privilege in order to edit job parameters. If you do not have these 
privileges, the window is viewable but no information can be edited. 

Where can you find it? 

· Choose the Schedule menu on the main your system window. 
· Choose the Current/Queue Jobs option. 

What do you want to know about? 

 Changing Display Groups  

 Changing Machines  

 Selecting Current/Queue Jobs  

 Editing Production Parameters  

 Editing Process and Profile Limits  

 Editing Setup Sheets  

 Editing Labor Manning Factors  

 Loading a Product Standard onto a Job 

 Saving Jobs as a Standard  

 Saving your Changes  

 Undoing your Changes  

 Closing the Window  
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3.3.3 Work Orders 
 

 

The Work Order window lets you add, change or delete work orders. A list of work orders is 
displayed on the left side of the window upon opening. If no work orders have yet been 
defined, the work order list will be empty. 

Work orders are essentially jobs that have been defined but not yet scheduled. In order to 
schedule jobs, you must first create a work order. A work order consists of a set of job 
parameters. These parameters define the job. They include such things as the number of 
pieces required and the standard rate at which the pieces will be produced. 

A list of existing work orders is displayed on the left side of the window and job parameters 
are on the right. Additionally, the process variable, profile, setup sheets, and manning factor 
parameters are available from the Limits, Setup Sheet, and Labor tabs, located in the top 
portion of the window. 

A work order may be created manually by entering the parameters or by loading in a product 
standard. 

NOTE: 
· Work orders can also be created and edited from the Job Schedule Board window. 
· You must have the proper privileges to enter this menu option. (See your System 

Administrator if you do not have the proper privileges.). 

Where can you find it? 

 Choose the Schedule menu within Monitor. 

 Choose the Work Orders option. 
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What do you want to know about? 

 Creating Work Orders  

 Selecting Work Orders 

 Changing Machines  

 Editing Production Parameters  

 Editing Process and Profile Limits  

 Editing Setup Sheets  

 Editing Labor Manning Factors  

 Loading a Product Standard onto a Job  

 Saving Jobs as a Standard  

 Creating Unassigned Child Jobs  

 Deleting Unassigned Child Jobs  

 Adding Child Jobs to a Work Order 

 Removing Child Jobs from a Work Order 

 Assigning Child Jobs  

 Deleting Work Orders  

 Saving your Changes  

 Undoing your Changes  

 Refreshing the Lists  

 Closing the Window  
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3.3.4 Product Standards 
 

 

A job may be created manually entering all these types of parameters into a work order and 
then scheduling the job. The process of entering all the parameters can be time consuming. 
To facilitate this process, the Product Standards window is available. This window allows 
you to build up a collection of product-based standards. Job scheduling then consists of 
copying an existing product standard into a work order. The work order is placed into the 
job schedule. This library of standards also aids in the development of pre-defined 
standards for recurring jobs. 

Every job in PlantStar consists of a set of parameters. These parameters are based upon the 
type of product produced and the machines on which the product will run. They, in essence, 
describe the job and set the standard for monitoring it. They define the line between the 
normal operating mode and various exception states for a machine. All monitoring is based 
upon these values. For instance, if the Standard Cycle parameter is set to 30 seconds and 
the Cycle Tolerance is set to 10 percent, a machine would be considered slow if is cycle time 
was currently 50 seconds. This same machine would be considered down if the down time 
threshold parameter was set to less than 50 seconds. 

Job parameters also determine the expected run time of a job. The pieces required, standard 
setup time and the standard rate factor are used when computing the completion date of a job. 
If 10,000 pieces are required and the standard rate is 50 pieces per hour, then the runtime of a 
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job would be 200 hours. Add this to the standard setup time and you have the expected 
runtime of a job. The schedule now and schedule factory parameters also affect the calculated 
completion date. These fields determine if the shift schedule should be followed when 
computing the completion date. Specifically, the Product Standards window is used to add, 
change or delete product standards. Job parameters are separated into two types (product 
versus machine-specific). Machine-specific parameters are located in the bottom right corner. 
Machine-specific parameters generally change from machine to machine. Product-specific 
parameters generally do not change from machine to machine. They can, however, be 
changed if needed. 

A list of existing product standards is displayed on the left side of the window and job 
parameters are on the right. Additionally, the process variable, profile, setup sheets, and 
manning factor parameters are available from the Limits, Setup Sheet, and Labor tabs, 
located in the top portion of the window. 

NOTE: Once a product standard is saved for a machine, an asterisk appears next to the 
machine in the machine field. This asterisk signifies that a product standard exists for the 
specific machine and product. 

NOTE: You must have the proper privileges to view or edit Product Standards. See 
your System Administrator if you need this privilege. 

Where can you find it? 

 Choose the Schedule menu within Monitor. 

 Choose the Product Standards option. 

What do you want to know about? 

 Creating a Product Standard  

 Selecting Product Standards  

 Changing Machines  

 Editing Production Parameters  

 Editing Process and Profile Limits  

 Editing Setup Sheets  

 Editing Labor Manning Factors  

 Adding Child Jobs to a Product Standard  

 Removing Child Jobs from a Product Standard  

 Copying Product Standards  

 Deleting Product Standards  

 Saving your Changes  

 Undoing Your Changes  

 Refreshing the Lists  

 Closing the Window  



88 SYSCON-PlantStar Help System 

 

 

3.3.5 Shift Schedule 
 

 

The Shift Schedule window is used to create, assign, delete and change work center 
schedules. If no schedules have been defined, the window appears blank. To create a work 
center's shift schedule, use the New button. 

Shift schedules define the start time and end time for work shifts, idle times for holidays or 
weekends, and any other events when jobs should not be running or have special needs. 
Shift schedules are not required but they do provide the flexibility to control part of the job 
process. If shift schedules are not created, all jobs run all the time. 

Shift schedules are created for a work center. Each work center has multiple schedules -- 
one for each year desired. Each year’s schedule may have up to twelve different weekly 
work schedules. There must be at least one work center defined before access to the 
Shift Schedule window is possible. 

NOTE: You must have the Scheduling privilege in order to access this window. See your 
System Administrator if you need this privilege. 

Where can you find it? 

 Choose the Schedule menu within Monitor. 

 Choose the Shift Schedule option. 
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What do you want to know about? 

General Functions: 

 Shift Scheduling Concepts 

 Changing Work Centers  

 Selecting a Year 

 Closing the Window 

Weekly Schedules: 

 Creating Weekly Schedules 

 Assigning Weekly Schedules 

Yearly Schedules: 

 Creating Work Center Schedules  

 Deleting Schedules  

 Updating Schedules  

 Saving your Changes 

 Undoing your Changes 
 

3.3.6 Material Forecast 
 

 

The Material Forecast window provides a forecast of the amount of material required for both 
current jobs and queued jobs. Forecasts are based upon scheduled jobs information. Job 
parameters such as standard multiplier, actual multiplier, part weight, and component 
percents are used to calculate forecast figures. The handling of reject parts and whether 
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runners are re-fed determines whether material forecast figures are based upon pieces 
remaining or whether shot size is taken into consideration. There is one row of information in 
the table for each material component within a current job or queued job. The background 
colors reflect the current machine state of the job running on a selected machine. See the 
Machine State Colors on-help section for further information. 

Queued jobs are displayed as white on dark grey and are listed after each machine's current 
job. 

NOTE: This window does not automatically update information with each machine cycle. 
The Build button must be used to obtain the most current forecast figures. 

Where can you find it? 

 Choose the Schedule menu on the main your system window. 

 Choose the Material Forecast option. 

What do you want to know about? 

 Changing Display Groups  

 Changing Machines  

 Changing Material Components 

 Rebuilding the Display  

 Closing the Window 

 
3.3.7 Labor Forecast 

 

 

The Labor Forecast Window is used to accurately forecast, by work center and shift, the 
number of employees needed in a given Labor Category. This forecast is based off current 
jobs and queued jobs scheduled. 
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There are two different views to Labor Forecasting: 

 Grid View  

 Graph View 

NOTE: This window does not automatically update information with each machine cycle. 
The Build button must be used to obtain the most current forecast figures. 

Where can you find it? 

 Choose the Schedule menu on the main your system window. 

 Choose the Labor Forecast option. 

What do you want to know about? 

 Changing Work Centers  

 Changing Start Date  

 Changing Shifts  

 Changing Number of Shifts to Forecast 

 Changing Forecast Views  

 Changing Graph Types  

 Changing Labor Categories  

 Rebuilding the display  

 Exporting Data  

 Sorting Columns  

 Resizing Columns  

 Closing the Window  
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3.3.8 Tool Change 
 

 

The Tool Change window provides information on upcoming tooling changes for both current 
jobs and queued jobs. The list of tooling changes can be filtered by display group, machine, 
forecast interval or tool name. The type of tooling changes displayed is selectable. The Tool 
Change Only and All Job Changes fields, located directly below the tool table, determine 
which jobs are displayed in the tool table. 

If Tool Change Only is selected, and if each job’s tool(s) are different, then current jobs and 
the next job scheduled on the same machine are displayed. If a currently-running job and 
upcoming queued job have the same tool, neither one is displayed. (The next job is color-
coded in blue on dark cyan.) 

If All Jobs Only is selected, all jobs which meet the selection filters (display group, 
machine, tool or forecast interval) are listed regardless of whether or not there are tooling 
changes. Current jobs are listed first, followed by the next queued job. 

Queued jobs can be listed twice in the tooling table -- once as a "next" job and once as a 
queued job with its own "next" job. Queued jobs that are listed a second time are displayed 
as white on dark grey. 

NOTE: This window does not automatically update information with each machine cycle. 
The Build button must be used to obtain the most current tool schedule. 

Where can you find it? 

 Choose the Schedule menu on the main your system window. 

 Choose the Tool Change option. 
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What do you want to know about? 

 Changing Display Groups  

 Changing Machines  

 Changing Tools  

 Toggling Tool Change View  

 Selecting Forecast Intervals 

 Rebuilding the Display  

 Closing the Window 
 

3.4 History Menu 
 
3.4.1 SPC History 

 

 
The SPC History window displays a line chart of the SPC values collected for a specific 
process variable and job. It includes two graphs. The top graph is a plot of X-bar values 
collected from the selected job and the bottom graph is a plot of the associated range values. 
The X-axis is the time at which the SPC values were recorded. The number of values graphed 
may be a subset of the total collected. On the top graph, the Y-axis is the X-bar value 
collected for the selected job and process variable. On the bottom graph, the Y-axis is the 
range value. The rightmost point is the most recent value for the process variable and job. 

There is a scroll bar at the bottom of the graph that allows you to scroll through the SPC 
values. As you slide the scroll bar, you see the X-axis change. The range of the scroll bar is 
shown below the scroll bar. The value on the left is the time of the first SPC data (the oldest 
data). The value on the right is the time of the latest SPC data collected for the process 
variable and job. To view more data, slide the scroll bar to the left. Move the scroll bar to the 
right to view more current data. 
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The number of plotted values on both graphs is changeable using the Size field. If the size 
is set to 100, then 100 SPC samples are plotted. Changing the size does not change the 
value of the scroll bar. It only changes the 'depth' of the data selection. 

The X-bar mean value for each graph is shown as a solid gray line. The upper and lower 
control limits are dashed blue lines. The upper and lower specification lines are shown on the 
X-Bar graph as dashed red lines. 

Where can you find it? 

 Choose the History menu on the main your system window. 

 Choose the SPC History option. 

What do you want to know about? 

General Functions: 

 SPC Statistics Concepts 

 Changing Machines 

 Changing Jobs 

 Selecting Process Variables 

 Displaying Standard SPC Statistics 

 Exporting Data 

 Closing the Window 

Graph Functions: 

 Changing the X-axis 

 Changing Rescaling Options 

 Viewing Actual Values 

 Viewing Maximum and Minimum Values 

 
3.4.2 Labor History 

 

 

The Labor History window displays a table of labor records for a specific job and shift. These 



Shop Floor Monitor 95 

 

 

records can be adjusted for historical shifts or current shifts. Labor history records include the 
following: 

· Employee Name 
· Labor Category  
· Start Date  
· Start Time  
· End Date  
· End Time  
· Total Hours  
· Down Time  
· Total Rejects  
· Net Pieces  

NOTE: Adjusted totals cannot be negative. 

NOTE: If the job selected is a non-family job, the child job selection will display "No Family 
Jobs Defined" and the child job selection would be disabled. If the machine selected is running 
a family job, the child job selection will be enabled and the user can select from one of the 
child jobs running. 

NOTE: You must have the proper privileges in order to view/edit Labor History. See 
your System Administrator if you do not have this privilege. 

Where can you find it? 

 Click on the History menu. 

 Choose the Labor History option. 

What do you want to know about? 

 Changing Work Centers 

 Changing Machines 

 Changing Jobs 

 Changing Shifts 

 Changing Child Jobs 

 Deleting a Labor Record 

 Changing Labor Categories 

 Adjusting Start/End Date 

 Adjusting Start/End Time 

 Adjusting Down Time 

 Adjusting Reject Counts 

 Adjusting Gross or Net Pieces 

 Adding an Employee to Labor History 

 Resizing Columns 

 Saving your Changes 

 Undoing your Changes 

 Closing the Window 
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3.4.3 Material Lot Tracking 
 

 

The Material Lot Tracking window displays material components and the material lot IDs 
that have been entered at a DCM through a bar code reader or a touch screen. You can 
select a material lot and view its detail. 

Upon entering this window, it is blank. Search keys located in the upper part of the window 
help find material lots quickly. If a search is initiated with search keys, all material 
components associated with those keys are listed at the bottom of the window. If all fields 
are left blank, all material lot records are listed. From this list, you can select a material lot 
record and view either its tote box or material lot history. See the Material Lot Detail on-help 
section for further information. 

Where can you find it? 

 Click on the History menu. 

 Choose the Material Lot Tracking option. 

What do you want to know about? 

 Material Lot Tracking Concepts 

 Searching Material Lots  

 Clearing Search Fields  

 Viewing Material Lot Detail 

 Exporting Data  

 Sorting Columns  



Shop Floor Monitor 97 

 

 

 Resizing Columns  

 Closing the Window  
 
3.4.3.1 Material Lot Detail 

 

 

The Material Lot Detail window displays the net pieces, total rejects, gross pieces, down 
time, tote pieces, material components and percents for a selected material lot ID. Each 
historical lot record is listed in chronological order, in the Lot ID field, at the top of the window. 

Where can you find it? 

The Material Lot Detail window can only be opened from the Material Lot Tracking 
window. 

What do you want to know about? 

 Selecting/Viewing Job List 

 Viewing Material Components 

 Selecting/Viewing Job Details 

 Selecting/Viewing Tote Details 

 Selecting a Different Lot ID 

 Sorting Columns 

 Resizing Columns 

 Closing the Window 
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3.4.4 Pareto/Pie Charts 

 
3.4.4.1 Down_Pareto_Pie 

 

 

The Down Pareto/Pie window displays down time in terms of hours or minutes. The X-axis 
lists the down reasons as previously stated, an ordered histogram of the down time for a 
selected shift, job, and child job. There is one vertical bar per down reason. Bar height 
represents the down time. Bars are displayed from left to right in descending order, in effect 
highlighting the main causes of any down time. The Y-axis represents down time in terms of 
hours or minutes. The X-axis lists the down reasons as previously stated. 

Where can you find it? 

 Choose either the Monitor or History menu items on the main system window. 

 Chose the Pareto/Pie Charts option. 

 Choose the Down Pareto/Pie option. 

What do you want to know about? 

 Changing Display Groups 

 Changing Machines 

 Changing Jobs 

 Changing Child Jobs 

 Changing Shifts 

 Changing Graph Types 

 Changing Number of Reasons Displayed 
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 Scrolling the view 

 Viewing Next Shift 

 Viewing Previous Shift 

 Closing the Window 
 
3.4.4.2 Assist_Pareto_Pie 

 

 

The Assist Pareto/Pie window displays an ordered histogram of the assist time for the 
selected shift, job, and child job. The X-axis lists the assist reasons as defined for a machine. 
There is one vertical bar per assist reason. Bar height represents the assist time displayed. 
Bars are displayed from left to right in descending order, in effect highlighting the main 
causes of any assist time. The Y-axis represents the amount of assist time in hours and 
minutes. 

The color of the bars reflects the current machine state of the selected machine. 
See the Machine State Colors on-help section for further information. 

Where can you find it? 

 Choose either the Monitor or History menu items on the main system window. 

 Chose the Pareto/Pie Charts option. 

 Choose the Assist Pareto/Pie option. 

What do you want to know about? 

 Changing Display Groups  

 Changing Machines  
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 Changing Jobs  

 Changing Child Jobs  

 Changing Shifts  

 Changing Graph Types  

 Changing Number of Reasons Displayed 

 Scrolling the view 

 Viewing Next Shift 

 Viewing Previous Shift 

 Closing the Window  
 
3.4.4.3 Reject_Pareto_Pie 

 

 

The Reject Pareto/Pie window displays an ordered histogram of the reject counts for the 
selected shift, job, and child job. The X-axis lists the reject reasons as defined for a machine. 
There is one vertical bar per reject reason. Bar height represents the number of rejected 
parts. Bars are displayed from left to right in descending order, in effect highlighting the main 
causes of rejects. The Y-axis represents the number of rejects. The color of the bars reflects 
the current machine state of the job running on a selected machine. See the Machine State 
Colors on-help section for further information. 

The window's scroll bars shift the view of the Pareto chart, allowing you to see all reject 
reasons defined for a machine. Click on the scroll bar to view reasons not immediately 
visible. 

NOTE: If the job selected is a non-family job, the child job selection will display "No Family 
Jobs Defined" and the child job selection would be disabled. If the machine selected is 
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running a family job, the child job selection will be enabled and the user can select from one 
of the child jobs running. 

Where can you find it? 

 Choose either the Monitor or History menu items on the main system window. 

 Chose the Pareto/Pie Charts option. 

 Choose the Reject Pareto/Pie option. 

What do you want to know about? 

 Changing Display Groups  

 Changing Machines  

 Changing Jobs  

 Changing Child Jobs  

 Changing Shifts  

 Changing Graph Types  

 Changing Number of Reasons Displayed  

 Scrolling the View 

 Viewing Next Shift 

 Viewing Previous Shift 

 Closing the Window  

 
3.4.5 Down Time Editor 

 

 

The Down Time Editor window displays a table of down time for a specified machine, job, 
and shift. There is one row of information in the table per down reason. Incorrect time values 
for a job can be corrected in this window. 

Adjustments can be made upward or downward for each defined reason. Adjusted 
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totals cannot, though, be negative. There is one row of information in the table for each 
down reason. Use the "Adjust +/-" column to make any necessary adjustments. 

A machine can also be forced into a down state from the Down Select field on this window. 
When a machine enters a forced down state, its associated DCM may or may not continue to 
count parts and monitor process variable information. The action taken depends upon how 
the down reason which triggered the "force down" is defined in terms of its “force down flag” 
and “ignore cycles flag”. These flags are set on the Down Reason Sets window. 

Where can you find it? 

 Click on the History menu. 

 Choose the Down Time Editor option. 

What do you want to know about? 

 Changing Machines  

 Changing Jobs  

 Changing Shifts  

 Adjusting Times  

 Forcing a Machine Down  

 Saving your Changes  

 Undoing your Changes  

 Closing the Window  

 
3.4.6 Assist Time Editor 

 

 

The Assist Time Editor window displays a table of assist time for a specified machine, job, 
and shift. There is one row of information in the table per assist reason. Incorrect time values 
for a job can be corrected in this window. 
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Adjustments can be made upward or downward for each defined reason. Adjusted 
totals cannot, though, be negative. There is one row of information in the table for each 
down reason. Use the "Adjust +/-" column to make any necessary adjustments. 

Where can you find it? 

 Click on the History menu. 

 Choose the Assist Time Editor option. 

What do you want to know about? 

 Changing Machines  

 Changing Jobs  

 Changing Shifts  

 Adjusting Times  

 Saving your Changes  

 Undoing your Changes 

 Closing the Window  

 
3.4.7 Parts Count Editor 

 

 

Incorrect counts for a shift and job can be adjusted from the Parts Count Editor window. 
This window displays two tables. The top table lists reject counts by reject reason for a 
specified machine, job, child job, and shift. The bottom table displays gross pieces and net 
pieces for the same time period. Adjustments can be made upward or downward for 
historical shifts and current shifts. 

NOTE: If the job selected is a non-family job, the child job selection will display "No Family 
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Jobs Defined" and the child job selection would be disabled. If the machine selected is 
running a family job, the child job selection will be enabled and the user can select from one 
of the child jobs running. 

Where can you find it? 

 Choose the History menu on the main your system window. 

 Choose the Parts Count Editor option. 

What do you want to know about? 

 Changing Machines 

 Changing Jobs 

 Changing Child Jobs 

 Changing Shifts 

 Adjusting Reject Counts 

 Adjusting Gross or Net Pieces 

 Saving your Changes 

 Undoing your Changes 

 Closing the Window 

 
3.5 Window Menu 

 
3.5.1 Arrange Icons 

To arrange the iconized windows into straight rows and columns, select the Window 
menu on the main screen of your system window. Choose the Arrange Icons option. 

 
3.5.2 Arrange Windows 

The windows can be arranged in 3 ways: 

 

Cascading: 

 

 

 

Vertical Tiles: 

 

 

 

  Horizontal Tiles: 

 

 

 

 

To choose one of these styles, select the Window menu from the main screen of your 
system window. Select one of the options displayed 
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3.6 Help Menu 

 
3.6.1 Help Contents 

General content help provides a table of contents for virtually all topics within this application. 
The Contents window can be used to jump to topics that explain various windows or how to 
get quick access to key reference topics. This help is available by selecting the Contents on 
the Help menu item. 

Use the scroll bar to the right side of the Help window to view the next page of the Table of 
Contents. 

 
3.6.2 Help Index 

The Index list is directly accessible from the Index on the Help menu item or from the Index 
tab within the on-line help utility. Index terms consist of: 

· definitions 
· formulas, if applicable 
· recommended values, if applicable. 

To access an item from the Index list: 

· Use the scroll bar on the right hand side to scroll the window to the desired item. 
· Point to the term or phase desired. 
· Double-click on the highlighted word to open. 

-Or- 

· Use the keyword field to search for the desired item. 
· Once found, double-click on the highlighted word to open. 

 
3.6.3 Help Search 

Another method to find a particular topic in Help is to use the Search option. To display the 
Search window, either choose Search from the Help menu on the application window or 
click the Search tab on the Help topic screen. 

Select a topic by: 

· Use the keyword field to search for the desired item. 
· click on the List Topics button to search on the keyword entered 
· A list of related topics then appears on the screen. 
· Once found, double-click on the highlighted topic to open. 

 
3.6.4 Help Active Window 

Window level help provides information on the display that currently has focus. Information 
for each window includes: 

· purpose of the window 
· specific field descriptions 
· window button explanations 
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This type of help is available by selecting and opening a desired window. Once opened, 
select the Help-Active Window menu on the application window or press the F1 key. 

NOTE: If there are currently no PlantStar windows open, this menu item will not display any 
help. 

 
3.6.5 About PlantStar 

For up-to-date resource information, the application provides a window with the following 
information: 

· PlantStar Software Version 
· PlantStar Copyright Date 
· Microsoft Windows Version 
· Amount of free memory 

To see this information: 

· Select the Help menu on the main menu. 
· Choose the About PlantStar menu item. 
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4 Voice Output 
A PlantStar system configured with the Voice Output Option is able to broadcast messages 
relating to currently monitored exception conditions such as: 

 Down states 

 Idle states 

 Fast states 

 Slow states 

 Assist states 

 Production exceptions 

 Process variable exceptions 

 Reject Exceptions 

These messages can be heard on speakers or public address systems. There are three 
primary components to the Voice application: 

 Configuring Your Voice System 

 Monitoring Exception Conditions 

 Monitoring Individual Machine Status 

The general procedure for setting up a Voice system is: 

· Define Your System Parameters - Decide upon how often announcement messages 
should be broadcast. Use the System Parameters window under the Configure 
menu to set this schedule. 

· Define The Announcement Format - Decide whether each exception announcement 
should be preceded by an attention announcement. Use the Attention 
Announcement window under the Configure menu to set this schedule. 

· Configure The Announcements - Decide on which machines, machine states, 
process variable exceptions, assist reasons, and down reasons should be monitored 
for exception announcement. Setup of these conditions is done via the Configure 
windows. 

 
4.1 File Menu 

 
4.1.1 Exit 

To exit the program, choose one of the following methods: 

· Select the Exit option under the File menu 
· Click your mouse button while it is positioned over the 'x' in the upper right hand 

corner of the window. 

NOTE: You must have the Exit Panorama privilege to exit the Monitor program. 
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4.2 Monitor Menu 

 
4.2.1 Exception Summary 

 

 

The Exception Summary window highlights machines that are experiencing performance 
problems. These are machines that are in an exception state for the selected display group. 
There is one line of information for each machine within a display group. The color of the line 
reflects the machine's running state. See the Machine State Colors on-line help section for 
further information. 

If a machine is in exception, the applicable column information is displayed. For example, if a 
machine is in process exception, the Process Variable column displays the variable in 
violation. If a machine is in assist state, the assist reason displays in the Assist Reason 
column. 

NOTE: More than one type of exception can be displayed at one time. The "Machine" and 
"Exception Since" columns both display the highest priority machine running state. 

Highlighted exception states are: 

 down state 

 idle state 

 off-line state 

 process exception 

 production exception 

 assist state 

Where can you find it? 

 Choose the Monitor menu on the main your system window. 
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 Choose the Exception Summary option. 

What do you want to know about? 

 Changing Display Groups 

 Changing View Options 

 Viewing Machine Exceptions 

 Closing the Window 

 
4.2.2 Machine Exception 

 

The Machine Exception window provides a greater detailed description of a selected 
machine's running state than the Exception Summary window. Any running state of the 
machine is displayed along with an exception time. If a process variable is in exception, this 
window shows whether it is a result of a higher limit or lower limit violation. Also, this window 
is color-coded according to the system Machine State Colors. 

Where can you find it? 

 Choose the Monitor menu on the main your system window. 

 Choose the Machine Exception option. 

NOTE: The Machine Exception window can also be accessed from the Exception 
Summary window. While on the Exception Summary window, click on a machine's row of 
information. Exception information for the selected machine appears. 

What do you want to know about? 

 Changing Display Groups 

 Changing Machines  



112 SYSCON-PlantStar Help System 

 

 

 Closing the Window  

 
4.3 Configure Menu 

 
4.3.1 System Parameters 

 

 

The System Parameters window lets you set the number of minutes between repeat 
announcements of the same exception condition. This time delay can be set for all machines 
in the specified work center. If a specific work center is selected and its announcement delay 
set, all Voice windows and announcements will refer to only those machines in the selected 
work center. 

A list of defined work centers is displayed upon the opening of this window. Choose the 
desired work center and type in its required Announcement delay. 

Where can you find it? 

 Click on the Configure menu. 

 Choose the System Parameters option. 

What do you want to know about? 

 Changing Work Centers 

 Saving your Changes  

 Undoing your Changes  

 Closing the Window  

 
4.3.2 Attention Announcement 

 

 

The Attention Announcement window lets you record and plays attention announcements. 
This announcement is broadcast before any other exception announcement and can be 
turned on or off as desired from the Play Attention field. 
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Where can you find it? 

 Click on the Configure menu. 

 Choose the Attention Announcement option. 

What do you want to know about? 

 Playing an Announcement 

 Recording an Announcement 

 Activating an Attention Announcement 

 Saving your Changes 

 Closing the Window 

 
4.3.3 State Announcement 

 

 

The State Announcement window lets you record and plays announcements for all machine 
running conditions except standard. Upon initially opening the window, each condition for 
which an announcement can be recorded is listed. Choose the desired machine state and 
click on the Record command button. 

Where can you find it? 

 Click on the Configure menu. 

 Choose the State Announcement option. 

What do you want to know about? 

 Playing an Announcement 

 Recording an Announcement 

 Closing the Window 
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4.3.4 Down Announcement 

 

 

The Down Announcement window lets you record, play and copy announcement 
messages for whenever a machine goes into a down state. A separate announcement 
can be recorded for each defined down reason within a selected down set. 

Note: Down does not mean the machine is no longer cycling. A machine is considered 
down under one of the following circumstances: 

· The machine is cycling so slowly that the actual cycle time is longer than the down time 
threshold specified in the current job. 

· The operator has selected a down reason that 'forces' the machine into a down state. 

Where can you find it? 

 Click on the Configure menu. 

 Choose the Down Announcement option. 

What do you want to know about? 

 Playing an Announcement 

 Copying an Announcement 

 Recording an Announcement 

 Saving your Changes 

 Undoing your Changes 

 Closing the Window 
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4.3.5 Assist Announcement 

 

 

The Assist Announcement window lets you record, play and copy announcement 
messages for whenever a machine goes into an assist state. A separate announcement 
can be recorded for each defined assist reason within a selected assist set. 

Where can you find it? 

 Click on the Configure menu. 

 Choose the Assist Announcement option. 

What do you want to know about? 

 Playing an Announcement 

 Copying an Announcement 

 Recording an Announcement 

 Saving your Changes 

 Undoing your Changes 

 Closing the Window 
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4.3.6 Process Announcement 

 

 

The Process Announcement window lets you record, play and copy announcement 
messages for a machine's process variables. A separate announcement can be recorded 
for each defined process variable for any existing machine. 

Where can you find it? 

 Click on the Configure menu. 

 Choose the Process Announcement option. 

What do you want to know about? 

 Playing an Announcement 

 Copying an Announcement 

 Recording an Announcement 

 Saving your Changes 

 Undoing your Changes 

 Closing the Window 
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4.3.7 Machine Announcement 

 

 

The Machine Announcement window lets you determine which exception states will be 
announced on a machine by machine basis. Once selected for announcement, an 
exception condition can have its own announcement message recorded and played back. 

A list of defined machines is displayed upon the opening of this window. Select the 
announcement conditions for a machine by clicking the box to the right of the desired 
condition. Click on the Record button to record the appropriate announcement message. 

Where can you find it? 

 Choose the Configure menu. 

 Choose the Machine Announcement option. 

What do you want to know about? 

 Playing an Announcement 

 Recording an Announcement 

 Saving your Changes 

 Undoing your Changes 

 Closing the Window 

 
4.4 Options Menu 

 
4.4.1 Silence Mode 

All voice announcements can be suspended from the Silence Menu option. When 
announcements are suspended, existing voice messages are not deleted. They are saved for 
later re-activation. Upon re-activation of all voice announcements, existing messages 
immediately sound if an exception condition is occurring. The suspension period stays in 
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effect as long as a check mark appears next to this option. 

· To select this mode, choose the Options menu on the main Voice window. 
· Click on the Silence menu option. A check mark appears indicating the activation of 

announcement suspensions. 
· To de-select this option, click on the Silence menu option until no check mark 

appears on the left- hand side. 

 
4.4.2 Changing Text Sizes 

This option sets the font size for the current PlantStar 
application. 

Text size choices are: 

· Tiny 

· Small 

· Medium 
· Large 

· Huge 

 
4.5 Window Menu 

 
4.5.1 Arrange Icons 

To arrange the iconized windows into straight rows and columns, select the Window 
menu on the main screen of your system window. Choose the Arrange Icons option. 

 
4.5.2 Arrange Windows 

The windows can be arranged in 3 ways: 

 
 
  Cascading: 

 
 
 
  Vertical Tiles: 
 
 
 
  Horizontal Tiles: 
 
 
 

To choose one of these styles, select the Window menu from the main screen of your 
system window. Select one of the options displayed. 
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4.6 Help Menu 

 
4.6.1 Help Contents 

General content help provides a table of contents for virtually all topics within this 
application. The Contents window can be used to jump to topics that explain various 
windows or how to get quick access to key reference topics. This help is available by 
selecting the Contents on the Help menu item. 

Use the scroll bar to the right side of the Help window to view the next page of the Table of 
Contents. 

 
4.6.2 Help Index 

The Index list is directly accessible from the Index on the Help menu item or from the Index 
tab within the on-line help utility. Index terms consist of: 

· definitions 
· formulas, if applicable 
· recommended values, if applicable. 

To access an item from the Index list: 

· Use the scroll bar on the right hand side to scroll the window to the desired item. 
· Point to the term or phase desired. 
· Double-click on the highlighted word to open. 

-Or- 

· Use the keyword field to search for the desired item. 
· Once found, double-click on the highlighted word to open. 

 
4.6.3 Help Search 

Another method to find a particular topic in Help is to use the Search option. To display the 
Search window, either choose Search from the Help menu on the application window or 
click the Search tab on the Help topic screen. 

Select a topic by: 

· Use the keyword field to search for the desired item. 
· Click on the List Topics button to search on the keyword entered 
· A list of related topics then appears on the screen. 
· Once found, double-click on the highlighted topic to open. 

 
4.6.4 Help Active Window 

Window level help provides information on the display that currently has focus. Information 
for each window includes: 

· purpose of the window 
· specific field descriptions 
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· window button explanations 

This type of help is available by selecting and opening a desired window. Once opened, 
select the Help-Active Window menu on the application window or press the F1 key. 

NOTE: If there are currently no PlantStar windows open, this menu item will not display any 
help. 

 
4.6.5 About PlantStar 

For up-to-date resource information, the application provides a window with the following 
information: 

· PlantStar Software Version 
· PlantStar Copyright Date 
· Microsoft Windows Version 
· Amount of free memory 

To see this information: 

· Select the Help menu on the main menu. 
· Choose the About PlantStar menu item. 
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5 View and Print 
The Custom Reports Print program provides three primary functions: 

· Prints custom reports 
· Schedules custom reports 
· Prints scheduled reports automatically 

Prints Custom Reports - Users can print custom reports on-demand. Any criterion that was 
defined via the Custom Reports Manager program is used to determine the content of any 
report. Both on-line and paper reports can be generated. 

Schedules Custom Reports - It is possible to set up a schedule for automatic printing 
of custom reports. Listed below are the scheduling options available: 

· Reports can be scheduled to print at a specific time 
· Reports can be scheduled on a daily basis 
· Reports can be scheduled on a weekly basis 
· Reports can be scheduled to print at the end of a shift 
· Reports can be scheduled to print at the end of each job 
· Reports can be printed on any network printer or sent to an HTML file. 

Prints Scheduled Reports Automatically – The Custom Reports Print program 
automatically prints any custom reports that you scheduled to your default Windows printer. 
Other users may schedule different custom reports on their PC. Their reports will not print 
out from your PC. 

To print scheduled reports, this program actively monitors end-of-shift and end-of-job events 
to determine when reports need to be printed. If the Print program is minimized, your custom 
reports will automatically print. If the Print program is not running when a scheduled event 
occurs, no scheduled reports will be printed. The next time the Print program is opened, you 
will receive a message asking to print previously-scheduled reports. 

 
5.1 Custom Reports 

 
5.1.1 View 
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Once a custom report has been designed and defined within PlantStar, the Print Custom 
Report window provides the capability of printing those reports on-demand. A list of 
defined reports appears upon entry into the window. When one of these custom reports is 
printed, any criteria that has been defined for the report is utilized. 

In terms of printing capabilities, both on-line and paper reports are available.  

Where can you find it? 

 Choose the Custom Reports menu on the main window. 

 Choose the Print option. 

What do you want to know about? 

 Selecting a Report 

 Selecting Criteria for a Report  

 Viewing the Selected Report  

 Sending a Report to the Printer 

 Refreshing the Display 

 
5.1.2 Schedule 

 

 

The Schedule Custom Reports window lets you schedule custom reports that have 
been defined within PlantStar for automatic printing. A variety of scheduling options are 
available: 

· Weekly Reports 
· Daily Reports 
· End-of-Shift Reports 
· End-of-Job Reports 

Custom reports are scheduled on a PC by PC basis. For example, the Custom Reports 
Print program automatically prints any custom reports that you schedule to your default 
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Windows printer. Other users may schedule different custom reports on their PC. Their 
reports will not print out from your PC. 

NOTE: For scheduled reports to print, the Custom Reports Print program must be 
minimized. If the Custom Reports Print program is not running when a scheduled event 
occurs, no scheduled reports will be printed. The next time the Custom Reports Print 
program is opened, you will receive a message asking to print previously-scheduled reports. 

Where can you find it? 

 Click on the Custom Reports menu. 

 Choose the Schedule option. 

What do you want to know about? 

 Changing Display Groups 

 Creating a New Report 

 Changing a Report 

 Ignore Criteria in a Report 

 Selecting a Period Interval 

 Set Report to Display in HTML Format 

 Assigning a Report File Name 

 Deleting a Scheduled Report 

 Saving your Changes 

 
5.1.3 Exit 

To exit the program, choose one of the following methods: 

· Select the Exit option under the Custom Reports menu 
· Click your mouse button while it is positioned over the 'x' in the upper right hand 

corner of the window. 

 
5.2 Help Menu 

 
5.2.1 Help Contents 

General content help provides a table of contents for virtually all topics within this 
application. The Contents window, when on-line, can be used to jump to topics that 
explain various windows or how to get quick access to key reference topics. This help is 
available by selecting the Contents on the Help menu item. 
Use the scroll bar to the right side of the Help window to view the next page of the table of 
contents. 

 
5.2.2 Help Index 

The Index list is directly accessible from the Index on the Help menu item or from the Index 
tab within the on-line help utility. Index terms consist of: 

· definitions 
· formulas, if applicable 
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· recommended values, if applicable 

To access an item from the Index list: 

· Use the scroll bar on the right hand side to scroll the window to the desired item. 
· Point to the term or phase desired. 
· Double-click on the highlighted word to open. 

-Or- 

· Use the keyword field to search for the desired item. 
· Once found, double-click on the highlighted word to open. 

 
5.2.3 Help Search 

Another method to find a particular topic in Help is to use the Search option. To display the 
Search window, either choose Search from the Help menu on the application window or 
click the Search tab on the Help topic screen. 

Select a topic by: 

· Use the keyword field to search for the desired item. 
· Click on the List Topics button to search on the keyword entered 
· A list of related topics then appears on the screen. 
· Once found, double-click on the highlighted topic to open. 

 
5.2.4 Help Active Window 

Window level help provides information on the display that currently has focus. Information 
for each window includes: 

· purpose of the window 
· specific field descriptions 
· window button explanations 

This type of help is available by selecting and opening a desired window. Once opened, 
select the Help-Active Window menu on the application window or press the F1 key. 

NOTE: If there are currently no PlantStar windows open, this menu item will not display any 
help. 

 
5.2.5 About PlantStar 

For up-to-date resource information, the application provides a window with the following 
information: 

· PlantStar Software Version 
· PlantStar Copyright Date 
· Microsoft Windows Version 
· Amount of free memory 

To see this information: 

· Select the Help menu on the main menu. 
· Choose the About PlantStar menu item. 
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6 Design Manager 

The Custom Reports Manager program transfers custom reports designed in Crystal 
Reports into PlantStar. It provides editing capabilities for these reports, deletion 
capabilities, and provides for the selection of report search criteria. 

Transferring Reports Into PlantStar - The first step in using custom reports within 
PlantStar is to design a report within the Crystal Reports program. Once a report has 
been designed, it can be transferred into PlantStar. The PlantStar database tables and 
fields must be used to create this custom report. 

Editing Report Definitions - Custom reports can be edited from the Custom Reports 
Manager window. A report's name, description, definitions, and criteria are 
changeable. 

Selecting Report Criteria - Report criteria can be set up from this window. Report criteria 
designate what type of information is included in a report. For example, a job history report 
can include all jobs for a certain product or it can be a report on a specific job. Several fields 
can be selected as criteria for a report or just one field. 

Criteria can also be set up for a report from within the Crystal Reports program. If fields 
are also designated as criteria from the Custom Reports Manager program, then the 
affected report is based upon BOTH sets of criteria. 
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6.1 Design Manager 

 

 

The Custom Reports Manager program transfers custom reports designed in Crystal 
Reports into PlantStar. It provides editing capabilities for these reports, deletion 
capabilities, and provides for the selection of report search criteria. 

Transferring Reports Into PlantStar - The first step in using custom reports within PlantStar is 
to design a report within the Crystal Reports program. Once a report has been designed, it 
can be transferred into PlantStar. The PlantStar database tables and fields must be used to 
create this custom report. Crystal Reports 9.0 or above must be used. 

Editing Report Definitions - Custom reports can be edited from the Custom Reports 
Manager window. A report's name, description, definitions, and criteria are changeable. 

NOTE: Standard PlantStar reports can be edited, but must be saved as a report with a 
different name 

Selecting Report Criteria - Report criteria can be set up from this window. Report criteria 
designate what type of information is included in a report. For example, a job history report 
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can include all jobs for a certain product or it can be a report on a specific job. Several fields 
can be selected as criteria for a report or just one field. Criteria can also be set up for a report 
from within the Crystal Reports program. If fields are also designated as criteria from the 
Custom Reports Manager program, then the affected report is based upon BOTH sets of 
criteria. 

Where can you find it? 

The Custom Reports Manager window is the only window within the Design 
Manager application. 

What do you want to know about? 

 Selecting a Report 

 Transferring a Custom Report into PlantStar 

 Editing Report Definitions  

 Setting Report Criteria  

 Deleting a Custom Report From PlantStar 

 
6.2 Help Menu 

 
6.2.1 About PlantStar 

For up-to-date resource information, the application provides a window with the following 
information: 

· PlantStar Software Version 
· PlantStar Copyright Date 
· Microsoft Windows Version 
· Amount of free memory 

To see this information: 

· Select the Help menu on the main menu. 
· Choose the About PlantStar menu item. 

 
6.2.2 Exit 

To exit the program, choose one of the following methods: 

· Select the Exit option under the Help menu 
· Click your mouse button while it is positioned over the 'x' in the upper right hand 

corner of the window. 
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7 DCM Browser Interface 

The browser screens at the DCM are divided into three sections, or frames. The menu frame 
is located at the top of the screen and displays the machine, child, and screen which are 
currently being viewed. It also supplies easy navigation between machines on the same 
DCM, and has the capability of a user definable navigation link that can be accessed by 
pressing the SYSCON-PlantStar logo in the upper right corner. 

The main frame occupies the central screen area and contains the screen specific data. 
This frame, depending on the screen being viewed, can provide summary data, detail data, 
and/or data entry capabilities. 

Across the bottom of the screen is the lights frame which provides both status information 
and navigation. The various buttons, or lights, allow the user to have a quick visual summary 
of the status of the currently viewed machine. The colors of the buttons will change 
depending on the machine state and follow the color conventions used in all other SYSCON-
PlantStar products. 

Both the menu frame and the lights frame are shown for every screen that is being 
displayed in the main frame. This allows for a consistent interface regardless of the 
current function being utilized. 

 

Menu Frame 
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Main Frame 
 

 
 

Lights Frame 
 

 

 
7.1 Menu Frame 

The menu frame is the primary method of navigating between machines on a DCM, and the 
children of a particular job. In addition a clock button and the current screen name are 
displayed. 

 

What do you want to know about? 

 Changing machines  

 Displaying parent or child job information  

 Changing the language used  

 Linking to another web page 
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7.1.1 Machine Navigation 

These buttons allow you to scroll through the machines on a particular DCM. The 
machines available are those that are configured to be on the same DCM and the order 
follows the machine index as defined within the shop floor configuration program. 

 

 
7.1.2 Child Navigation 

These buttons allow you to navigate through the children of the currently running job on the 
selected machine. The displayed text is the same as the job field as defined when the job was 
created. 

 

 
7.1.3 Menu Clock 

The current date and time of the computer being used to browse to the DCM is displayed 
here. 

This button also allows for the selection of which language is being used to describe the 
fields being displayed. Repeated pressing, will cycle through all available languages. 

 

 
7.1.4 Logo Link 

The SYSCON-PlantStar logo in the menu frame is actually an HTML hyperlink. This can be 
configured by the system administrator to link any other web page available on the 
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company's intranet. 

Caution should be used when this link is selected as all three DCM frames will be replaced 
with the new page. This may lead to confusion and/or difficulty in returning to the DCM 
browser interface. 

 

 
7.2 Main Frame 

The Main Frame for the DCM browser screens occupies the center of the display. While it is 
possible to navigate outside of the default frames from setup sheets or through the use of the 
logo link, all of the PlantStar data pertaining to a specific DCM will be displayed here. 

The Lights Frame that is displayed across the bottom of the screen is the main navigation 
tool for moving between the available screens. The following screens can be viewed within 
this frame: 
 
Job Summary 
Down Select 
Assist Select 
Reject Update 

 
Process Summary  

Process Select 
Process Table 
Process Graph 
 
SPC Graph  
Profile Tiled  
Profile Overlay  
Profile Cross Plot   
Profile Store Graph  
 
SQC Sample 
 

Production Summary 
Setup Sheets   
Job Update   
Labor Login   
Material Lot   
Machine Logs 

 
7.2.1 Job Summary 

The left half of the Job Summary screen displays information for a selected job running on a 
machine. A summary of the pieces produced and rejected is provided for the current shift and 
the job to date. 
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The Job Summary screen allows you to scroll through the job queue information for the 
selected machine which is set up via the Job Scheduling Board in the Shop Floor Monitor 
Program. The current job running on the machine can be changed by using the selection 
buttons on the right side of the screen. 

Images for the current and the next scheduled job products can be displayed in the lower 
right area of the screen. 

 

If a tote box is defined for a job, an additional section of information will appear on the Job 
Summary screen above the shift and job totals area. The section tracks the job progress in 
units based on the tote box size and if required, it allows the operator to mark an incomplete 
tote as finished or to reprint a tote label. 
 

 

 
7.2.2 Down Select 

The Down Select screen allows the operator to select the appropriate reason for why the 
selected machine is down. Pressing one of the down reason buttons will highlight that 
reason and all down time will be assigned to that reason. If another reason is selected then 
any additional down time will be associated with the newly selected reason. 

Twenty reasons are listed on a down screen. For installations where the extended down 
option has been purchased, the buttons along the top of this screen will allow navigation 
to additional down reasons. 
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The down select screen displays the accumulated down time for each possible down 
reason of the currently running job. 
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7.2.3 Assist Select 

The Assist Select screen allows the shop floor staff to "call for help" by pressing the button 
for the appropriate assist reason. The call for help is logged in the system and the machine 
is put into the assist state which will be reflected in the lights frame. Once selected, time is 
accrued until the assist button is pressed again to turn off the assist state. 

The screen displays the accumulated assist time for each possible assist reason for the 
currently running job. 

 

 
7.2.4 Reject Update 

The Reject Update screen provides a summary of rejects that have been assigned to each 
defined reject reason for the current job. It also provides a means for the operator to add or 
subtract rejects for a reject reason. For a family job, the parent screen will display an 
accounting summary for each child. 

Twenty reasons are listed on a reject screen. For installations where the extended reject 
option has been purchased, the buttons along the top of this screen will allow navigation to 
additional reject reasons. 
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Pressing one of the reject reason buttons will highlight that reason and a keypad will be 
presented. The amount of rejects to be assigned to that category can then be entered. 
Negative numbers can be entered to subtract rejects from a category. In addition to the 
actual quantity of rejects, the part weight can be used so that a given weight can be entered 
as rejects. This weight will be divided by the part weight so that an actual part count can be 
automatically rejected. 
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The Reject Update screen for a family job displays an accounting summary for each child 
on the parent screen. The background color of the row in the summary table reflects the 
machine state for the child. 

 

This parent screen can be used to reject an entire cycle of parts as shown below. 
Using the menu frame to navigate to a child job allows rejects to that specific part 
as described above. 
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7.2.5 Process Summary 

The Process Summary screens display information for a machine's process variables 
measured during the last fifty complete machine cycles. The table of values includes the 
low and high limits defined for the current job, the last value, the high value and low 
value, and the average value for each process variable defined. Up to twenty-five 
variables can be displayed per screen and navigation buttons are provided to scroll 
between summary screens. 

The Process Summary screen provides quick access to the Process Select, Profile, and 
SQC Sample screens for a specified machine by using the screen navigation buttons at the 
left side. 

When a process variable reading is collected, it is compared to the process limits which have 
been defined for the job. If a process variable is above the higher limit or below the lower 
limit, that process variable is highlighted according to the following default color scheme: 

· Red - value is above the higher limit 

· Blue - value is below the lower limit 

If a process variable is outside of its defined limits for the job, the machine will be 
put in the process exception state for that cycle which will be reflected in the lights 
frame. 
 

 

What do you want to know about? 

 Selecting a process variable to see more detailed information  

 Displaying profile information  

 Taking an SQC Sample 
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7.2.5.1 Process Select 

The Process Select screen allows for monitoring up to fifty process variables that may be 
defined for the currently running job on the selected machine. 

It provides a quick visual reference to monitor the process exception state for a machine. If 
the last value recorded for a process variable is above the higher limit or below the lower 
limit defined for the job, that process variable is highlighted according to the following 
default color scheme: 

· Red - value is above the higher limit 

· Blue - value is below the lower limit 

If a process variable exceeds its defined limits for the job, the machine will be put in the 
process exception state for that cycle which will be reflected by the color conventions used in 
the lights frame. 

Pressing a process variable button will display the Process Table screen for the selected 
variable. 

The Process Select screen also provides quick access to the Profile, and SQC Sample 
screens for a specified machine by using the buttons at the top left. Use the Lights Frame to 
return to the Process Summary screen. 

 

 

What do you want to know about? 

 Selecting a process variable to see the last fifty values 

 Displaying profile information 
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 Taking an SQC Sample  
 
7.2.5.2 Process Table 

 
The Process Table screen details the history of a process variable over the last fifty machine 
cycles. The name, defined limits, and units of the variable are shown in the table heading. If a 
process variable is above the higher limit or below the lower limit defined for the job, that 
process variable value is highlighted in the table according to the following default color 
scheme: 

· Red - value is above the higher limit 

· Blue - value is below the lower limit 

If the last value of a process variable exceeds its defined limits for the job, the machine will 
be put in the process exception state for that cycle which will be reflected in the lights 
frame. 

There are three screen navigation buttons on the left to navigate among the Process 
Screens. The Process Select button will return you to the selection screen. The Graph 
button provides the option to display the data in graphical form on the Process Graph 
screen. If SPC data is available, a navigation button will be shown to display the SPC graph. 

 

Use the Lights Frame to return to the Process Summary screen. 

What do you want to know about? 

 Displaying the values as a graph 

 Displaying an SPC graph for the variable information 
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7.2.5.3 Process Graph 

The Process Graph screen for a variable can be displayed by pressing the "GRAPH" 
button on the Process Table screen. The variable name and the units of measurement are 
displayed at the top of the graph. The high and low limits as defined for the job are 
indicated on the left side. 

The x-axis is the cycle number. The y-axis is the actual process variable value. The graph 
can display the last fifty values with the rightmost point being the most recent value. For each 
machine cycle update, the new value enters from the right and moves the older values to the 
left. An undefined value will be a blank space in the graph. 

There are three screen navigation buttons to navigate among the Process Screens. This 
screen provides the option to display the data in graphical form on the Process Graph 
screen. If SPC data is available, a navigation button will be shown to display the SPC graph 
as shown in the screenshot. The Process Select button will return you to the selection 
screen. 

There are three screen navigation buttons on the left to navigate among the Process 
Screens. The Process Select button will return you to the selection screen. The Table 
button provides the option to return to the data detail on the Process Table screen. If SPC 
data is available, the Navigation button will be shown to display the SPC graph. 

 

Use the Lights Frame to return to the Process Summary screen. 
 
7.2.5.4 Process SPC 

The Process SPC screen displays SPC data that is monitored by the DCMs. The standard 
SPC statistics are shown at the top of the screen. The top graph is a plot of X-bar values and 
the bottom is a plot of the associated range values. The X-axis is the time at which the SPC 
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values were recorded. 

The Process SPC screen can only be selected from the Process Table screen for a process 
variable if SPC data is available. 

There are three screen navigation buttons on the left to navigate among the Process 
Screens. The Process Select button will return you to the selection screen. The Table button 
provides the option to return to the data detail on the Process Table screen. The Graph 
button provides the option to display the data in graphical form on the Process Graph 
screen. Use the Lights Frame to return to the Process Summary screen. 

 

Alarms are displayed to the right of the graph. The key for the alarms is as follows: 

XCL The last X-bar value was not within control limits 
RCL The last Range values was not within control limits 
INC The last 8 X-bar values were continuously increasing 
DEC The last 8 X-bar values were continuously decreasing 
ABV The last 8 X-bar values were above the mean 
BLW The last 8 X-bar values were below the mean 
UTR The last 25 X-bar values show an upward trend 
DTR The last 25 X-bar values show a downward trend 
RSM Within the last 25 X-bar values, a RUNSUM exceeded 4. 
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7.2.5.5 Profile Tiled 

The Profile Tiled screen graphically displays the values of machine's profile data. A profile is 
a set of up to 500 readings of a rapidly changing process variable, such as pressure or 
position, collected during one machine cycle. Up to four profiles can be monitored and 
displayed for a machine. 

The Profile Tiled screen is the default profile screen that is displayed when the "PROFILE" 
button is selected on either the Process Summary or the Process Select screens. 

The area below the graphs provides additional option buttons for displaying profile 
information. One or more of the available profile variables can be selected/deselected for 
graphing by using the named buttons. In addition, the profile screens provide navigation 
buttons to display the four available graph formats: 

· the profile tiled graph 
· the profile overlay graph 
· the profile cross plot graph 
· the profile store graph 

 

Use the Lights Frame to return to the Process Summary screen. 

 
7.2.5.6 Profile Overlay 

The Profile Overlay screen graphically displays the values of machine's profile data. A 
profile is a set of up to 500 readings of a rapidly changing process variable, such as pressure 
or position, collected during one machine cycle. The overlay displays up to four profiles for a 
machine on one graph. 
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The Profile Tiled screen is the default profile screen that is displayed when the "PROFILE" 
button is selected on either the Process Summary or the Process Select screens. The 
Profile Overlay screen can only be selected from another of the profile graph screens. 

The area below the graphs provides additional option buttons for displaying profile 
information. One or more of the available profile variables can be selected or deselected for 
graphing by using the named buttons. In addition, the profile screens provide navigation 
buttons to display the four available graph formats: 

· the profile tiled graph 
· the profile overlay graph 
· the profile cross plot graph 
· the profile store graph 

 

 

Use the Lights Frame to return to the Process Summary screen. 

 
7.2.5.7 Profile Cross 

The Profile Cross screen graphically displays the values of machine's profile data. A profile 
is a set of up to 500 readings of a rapidly changing process variable, such as pressure or 
position, collected during one machine cycle. The cross plot displays two selected profiles for 
a machine on one graph. The profiles selected must have the same delay and period defined. 
The first variable is the x-axis value and the second variable is the y-axis value in the cross 
plot. 

If a valid combination of two profile variables has not been selected, the profile store screen 
will display the list of combinations from which to choose as shown below. 

The Profile Tiled screen is the default profile screen that is displayed when the "PROFILE" 
button is selected on either the Process Summary or the Process Select screens. The 
Profile Cross screen can only be selected from another of the profile graph screens. 
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The area below the graphs provides additional option buttons for displaying profile 
information. One or more of the available profile variables can be selected or deselected for 
graphing by using the named buttons. In addition, the profile screens provide navigation 
buttons to display the four available graph formats: 

· the profile tiled graph 
· the profile overlay graph 
· the profile cross plot graph 
· the profile store graph 

 

Pressure, inject position, and temperature were selected in this example. This is an error 
because only two profiles can be selected for the profile cross graph. The valid 
combinations are listed on the screen. 
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Use the Lights Frame to return to the Process Summary screen.  
 
7.2.5.8 Profile Store 

The Profile Store screen graphically displays the values of one machine profile variable 
over time. A profile is a set of up to 500 readings of a rapidly changing process variable, 
such as pressure or position, collected during one machine cycle. The profile store displays 
the profile data from successive machine cycles on one graph. 

The Profile Tiled screen is the default profile screen that is displayed when the "PROFILE" 
button is selected on either the Process Summary or the Process Select screens. The 
Profile Store screen can only be selected from another of the profile graph screens. 

The area below the graphs provides additional option buttons for displaying profile 
information. One or more of the available profile variables can be selected or deselected for 
graphing by using the named buttons. In addition, the profile screens provide navigation 
buttons to display the four available graph formats: 

· the profile tiled graph 
· the profile overlay graph 
· the profile cross plot graph 
· the profile store graph 
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Use the Lights Frame to return to the Process Summary screen. 
 
7.2.5.9 SQC Sample 

The SQC Sample screen allows the operator to sample the next shot and print a sample 
label for quality auditing purposes with the "SAMPLE NEXT SHOT" button. The end of cycle 
data is written to the machine's log file. 

This screen is displayed using the "SQC SAMPLE" button on either the Process 
Summary or the Process Select screens. 

The screen displays an image of the current job product, job summary data, and the 
current shot ID number as well as the shot ID numbers of the samples which have been 
taken. The "CLEAR SHOT LIST" button will clear the screen list of sample ID numbers. 
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Use the Lights Frame to return to the Process Summary screen. 

 
7.2.6 Production Summary 

The Production Summary screen presents a snapshot of the machine's current state in 
terms of machine performance and progress toward completion of the current job. The 
background color of the line reflects the machine's state. 

In addition, the Production Summary screen has navigation buttons to access and update 
further levels of production information. The Setup Sheet button is used to display the Job 
Setup information. The Update button allows updating of the actual multiplier, reject multiplier, 
and box count. The Labor button accesses the optional Labor Tracking feature which allows 
employees to log in and out of specific machines and labor categories. The Material button 
accesses the optional Material Lot Tracking feature. The Logs button displays the detail of 
the event log. 
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What do you want to know about? 

 Displaying information on the setup sheets.  

 Updating the reject multiplier, actual multiplier, or box count 

 Logging into a machine  

 Displaying the employees logged in for a machine  

 Logging out of a machine  

 Changing your labor category on a machine  

 Displaying the material components for a job  

 Changing a material component or lot ID number for a job  

 Displaying the event log for a job  
 
7.2.6.1 Job Setup 

The Job Setup screen allows for the display of job setup instructions for the current job or 
any job in the job queue for a machine. 

On browser based DCMs the setup sheet can contain HTML code and will be displayed as 
such. This allows the insertion of hyperlinks and other html objects in the setup sheet. 
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Use the Lights Frame to return to the Production Summary screen. 
 
7.2.6.2 Job Update 

The Job Update screen displays the standard multiplier for a job which is a product 
parameter that defines the maximum number of pieces produced per machine cycle for a 
job. 

The actual multiplier, reject multiplier, and box count may be updated from this screen. To 
update a value, first press the update button to the left of the desired field. The row will be 
highlighted and the value that is typed on the keypad will be used to update the selected 
row. 
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Use the Lights Frame to return to the Production Summary screen. 
 
7.2.6.3 Labor Login 

If the Labor Tracking feature is enabled for your system and configured for a machine, the 
Labor Login screen can collect employee data to help in the tracking of operator/staff 
requirements and the costs of jobs being run on the shop floor. 

The Labor Login screen allows an employee to login or logout of a specific machine. The 
screen lists all employees currently logged into a machine, their labor category, and their 
login time. The employee is prompted to enter a valid employee id with the keypad. 
Employee's identification numbers and valid labor categories are defined in the Shop Floor 
Configuration program. If the employee id is not valid, the user is presented with an "Invalid 
Employee" message. 
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When a valid employee id is entered with the keypad, a second screen is presented. The 
name of the selected employee is shown in bold in the center of the screen. The keypad can 
be used to change the selected employee. 

The top of the screen displays up to 30 labor categories that are valid for the employee. The 
employee must choose a labor category and press the "log in" button to log in to the 
machine. The bottom of the screen lists the currently logged in employees for the selected 
machine. 

 
 

The Labor Login screen also allows an employee to logout of a machine or to change their 
labor category on the selected machine. When the employee ID for an employee currently 
logged into the machine is entered, the second screen which is presented will highlight the 
selected employee's row in the employee list on the lower half of the screen. The logout 
button is used to logout the selected employee and return to the Labor Login screen. 

The valid labor categories for the employee are presented at the top of the screen. To 
change labor categories, click on any valid category on the top of the screen and press the 
"log in" button. The employee will be logged out of their current labor category for the 
machine and logged in for their new category. 
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Use the Lights Frame to return to the Production Summary screen. 
 
7.2.6.4 Material Lot 

If the Material Lot Tracking feature is enabled for your system, the Material Lot screen 
provides an auditing feature to trace material lot usage. A material lot can be traced to a 
specific tote box. For each tote box or material lot change at the DCM, an event is 
recorded to form a lot history. 

The Material Lot screen displays a list of the material components and material Lot IDs for 
the current job. The Lot ID can be vendor or user-defined and will create an audit trail 
between the lots of raw material fed into the machine and the finished products produced. 
Several material changes can be specified to take effect as a group. 

If a different raw material lot needs to be used on a running job, the SELECT button to the left 
of the material name can be used to access a typewriter screen to enter a new material 
name, Lot ID, and delay timer. The delay timer is used to specify the amount of time in 
minutes that should elapse before the raw material change is to take effect on the job. 
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To make your required changes, click the button below the field that you wish to update. 
The button for the selected field will be highlighted. Type in the new value and press enter. 
The value will be shown in the "Next Material Component", "Next Lot ID", or "Delay" 
column as specified. If a delay is not specified, the default delay timer value is set to zero. 
After all the required changes are entered, click "RETURN" to go back to the Material Lot 
List screen. 
 

 

Your changes will be recorded in the "Next Material Component", "Next Lot ID", and 
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"Delay" columns on the material list. 
 

 

At this time, additional materials can be selected from the list to specify changes that will take 
effect as a group. 

The timer will begin counting down when the RUN button is pressed on the material list 
screen. The change goes into effect when the timer value counts down to zero. The PAUSE 
button can be used to temporarily stop the timer count down. The CANCEL button will 
discard any pending changes. When the time expires, the current materials are replaced 
with the new materials and the event will be recorded in the audit trail. 

Use the Lights Frame to return to the Production Summary screen. 
 
7.2.6.5 Machine Logs 

The Machine Log screen displays a list of the most recent events relating to a selected 
machine. These events are recorded at the DCM. 

All recorded events will be displayed by default or the events displayed can be filtered by 
using one of the event type buttons on the left side of the screen. The selected filter button 
will be highlighted. Event types include 

· Job Related Events - start/end of a job or a job change; 
· Shift Related Events - start of a new shift or a shift idle period; 
· Down Events - start and end of down time periods; 
· Assist Events - start and end of assist time periods; 
· Process Alarm Events - time of a process exception, the actual "exception" value, 

and the limit it violated. Process exceptions are only logged, though, if the machine 
is not in a down state. If a process exception begins while a machine is down, the 
exception events are not logged for the machine. 
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· Material Events - material changes on the selected machine 
· Labor Events - login and logout of users on the selected machine 

 

Use the Lights Frame to return to the Production Summary screen. 

 
7.2.7 Journals 

The PlantStar Process Journal program is a web-based program designed to provide the 
shop floor personnel with a method to record changes made to a process being monitored 
by the PlantStar system. 

An overview of the Process Journal program and instructions for how to view and 
create Process Journal tickets can be found in Application Notes 2007-03 and 2007-
04. 

 
7.3 Lights Frame 

The Lights Frame, at-a-glance, gives the user the current machine state of the selected 
machine. The colors of the buttons will change depending on the machine state and follow 
the color conventions used in all SYSCON-PlantStar products. 

This frame also serves as the primary navigation method for changing the screen that is 
displayed within the main frame.  
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8 System Administration 
 
8.1 Configuring the Host 

This section outlines the installation for first-time setup of the host computer and 
describes the installation results. For QuickShot systems, host configuration changes 
require attachment of a monitor and keyboard, not supplied with the system. 

Hardware Overview 

The host computer and support equipment is, in virtually all cases, directly purchased from 
SYSCON-PlantStar. The standard hardware package includes 

· Server with external modem 
· Uninterruptible power supply (UPS) 
· Keyboard 

Optional equipment, such as additional disk drives, printers, Modems and CDRW 
drives can be purchased depending upon site configuration. 

On QuickShot Systems, the host and DCM are both contained in one NEMA box. 

Disk Space 

The system database stores historical production and SPC information. How much it can 
store on disk is dependent upon available disk space. Typically a year or more can be stored 
on the supplied disks. The speed at which disk space is used is dependent upon the number 
of machines defined and the number of monitored process variables. The host automatically 
monitors its free space and alerts the administrator, via console messages, when space is 
getting low. 

Printers 

Printers for generating paper copies of reports and screen captures can be connected to 
the host computer directly or by Ethernet. Production reports are printed via client 
workstations using their default or user-specified printer. 

 
8.1.1 Software Configuration 

Software Configuration 

This section describes the steps necessary for first-time configuration of the host 
computer. Another Chapter, Administering the Host Computer, provides information for 
general maintenance on an on-going basis. 

There are two utilities that set up the host computer – configure.f2k and netconfig. The 
configure.f2k utility is used to define the host computer's time zone, your company name, 
host name, and authorization key. It is also used to start and stop information routing 
processes that run on the host. The netconfig utility is used to define and change the host's 
Ethernet/internet and Slip addresses. 
 

Configure.f2k Utility 
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1. Log into the host computer as root. The initial password is pstar. 

2. Check to make sure that the shop floor processes are running. Two processes 
automatically startup upon booting. Type in psg sfd and then psg pcd. 

3. The following should appear. The highlighted entries indicate that the Panorama 
processes are running. 

psg sfd 
 

(A) 00:00:00 sh -c (sfd -s 60; CODE=$?7; DIFF… 

(B) 00:00:00 sfd -s 60 

 
psg sfd 
 
(A) 00:00:00 sh -c (pcd ;CODE=$?7; DIFF=`dc >… 

(B) 00:00:00 pcd 
 

 
NOTE: More lines than shown above may appear. 

4. At the shell prompt, type in configure.f2k and press the <ENTER> key. This command 
starts up a utility to facilitate setting up your system. The following menu appears: 

--Focus2000 Configuration-- 

Select Configuration Option 

1. Set Time zone 

2. Set System Time 

3. Set Authorization Key 

4. Set Company Name 

5. Set Host name 

6. Enable / disable startup 

7. Start MySQL / Panorama 

8. Stop MySQL / Panorama 

9. Configure Email Server 

10. Configure CD Burner 

0. Exit 

< OK > <Cancel> 

5. Menu items 1 and 4 must be done for a first time software configuration. Each menu 
item asks a series of questions. Be careful when answering these questions. The 
configure.f2k program does not always have verification prompts 

6. To set the time zone, type in 1, tab to <ok>, and press <ENTER>. The following 
displays on the screen. 
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The MySQL RDBMS and Panorama will now be stopped.  

After the time zone is set MySQL and PlantStar will be restarted. 

< Yes > < No > 

7. The first question is a warning message. Tab to <yes> and press the <ENTER> key 
to continue. After Panorama and MySQL are stopped, the following will appear. 

--HARDWARE CLOCK SET TO UTC-- 

Is the hardware clock set to Coordinated Universal Time 

(UTC/GMT)? If it is, select YES here. If the hardware clock 

is set to the current local time (this is how most PCs are 

set up), then say NO here. If you are not sure what this is, 

you should answer NO here. 

NO Hardware clock is set to local time 

YES Hardware clock is set to UTC 

< OK > <Cancel> 

8. Type n (or y), tab to <ok>, and press the <ENTER> key to continue. The time zone 
options will appear. 

--TIMEZONE CONFIGURATION-- 

Please select one of the following time 

zones for your machine: 

US/Alaska 

US/Aleutian 

US/Arizona 

US/Central 

US/East-Indiana 

US/Eastern 

US/Hawaii 

US/Indiana-Starke 

US/Michigan 

US/Mountain 

US/Pacific 

US/Samoa 

Africa/Abidjan… 

< OK > <Cancel> 

9. Scroll to select the desired time zone, tab to <ok>, and press <ENTER>. Panorama 
will restart and the configuration menu will return. 

10. The second option on the configuration menu is to set the system time. Select 2, 
or scroll to the entry, tab to <ok>, and press <ENTER>. A warning prompt will 
appear. 



164 SYSCON-PlantStar Help System 

 

 

 

Panorama will now be stopped. 
After the time is set Panorama will be restarted. 

< Yes > < No > 

11. Respond with "yes", again, with tab to <yes> and press the <ENTER> key. After 
Panorama is halted, a "Set Date" panel will be presented. 

--Set Date-- 

Move between boxes with the Tab key. 

Use the arrow keys to change values.  

?  

Month Year 

March 2008 
 

Sun Mon Tue Wed Thu Fri Sa

t 

1 2 3 4 5 6 7 8 

9 10 11 12 13 14 15 

16 17 18 19 20 21 22 

23 24 25 26 27 28 29 

30 31      
v(+) 

< OK > <Cancel> 

12. Tab to the Month, Year, and Day fields and use the scroll keys to select the 
appropriate values. Then tab to <ok> and press <ENTER>. The "Set system Time" 
panel will appear. 

--Set System Time-- 

Move between boxes with the Tab key. 

Use the arrow keys to change values. 

  10 : 55 : 55 

   < OK > <Cancel> 

13. Move between the hours, minutes, and seconds, and then use arrow keys to scroll to 
the desired values. Note the 24 hour clock vs. a.m. and p.m. When ready, select <ok> 
and <ENTER>, as before. The time and date will be reset, Panorama will be 
restarted, and the configuration menu will return. 

14. Setting the authorization key, item 3, will be done by SYSCON-PlantStar personnel. 

15. Select item 4 as previously-described to set the company name. This task does not 
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reboot the computer. A screen similar to the following appears. 

--Company Name-- 

Your company name is currently: 

? 

SYSCON International, Inc. 

? 

Select Yes to change the name or No to abort. 

< Yes > < No > 

16. Select <Yes> and press the <ENTER> key to change your company name. Edit your 
company name in the subsequent panel. 

--Company Name Update-- 

Please enter your new company name (up to 50 

characters) 

    My Company Name 

< OK > <Cancel> 

17. After updating your company name, select <ok> and <ENTER>. The system responds 
with: 

Company name update completed. 

     < OK > 

18. Select <ok> and return to the configuration menu. Once finished with running all four 
menu items, exit the configure.f2k program by selection option 0 (zero) and <ENTER> 

19. Verify that the network environment is working. On a previously-configured 
workstation, PING to the host computer. 

Typical Installation Results 

A successful host computer installation performs the following operations: 

· Sets up the host computer hardware: console terminal, modem, and tape drive 
· Sets the computer's time zone 
· Sets the computer's company name 
· Sets the computer's Ethernet/internet address 
· Enables workstations to ping to the host computer 

On the host computer, all system files are located in the directory, /focus2000. This 
directory has four sub-directories. A brief description of each follows: 
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Directory Purpose  

DBextended Stores auxillary data files 
installed Stores binary executable files and environment scripts 
log Stores log files for all processes; 
tmp Used for sorting and other miscellaneous tasks 

 
8.2 Administering the Host 

Administering the Host Computer 

System monitoring of the host computer may need to be done periodically. Several LINUX 
commands are described below to help in this monitoring activity. Your system provides 
additional commands for viewing the status of the shop floor routing processes, identifying 
current system users, and viewing your authorization string. 

System Monitoring Commands 

cat <filename> 
Displays contents of a file. This command is useful for looking at the contents of log files, etc. 
If a file is large, the tail command may be more efficient. Combine the cat command with the 
more command to view files page by page: 

cat sfd.log | more 
Note: you must be in the /focus2000/log directory in order for this command to find the 
sfd.log file. 

df -l 
Displays the amounts of free disk space and the percentage used. One line of information 
appears for each defined file system. This command is useful for determining when to archive 
system job information. It is recommended that one-third of the available space always 
remain free. 

Sample Output: 
Filesystem 1K-blocks Used Available Use% Mounted on 

/dev/md1 1003932 535244 468688 54% / 

/dev/md3 132267060 9596352 122670708 8% /var 

/dev/md4 2007932 82876 1925056 5% /tmp 

/dev/md5 10008072 5805064 4203008 59% /home 

/dev/md6 9992008 5094440 4897568 51% /usr 

f2kdown <Level> <Time> 
This utility will signal an orderly shutdown or startup to all active 
workstations. Usage: f2kdown [Level] [Time] 

Level - Shutdown level -1 =shutdown, 0=startup 
Time - Minutes to wait before shutdown, 0 to 99 

f2kulog -l 
Displays a list of users currently logged into your system. This command can also be used 
to delete any user processes that no longer respond from the workstation. 
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Sample Output: 

LOG LOGIN USER INET ADDRESS PCC PID 
SEQ TIME NAME (station) 

10047 06/16/1994 08:46:42 pstar 128.1.11 .2(engtest2) 16075 

Several other options are available for this command: 

-d SEQ Deletes the F2K user login where LOG_SEQ = SEQ 

-d all Deletes all existing F2K user logins. 

-k SEQ Deletes the F2K user login where LOG_SEQ = SEQ and kills the associated 
f2kpcc process. This option is used when the workstation has become 
unresponsive. 

ls 
Displays a list of files for a directory in alphabetic order. If the -l option is used with the ls 
command the mode, number of links, owner, group, size (in bytes), and time of last 
modification for each file displays. If the file is a special file, the size field contains the major 
and minor device numbers. If the file is a symbolic link, the path name of the linked-to file is 
printed preceded by a ->. The attributes of the symbolic link are displayed. 

more 
Paginates displayed information; can be used with almost any Linux command. 
For example: 

set | more = displays current environment variables page by page. 
cat sfd.log | more = displays the sfd.log file page by page for ease of reading. 

Use the space bar to scroll to the next page of information; 
Use the <ENTER> key to scroll one line; 
Press the Q key to stop viewing the information in question. 

ps -ef 
Displays active processes in terms of time started, process IDs, and other general 
information. List has headings for each column of information provided. 

Sample Output: 

USER PID TTY STAT TIME COMMAND 
root 29501 tty3 Ss+ 0:00 -bash REMOTEHOST=… 
root 1647 tty6 Ss+ 0:00 /sbin/agetty 38400 tty6… 

read_auth 
Displays the host computer's current authorization string as well as all authorized system 
features. A Yes or No appears after each available feature. 
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Example Output: 

 
Authorization Utility for Panorama, Version 4.30 

Authorization String: PIBPHFCE IBKFFLBH GHEKGOLM QHEHFIQH DIKIKEBE 

********** Authorized Features *********** 

1(10)Max Users | 2(Y)PVAR | 3(N)Camac XTA | 4(Y)Maco 8000 

5(N)Moog | 6 (N) GageTalk | 7 (N)Mitutoyo | 8(N)Mettler 

9(Y)Engel |10(N)Precisa |11(Y)Camac 486,VSX |12(N)Camac VLC 

13(Y)Roboshot,ACT |14(N)CRT-C |15(Y)Pathfinder |16(N)Accudata 

17(N)BetaMUX |18(N)HPM CMD |19(N)Unilog 9000B |20(Y)Toyo 

21(N) NetStal |22(Y)L Type TC |23(N)Extended SPC |24(Y)Husky 

25(N)JSW uPac |26(Y)Mat Lot Track |27(Y)Multiple Mat |28(Y)Profile 

29(N)RKC F900 |30(Y)Toshiba |31(Y)Tote Label |32(Y)Voice 

33(N)Maco 4000 |34(Y)Setup Sheets |35(N)Square D |36(N)A-B PLC5/E 

37(N)A&D Scale |38(N)TI-545 PLC |39(Y)Ext Down/Rej |40(N)Kawaguchi 

41(N)Hekuma |42(Y)Delta |43(Y)Panorama |44(N)Portrait 

45(Y)Family Mold |46(N)KuDA |47(N)AC-9000 |48(Y)Design Mangr 

49(Y)Labor Track |50(N)French |51(Y)German |52(Y)Spanish 

53(Y)Dutch |54(N)Chinese |55(N)Language 6 |56(N)Language 7 

57(N)Language 8 |58(N)Language 9 |59(N)Language 10 |60(N)Language 11 

61(N)Language 12 |62(N)Language 13 |63(N)Language 14 |64(N)Language 15 

65(N)Language 16 |82 (200)Max Machines 

Use -x option to print additional 

features. bash$ read_auth -x  

Authorization Utility for Panorama, Version 4.30 

Authorization String: PIBPHFCE IBKFFLBH GHEKGOLM QHEHFIQH DIKIKEBE 

***********Extra Features********** 

66(Y)Sartorius |67(Y)Asset Manage |68(Y)Nissei |69(N)Ext. MatLot 

70(Y)OPC_plc |71(Y)SPI_plc |72(Y)Labor Auth |73(Y)Tech Connect 

74(N)Cycle Log |75(N)Rate Based |76(Y)Arburg |77(Y)Ohaus 

78(Y)Indusoft Dryer|79(Y)Sequencing |80 (N)Extreem |81 (Y)Maco 6000 

83(N)AB DF1 |84(Y)Branson |85(N)Peet Bros 

set 
Displays current environment variables. 

sfdctrl -stats 
Reports the current status of the shop floor routing process. 

Sample Output: 

Panorama shop floor daemon control program, version 4.30 

Requesting status from sfd. 

localhost:sfd is online and active. 

Debug level logging is disabled. 

Trace level logging is disabled. 

Shop floor daemon statistics. Accumulation interval = 60 minutes. 

Overall stats: 

Avg service time = 0.000, Max = 0.000, Count = 1 

Avg idle time = 1739.000, Max = 2.000 

Datagram stats: 
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Received = 1, Unknown type = 0, Bad size = 0  

End-of-cycle stats: 

 Service SF-comm DB-update 

Count 0 

Avg time 0.000 0.000 0.000 

Max time 0.000 0.000 0.000 

Shop floor update stats: 

Avg service time = 0.000, Max =0.000, Count = 0 

su - <user name> 
Changes a user's privileges and authorizations to those of the specified user. If no user 
name is provided, the current user's privileges will be changed to those of the Root 
user id. 

tail <number of lines> <filename> 
Displays the end of a file. This command is useful when a file is large like the log file for the 
shop floor routing process. 

An example valid command is: 

tail -40 sfd.log displays the last 40 lines of the sfd.log file 
tail -f sfd.log displays the end of the sfd.log to the terminal 

monitor and continues to display new output until <Delete> 
is typed. 

Startup and Shutdown Procedures 
Your system is designed to run continuously. It is extremely rare that the host computer will 
need to be powered down or rebooted. It is also rare that any process will need to be 
manually stopped or started. Step-by-step instructions on startup and shutdown procedures 
are included, though, in the case of known power outages and extreme error conditions. It is 
recommended that you contact SYSCON-Intl Customer Support before attempting to 
manually start and stop processes. 

Starting System Processes 
The shop floor message and routing processes (shop floor daemon) are configured to 
automatically start up upon booting the host computer. Use the ps command to verify that 
they are running. 

If the shop floor processes have been stopped and need to be re-started, use the 
configure.f2k utility. This utility starts up all system processes without the need for 
rebooting the host computer. 

1. At the system prompt, type in configure.f2k and press the <ENTER> key. 
2. The following screen appears. 
 

--Focus2000 Configuration— 

Select Configuration Option 

1 Set Time zone 

2 Set System Time 

3 Set Authorization Key 

4 Set Company Name 

5 Set Host name 
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6 Enable / disable startup 

7 Start Mysql / Panorama 

8 Stop MySQL / Panorama 

9 Configure Email Server 

10 Configure CD Burner 

0 Exit 

< OK > <Cancel> 

3. To start up system processes, select menu item 7. This menu item does not reboot the 
host computer. 

4. This process takes a few minutes. When complete the Configuration menu returns. 
5. Type in 0 (zero) to exit configure.f2k. 
6. Wait about 5 minutes for all system processes to start. 

Stopping System Processes 

If an error situation is occurring that necessitates stopping all system processes, use the 
configure.f2k utility. 

1. At the system prompt, type in configure.f2k. 
2. The following screen appears. 

--Focus2000 Configuration— 

Select Configuration Option 

1 Set Time zone 

2 Set System Time 

3 Set Authorization Key 

4 Set Company Name 

5 Set Host name 

6 Enable / disable startup 

7 Start MySQL / Panorama 

8 Stop MySQL / Panorama 

9 Configure Email Server 

10 Configure CD Burner  

0 Exit 

< OK > <Cancel> 

3. To stop all system processes, select menu item 8. This menu item does not 
reboot the host computer. 

4. Upon completion, the Configuration menu returns. 
5. Type in 0 (zero) to exit configure.f2k. 

Rebooting The Host Computer 

If an error situation occurs that necessitates rebooting the host computer, follow these 
instructions. 
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1. At the system prompt, type in shutdown –r now. Note that this command is case-
sensitive. 

2. The system shuts down all active processes and then reboots. At times the process 
appears to pause. This is normal behavior. 

3. All system processes are automatically started upon boot up. They do not have to 
be manually started. 

4. Log back in. 
5. Wait about 5 minutes for all system applications to start. 
6. If desired, check the shop floor processes to ensure that they are running. Type in       

ps -ef: 

 
PID  TTY  STAT  TIME  COMMAND 
29501  pts/1  Ss+  0:00  -bash REMOTEHOST=… 
1647  tty6  Ss+  0:00  /sbin/agetty 38400 tty6… 

!!!Caution !!!  
Do not press the RESET button on the host computer to reboot. This action can result 
in serious complications. 

Powering Down The Host Computer 
There are times when the host computer needs to be powered down -- either for power 
outages or maintenance. If any of these situations arise, follow these instructions: 

1. At the system prompt, type in shutdown –h now. Note that this command is case-
sensitive. 

2. A message appears stating the shutdown program has begun. At times the process 
appears to pause. This is normal behavior. 

3. Once shutdown has been invoked, it must be allowed to run to completion. 

!!!Caution !!!  
Do not just turn the power switch off. This action can result in serious complications. 

 
8.3 Archiving Data 

Archiving Data 
Your system collects and stores large amounts of historical information. After a period of 
time, the host computer's disk space becomes full. To free up disk space, your system 
provides an archiving utility. This utility, archive.f2k, saves completed job information to a 
file, CD or CDRW and then removes it from the database. The file can be FTP’d to a 
backup file system. On the QuickShot System the file must be ftp'd to another computer; 
CD or CDRW backup is not provided. It is recommended that you contact PlantStar 
Customer Support before archiving. This topic is covered in Application Note 2004-06. 

Archiving should be done before the host computer's disk space is used up. Checking 
the host computer's disk space is done via the df command. The amount of disk 
space displayed, in combination with plant guidelines, determines the timing of the 
archive process. Note that the archive.f2k utility does not save all Portrait 
information. For a complete back up of your system, refer to the next section on 
Backing Up the System. 
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NOTE: We recommend archiving no more than three months worth of data at a 
time. 

Once job information is stored on a file, CD or CDRW, it can be restored for system 
users. The unarchive.f2k utility provides this function. 

To obtain a list of completed jobs available for archiving before a specific date: 

1. Log onto the host computer. 
2. At the system prompt, type in archive.f2k –l –e YYMMDD and press the <ENTER> key. 
3. A listing similar to the following should appear: 

f2karc -l -e 060101 

Panorama History Archive V4.30 

preparing job list by DATE 
. 

preparing shift list 

. 

preparing material list 

. 

The list of jobs finished before 2006-01-01 23:59:59: 

 

1. job=Idle, family _seq=-150381, family _count 1

  1 ss records, 0 spc records, 0 ls records, 

  1 jts records, 1 mls records, 0 ts records 

2. job=, family _seq=0, family_count 0  

 0 ss records, 0 spc records, 0 ls records, 

 0 jts records, 0 mls records, 11 ts records 

To archive and remove jobs completed before a specific cutoff date: 

1. Log onto the host computer. 
2. Select the media you wish to use and put it into the host. The archive utility will 

check CD or CDRW for usability automatically. 
3. Decide on a cutoff date for completed jobs. The archive process generally takes at 

least 30 minutes to run for an average number of jobs. The more SPC information 
that is collected per machine, the longer the archiving process takes. 

4. At the system prompt, type in archive.f2k -e YYMMDD -r -y –m <media> where 
YYMMDD is a desired cutoff date and <media> is the media you are archiving to. The -
r option removes all archived jobs from the database after writing them to the media. 
The -y option will not prompt for individual confirmation of each job to be archived. If 
you wish to individually confirm each job, do not add the -y option. 

5. A message prompting for media appears. Press the <ENTER> key. 
6. The archiving process begins. 

Several other options are available for the archive command. All options and their 
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descriptions are provided below: 

archive.f2k [-cdlnqrtyz] [+f] -m media [-e YYMMDD] [-j JOB_NAME] [-A num_months] 

-A NUM_MONTHS Automatic archive jobs finishing before NUM_MONTHS. 

-c Counts jobs and records only. 

-d Enables debug level message log. 

-e YYMMDD Cut-off date (in YYMMDD format), archive 
only those jobs that finished before the given cut-off 
date. 

-j JOB NAME Archive those jobs that match the given job name. 

-l Lists jobs only, no archive 

-m <media> Write Archive to media type <media>. (No 
Default) Valid values are: file, cdr, cdrw, and 
ftp. Files are originally written to 
/focus2000/tmp/archive 

cdr, cdrw, options remove files after the disk is verified 
ftp removes files after ftp is verified. 
file leaves files in directory until manually 

removed. Copies of files are kept in 
/focus2000/tmp labeled as f2karc.dat and 
archive.dat until manually removed or 
overwritten by next archive. 

-n Prevents archiving. This option is intended for use with 
the -r option to allow the permanent removal of 
unwanted job histories. 

-q Run all queries, but don't archive. 

-r Remove the jobs from the database after archived. 

-t Enables trace level message log. 

-y Don't prompt for confirmation for individual jobs when archived and 
removed. 

-z  <file> Specify <file> path/name to use with media file type. File 
automatically has .dat extension added. 
All data files are automatically zipped (.gz added) 
The archive.dat file is copied as archive-<file> 
Note: the default file (f2karc.dat and archive.dat) remain 
In the /focus2000/tmp directory until removed or overwritten. 

NOTE: Either the -j or -e option must be used, not both.  

To obtain a list of archived jobs on CD or CDRW: 

1. Select the archived media and put it into the host. 
2. Log onto the host computer. 
3. At the system prompt, type in unarchive.f2k –l –z and press the <ENTER> key. 
4. A listing similar to the following appears: 
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Options: f2kunarc program -z -l "" "" 
mount: block device /dev/cdrom is write-protected, mounting read-only 
found opt file: f2karc-060101.dat.gz 
looking for archive-060101 .dat 

Historical Job Data of Panorama 0. 

Date of Archive: 2008-04-14 10:53:01 

The list of jobs found in the archive: 
1. job=Idle, family_seq=-1 50381, family_count 1  

1 ss records, 0 spc records, 0 ls records,   

1 jts records, 1 mls records, 0 ts records 

2. job=, family_seq=0, family_count 0        

0 ss records, 0 spc records, 0 ls records,  

0 jts records, 0 mls records, 0 ts records 

 
8.4 Backing Up the System 

Backing Up The System 

SYSCON-PlantStar provides automatic back up capabilities of all system information. The 
timing and frequency of backups is configurable. When determining a backup schedule, keep 
in mind the following: 

 The length of time between backups determines the amount of risk you are willing to 
take on the potential loss of data. If, for some reason, the system database becomes 
corrupted, backups are used to restore all information. The database is restored to the 
point in time when the backup was done. SYSCON-PlantStar recommends at least a 
weekly backup schedule. 

 The system application is available during the backup process. Users are able to log 
in. shop floor information is still collected during this down time. 

 The CD or CDRW disc must be large enough to store the system database. The 
backup utility does not write to multiple CDs. If multiple CDs are necessary, contact 
SYSCON Customer Service. 

 The backup process can take up to an hour for large databases. 

 PlantStar's backup utility incorporates database maintenance and clean up 
commands which affect the performance of system applications. 

Backup schedules are implemented by SYSCON-PlantStar personnel upon request. 
When backup needs are ascertained, contact SYSCON-PlantStar Customer Service. 
Once the backup schedule is set up, it is the System Administrator's responsibility to 
maintain the backup schedule: 

1. Select a media and place it in the drive at the designated backup schedule time. 
You can put the media in ahead of time. Once the backup is complete, change 
media on the morning after the scheduled backup and leave it in until the next 
scheduled time. 
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2. To check the backup logs, type in cd /focus2000/log to change directories. 
3. Review the backup.log file. Type in cat backup.log | more. Any errors that 

occur during the backup process are written to this file. 

Note: backup.f2k MUST be run with specific command line switches. You should review 

your current settings before attempting to backup independent of a scheduled backup. It is 
always wise to contact Customer Support prior to issuing a backup.f2k command.  

For informational purposes only, the command line argument explanation follows: 

Backup script for Panorama 4.30 started Tue Apr 15 14:36:52 CDT 2003 
Usage: /focus2000/installed/bin/backup.f2k [-ik] [-s <media>] [-w <device>] [-d <tmp_dir>] [-t 
<type> | - [cmou] ] 

Option descriptions: 

-d <dir> Use directory <dir> for temp space. Default is F2K_DIR/tmp/backup 
for one-disk systems, and /Database/backup for two-disk systems. 

-s <media> Write backup to media type <media>.Valid values are hd, cdr, and 
cdrw. The default is cdr. 

-t <bckup_type>  Perform <bckup_type> type backup. Valid values are 
checkpoint, online, maintenance, unload. 

-c Perform checkpoint backup. 

-m Perform maintenance backup. 

-o Perform online backup. 

-u Perform unload backup. 

-i Use semaphore to synchronize access to tape device. 

-k Remove old checkpoint files from disk (online backups only.) 

-w <dev> Specify backup device location. Defaults are /dev/nrct0 for tape; 
/dev/rcd0:5,0 for CDR and CDRW; and the current directory for hard 
drive. 

Running backup.f2k with no arguments will perform a checkpoint backup to CDR. 

4. The following is a sample backup log file with no errors: 

System shutdown. 
System snapshot daemon control program 
Sending shutdown request to sfd. 
Waiting for confirmation from 
sfd. Shutdown confirmed. 
PC daemon control program, version 2.0 
Sending shutdown request to f2kpcd. 
Waiting for confirmation from f2kpcd. 
Shutdown confirmed. 
Terminating qaspcd; pid = 10725 
System shutdown complete. 

. 
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. 
beginning checkpoint to tape /dev/rmt0. 1 of 1 locations 
Sun May 8 00:10:25 1994 CPP: Starting checkpoint of location: focus2000 to tape: 
path = '/dev/rmt0. 1', 
file = 'c0003001.ckp'. 
mount CDR and press return 
tar: /dev/rmt0. 1 
a ./focus2000/install/up2.scr 61 blocks 
a ./focus2000/install/up3.scr 60 blocks 
a ./focus2000/install/up4.scr 40 blocks 
a ./focus2000/bin/f2krep 61 blocks 
. 
. 

. 
f2kdbmod - Compress table structures in database focus2000 
rows) 
Continue 
* * * Executing ... 
rows) 
Continue 
* * * Executing 
. 
. 
. 
System startup complete. 

Backups can be run on-demand: 

1. Select a media and place it in the drive. 
2. Log in as root to the host computer. 
3. At the system prompt, type in backup.f2k, (options). The backup utility writes all 

necessary files to the media, or runs some database maintenance programs. 
4. All status and output information appears on the screen for this utility. 

 
8.5 Host Log Files 

Host Log Files 

Host computer log files are located in the /focus2000/log directory. 

Log File Name Contents 

backup.log Log file containing status messages from the last Portrait backup 

eoj.log Log file containing status messages from the last time end-of-job reports were 
generated 

eos.log Log file containing status messages from the last time end-of-shift 
reports were generated 

f2karc.log Log file containing status messages from the last Portrait archive task 

f2kunarc.log Log file containing status messages from the last Portrait unarchive task 

f2kpcd.log Log file containing status messages about the PC connection to the host 
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computer 

sfd.log Log file containing status messages about the shop floor message and routing 
process 

 
8.6 Software Upgrades 

Software Upgrades 
Special maintenance updates for the host computer are done via the update.f2k utility. 
During an update, users do not have access to system applications. 

If an update is received, follow these instructions: 

1. Log onto the host computer as root. 
2. Ensure that all system users are off the system. 
3. Go to the following directory: 

cd /focus2000/installed/install 

4. At the system prompt, type in update.f2k. 
5. The update utility checks user privileges, shuts down all system processes, backs 

up production data, and then installs the update. At certain points, the procedure 
asks whether to proceed or abort the update process. Answer y to continue, n to 
stop. 

Sample Output of update.f2k utility 

System update script. 

***** WARNING ***** 

This script is intended for updating the system host software from a PlantStar 
supplied distribution media. 

Shutting down system services. 

***** WARNING ***** 

This update script must have EXCLUSIVE access to the system database. Failure to 

comply with this requirement may cause the update to fail and/or the system database to 
be corrupted. 

This script will now pause until it has exclusive access to the system database. If you are 
unable to close all open sessions, press <CTRL-C> to abort this script. 

Proceeding with update. 

Please insert the media labeled "Final Backup Before Update" which came with the 
update kit. Proceed with final backup -> y 

Compressing the database... 
Checkpointing database to media... 

Please remove the media. Turn the write protect indicator to SAFE. 
Store the media in a safe place. 
Proceed with final backup -> y 
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Please insert the media labeled "Host Distribution” which came with the update kit. 
Proceed with update -> y 

Pausing for any manual adjustments before proceeding with the version specific 
portion of this update. 

Press <Enter> to proceed, <Ctrl>-C to abort -> 

5. Once the distribution media is read, the update procedure prompts for continuation. 
6. When finished, the system prompt appears. 

If an update requires on-site support, advance notification is provided. 

 
8.7 Product Standards Import 

Product Standards can be imported from other systems or databases via a transfer of 
records and fields in ASCII format. The layout of the data can be configured to meet the 
customer's needs. The application used on the system host to accomplish this task has 
several parameters as shown below: 

# primp 

Focus-2000 product standards import program, version 4.10 

Usage: primp PS_ASCII_FILE [-a] [-d] [-f] [-n N _MAX] [-s FMT_SEQ] 

-a Update all machines for a matching product if a particular machine is not specified. 

-d Enable debug level logging. 

-f Use default product standard to update missing fields if there is no matching product 
standard. 

-n N_MAX Import only first N_MAX product standards from ASCII 
product standards file into database. If -n option is not used, 
all product standards in the file will be imported. 

-s FMT_SEQ Sequence number of the file/field format used for 
converting product standards file into database. If -s option is 
not used, the first format in the database will be used. 

Additionally, this import can be used on a recurring basis for those companies that make 
engineering changes regularly to Product Standards. Our Customer Support staff will 
create the initial upload for you, as well as configure a recurring upload if needed. 



System Administration 179 

 

 

 
8.8 Work Orders Import 

Some customers wish to integrate their scheduling efforts with other systems. This is made 
possible by the import of new Work Orders from another system. Our system host utility 
allows customers the flexibility to import a list of jobs to be scheduled, or if desired, an 
entirely configured "master schedule". Our Customer Support staff will configure the import 
capability with your data file. It can be run on command or on a recurring basis. 

# woimp 

Usage: woimp WO_ASCI I_FI LE [-a][-C][-d][-f][-n N_MAX][-p S_PORT][-s FMT_SEQ] 

-a Import-ADD mode. Bring in only non-existing orders. 

-C Clear-and-replace mode. This option will clear all current job queues and then place 
those imported work orders that have machine name and queue position specified into 
job queues accordingly. 

-d Enable debug level logging 

-f Use default job standard if there is no matching job standard. 

-h Do not check history for duplicate work orders. 

-n N_MAX Import only first N_MAX work orders from ASCII work order 
file into database. If -n option is not used, all work orders in the file 
will be imported. 

-o Only look for duplicates in the work order list 

-p S_PORT Service port of shop floor daemon for datagram. The default is "f2k-sfd". 

-r Remove mode. This option will remove current work orders before import begins. 

-s FMT_SEQ Sequence number of the file/field format used for converting work 
order file into database. If -s option is not used, the first format in the database 
will be used. 

-u Stop and replace the current running job. This option will stop and replace the current 
running job on the DCM for an imported work order with its queue position set to zero. 

 
8.9 Production and/or Process Data Export 

Your system collects various types of valuable information that could be used by other 
systems. One of the utilities we provide for this purpose is the Product/Process Data Export 
Utility. Our Customer Support staff will, with your assistance, select the desired fields of data 
that can be used in other company information systems. This export can be configured to run 
on a recurring basis or on demand, and can also be configured to transfer the created data 
files to the appropriate server that will use the data. 

# f2kexp 

Panorama Production/SPC/Labor/Material Lot export program, version 4.31 

Usage: f2kexp [-e] [-d] [-r] [-j JOB_NAME] [-J JOB_SEQ] [-p [PROD_FILE]] 
[-s EOS_SEQ] [-f FMT_SEQ] [-x [SPC_FILE]] 
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-e Exclude idle jobs from job and shift production exports. Idle 
jobs are defined as those having zero pieces required. 

-d Enable debug mode.  

-r Right justify all number fields, left justify all text 
This option is used primarily for any system that 
requires a fixed decimal point (such as an AS/400). 

-j JOB_NAME Export production and/or spc data for the 
job with the given JOB_NAME. This option cannot be 
used with the -J or -s option. 

-J JOB_SEQ Export production and/or spc data for the 
job with the given JOB_SEQ. This option cannot be 
used with the -j or -s option 

-p PROD_FILE Export production data for a job (with -j 
option) or a shift (with -s option) to the ASCII file 
PROD_FILE. If PROD_FILE is not specified, default 
name prod.exp is used. 

-l LABOR_FILE Export labor data for a shift with -l options to 
ASCII file LABOR_FILE. If LABOR_FILE is not specified, 
default name labor.exp is used. 

-s EOS_SEQ Export production and/or spc data for the 
shift with given EOS_SEQ. This option cannot be used 
with the -j or -J option 

-f FMT_SEQ Sequence number of the file/field format 
used for writing data to the work order file. The -f option 
must be used. 

-x SPC_FILE Export SPC data for a job (with -j option) or 
a shift (with -s option) to the ASCII file SPC_FILE. If 
SPC_FILE is not specified, default name spc.exp is used. 

Exactly one of the -j, -s, or -J options must be used. 
At least one of the -p, -x or -l options must be used. 
The format sequence number must be specified (via the -f option.) 

 
8.10 Job Schedule Data Export 

Some customers prefer to use our Job Schedule Board to create the final actual machine 
loading of their shop floor, but need to send that information to other information systems. 
Our Job Queue Export Utility will generate a data file that can be used (imported) by those 
other systems. As with other utilities we provide, it is flexible, can be run on demand, and can 
be run on a recurring basis 

# f2kjqexp 

Panorama Job/Work Order program, version 4.10 

Usage: f2kjqexp [-d] [-r] [-e EVENT_TYPE] [-f FMT_SEQ] [-o OUT_FILE] [-m MACH_SEQ] [-w] 
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-d Enable debug mode. 

-r Right justify all number fields, left justify all text 
This option is used primarily for any system that 
requires a fixed decimal point (such as an AS/400). 

-e EVENT_TYPE Export data for only the specified event. 
This flag is only valid for a machine log export template. 

-f FMT_SEQ Sequence number of the file/field 
format used for writing data to the export file. The -f 
option must be used. 

-j Export current and queued job data. 

-o OUT_FILE Export data to the ASCII file OUT_FILE. If 
OUT_FILE is not specified, default name data.exp is used. 

-m MACH_SEQ  Export data for only the specified machine 
sequence number. 

-w Export work order data. 

 
8.11 Material Lot Data Export 

Customers that have purchased the Material Lot Tracking option almost always have the 
need to export the data collected by their system to another information system that is 
tracking inventory quantities, ISO Lot information or both. Our utility is flexible and can be 
configured to run recurrently or on demand as the customer's need dictates. 

# f2kmatexp 

Panorama Material Lot export program, version 4.10 

Usage: f2kmatexp [-d] [-r] [-J JOB_SEQ] [-m [PROD_FILE]] 
[-s EOS_SEQ] [-f FMT_SEQ] [-C] [-L] 

-d Enable debug mode. 

-r Right justify all number fields, left justify all text. This option is 
used primarily for any system that requires a fixed decimal point 
(such as an AS/400). 

-j JOB_NAME Export production and/or SPC data for the job with 
the given JOB_NAME. This option cannot be used with the -J or -s 
option. 

-J JOB_SEQ Export material history data for the job with the 
given JOB_SEQ. This option cannot be used with the -j or -s 
option 

-m MATERIAL_FILE Export material data for a shift with -m 
option to ASCII file MATERIAL_FILE. If MATERIAL_FILE is not 
specified, default name material.exp is used. 

-s EOS_SEQ Export material data for the shift with given 
EOS_SEQ. This option cannot be used with the -j or -J option 

-f FMT_SEQ Sequence number of the file/field format used for 
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writing data to the work order file. The -f option must be used. 

-C Summary by material component. 

-L Summary by material lot id. 

Exactly one of the -s, and -J options must be used. 
The format sequence number must be specified (via the -f option.) 
Only one of the -C and -L options may be used. 
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9 Knowledge Base 
 
9.1 Application Notes 

Application Notes 

The following list of Application Notes is available to all customers via FAX or email. 
Simply review the list and call Customer Support and request the document by the App 
Note Number. 

App Note  Topic 

91-004 PLC Serial Interface Handbook 
92-001 SACK Code Listing/Explanations 
92-002 High Speed Data Acquisition / Inj. Molding 
92-004 Sensor Selection: Injection Molding Machines 
92-005 Non-Normal Data Analysis in QA/S 
92-008 Paralleling Existing Sensors 
92-009 Configuring a CP3-32, CP3-32S, CP3-64 
92-018 Printer Setups to Allow Labels to Work. 
93-005 Net Parts Counting 
93-006 Calculating Tonnage 
93-007 Siemens/Pathfinder Up/Download Instructions 
96-004 Checking Statistics at a Communications Processor 
96-006 Power Conditioning 
96-011 Identifying M-CIM hardware (CPU revision, memory) 
96-015 Material Lot Tracking description. 
97-010 HP Network Printer Setup for Portrait 
97-012 Material Lot Tracking at DCM 
98-006 PlantStar-Hekuma Communications Link 
98-007 TI-545 PLC 
98-008 PlantStar-Nissei Interface 
98-009 Toshiba InjectVisor S10/V10 
98-010 Toshiba InjectVisor S10/V10v Parameter List for PlantStar Process Variables 
99-005 Adding a Permanent Route on Host (SCO and AIX) 
99-007 Using crontab Feature 
99-009 How to Troubleshoot the Custom Reports Ingres/Net Client 
99-010 Disaster Recovery: Identifying a Failed Hard Disk or Partition 
99-011 Disaster Recovery: Failed Second Hard Disk 
99-015 New Boolean Equation Type JEQ_CYC2 in Panorama v2.40 
99-016 CPU7.0 Board Information and Ethernet DCM16 Info. (DIP switches, etc.) 
99-018 Changing the System Host Name When "configure.f2k" is not Available 
99-021 Configure HP Network Printers Updated. 
99-026 Implementing and Troubleshooting Import-Export Templates and Scripts 
99-027 Checkpoint Backup Restoration Procedures 
99-029 PowerChute Password Instructions and Procedures. 
2001-001 Installing Lexmark Printer Drivers for SCO UNIX. 
2001-002 Running Multiple Logins for Shop Floor Monitor. 
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2001-004 Installing Engel Serial Interface on RTLDCM's 
2001-005 Linking the RTLDCM Browser Interface to Support Documents 
2002-002 Creating Browser Links from Setup Sheets 
2002-003 CIM/RTL Setup and Operation for Production 
2002-004 Configuring IP Address on Linux Web-Pad 
2002-005 Tips for Crystal Report Conversion for Family Molding 
2002-006 Command Line Options for Multiple Vnode Printing 
2002-007 Procedure to Change an Ethernet el7 to an rs485 el7 
2002-008 Resetting APC Smart-UPS after Battery Change 
2002-009 Nissei Interface 
2002-010 RTL-Boot Disks 
2002.11 Customer Host Upgrade Instructions X.10 
2003.1 Database Transfer Host to Host 
2004.1 Installation of Windows 2003 Server on a Host 
2004.2 Toshiba Serial Cable Diagram 
2004.3 Configuring the PlantStar Server as a Gateway 
2004.4 Setting Up WINXP for dial-up slip 
2004.5 Using f2karc 
2004.6 Using archive.f2k 
2004.7 PlantStar OEE Definitions 
2004.8 Compaq Workstation Linux Slackware Install 
2005.1 Excel Spreadsheet Problems and PlantStar 
2005.2 Reiser Image Installation Guide 
2005.3 Pstar_setup Instruction Guide 
2005.4 
2005.5 PlantStar Software Patch Installation 
2005.6 View & Print User Privileges 
2005.7 Touch 8 Set-Up Instructions 
2006.3 Process Journals User Manual 
2006.4 
2006.5 Machine Removal Instructions 
2006.6 PM Asset Import from External Source 
2006.7 Using Excel or Access with PlantStar 
2006-08 Using Microsoft Excel or Access with PlantStar 
2006-09 Linux Serial and USB Device Management Using usbconf 
2006-10 RTL Screen Saver Setup 
2007-01 DNS Mail Server Setup 
2007-02 Apache Web Server Daemon Change 
2007-03 Process Journal User Manual 
2007-04 Process Journal Administrator's Manual 
2007-05 Understanding and Developing Digital Equations 
2007-06 Passing Parameters in a Link 
2007-07 Creating Browser Links from Setup Sheets (Replaces 2002-01) 
2007-08 Configuring Remote System Logging 
2008-01 Scheduled MySQL Backup 
2008-02 Cincinnati Milacron Mosaic Control Instructions to Change Sequencer IP 

Address 
2008-03 Linux Server Build Instructions 
2008-04 OPC Client Application User's Guide 
2008-05 APC UPS Configuration in Linux 
2008-06 Ingres to MySQL Database Conversion 
2008-07 Script & Directory Changes for Version 4.30 
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9.2 Arranging Windows and Icons 

9.2.1 Arange Icons 

To arrange the iconized windows into straight rows and columns, select the  

Window menu on the main screen of you your system window.  

Choose the Arrange Icons option. 

 
9.2.2 Arrange Windows 

The windows can be arranged in 3 ways: 
 
 

 
 
  Cascading: 

 
 
 
  Vertical Tiles: 
 
 
 
  Horizontal Tiles: 
 
 

 
 
To choose one of these styles, select the Window menu from the main screen of your 
system window. Select one of the options displayed. 
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9.3 Changing View Options 

 

The View button opens the View Options window. This window filters the list of machines 
that appear on a Monitor window. The filtering is done by machine state or a selected 
machine list. Click on one of the circles to the left of the desired machine state. The Monitor 
window immediately changes its list of machines to those that are currently in the selected 
machine state. 

Where can you find it? 

The View Options window is accessible from the Material Usage, Production 
Summary, Exception Summary, and Machine Performance windows. 

What do you want to know about? 

 Selecting a Machine State  

 Selecting Specific Machines  

 Selecting All Machines in a Display Group 

 Clearing Machines  

 Closing the Window 

 
9.4 Colors 

This image represents the possible machine states and their associated colors. 



188 SYSCON-PlantStar Help System 

 

 

 

 
9.5 Creating Work Orders 

Work Orders are essentially jobs that have been defined but not yet scheduled. In order to 
schedule jobs, you must first create a work order. A work order consists of a set of job 
parameters. These parameters define the job. They include such things as the number of 
pieces required and the standard rate at which the pieces will be produced. 

A work order may be created manually by entering the parameters or by loading in a product 
standard. Work Orders can be created from the Work Orders or Job Schedule Board 
windows. 

From the Work Orders window: 

· Click on the New button. 
· Select a machine from the machine field. 
· Move the cursor to the Value column for each desired parameter. Directly type in 

parameter values. If default information is displayed, edit it as desired by typing over it. 
· Click on the Apply button to save the new work order after all relevant job parameters 

have been entered. Once a work order is saved for a machine, an asterisk appears next 
to the machine in the machine field. This asterisk signifies that a work order exists for 
the specific machine and product combination. 

From the Job Schedule window: 

· Click on     the button. The Edit Job Parameters window appears which looks similar 
to the Work Orders window. 

· Move the cursor to the Value column for each desired parameter. Directly type in 
parameter values. If default information is displayed, edit it as desired by typing over it. 

· Click on the Commit button    on the Job Schedule window to save the changes to 
the Job Schedule Board. If this step is not done, the changes will not be permanent or 
sent down to the shop floor. 

 
9.6 FAQ - Frequently Asked Questions 

Following are the most common questions asked about your system. Scan this list 
before you call Customer Service. Each question is followed by the answer. 
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Question 1:  
What do I do when a message appears stating that system resources are too low to open a 
window? 

Answer: 
System resource limitations restrict the number of windows which can be open at one time. If 
you are running your system and several other programs, close one or more of the other 
programs. If you are only running your system and receive this message, close some of 
your open windows. To see how much free resources are available, select the About... menu 
item under the Help menu within your system. 

Question 2:  
Why did your system stop updating the Real-Time windows within Monitor? 

Answer: 
If window information is not being updated, make sure all host computer programs are 
running. Specifically, the System Administrator should check and ensure that the shop floor 
routing process is running. Use the sfdctrl -stats command on the host computer to obtain 
the current status of the shop floor routing process. 

Question 3:  
Automatic reports are not printing. Why? 

Answer: 
If automatically scheduled reports are not running 

· Open the Schedule Reports window under the REPORTS menu within the Monitor 
program. Ensure that the reports are correctly set up for the scheduled time. Make sure 
that there is a shift schedule for the current year. (At year end, shift schedules do not 
roll over.) 

· Check the printer to ensure it is ready and on-line. 
· Use another program to try to print something to the printer. 

Question 4:  
Why does your system report that a machine is down (appears blue) when the machine 
is actually running. 

Answer: 
· The down threshold may be set too low. Open the Edit Current Job window in the 

Monitor program and make sure that the down threshold setting is larger than the 
current cycle time of the machine. 

· The machine's DCM may not be receiving a contact closure from the machine. Check 
the wiring from the machine's relay to the DCM. Check the relay inside the machine 
cabinet. It should open and close each time the machine cycles. Make sure that all 
ribbon cables are seated securely at both ends. 

Question 5:  
Why would all machines show as off-line (appear white in the Monitor windows)? 

Answer 
· Make sure that there is power to the DCM. 
· Check all wiring. Using a volt meter, measure the RS-232 voltages inside the DCM. Go to 

the COMM 1 section of the terminal board and measure the voltage across RXD and 
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GND. The voltage should be between -8.0 VDC and -11.0 VDC. If this voltage is not 
present, the wiring is faulty. 

Question 6:  
How can I find out the version number from a system distribution tape? 

Answer 
The system version number is documented within the install.f2k and update2.sh installation 
files. 

 
· Untar the first tar set on the distribution tape into a temporary (for example, tmp) 

directory. 
· Two files -- update2.sh and install.f2k -- now exist after the untar procedure. 
· View either file. Look for the F2K_VERSION variable within either file. This variable 

displays the version number for the distribution tape. 

 
9.7 Getting A Screen Capture 

Windows within your system can be printed using the standard Print Screen Key function 
and any windows application that will accept a Windows Clipboard Paste. This utility 
provides an easy way to capture and print either an active window or the entire screen. The 
screen picture can be resized and pasted into any Windows program which handles 
graphics such as Microsoft Word or Paint Brush. 

 
9.8 JIT - Product Standard Matching 

JIT scheduling is an authorized feature that allows customers to switch product standards by 
selecting from a drop-down list of products on the work order edit screen. For instance, the 
customer knows he needs to make "Cooties", but his ERP system does not know which of 
six tools will be used. Each tool defines a unique product standard. Work order import 
requires the import of a unique "Cooties" standard. Once this is completed, the user can go 
to the Job Edit screen and select from a drop-down list of unique tools (in this example) 
and over-write the work order with selected information from the selected product standard 
associated with that tool. 

The implementation of this feature requires a custom import template to be written. 
Please contact Customer Support for information regarding this template. 

 
9.9 Job Schedule Board Overview 

In order to collect process variables and production data for a machine, a job must be 
assigned on that machine. The process of scheduling or queuing jobs is handled through the 
Job Schedule window. 

The Job Schedule window consists of a Gantt style scheduling board. Calendar time is 
shown on the horizontal axis. Machines within a selected display group are shown on the 
vertical axis. Each row represents a machine's job queue and each rectangular block is a 
scheduled job. The first rectangular block for each machine is its current job. The block 
length indicates the expected run time for the job. Block labels are selectable. They can be 
either job or product names. 

http://update2.sh
http://update2.sh
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A job is scheduled by selecting a work order and placing it in the job queue of a given 
machine. By default, jobs are scheduled sequentially from left to right. There are two 
scheduling methods available within Panorama: 

· Schedule jobs by earliest start date (default) 
· Schedule jobs by due date  

The default method on the Job Schedule window is for jobs to run immediately following the 
completion of previously-queued jobs. The estimated completion time of a job becomes the 
starting time for the next queued job. Under this method, jobs that are expected to be 
completed on time are shown in green. A red rectangular block indicates that a job will not 
complete by its estimated completion date. The default method is active unless the second 
scheduling method has been activated and/or saved during a previous session. 

The second method is to schedule jobs by due date. This method places a selected job (or 
jobs) on the job board at the latest possible time which allows it to be completed by its due 
date. Specifically, a job's required by date is used as the starting point. The length of time to 
run a job is then used to walk backwards through the shift schedule to estimate the start date. 
Using this method, gaps may occur between a job's starting time and a previous job's ending 
time. These "gaps" are represented on the job board by gray blocks and indicate slack time 
where new jobs can be scheduled. Under this method, jobs that are expected to be 
completed on time are shown in green. If this method causes a subsequent job to become 
late, the late job's rectangular block is colored orange. 

The       marker, located along the top of the job board area, indicates which jobs are 
scheduled according to their due dates. All jobs to the left of this marker are scheduled 
according to the earliest possible start -- a job starts immediately upon completion of the 
previous job (method one). All jobs to the right of this marker are displayed on the job board 
according to their due dates (method two). (For more detailed explanations refer to the field 

help provided on the     icon.) 

NOTE: You must have the proper privileges in order to schedule jobs. See your System 
Administrator if you do not have the Scheduling privilege. 

 
9.10 Job Scheduling Concepts 

Once the shop floor is defined, its work schedule can be created. There are numerous 
steps for creating the shop floor work schedule. The first step in understanding how to 
schedule jobs centers around the Work Center. Work centers define how jobs are 
scheduled and when they run. 

The following sections discuss some basic relationships about scheduling jobs. These 
relationships are presented here to facilitate the use of the SCHEDULE windows. Once 
understood, job scheduling within your system is straightforward. 

Shifts  

A machine follows one shift schedule -- the one belonging to its work center. It is important to 
design your work centers with this in mind. Each work center has a set of annual shift 
schedules. Annual shift schedules are divided into 52 weeks. Weeks start on Monday and 
end on Sunday. 
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Schedules for each week of the year can be set from one of twelve weekly schedules. Each 
weekly schedule defines the day-to-day shift changes for up to six different day shifts. Two 
idle periods per day are available for times when the machines should not be in operation. 
During an idle period, the machine's DCM ignores all inputs. Only idle time is accumulated. If 
no shift schedule is assigned to a machine, the machine is considered to be up 24 hours a 
day. 

These shift schedules are important because they are used by your system to create 
historical production records. The production records are the raw data for the monitoring 
windows. A new historical production record is created for each machine at each shift or 
job change. 

Jobs  

A job is the basic unit which defines production monitoring on a machine. Every monitored 
machine in the system must have a job assigned to it. Scheduling a job is a two step 
process. Every job within your system starts as a work order, which is step one. A work 
order is a job which has not yet been scheduled on a machine. It consists of parameters 
which define how to monitor a job's performance and progress. These parameters are based 
upon the type of product produced and the machines on which the product will run. They, in 
essence, describe the job and set the standard for monitoring it. They define the line 
between the normal operating mode and various exception states for a machine. All 
monitoring is based upon these values. Examples of job parameters are job name, product, 
material, tool, standard cycle, pieces required, required date, and process limits. Care 
should be taken when defining job parameters. For instance, if the Standard Cycle 
parameter is set to 30 seconds and the Cycle Tolerance is set to 10 percent, a machine 
would be considered slow if its cycle time was currently 33 seconds. This same machine 
would be considered down if the down time threshold parameter was set to less than 33 
seconds. 

Job parameters also determine the expected run time of a job. The pieces required, 
standard setup and the standard rate factor are used when computing the completion date 
of a job. If 10,000 pieces are required and the standard rate is 50 pieces/hour, then the 
runtime of a job would be 200 hours. Add this to the standard setup time and you have the 
expected runtime of a job. The Schedule Now and Schedule Factory parameters also 
affect the calculated completion date. These fields determine if the shift schedule should be 
followed when computing the completion date. 

Once a work order is created, it can be scheduled as a job -- the second step in job 
scheduling. Each machine has a currently-running job and a queue of jobs waiting to run. 
The scheduling person must know which jobs can be run on which machines. The main 
objective is to arrange the job queues so that as many jobs as possible complete on or 
before their required completion date. 

Once started, a job cannot be removed or stopped. It can only be replaced by another job. If a 
current job is not complete when it is replaced with a new job, it can be suspended. A new 
work order is created. The Pieces Required parameter on this work order is set to equal the 
pieces remaining to complete the job. The comment parameter will indicate that this work 
order was created from a suspended job. The work order can then be scheduled on a new or 
the same machine at a future date. 

A job is considered completed when the pieces required for a job is equal to the net pieces 
produced. When a job is completed, it may be set to an idle state if there is no new job in the 
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machine's queue. This "job idle state" is exactly the same as a shift idle period for a single 
machine. The machine's DCM ignores all inputs from the machine. To put a job in the idle 
state, set the job parameters "Schedule Now" and "Schedule Factory" both to No. 

Additional Considerations: 

Estimated completion dates for a job are only as accurate as the job's parameters and shift 
schedule. The parameters Standard Rate and Standard Setup Time: are especially 
important for accurate estimates. 

To facilitate the creation of a work order, a Product Standard can be created. Product 
Standards are templates which contain the same parameters as a work order. A library of 
standards can be created and maintained within your system. When a work order needs to 
be created, a Product Standard can be loaded in and used as a base for the work order. 
Pieces Required and Required Completion Date are the most common parameters which 
are set when using a standard to define a new job. 

A maintenance (non-production) job can be created within your system. This is 
accomplished by setting the job parameters Pieces Required and Standard Rate both 
equal to zero. The Standard Setup parameter can then be used to define the duration of the 
maintenance job. 
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9.11 Loading a Product Standard onto a Job 

 

Any job can be updated by loading (copying) a product standard from the Load Product 
Standard window. 

Where can you find it? 

· The Load Product Standard window can be accessed from the Current/Queue Job, 
Work Orders, and Job Schedule Board windows. 

· Click on the Load Std button. 
· The Select Product Standard window appears. Select a product standard. Once 

selected, the Work Order window reappears with the job parameters of the desired 
standard. 
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9.12 Logging into your PlantStar system 

 

The login window provides security for all programs within your system. Only users 
that have permission to access the application are allowed. Only ONE Monitor 
session is allowed per workstation. 

To access: 

· Install the application into your Windows software. 

· If the Monitor icon is highlighted, then double-click on the icon. If it is not 
highlighted, move the mouse pointer to the icon and then double-click on it. 

· The main login window appears which asks for a user name and password. Both of 
these can be obtained from the System Administrator. 

· Use the <TAB> key to go from field to field. After your name and password are 
entered, click on the Login button or press the <ENTER> key. 

NOTE: If your password does not seem to work, first try to re-enter your password. If it still 
does not work, contact your System Administrator. 

 
9.13 Material Lot Tracking Concepts 

Every monitored machine has a job assigned to it. The job has a defined material 
formula. This formula can consist of up to four raw materials. Once a job is running on a 
machine, its associated DCM enables the entering of Material Lot IDs for each of the raw 
materials. 

Lot IDs can be vendor or user-defined. Lot IDs create an audit trail between the lots of raw 
material fed into a machine and the tote boxes of finished products which come out of the 
machine. If a different raw material lot needs to be used on a running job, the new Lot ID and 
material name can be entered at the DCM. 
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A delay timer is available for specifying the amount of time to elapse before a new material 
lot is used on the current job. When the time expires, the current material lot is replaced 
with the new material lot. The current material lot then becomes part of the historical audit 
trail. 

Material Lot Tracking is an auditing feature that traces material lot usage. A material lot 
can be traced to a specific tote box. Each time a tote box becomes full, an operator presses 
the tote change button on a DCM, or a material lot changes for a job, the event is recorded. 
These events form a lot history. 

 
9.14 O.E.E. 

OEE is a tool to measure the performance of individual equipment or an entire process. 

OEE can be used to measure losses caused by poor quality, equipment problems or non-
optimal run rates. The calculation for OEE is: 

%OEE = (% availability)*(% productivity)*(% quality) 

This equation can be applied to a single machine or an entire process. It should be tracked 
over time to see the impact of changes in equipment, training, and maintenance, 
purchased materials and management direction. 

OEE will help identify the areas requiring improvement, the potential revenue from an 
improvement and serve as a benchmark against competition. One of many ways of 
expressing OEE is (Operating Time/Total Time)*(Std Cycle/Std Mult) 

Typical items measured by OEE will be actual downtime vs. planned, slower production 
rates than standard, defects, and minor but important problems. The Emerson Company 
offers the following guidelines for OEE. Other references can be found on the web by 
searching on OEE. 

 Quartile    

Process 
Type 

Worst 3rd 2nd Top 
Continuous <78% 78-84% 85-91% >91% 
Batch <72% 72-80% 8 1-90% >90% 
Chem., 

Power 
<85% 85-90% 91-95% >95% 

Paper <83% 83-86% 87-94% >94%  

The elements of OEE are Availability, Productivity and Quality. 

Availability takes into account Down Time or stoppages, time the machine is not running as 
scheduled. 

% Availability is defined as Actual Production time/Planned production time, or Operating 
Time/ planned production time, or the percentage the equipment is available for 
production. It can be affected by changes in process variables, preventive maintenance, 
and machine failure detection. 

Avail = 
Uptime 

 (Uptime Downtime) 
+ 

PlantStar defines availability as 
Idle time is not a part of this calculation. I.e. A machine is not available when idle for 

. 
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whatever reason. Idle time can be scheduled or non-scheduled. 

Productivity or Performance takes into account Speed Loss. 

% Productivity is defined as Actual Production/Optimum Capacity or (Minutes/part)/(Total 
parts/Operating time), or Ideal cycle Time/(operating time/Total parts), or (Total 
parts/Operating time)/Ideal run rate, or parts per time to produce. Material availability, 
operator training, equipment breakdowns and machine speeds affect it. If production was 
planned for a machine and it is down, the productivity clock is still running. 

PlantStar defines productivity as (gross parts produced/up time)*(std 
cycle/std mult). Or (gross parts/up time)*((seconds/cycle)/pieces/cycle). 

Productivity is a unit less quantity, a number. Expanding just a little: 

Gross Parts Gross Parts Time to make a part 
Productivity = ----------------  =     ----------------------   X  --------------------------  

Scheduled Pieces   Time to make a part    Scheduled Pieces 

Gross Parts Time to make a part 
Productivity =  -------------------------- X -----------------------------------  

Time to make a part     Std Mult x Num of Cycles 

Gross Parts Time to make a part 
Productivity =     X  

(up time)/Std Cycle        Std Mult x Num of Cycles 

Gross Parts        (Time to make a part x Std Cycle) 
Productivity = -------------------- X -----------------------------------------  

up time                (Std Mult x Num of Cycles) 

where Std rate = Std Mult/Std Cycle 

Gross Parts 1 
Productivity = ----------------  X ---------  

up time std rate 

Quality takes into account bad parts or wastage. 

% Quality is defined as (Product produced – (rejects))/Product produced, or Good parts/total 
parts. It is affected by changes in process variables, material quality, and equipment 
performance. 

PlantStar defines Quality as (net pieces/gross pieces). 

The total calculation can be expressed as: 

(up time/(up time + down time))(net parts produced/(up time + down time))(std cycle/std mult) 

For Example: 
Shift Time = 8 hrs 
Breaks = 30 minutes 
Lunch = 1 hr 
Down time = 35 minutes 
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Ideal Run Rate = 10 seconds 
Gross parts = 2200 
Rejects = 37 

Availability = Operating time/Planned production time = (480–30-60-35)/(480-30-60) = 0.91 
Availability = Up Time/(Up Time + down time) = 355/390 = 0.91 

Productivity = Gross Parts/Scheduled Parts = 2200/(60*390)/10 = 2200/2340 = 0.94 
Productivity = Gross Parts/operating time/run rate = 2200/390*60/10 = 0.94 

Quality = Good Parts/(good parts + rejects)= 2163/2200 = 0.98 

OEE = Availability * Productivity * Quality = 0.91 * 0.94 * 0.98 = 0.838 

 
9.15 OSI Model 

Networks are a series of computers and devices tied together by the Open System 
Interconnect (OSI) model. The OSI model provides a way of describing the way a computer 
connects a running program to the network. Within a computer there are many layers of 
things going on both at the hardware and software level. There is the CPU connected to 
several buses, in turn connected to memory, drives, ports etc. There is a software operation 
system, software modules running the connected devices, and one or more application 
programs. As a user we see all this as a computer not as all its parts. This is called looking at 
the computer as a whole as a level of abstraction. The OSI model provides a level of 
abstraction to view the connection between a network and the running program. 

There are seven layers in the OSI model: 

1. Application 
2. Presentation 
3. Session 
4. Transport 
5. Network 
6. Data Link 
7. Physical 

The Application layer provides services to the running program. It handles such matters as 
screen size and fonts. The Presentation layer converts the information flow to a network 
standard. Different computers define character sets, escape characters etc. in a different 
way. The Presentation layer converts these to a network standard. The Session layer 
handles the bookkeeping required. It knows to whom it is talking and can re-establish 
communication if contact is lost or part of a file transfer must be repeated. The Transport 
layer handles the end to end communication. It must cut up a message into packets that 
match the ability of the network to handle. If a file transfer was done in one packet of a million 
bytes and one present of the packet was lost on each transfer, the file would never complete. 
If the file was sent as one thousand packets of one thousands bytes each, only a small 
percent would have to be re-transmitted to cover the lost packet. The Network layer handles 
the routing. It keeps track of the route over which a packet must travel. The Data Link layer 
provides error control, re-assemblies packets of data that may have been scrambled in 
transmission and puts packets back in order. It does the handshaking between connections. 
It requests a re-transmission of a lost packet and throws out duplicate packets that might 
arrive. The media access control or MAC is located in the Data Link layer and contains the 
device address. The Physical layer provides the connection to the network. It deals in ones 
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and zeros and the time between them. 

A Domain is a feature that allows the Internet to map from a language description (English 
usually) to an Internet address. For example mordred.cs.purdue.edu is the English name for 
a computer at Purdue. Its domain is purdue.edu. It is in the computer science department 
and its name is mordred. 

The domain for PlantStar is Syscon-intl.com. The domain most of you will be working on will 
be mycompany.com All Internet addresses are actually what are known as a dotted quad. 
This is four numbers between 0 and 255 each separated by a period or dot. An example is 
192.17.10.11 which is the address of a Syscon computer. When you type a name into your 
computer, it goes up the chain of servers on the net until it finds one that knows the correct 
dotted quad address equivalent to the name you typed. That address is returned to your box 
and the connection is then made. The new address is saved in a routing table in your 
computer so the next time that name is typed in, your computer will already know where to 
find the requested address. As an FYI, the world is running out of numbers and the dotted 
quad will change to a dotted sextet sometime soon. This will provide a unique number for 
every square meter on earth 

A PlantStar host has two network cards. One handles communication with the DCMs and 
the other handles communication with the PCs. 

Local Area Networks: 

This section will discuss local area network (LAN) as used by the PlantStar System. A LAN 
is a network where multiple devices (stations) use the same media access technology and 
exist within the same broadcast domain. That is, each device can send and receive 
information without the need for routing. PlantStar is usually set up as a single LAN and all 
devices see the traffic at the data link layer. If a message is not for a given computer it stops 
at the data link layer. If a large area or more than one building is covered then a router or a 
bridge can be used for connecting devices. If a bridge is used to connect devices within a 
LAN it is known as an Extended LAN. A router can be used to connect multiple LANs at the 
network layer. Each LAN would have its own broadcast domain and the router would be 
used when a device in one domain talked to a device in another domain. The collection is 
known as a wide area network (WAN). 

A computer can broadcast to ALL devices in its domain by sending the first three numbers in 
its dotted quad and making the last number 255. As an example at Syscon, the address 
would be 172.17.10.255. A broadcast is used by a host to ask all the computers in its 
domain to tell it their addresses. 

http://mordred.cs.purdue.edu
http://purdue.edu
http://Syscon-intl.com
http://mycompany.com
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There are a number of types of networks and the standards that define them. PlantStar is 
an Ethernet network defined by IEEE standard 802.3. Each DCM has a unique address, 
which can be assigned during setup. This standard allows all stations to try to talk at any 
time. Collisions are detected and stations back off a variable amount of time and try again. 
This technique is known as CSMA/CD, which stands for Carrier Sense Multiple 
Access/Collision Detection. In a PlantStar only network (no other devices on the local net) 
Collisions are not a problem. PlantStar is a talker/listener system. The host goes from 
station to station and requests information. It listens for a response and then goes to the 
next station. There are never two units trying to talk at the same time. 

Workstations may have a fixed address or have one assigned to them when they power up 
using Dynamic Host Communication Protocol (DHCP). Which approach is used in your 
shop is based on a decision made by your IT person. 

Ethernet comes in several speeds. Older networks run at 1 0Mbyes/sec half duplex (talk in 
only one direction at once). Today's standard is 100 Mbytes/sec full duplex. One Gbyte/sec 
is available and plans are underway for a 10 Gbyte/sec system. Other LAN types are Token 
Ring and FDDI (Fiber Distributed Data Interface. A special bridge can be used to connect a 
Token Ring or a FDDI ring to a standard Ethernet but that technology is outside this 
discussion. 

PlantStar uses the Transmission Control Protocol/Internet Protocol (TCP/IP) (standard) to 
talk to devices on the network. Many other protocols exist and are often used on wide area 
networks and the Web. Again these other protocols will not be covered during this class. 

Network Topology: 

PlantStar uses a distributed star topology. In a small system the host computer is connected 
to each of the DCMs with a network cable. As the system gets larger, routers and bridges are 
used to reduce the length of cable runs and to isolate sections of the network. It is possible to 
connect individual DCMs and the PlantStar host to a plant bus as it passes the devices. 
However, PlantStar prefers to run a local bus for the PlantStar system and join the PlantStar 
system and the plant bus together at the host using two network cards in the host to separate 
the networks. This provides a high degree of isolation between systems and makes 
maintenance and troubleshooting much easier. If all devices are on one plant network, an on-
site technician may be required to keep the systems up and running. 

Networks can be hard wired or wireless. Wireless is usually cheaper today but comes with 
its own set of problems. The specification is numbered 802.11 and comes in several flavors, 
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b and g being the ones that are interesting for a PlantStar system. The b version talks at up 
to 11mbytes/sec and the g version up to 54 mbytes/sec. Both offer 11 channels to talk on 
but these channels overlap so that there are really only three usable in a plant 1, 6, and 11. 
Each DCM will need a bridge and depending on the distance up to eight bridges might talk 
to one access point. Cable is usually run from the access point to the host. One combination 
would be to run a group of machines say eight on channel 1 to the first access point, the 
second eight machines to the second access point on channel 6 and the third set of eight 
machines to another access point on channel 11. Repeat until done. 

Another approach might be to alternate channels 1 and 11 throughout the shop and use 
channel 6 to bring the signals back to the host. A key to making this work is that each 
access point can be told what addresses it can and can not talk to, which prevents two 
access points trying to talk to the same machine and causing problems with the host. 

Cabling: 

Computers can be connected with copper wire, fiber optic cable, coaxial cable or even 
wirelessly. Copper wire is the media used in almost all installations today. UTP5e is the 
designation. It describes Unshielded Twisted Pair cable and the capacitance between wires. 
A shielded version (STP5e) is also available but used only in very noisy installations. Some 
UTP3 is in place in older systems, it will support a 10Mbytes/sec Ethernet connection up to 
100 meters. UTP5e will support 100Mbytes/sec. Because of increased usage, there is little 
difference in cost and all new installations should be run with 5e. The connector used with 
this cable is known as RJ45, an eight-wire connector that started life in the telephone 
industry. In your house it may be a different story. If you have cable, it will be run with coax. 
Coax cable can support broadband while UTP is always baseband. Baseband is when the 
ones and zeros appear directly on the cable as a plus and minus voltages. The cable pair 
can support only one bit of information at a time. With broadband, the data is used to 
modulate a frequency carrier and thousands of signals, each at a different frequency can co-
exist on the wire. This technique is expensive and used on the Internet backbone where a 
large amount of data is carried. The frequencies can extend to the range of light and fiber 
optic cable can be used. 

Bridges, Hubs, Switches, Routers, Gateways: 

Bridges are used to connect two or more subnets or LAN with the same domain. A standard 
bridge contains just the data link and physical layers of the OSI. They can determine if a 
data packet needs to be passed from one LAN to another by checking the destination 
address in the packet. A translation bridge is capable of translating data packets from one 
type of network to another. This also reduces total traffic on the extended LAN. 

A hub typically connects 8, 16 or 24 devices. A hub can be used to reduce the amount of 
wiring required in a plant. A hub can concentrate a number of devices in one area into one 
line connecting to the rest of the plant. Smarter hubs can be accessed over the network to 
check their operation and change some parameters. 

Another step up is a switch. A bridge provides a “one to one” connection, a hub provides a 
“one to many” connection, a switch provides a “many to many” connection. A switch can be 
used to connect multiple networks without the use of a backbone or to reduce the traffic on a 
backbone. A backbone is the highest level the signal must traverse to get to and from its 
goal. In a plant the backbone would be the wire connecting accounting, the shop floor, the 
front office, etc. In a multi-plant operation, it would be the wiring connecting the plants. On 
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the Internet it is the grid connecting major cities all over the world. 

A router works with more than just the data and physical layers. Adding network and 
transport layers allows routers to handle traffic between different types of networks. 
A gateway is a smart router. It stands at the entry to a domain and looks at all traffic into 
and out of a domain. It can be set to reject a single internet address (Whitehouse.com), 
addresses that are mostly personal (JUNO.net), a list from the anti-porn league, or what 
have you. The reject list is maintained by the IT group. 

Virtual Private Networks (VPN): 

A VPN is a way to connect a remote device to a network with a reasonable level of security. 
Just adding a modem to a system allows the remote device the same access that any other 
device on the LAN to which it is connected. If the modem is connected to a LAN segment that 
is in turn connected to the main LAN, it may be possible for a remote connection to access 
sensitive information. If the modem is connected through a level three switch, the switch can 
be told to match software and hardware address from the remote device. This will restrict 
unauthorized users from getting into the system; furthermore, if the switch and modem are 
properly located, the external device will only be allowed to access the LAN to which the 
modem is connected. If the PlantStar system is set up as a separate LAN, then the switch 
can be set up so the PlantStar system can be contacted by Syscon for service but Syscon 
would be blocked from access to anything else. 

 
9.16 Process and Production Monitoring 

There are two primary types of monitoring windows within your system -- process and 
production. Production information is available for a specific machine or a group of machines. 
Process information is available for a specific machine. Both types of windows are accessible 
through the MONITOR menu. 

How a job is set up directly relates to the monitoring information available. The job 
parameter Schedule Now, for example, determines whether to monitor a job without 
reference to its machine's defined shift schedule. If this job parameter is set to "yes", the 
machine is monitored and job data is generated regardless of any idle periods in the shift. 
If this parameter is set to "no", the state of the Schedule Factory parameter determines 
when the machine is monitored. 

The Schedule Factory job parameter indicates whether to use the factory shift schedule for 
the job. If this parameter is "yes", the job follows the defined shift schedule. If this parameter 
is set to "no", the job is considered to be idle and the associated machine is not monitored. If 
the Schedule Now parameter is "yes", this parameter is ignored. 

Thus, these two job parameters affect how and when a job is monitored. How a machine 
is defined also affects the monitoring component of your system. Process variables and 
profile variables, if defined, have numerous windows devoted to reporting their behavior. 

The following sections discuss some other job parameters and basic concepts that 
influence how information is monitored and presented within your system. A few of the 
more important types are discussed individually. 

http://Whitehouse.com
http://JUNO.net


Knowledge Base 203 

 

 

Production Monitoring  

For production monitoring, there are two fundamental pieces of data -- pieces and time. 
Virtually all monitoring information involves or uses these two pieces of data to report on the 
progress and performance of a job. 

Pieces 

The first fundamental production monitoring quantity is pieces. Gross pieces are 
accumulated by counting closures of the primary contact. The standard multiplier is a 
parameter entered in the job's work order. It defines the maximum number of pieces 
produced per machine cycle for a job. The actual multiplier reports the number of pieces 
currently produced per machine cycle. 

Reject pieces 

Reject pieces are counted within your system to keep track of the number of good pieces. 
Rejects can be entered in one of three ways: 

· by an operator at a keypad or EL/TS DCM, 
· by a user at a work station, 
· by automated equipment using contact inputs to the DCM. 

Rejected pieces are used in the calculation of net pieces. The number of rejected pieces is 
subtracted from gross pieces to obtain net pieces. 

Net parts counting is an alternate method of monitoring good parts. Using this method, 
finished boxes of good parts are counted instead of counting rejected parts. Any difference 
between the good parts counted and the gross pieces produced by the machine is 
automatically accumulated in the machine's designated reject reason. (The designated 
reason is defined from the Force Scrap flag on the Down Reason Sets window.) The 
number of good parts to be counted each time the net parts input contact is closed is tracked 
by the job parameter, net parts multiplier. 

Time 

The second fundamental production monitoring quantity is time. Production time is divided 
up into up time, down time and idle time. Down time is accumulated based upon cycle 
time exceeding the down time threshold. Pieces, possibly good pieces, can be produced 
while down time is accumulating. This depends upon how the down threshold and 
standard cycle time parameters are defined for a job. Down time quantities may be 
adjusted by a user at a work station. 

Assist time is accumulated in parallel with production time. No assist time accumulates 
while a job is idle. Operators may call for assistance at any time by selecting one of the 
available assist reasons. This does not affect the production monitoring of the machine. 

Process Monitoring 

Process Variables 

If defined for a machine, up to 50 process variables can be monitored. Most process 
variables are collected once per machine cycle. These types of process variables are used 
to monitor characteristics which are repeated with every machine cycle. Examples are 
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pressure, temperature or time duration process variables. 

Some process variables are collected only when new readings are provided by the 
operator. These types of process variables are used to monitor something which is 
sampled at irregular intervals. Examples are measurements of sampled parts such as 
weight or dimensions. 

Whenever a reading is collected, it is compared to the process limits which have been 
defined for a job. If the reading is out of bounds, a process violation is flagged. This 
violation is displayed on the monitoring windows as a process exception. 

Profiles 

Up to 4 profiles can be monitored for each machine. Their behavior can be graphically 
displayed on any work station or at the relevant EL/TS DCM. A profile is a set of up to 500 
readings of a single process input channel collected during one machine cycle. The input 
channel can be sampled as fast as once every 10 mS. Limits may be set for the minimum 
and maximum values (similar to process limits) to flag a process violation. Again, any 
violations are displayed on the monitoring windows. 

Various values can be collected from a profile. These values can be read as process 
variables (called pseudo variables) for further tracking and limit checking. 

SPC Data 

DCMs calculate and monitor a variety of SPC parameters. X-bar and Range graphs display 
SPC alarms for defined process variables. On an EL/TS, the alarms are displayed to the 
right of the graph. The key for the alarms is as follows: 

XCL The last X-bar value was not within control limits 
RCL The last Range values was not within control limits 
INC The last 8 X-bar values were continuously increasing 
DEC The last 8 X-bar values were continuously decreasing 
ABV The last 8 X-bar values were above the mean 
BLW The last 8 X-bar values were below the mean 
UTR The last 25 X-bar values show an upward trend 
DTR The last 25 X-bar values show a downward trend 

RSM Within the last 25 X-bar values, a RUNSUM exceeded 4. 

If any of these parameters fall outside of accepted norms, an SPC violation is flagged on an 
EL/TS DCM. SPC subgroups can be collected for each process variable on a job-by-job 
basis. Monitor X-bar and Range charts are then provided in the monitoring windows for all 
current jobs. Historical X-Bar/Range charts can be displayed for completed jobs. Undefined 
and down cycle process readings are never included in SPC subgroups. SPC data can be 
transferred to the Extended SPC database for more advanced analysis. 



Knowledge Base 205 

 

 

 
9.17 Saving Jobs as a Product Standard 

 

Any job can be saved as a product standard from the Save as Product Standard window. 

Where can you find it? 

· The Load Product Standard window can be accessed from the Current/Queue Job, 
Work Orders, and Job Schedule Board windows. 

· Select an existing job or work order from the list on the left-hand side of the window 
· Click on the Save Std button. 
· The Save as Product Standard window appears. 
· To save a job as a new standard, click on the New button. 
· To update an existing standard, click on the Update button. (See the Save As 

Product Standard window on-line help topic for further information.) The Update 
button replaces the existing job standard's parameters with the job parameters from 
the previous window. 

· Once changes are complete, the Save As Product Standard window immediately 
returns you to the previous window. 
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9.18 Setting up your System 

The general operating procedure for setting up your system is: 

· Define your Shop Floor Characteristics - Describe your machines, process 
variables, DCMs, profiles, reason sets and all other relevant information from the 
Shopfloor Configuration program. 

· Schedule Jobs To Run - Schedule jobs from the Monitor program. There are four 
basic steps to scheduling jobs -- creating shift schedules, creating product standards, 
creating work orders, and assigning work orders to machines to run as jobs. 

1. Creating shift schedules is done from the Shift Schedule window. Shift schedules 
are created for a work center. Each work center has multiple schedules -- one for 
each year desired. Each week within a year may have a different work schedule. 

2. Creating product standards is optional. Product Standards facilitate the creation of 
work orders (step three). 

3. Work orders are not optional. You must create work orders to schedule jobs. Work 
Orders can be created from the Job Schedule Board or the Work Orders windows 

4. Assigning work orders to machines to run as jobs through the Job Schedule Board 
window. 

· Monitor the Shop Floor - After machines have been defined, summary, production 
process and material lot tracking information can be monitored using a variety of 
windows within the Monitor program. 

· Print and/or View Reports - Your system offers several types of reports. You can 
decide what reports should be printed automatically at the end of a shift or end of a 
job. You can also select certain reports for immediate printing. 

· Generate Quality Assurance Information (optional) - X-bar and Range graphs are 
available for a machine's process history within the Monitor program. There is also a 
statistical process control package which interfaces with your system for further SPC 
analysis. 

There are a number of optional capabilities available within your system that you may or may 
not have purchased. These options can be added to your system at any time. All of the 
options require not only additional software licensing, but some may require additional 
hardware be purchased. 

 
9.19 Shift Scheduling 

Shift schedules define the start and end times for work shifts, idle times for holidays or 
weekends, and any other events when jobs should not be running or have special needs. 
Shift schedules are not required but they do provide the flexibility to control part of the job 
process. If shift schedules are not created, all jobs run all the time. 

Shift schedules are created for a work center. Each work center has multiple schedules -- 
one for each year desired. Each year schedule may have up to 12 different weekly work 
schedules. There must, therefore, be at least one work center defined before access to 
the Shift Schedule window is possible. The Scheduling privilege is also needed in order 
to access this window. 

The Shift Schedule window is used to create, assign, delete and change work center 
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schedules. If no schedules have been defined, the window appears blank. To create a work 
center schedule, use the NEW button. 

What do you want to know about? 

 Selecting a Work Center Schedule  

 Creating a Work Center Schedule  

 Changing a Work Center Schedule  

 Creating a Weekly Schedule  

 Assigning a Weekly Schedule to an Annual Schedule 

 Deleting a Work Center Schedule  

Selecting a Work Center Schedule  

· Once on the Shift Schedule window, position the cursor on the arrow to the right of the 
WC field. 

· Choose the new work center by sliding the pointer down the selection list to the 
appropriate work center and click. 

· Upon selection, a new list of year schedules assigned to the selected work center 
appears in the Year field. 

· The Calendar and Weekly Schedules list reflects the annual schedule for the visible 
work center and year. 

Every work center schedule has multiple annual schedules. To select a specific year's 
schedule and its work schedule assignments: 

· Once on the Shift Schedule window, position the cursor on the arrow to the right of the 
Year field. 

· Choose the new year by sliding the pointer down the selection list to the appropriate line 
and click. 

· Upon selection, the Calendar and Weekly Schedules List reflects the work schedule 
assignments for the visible work center and year. 

An annual schedule may have up to 12 weekly schedules defined and associated with it. A 
'none' weekly schedule always appears at the top of the Weekly Schedules List. It is used 
for clearing out or 'unassigning' a weekly schedule previously assigned to a yearly schedule. 

Creating a Work Center Schedule  

A work center schedule is created from the Shift Schedule window. A work center schedule 
consists of one or more annual schedules and one or more weekly work schedules. 

· Go to the Shift Schedule window. 
· If there is no work center schedule for the current year, click on the NEW button to 

create a current year work center schedule. Each time the NEW button is selected, it 
checks to see what the latest, existing year schedule for the selected work center is. 
The NEW button increments the year by one each time it is pressed. 

· Move the cursor to the Weekly Schedules List field. If a work center schedule existed 
for a previous year, the Weekly Schedules List contains the previous year's weekly 
schedules. Define any new weekly schedules for the new year or change any existing 
weekly schedules. 
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· Assign weekly schedules to all or some of the week blocks on the Calendar. 

· Click on the Save button when all weekly schedules are assigned to the new year 
schedule. 

· A new work center schedule is created. 

Changing a Work Center Schedule  

Many different types of changes can be made to a work center schedule from the Shift 
Schedule window. Possible changes are: 

· Assign a different weekly schedule to a specific week on the Calendar; 
· Change a start, idle, or end idle time in a weekly schedule; 
· Un-assign a weekly schedule for a specific week on the Calendar; 
· Change the name of a weekly schedule. 

To make a change: 

· Go to the Shift Schedule window. 
· Move the cursor to the WC field. Choose the work center desired. 
· Move the cursor to the Year field. Choose the year schedule desire. 
· The weekly schedules associated with the selected yearly schedule appear in the 

Weekly Schedules List. 
· Make any necessary changes by referring to the appropriate on-line help section listed 

below:  

A. Assign a different weekly schedule to a specific week Calendar week; Refer to the 
Assigning Weekly Schedules For A Year help topic. 

B. Change a start, idle, or end idle time in a weekly schedule; Refer to the 
Creating Weekly Schedules help topic. 

C. Un-assign a work schedule for a specific week block on the Calendar; Refer to 
the Assigning Weekly Schedules To The Calendar Board help topic. 

D. Change the name of a weekly schedule; to change a schedule name, simply 
type over the existing schedule name in the Weekly Schedules List field. 

· Click on the Save button. 
· The work center schedule is updated. 

Creating a Weekly Schedule  

· Go to the Shift Schedule window. 
· Move the cursor to the WC field. Choose the work center desired. 

· Move the cursor to the Year field. Choose the annual schedule desired. Any defined 
weekly schedules for the selected work center and year appear in the Weekly 
Schedules List, located in the upper left corner. 

· Move the cursor to the Weekly Schedules List field. 
· If you want to edit an existing work schedule, click on it. The Work Schedule Chart, 

located below the Schedules list displays running and idle periods for the selected 
weekly schedule. 

· To change a shift time, move the cursor to the appropriate field, click, and type over 
any existing time. 

· If you want to create a new work schedule, click on a row in the Weekly Schedules 
List that is 'unused'. Click again to set the insertion point. Enter a new name over 
the unused title. Use the <DELETE> key to erase any unwanted characters. 

· Move the cursor to the shift name fields. These names default to 1, 2, 3, 4, 5, 6, 
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Idle, and End Idle. You can change the shift names, which can be up to 4 
characters long. 

· Move the cursor to the desired time fields on the Weekly Schedule Chart and click. 
Type in new times. 

· Click on the Save button. 

NOTE: A change made to a weekly schedule affects all weeks using the same 
schedule in that calendar year. 

Assigning a Weekly Schedule to an Annual Schedule  

The Shift Schedule window lets you assign one weekly schedule to each week within 
an annual schedule. An annual schedule can have a mixture of different weekly 
schedules or no weekly schedule. Assignments are done using the Calendar Board 
and a 'drag and drop' method. 

To assign weekly schedules to an annual schedule: 

1. Go to the Shift Schedule window. 
2. Choose a work center with the WC field. 
3. Choose a year with the Year field. 
4. Move the cursor to the Weekly Schedules List field. Click on the desired weekly 

schedule. Holding down the mouse button, drag the rectangle that appears to the 
desired week block on the Calendar. If you want to un-assign' a work schedule from a 
specific week, click on the NONE option in the Weekly Schedules List (always 
located at the top of the Weekly Schedule List). Holding down the mouse button, drag 
the rectangle that appears to the desired week block on the Calendar. 

5. Release the mouse button. The week block color changes to match the color of the 
weekly schedule in the Weekly Schedules List. 

6. Repeat steps 4 and 5 as many times as needed. 
7. Click on the Save button. 

Deleting a Work Center Schedule  

Existing shift schedules may be deleted from the Shift Schedule window. Deleting a yearly 
schedule deletes not only the selected year schedule but all the year's weekly schedules 
as well. 

To delete a work center schedule: 

· Go to the Shift Schedule window. 

· Move the cursor to the WC field. Choose the work center desired. 
· Move the cursor to the Year field. Choose the year schedule targeted for deletion. 
· The weekly schedules associated with the selected year schedule appear. 
· Click on the Delete button. 

· The work center schedule is deleted. 

 
9.20 Shop Floor Configuration 

There are numerous steps to setting up and defining a shop floor. Each step entails providing 
specific information. The information on one element of the shop floor directly relates and is 
associated with a second element. communication processor information, for example, needs 
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boot set information. Machine definitions need communications processor and Data 
Collection Module (DCM) information. Changes to some shop floor definitions force a re-
initialization of a DCM. This, in turn, affects the currently running job. 

The following sections discuss some basic relationships between specific shop floor 
components. These relationships are presented here to facilitate the entering of 
information. 

What do you want to know about? 

 User Defined Labels  

 Reason Sets  
 Work Centers  

 Display Groups  

 Labor Categories  

 Communications 
Processors DCMs  

 Machines  
 Process Variables  

 
9.21 SPC Statistics Concepts 

Standard SPC statistics can be viewed on the Process Trend/SPC and SPC History 
windows. Standard SPC statistics are defined as: 

 X-Bar Upper Control Limit  

 X-Bar Lower Control Limit  

 Range Upper Control Limit 

 Range Lower Control Limit 

 X-Bar Mean  

 Range Mean  

 Upper Specification  

 Lower Specification  

These values can be viewed by pressing the    icon. To close the popup window, 

click on this icon     again. 

What do you want to know about?  

 SPC Graph Area  

 Graph Area  

 Viewing Actual Values on a Graph  

 Viewing Maximum and Minimum Graph Values 

 Size Field  

 Changing The X-Axis  

 Graph Scaling Options  

 Manually Scaling Graphs  

 Autoscaling Graphs  

 Auto Scale Every Cycle  

 Cycle  
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 Cycle Value  

SPC Graph Area 

The window displays a line chart of the SPC values collected for a specific process variable. 
It includes two graphs. The top graph is a plot of X-bar values and the bottom is a plot of the 
associated range values. The X-axis is the time at which the SPC values were recorded. 
The number of values graphed may be a subset of the total collected. 

To view the maximum value for a graph, click anywhere on the far right-hand side of the 
window, outside of the graph borders but within the top and bottom lines of the desired 
graph. To view the minimum value of a graph, click anywhere on the far left-hand side of 
the graph, outside of the graph borders. To view actual values, click in the middle of the 
graph area. 

Graph Area 

The graph area displays a plot of the most recent process variable values. Clicking 
anywhere within the graph area displays a new window with exact x, y coordinate values. 
A vertical line marker also appears -- designating the data point selected. 

To view the maximum value for a graph, click anywhere on the far right-hand side of the 
window, outside of the graph borders but within the top and bottom lines of the desired 
graph. To view the minimum value of a graph, click anywhere on the far left-hand side of 
the graph, outside of the graph borders. To view actual values, click in the middle of the 
graph area. 

Viewing Actual Values on a Graph 

There are two ways to view the exact values of the last 'n' cycles on a graphical window: 

· Click anywhere within the borders of the graph. A vertical line marker appears -- 
designating the data point selected. A new window also appears displaying the 
exact x, y coordinates. The data point selected by the mouse placement is 
highlighted on the new window. 

- Or - 

· Click on the  icon for a table format of a Trend graph. 
· For each machine cycle update, the new value appears in the Cycle 1 Value cell, 

moving older values down sequentially. 

Viewing Maximum and Minimum Graph Values 

To view the maximum value on any graph window: 

· Click anywhere on the far right-hand side of the window, outside of the graph borders 
but within the top and bottom lines of the desired graph. 

To view the minimum value: 

· Click anywhere on the far left-hand side of the window, outside of the graph borders, 
but within the top and bottom lines of the desired graph. 
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Size Field 

Changes the number of plotted values on the graph. 

Changing The X-Axis 

The x-axis may be changed from the Size field. The Size field represents the displayable 
history size for the process history graph or the SPC History size for the X-Bar and Range 
chart. 

To change the x-axis: 

· Click on the Size field. 
· Move the cursor down the selection list to the desired x-axis range. 
· Release the mouse button. 

Graph Scaling Options 

There are three primary scaling options: 

· Manual Scale - This option allows you to manually enter the maximum and minimum 
values for the Y-axis. The Manual Scales window appears when this button is pressed. 

1. Click on the   icon. 
2. Type in the values you wish to change. 
3. To make the changes effective, select the OK button. 
4. To cancel any changes made, select the Cancel button. 

· Auto scale Once - This option automatically scales the graph when the button is 
pressed. The maximum and minimum values for the Y-axis are calculated using the 
selected data, the high limit, and the low limit. Once these values are calculated, they are 
retained until this button is clicked again or another scale option is chosen. 

· Auto scale every machine cycle - Each window update forces a rescale when the 
button is chosen. The graph is always scaled according to the displayed data. The 
maximum and minimum values for the Y-axis are calculated using the selected data, the 
high limit, and the low limit. 

Manually Scaling Graphs 

Allows you to manually enter the maximum and minimum values for the Y-axis. A new 
window appears when this button is pressed. 

Auto Scaling Graphs 
 
Automatically scales the graph when the above button is pressed. The maximum and 
minimum values for the Y-axis are calculated using the selected data, the high limit and the 
low limit. Once these values are calculated, they are retained until this button is clicked again 
or another scale option is chosen. 

Auto Scale Every Cycle 

Forces a rescale when chosen. The graph is always scaled according to the displayed data. 
The maximum and minimum values for the Y-axis are calculated using the selected data, the 
high limit, and the low limit. 
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Cycle 

The actual machine cycle number. 

Cycle Value 

The actual machine cycle value. 

 

9.22 System Architecture 

All of the systems we supply run on your existing Local Area Network. We may employ a 
subnet to optimize performance, or include wireless components for mobility, or we may 
even link multiple plants together in a Wide Area Network. In any of these cases, we employ 
system components that come together as in the following examples of system architecture: 

 

 

9.23 Understanding Machine States 

All monitoring windows display the state of a machine by color. On machine-specific 
windows, the background color of the window represents the machine state. Monitoring 
windows which list multiple machines display the machine state from each machine name's 
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background color. On DCMs, the colored lights represent the machine states. 

A machine's state is determined by a set of exception flags. Each flag indicates one possible 
exception condition. The following table lists each machine state and its associated color. The 
highest priority state determines the color displayed. The states are listed below in order of 
priority, with the highest of importance listed first. 

 

A machine can be in one or more states at a time. It can have a process or production 
exception and be in the assist state. Process and production exception states can also co-
exist on the same machine at the same time. The following list provides a general overview of 
machine states and their relationships to each other. 

· The off-line state is mutually exclusive from all other machine states. 
· If a machine is idle, all other states, except off-line, are excluded. 
· If a machine is down, it can still be in assist or have a process and/or production 

exception. 

· A machine can be fast, slow, standard, or down. 

Other combinations not specifically mentioned above are possible. 

There are many ways that machines can enter or exit a certain state. Selection of an assist 
reason by an operator at a DCM triggers the respective state for the selected machine. 
Process exceptions occur when a process variable measurement is outside of an assigned 
limit, either high or low. A machine can go in or out of a process exception state with each 
new cycle value. 

Production exceptions occur when a machine's pieces to go is negative (too many pieces 
have been made) or when its job-to-date percent rejects is greater than its reject threshold 
for the current job. Once these two relationships are no longer true, a machine exits the 
production exception state. 

There are two ways a machine can enter an idle state. A machine becomes idle if it is 
following a shift schedule that has an idle period defined. For the duration of the idle period, 
the machine is classified as idle. The second way a machine can become idle is by 
suspending its job. To suspend a job, set the job parameters Schedule Now and Schedule 
Factory both to No. The idle state stays in effect until these job parameters are changed. 

The down state is entered when the average cycle time exceeds the down threshold. The 
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down state ends when the average cycle time is once again less than the down threshold. 
The down state can also be entered if the operator selects a down reason which is 
configured to force a machine down. 

The fast, slow, and standard machine states are basic indicators of machine performance. 
For each machine cycle, the cycle tolerance is monitored. The tolerance is the percent 
deviation of a job from its normal standard cycle time. An average cycle is computed and a 
comparison is made using the cycle tolerance and standard cycle values. If the average 
cycle is greater than the resultant value, the machine is considered to be running slow. If the 
average cycle is less than the resultant value, the machine is considered fast. 

Moving Average Cycle 

The moving average cycle is compared to the standard cycle to determine the fast state/slow 
state of a machine. 

The machine is slow if: 

(Average Cycle) > (Standard Cycle) + ((Cycle Tolerance) * (Standard Cycle) /1 00) 

The machine is fast if: 

(Average Cycle) < (Standard Cycle) - ((Cycle Tolerance) * (Standard Cycle) /1 00) 

The "Your System" Icon 

When your system is iconized, the           icon displays on the bottom of the workstation 
monitor. The top three circles signal exception states for any machine listed on an open 
window. For example, if you open the Machine Performance window and then iconize your 
system, the icon blinks if one of the machines displayed on the window goes into exception. 
Exceptions displayed from the icon are down, assist, production exception, and process 
exception. 
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9.24 User Preferences 

 

The User Preference window enables you to customize the PlantStar environment in 
terms of: 

· Font Size -- Changing Text Sizes sets the font size for all PlantStar 
windows.·  

· Job Primary Label -- The label to use for all jobs displayed on the Job Schedule 
Board window can be selected. The job label field lists all jobs on the Gantt chart 
by job name. The product label shows all jobs by product name. 

· Default When Moving a Job - You can select what will happen by default when 
moving work orders or jobs from one machine to another on the Job Schedule 
window. 

· Screen Load Behavior - This option enables the quick loading of screens. When 
the quick load option is enabled, a screen is loaded without retrieving the data 
for the selection criteria. Data is loaded after the window is opened and selection 
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is made. 
· Search Criteria - The search method used on the Job Schedule Board window 

can be selected. There are three search methods: left, embedded, and exact. Left 
matching searches for records that start with a specified text. Embedded 
matching finds all occurrences of a text wherever it is located. Exact matching 
finds exact matches only. (Specific examples are provided under each method's 
field help topics.) 

· Show labor hours displays the total number of man hours required for each shift. 
· Language - This allows the users to select their language preference. 

These preferences are saved from session to session and will not change until the next 
modification.  

Where can you find it? 

· Choose the File menu on the Monitor window. 
· Choose the User Preference option. 

What do you want to know about? 

 Changing Preferences 

 Saving Your Changes 

 Undoing Your Changes 
 Closing the Window 

 
9.25 Using PlantStar Help 

 
9.25.1 About PlantStar 

For up-to-date resource information, the application provides a window with the following 
information: 

· PlantStar Software Version 
· PlantStar Copyright Date 
· Microsoft Windows Version 
· Amount of free memory 

To see this information: 

· Select the Help menu on the main menu. 
· Choose the About PlantStar menu item. 

 
9.25.2 Help Active Window 

Window level help provides information on the display that currently has focus. 
Information for each window includes: 

· purpose of the window 
· specific field descriptions 
· window button explanations 

This type of help is available by selecting and opening a desired window. Once opened, 
select the Help-Active Window menu on the application window or press the F1 key. 
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NOTE: If there are currently no PlantStar windows open, this menu item will not display any 
help. 

9.25.3 Help Contents 

General content help provides a table of contents for virtually all topics within this 
application. The Contents window can be used to jump to topics that explain various 
windows or how to get quick access to key reference topics. This help is available by 
selecting the Contents on the Help menu item. 
Use the scroll bar to the right side of the Help window to view the next page of the Table of 
Contents. 

9.25.4 Help Index 

The Index list is directly accessible from the Index on the Help menu item or from the Index 
tab within the on-line help utility. Index terms consist of: 

· definitions 
· formulas, if applicable 
· recommended values, if applicable. 

To access an item from the Index list: 

· Use the scroll bar on the right hand side to scroll the window to the desired item. 
· Point to the term or phase desired. 
· Double-click on the highlighted word to open. 

-Or- 

· Use the keyword field to search for the desired item. 
· Once found, double-click on the highlighted word to open. 

9.25.5 Help Search 

Another method to find a particular topic in Help is to use the Search option. To display the 
Search window, either choose Search from the Help menu on the application window or 
click the Search tab on the Help topic screen. 

Select a topic by: 
· Use the keyword field to search for the desired item. 
· Click on the List Topics button to search on the keyword entered 
· A list of related topics then appears on the screen. 
· Once found, double-click on the highlighted topic to open. 
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10 Functions 
10.1 Activating an attention announcement 

The Play Attention field on the Attention Announcement window determines whether an 
attention message is played before any other exception message. 

To activate an attention message: 

· Click on the box to the left of the Play Attention field. 
· An "x" appears. This "x" signifies that an attention message will be broadcast 

before any other message is played. 
· To cancel the playing of the attention message, click on the box to the left of the Play 

Attention field until the "x" disappears (usually once). 

· Click on the Update button. 

10.2 Adding a DCM 

· Click on the New button. 

· Type in the new DCM name. 
· After entering your information, click on the Update button to temporarily store your 

changes and to allow other windows access to the new DCM. 
· To send the new DCM definitions to the shop floor, select the Save Session command 

under the File menu. 

A window's Delete button deletes information from PlantStar's database. Depending upon the 
window, a reason set, boot set, work center, display group, communications processor, 
machine or DCM will be deleted. 

10.3 Adding a labor category 

· Click on the Labor Categories tab located at the top of the window. 

· Scroll the list until you find an empty record. Up to 30 labor categories can be added. 

· Type in the new labor category name. 

10.4 Adding an employee 

· Click on the Employees tab located at the top of the window. 
· Click on the New button. 

· Type in the new employee name. 

10.5 Adding an employee to labor history 

If an employee is not logged in during the shift they work, they may need to be added to the 
labor history at a later time. To add an employee record to history, click the Add button at 
the bottom of the screen. Once clicked, you will be presented a login dialog. 
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From this dialog you would enter a valid employee id. Employees are defined in the Labor 
Setup  window, which is in the Shop Floor Configuration program. If the employee id is 
invalid, you will be presented with a pop up message "Invalid Employee". Once a valid 
employee id is entered, you will be prompted for a labor category you wish to log into. 
 

 

From this dialog you can select a labor category from the drop down list. The drop down list 
consists only of the categories that have been assigned to the employee id entered. 
Employee-Labor Category definitions are defined in the Shop Floor Configuration program. 
Once a labor category has been selected, the login record will be added to the shifts labor 
history. 

NOTE: Labor history records cannot be added to the current shift. Employees can be 
added to the current shift by logging in at the DCM or from the Labor Status window. 

10.6 Adding child jobs 

Up to 12 child jobs can be assigned to either a work order or a product standard. 

To assign a child job to an existing product standard, 

· Select the "Add Child" button at the bottom of the screen. 
· This will add a child job to the product standard using the parent information as a base. 

To assign a child job to an existing work order: 

· Use the mouse and right click over the work order list or the child parameter grid. 

· Select "Add Child" from the pop up menu. 
- or - 

· Use the mouse and select "Edit" from the main PlantStar window. 
· Select "Add Child" from the menu. 

NOTE: Child Jobs cannot be added or removed from current jobs or queued jobs. In other 
words, the number of child jobs assigned to a job cannot be changed once the job has been 
scheduled. 

10.7 Adding machines to a display group 



222 SYSCON-PlantStar Help System 

 

 

The Add button enables you to include new machines into an existing display group. 

· Select a machine from the Available Machines list by clicking on the desired machine in 
the list. 

· To select several machines next to each other, keep the mouse button pressed down 
and move the mouse up or down. Then let go. 

· To select several machines that are not next to each other in the list, press the 
CTRL button, in combination with the mouse button, over each desired machine. 

· Click on the Add button. 
· Click on the Update button. 
· Select the Save Session command under the File menu. 

10.8 Adding machines to an REU list 

The Add button enables you to include new machines and make them accessible from an 
REU. 

· Select a machine from the Available Machines list by clicking on it. To select several 
machines next to each other, keep the mouse button pressed down and move the 
mouse up or down. Then let go. To select several machines that are not next to each 
other in the list, press the CTRL button, in combination with the mouse button, over 
each desired machine. 

· Click on the Add button. 
· Click on the Update button. 
· Click on the Save Session button under the File menu to transfer the new machines 

for the REU to the shop floor. 

10.9 Adding users 

The New button on the User Accounts window clears the window and enables you to type 
in a new user's information. To add a user: 

· Go to the User Accounts window 
· Click on the New button. Type in the new user name. The name may contain 

letters and/or numbers and be up to 20 characters in length. 
· Set up the user's password by clicking on the Password button. 

· Set the user privileges by clicking on the appropriate check boxes next to each privilege. 
· Click on the Save button to add the new user to the system. 
· If a user already exists with that name, a warning message will be displayed. Type in a 

different user name and select the Save button again. 

· To permanently save the new user, click on the Save Session command under the File 
menu. 



Functions 223 

 

 

10.10 Adding/editing multiple materials 

 

If you have the multiple materials feature, a pop up window appears when clicking the 
material button on the job editor screen. 

To add one material, enter the name in the material field. To add multiple materials: 
· Enter the material formula in the material field. 
· Click or tab out of the material field. Another window appears. 
· Enter the name of a material component. Up to four components can be entered. 
· Enter a component percent for each material listed. 

· Click or tab out of the component fields to close the window. 

10.11 Adjusting gross or net pieces 

Incorrect piece counts can be adjusted. Adjustments can be made upward or 
downward. To adjust gross pieces or net pieces: 

· Move the cursor and select the reject cell to update 
· Type in the adjustment value. 

10.12 Adjusting reject counts 

Incorrect reject counts can be adjusted. Adjustments can be made upward or 
downward. To adjust reject counts: 

· Move the cursor and select the reject cell to update 
· Type in the new reject value. 

10.13 Adjusting start/end date 

· Move the cursor and select the cell to update 

· Type in the new date value. Format is Day/Month/Year (dd/mm/yy). 

10.14 Adjusting start/end time 

· Move the cursor and select the cell to update 

· Type in the new time value. Format is Hours: Minutes (hh:mm). 

10.15 Adjusting times 

Incorrect time values can be adjusted. Adjustments can be made upward or downward 
for each defined reason. 

To adjust times: 

· Move the cursor and select the cell to update 
· Type in the new time. Format is Minutes:Seconds (mm:ss). 
· If you wish to subtract time you can press the plus button on the screen. 

· To change to positive values click the minus button on the screen. 
· Using the plus and minus keys on the keyboard functions in the same manner. 
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10.16 Anchoring selected job 

Anchoring job in the Job Schedule Board allows you to move the selected job anywhere 
within its position of the job queue. This gives you the ability to schedule the job at a more 
precise date and time than the other job scheduling methods. 

First, you must first choose one of the two scheduling methods: 

· Schedule jobs by earliest start date (default) 

· Schedule jobs by due date  

The default method on the Job Schedule window is the first method; which will schedule the 
next job to run immediately following the completion of previously-queued jobs. 

To anchor a selected job: 
· Choose one of the two scheduling methods desribed above. This determines the 

anchor point of the selected job. 

· Click on the Anchor button.          This will display an anchor icon on the selected bar. 
· If the job schedule by earliest start date is selected, the icon will appear on the left 

side of the selected job. If the job schedule by due date is selected, the icon will 
appear on the right side of the selected job. 

· Once anchored, you can move the selected job anywhere within its position of the job 
queue. This allows you to specify the exact time a job will run. 

· Click on the Commit    button. 

NOTE: If the job is anchored at its earliest start date, the anchor on the bar will appear red 
in color. If scheduled at any other time, the bar anchor will appear blue. 

10.17 Assigning a report file name 

· Move the cursor down the report list to the desired choice 

· Type in the directory name and file name of the file you wish to export the report. 

10.18 Assigning an employee to a labor category 

Labor cateogories are user-definable categories which one or more can be assigned to an 
employee. When an employee attempts to login, they are presented with a list which consist 
only of the labor categories to which they have been assigned. Employee-Labor Category 
definitions are also defined in the Labor Setup window. 

To assign an employee to a labor category: 
· Select the employee record to update. 

· Select the column that corresponds to the labor category you wish to assign. 
· Using the mouse or cursor, check the check box in the labor category column. 

10.19 Assigning child jobs 

To assign child jobs, there must be existing unassigned child jobs to assign to a child job. 
Unassigned child jobs would appear in the "Available Child Jobs" list, which is directly under 
the work order list. 

To assign a child job to an existing child job: 

· Use the mouse and right click over the work order list or the child parameter grid. 
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· Select "Load Child" from the pop up menu. You will be presented with a list of available 
child jobs. 

· From this screen, you can search or scroll through the list of child jobs. 
· Once a child has been selected, click the "OK" to load the child job onto the child job 

selected. 
· Alternatively, you can use the default product standard by clicking the "Default" button 

and selecting  "OK". 

NOTE: You can only assign child jobs to existing child jobs. See Adding Child Jobs for further 
details. 

10.20 Assigning weekly schedules 

The Shift Schedule window lets you assign one weekly schedule to each week within 
an annual schedule. An annual schedule can have a mixture of different weekly 
schedules or no weekly schedule. Assignments are done using the Calendar Board 
and a 'drag and drop' method. 

To assign weekly schedules to an annual schedule: 

1. Choose a work center with the Work Center field. 

2. Choose a year with the Year field. 
3. Move the cursor to the Weekly Schedules List field. Click on the desired weekly 

schedule. Holding down the mouse button, drag the rectangle that appears to the 
desired week block on the Calendar. If you want to 'unassign' a work schedule from a 
specific week, click on the None option in the Weekly Schedules List (always located 
at the top of the Weekly Schedule list). Holding down the mouse button, drag the 
rectangle that appears to the desired week block on the Calendar. 

4. Release the mouse button. The week block color changes to match the color of 
the weekly schedule in the Weekly Schedules List. 

5. Repeat steps 4 and 5 as many times as needed. 
6. Click on the Save button. 

10.21 Changing a comm processor's name 

· Type over the existing Comm Processor's name. 

· Click on the Update button. 
· Select the Save Session command under the File menu to immediately transfer any 

changes to the shop floor. 

10.22 Changing a machine's name 

· Type over the existing machine name. 
· Click on the Update button. 

· To send your changes to the shop floor, select the Save Session command under the 
File menu. 

10.23 Changing a report 

There may be times when a scheduled report needs to be changed. Shift changes, period 
changes, day of the week and even the type of report can be changed. To make changes: 

· Move the cursor down the report list to the desired choice 
· Click on the arrow to the right of the report field. 
· Choose the report you want by sliding the pointer down the selection list to the 
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appropriate line 

10.24 Changing an existing work center's name 

To change a work center's name 

· Type over the existing work center name. 
· Click on the Update button. 
· Select the Save Session command under the File menu. 

10.25 Changing child jobs 

To change the Child Job that you are viewing: 

· Position the mouse pointer over the arrow to the right of the Child Job field and click. 
· Choose the new Child Job you want by sliding the pointer down the selection list to 

the appropriate line. Click again. 

10.26 Changing com port settings 
 

 

The com ports tab allows the user to set the serial port communications. 

To change the Com Ports settings, click on the Com Ports tab located in the middle of the 
screen. 

These are used to pass messages to and from printers, barcode scanners, and machine 
specific PLCs. In order to use these devices the correct communication protocols for the 
device need to be specified here. 

10.27 Changing contact input settings 
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The Contact Inputs tab allows the user to set up simulated contact inputs. 
To change the Contact Inputs settings, click on the Contact Inputs tab located in the 
middle of the screen. 

This is useful for diagnostic purposes. The first input is always Cycle Time. The open and 
close ticks are defined as being 10 milliseconds per tick, so to have the contact open for 5 
seconds the setting should be 500. In order for the DCM to operate correctly these must be 
reset to zero when testing is completed. 

10.28 Changing display groups 

To change the display group that you are viewing: 

· Position the mouse pointer over the arrow to the right of the Display Group field and 
click. 

· Choose the new display group you want by sliding the pointer down the 
selection list to the appropriate line. Click again. 

10.29 Changing down, assist and reject data 

This privilege gives users the ability to update historical down, assist, reject, gross or 
net pieces information. These updates are done via three windows within the Monitor 
program: 

· Down Time Editor 

· Assist Time Editor  
· Parts Count Editor 
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10.30 Changing end date 

· Move the cursor to the end date field 
· Type in the date value. Format is Day/Month/Year (dd/mm/yy). 

10.31 Changing forecast start date 

The start date displayed is the date Labor Forecasting will start calculating manning 
factors for the scheduled jobs. To change the start date: 

· Move the cursor to the start date field 

· Type in the date value. Format is Day/Month/Year (dd/mm/yy). 

- or - 

· Position the mouse pointer over the arrow to the right of the Start Date field. A pop up 
calendar will display the current date selected. 

· Choose a start date by navigating the calendar to the selected date. To select the 
current date, select the "Today" button at the bottom of the pop up calendar. 

NOTE: Dates prior to the current date cannot be selected. Labor Forecast was designed to 
forecast man-hour needs for jobs currently running and scheduled to run in the future. 

10.32 Changing forecast views 

There are two different views to Labor Forecasting: 

· Grid View - The Grid View displays a table of labor manning factors for a specific 
shift and labor category. 

· Graph View - The Graph View displays an ordered histogram of the manning factors for 
a labor category. There is one vertical bar per shift. Bar height represents the man 
hour needs for the given shift. Bars are displayed from left to right in order of shift 
occurrence. 

To select one of the views, select from the Grid View or Graph View tabs, at the top of the 
screen. 
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10.33 Changing general DCM settings 
 

 

The general tab allows the user to set the appropriate physical settings for the DCM. 

To change the General settings: 

· Click on the General tab located in the middle of the screen. 

These include Base Model type, Display Type, Memory, Job History Size, etc. If a setting is 
grayed out the option is currently unavailable either because of setup limitations or the option 
has not been authorized. The memory required field is used as a guide line to let the user 
know approximatley how much memory the current setup will require. These figures are 
estimates only, and problems may occur if the memory required is greater then the memory 
installed on the DCM. This is only an issue with older DCMs such as the CPU5 and the CPU7 
where memory is very limited. 

10.34 Changing graph types 

To change the type of graph you are viewing: 

· Position the mouse pointer over the Graph field. 
· Choose the new graph type, by sliding the pointer down the selection list to the 

appropriate line. 

10.35 Changing jobs 

To change the Job that you are viewing: 

· Position the mouse pointer over the arrow to the right of the Job field and click. 
· Choose the new Job you want by sliding the pointer down the selection list to the 

appropriate line. Click again. 

10.36 Changing labor categories 

· Move the cursor and select the labor category cell to update 
· Position the mouse pointer over the arrow to the right of the labor category field and 

click. 
· Choose the new labor category you want by sliding the pointer down the 

selection list to the appropriate line. 
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NOTE: The Labor Forecast screen allows the selection of "All" labor categories. To view 
All labor categories, select the item "All", which is the first item in the labor category list. 

10.37 Changing machines 

To change the machine that you are viewing: 

· Position the mouse pointer over the arrow to the right of the Machine field and click. 
· Choose the new machine you want by sliding the pointer down the selection list to 

the appropriate line. 

10.38 Changing material components 

To change the material components that you are viewing: 

· Position the mouse pointer over the arrow to the right of the material name field and 
click. 

· Choose the new material components you want by sliding the pointer down the 
selection list to the appropriate line. Click again. 

10.39 Changing number of plotted values 

The combo box indicates the number of plotted values on the graph: 

To change the number of plotted values that you are viewing: 

· Position the mouse pointer over the arrow to the right of the field and click. 
· Choose the new number you want by sliding the pointer down the selection list to 

the appropriate line. 

10.40 Changing number of reasons displayed 

The combo box indicates the number of reasons displayed in the Pareto chart. 

To change the number of reasons that you are viewing: 

· Position the mouse pointer over the arrow to the right of the field and click. 
· Choose the new number you want by sliding the pointer down the selection list to 

the appropriate line. 

10.41 Changing number of shifts 

The number of shift records PlantStar should attempt to retrieve for the given selection 
criteria. 

To change the number of shifts to display: 

· Position the cursor in the "Num of Shifts" field. 
· Enter the number of shifts to display. 

NOTE: If the shift count exceeds the number of actual shift records, PlantStar will only return 
the actual shift records found. 

NOTE: The Labor Forecasting window allows entries of 1-100. Job Summary window allows 
entries of 1-350 

10.42 Changing passwords 

To change your password: 
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· Choose the User menu on the main Shop Floor Configuration window. 

· Choose the User Accounts window. 
· Click on the Password button on the User Account window. 
· A new window appears with 2 fields: a password field and a verification field. 

· Type in your new password and its verification. 
· Click on the OK button. 
· Click on the Save button on the User Account window. 

· To permanently save all user changes, click on the Save Session command under the 
File menu. 

10.43 Changing preferences 

· Select a font size -- tiny, small, medium or large. 
· Select a Job Schedule Board window label. 
· Select the default job movement method for the Job Schedule window. 

· Select screen load behavior. 
· Select the search method to be used on the Job Schedule Board window for work 

orders and on the Job Schedule Search window. 

· Select the language preference. 

10.44 Changing process graph modes 

The graph mode button plots a graph of the n most recent values of a variable on a machine. 

· To change the graph mode, click the            graph mode button 

10.45 Changing process variables name 

You can change a process variable or profile name at any time. 
· Select the process variable or profile desired from the variable index field. Click on the 

arrow to the right of this field. Move your cursor down the list to the appropriate variable 
and click again. 

· Type in a new name for the variable in the variable name field. (Directly type over 
the existing name.) 

· Click on the Update button. 
· Select the Save Session button under the File menu to transfer this information to the 

shop floor. 

10.46 Changing profile graph modes 

Profiles can be viewed by themselves, overlaid on top of other profiles, or crossplotted 
with other profiles. If more than one profile is selected, the default viewing mode is to 
overlay the profiles. 

To overlay two or more profiles: 

1. Select the desired profiles by clicking on the colored box to the left of each profile. An 'x' 
appears in the box. As each profile is selected, its line graph is drawn on top of the 
previously selected profile. To de-select a profile, click on the colored box to the left of 
the profile name again. The 'x' disappears. 

2. Or if you have the CROSSPLOT mode turned on, then click on the         button to 
display all selected profiles in overlay mode. 

To crossplot two or more profiles: 
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1. Select the desired profiles by clicking on the colored box to the left of each profile. An 'x' 
appears in the box. As each profile is selected, its line graph is drawn on top of the 
previously selected profile. To de-select a profile, click on the colored box to the left of 
the profile name again. The 'x' disappears. 

2. Click on the        button to crossplot the profiles. 

10.47 Changing profile variables name 

You can change a process variable or profile name at any time. 

· Select the process variable or profile desired from the variable index field. Click on the 
arrow to the right of this field. Move your cursor down the list to the appropriate variable 
and click again. 

· Type in a new name for the variable in the variable name field. (Directly type over 
the existing name.) 

· Click on the Update button. 
· Select the Save Session button under the File menu to transfer this information to the 

shop floor. 

10.48 Changing rescaling options 

There are three primary scaling options: 

1. Manual Scale - This option allows you to manually enter the maximum and minimum 
values for the Y-axis. The Manual Scales window appears when this button is pressed. 

· Click on the  icon. 
· Type in the values you wish to change. 
· To make the changes effective, select the OK button. 
· To cancel any changes made, select the Cancel button. 
2. Auto scale Once - This option automatically scales the graph when the             button is 

pressed. 
The maximum and minimum values for the Y-axis are calculated using the selected 
data, the higher limit, and the lower limit. Once these values are calculated, they are 
retained until this button is clicked again or another scale option is chosen. 

3. Auto scale every machine cycle - Each window update forces a rescale when the       button 
is chosen. The graph is always scaled according to the displayed data. The maximum and 
minimum values for the Y-axis are calculated using the selected data, the higher limit, and 
the lower limit. 



Functions 233 

 

 

10.49 Changing RIO settings 
 

 

The RIO tab is only available after an RIO has been defined in the com ports tab. 

To change the RIO settings: 

· Click on the RIO tab located in the middle of the screen. 

This tab allows the configuration of the Remote I/O unit. In order for a machine to be able to 
collect data from the RIO the check box next to the machine number must be selected. Once 
selected, the machine will retrieve all process variables and profile data including cycle time 
from the RIO unit. The other boxes allow the user to specify whether 1 RIO is connected to all 
machines or each machine has its own RIO, if the analog card in the RIO is isolated, or 
whether the shuttle type boot set should be downloaded to the RIO. 

10.50 Changing shifts 

To change the shifts that you are viewing: 

· Position the mouse pointer over the arrow to the right of the shifts field and click. 

· Choose the new shifts you want by sliding the pointer down the selection list to the 
appropriate line. 

NOTE: If the All shifts menu option is available, selecting the item "All", will update the 
display with all available shifts. 

10.51 Changing start date 

· Move the cursor to the start date field 
· Type in the date value. Format is Day/Month/Year (dd/mm/yy). 

10.52 Changing the x-axis 

The X-axis may be changed from the Size field. The Size field represents the displayable 
history size for the process history graph or the SPC History size for the X-Bar and Range 
chart. 
 
To change the X-axis: 
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· Click on the Size field. 

· Move the cursor down the selection list to the desired x-axis range. 
· Release the mouse button. 

10.53 Changing tools 

To change the tool: 

· Position the mouse pointer over the arrow to the left of the Tool field. 

· Click and slide the pointer down the selection list to the appropriate line. 

10.54 Changing user-defined labels 

To change user-defined field label 

· Select the field title to change from the parameter name field. 

· Type in the new label for the field in the current name field. 

10.55 Changing work centers 

To change the work center that you are viewing: 

· Position the mouse pointer over the arrow to the right of the work center field and click. 
· Choose the new work center you want by sliding the pointer down the selection list to 

the appropriate line. 

10.56 Clearing machines 

The Clear All button clears the existing machine selection. 

10.57 Clearing process history information 

The Clear button deletes all current process history information for the displayed job and 
machine. This button is enabled for both the graph and table modes. In order to use it, the 
Change SPC and PVAR History Data privilege on the User Accounts window must be 
granted. 

10.58 Clearing search fields 

The Clear All button blanks out all searching key fields and any material components found. 

10.59 Clipping the graph 

The Process Trend/SPC and Profile windows feature a 'clip' option for the graph. Clipping 
redraws the graph, displaying only the positive or zero values. The clipping feature stays into 
effect until canceled. 

To clip the graph: 

1.  Click on the  button. 
2.  Once selected, this button appears 'depressed' into the background of the window. 
3. To cancel this feature, click on the icon again. It should appear not selected. 

10.60 Closing the window-Close 

To close the current window, choose one of the following methods: 

· Select the Close button. 
- or - 
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· Click your mouse button while it is positioned over the 'x' in the upper right hand 
corner of the window. 

10.61 Closing the window-OK-Cancel 

To close the current window, choose one of the following methods: 

· Select the OK button at the bottom of the window. 
- or - 

· Select the Cancel button at the bottom of the window. 
- or - 
· Click your mouse button while it is positioned over the 'x' in the upper right hand corner 

of the window. 

NOTE: If the Cancel button is selected, all changes will be disregarded and you will not be 
prompted to save your changes. 

After saving, any necessary adjustments will be sent to the DCM and other PlantStar clients. 

10.62 Coldstart a DCM 

Many changes made to the DCM setup require a restart of the DCM for the changes to take 
effect. If this check box is grayed out, it means that when you save your changes from the 
Save Session command under the file menu, the DCM will reboot and your changes will be 
implemented. You may also wish to manually check this box to force the DCM to coldstart. 

10.63 Committing a schedule 

The Commit button    on the Job Schedule Board window sends the schedule to the shop 
floor. 
Click on this button to transfer job queues to a DCM. 

10.64 Copying a product standard 

An existing product standard can be copied and then edited to create a new standard. 

· Select a standard to copy. 
· Click on the New button. The screen will still display the previous standards information. 

· Make any necessary changes. 
· Click on the Apply button. A new product standard has been created using the previous 

standard as a template. 
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10.65 Copying an announcement 

Announcements or voice files can be copied from: 

· one assist reason set to another 
· one down reason set to another 
· one assist reason to another 
· one down reason to another 
· one process variable to another 
· one machine's process variables to another 

To copy: 

· Select the Process Announcement, Assist Announcement or the Down Announcement 
window from the Configure menu. 

· Select the process variable, assist reason, or down reason, which is to be the 
destination for the copy. 

· Click on the Copy command button. The Select File To Copy window appears. 
· Select the down set, assist set, or machine from which to copy. 

· Click on the down reason, assist reason or process variable to copy. 
· Click on the OK button. The voice file associated with the item from the previous step 

is copied to the originally-selected reason or process variable. 

10.66 Creating a comm processor 

The New button allows the user to add a new communications processor: 

· Click on the New button. 
· Type in the new Communications Processor's name. 
· After entering your information, click on the Update button to temporarily store your 

changes. 

· Select the Save Session command under the File menu to transfer the new 
changes to the shop floor. 

10.67 Creating display groups 

The New button enables you to define a new display group. 

· Click on the New button. 
· Select a work center from the work center field. A list of available machines appears in 

the Available Machines field. 

· Type in the new display group's name and any comments you may have. 
· Select the desired machines from the Available Machines list for inclusion in the 

group. Highlight a machine or group of machines. 
· Click on the Add Button. 

· Click on the Update button. 
· Select the Save Session command from the File menu. 
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10.68 Creating machines 

The New button allows the user to add a new machine: 

· Click on the New button. 
· Type in the new machine's name. 
· After entering your information, click on the Update button to temporarily store your 

changes. Other windows, such as the Display Group window, will now have access to 
the new machine. 

· Select the Save Session command under the File menu to transfer the new 
machine to the shop floor. 

10.69 Creating new standards 

To create a new standard based upon the job or work order on the previous window, click 
on the New button. 

Once the update is complete, the Save As Product Standard window immediately returns 
you to the previous window. 

10.70 Creating process variables 

For each machine, PlantStar lets you define 0, 20, or up to 50 process variables 
depending on the options purchased. 

To create a new process variable: 

· Choose the Shop Floor menu on the main Shop Floor Configuration window. 
· Choose the Machine Setup option. 
· Select a machine on the window. 

· Click on the process option button, located on the left hand side of the window. A 
list of defined process variables displays. 

· Click on the arrow to the right of the variable index field. Select a process variable 
index that has an empty process variable name field. If none are empty, you cannot 
add a new process variable. 

· If one is empty, type in your new name for the process variable in the variable name 
field. Select a source type and complete all source type information. 

· Click on the Update button to save your information. 
· Select the Save Session command under the File menu to send the process 

variable to the shop floor. 

10.71 Creating product standards 

· Click on the New button. 
· Select a machine from the machine field. 
· Move the cursor to the Value column for each desired parameter. Directly type in 

parameter values. If default information is displayed, edit it as desired by typing over it. 

10.72 Creating profile variables 

PlantStar lets you define up to 4 profile variables if the profile option has been 
purchased. To create a new profile: 

· Choose the Shop Floor menu on the main Shop Floor Configuration window. 
· Choose the Machine Setup option. 
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· Select a machine on the window. 
· Click on the Edit profile option button, located on the left hand side of the window. A 

list of defined profiles displays. 
· Move the cursor to the variable index field. Click on the arrow to the right of the field 

and slide your cursor down the list. Select a variable index that has an empty variable 
name field. If none are empty, you cannot add a new profile variable. 

· If one is empty, type in your new name for the profile and then fill out any other relevant 
information. 

· Click on the Update button to save your information and then on the Save Session 
command under the File menu. 

10.73 Creating reason sets 

The New button allows the user to add a new reason set or boot set: 

· Click on the New button. 

· Type in the new set's name and any comments you may have. 
· Enter the list of reason names for the reason set by clicking on a row in the reason 

table. Type over the text in the Reason List if you want to change the default names 
displayed. 

· If editing boot sets, click on the boot file column to select or de-select a boot file. 

· After entering your information, click on the Update button to temporarily store your 
changes. 

· Click on the Save Session button under the File menu to immediately download your 
changes to the shop floor. 

10.74 Creating REUs 

The New button enables you to define a new REU. As of version 4.10 this feature is 
no longer supported. 

· Click on the New button. 
· Type in the new REU's name, its address, communications processor, boot set, and 

location. 
· Highlight the machines which are accessible on the REU from the Available Machines 

list. To select several machines next to each other, keep the mouse button pressed 
down and move the mouse up or down. Then let go. To select several machines that 
are not next to each other in the list, press the CTRL button, in combination with the 
mouse button, over each desired machine. 

· Click on the Add Button. 

· Enable the REU, if desired. 
· Click on the Update button. 
· Click on the Save Session command under the File menu to transfer REU 

information to the shop floor. 

10.75 Creating unassigned child jobs 

Unassigned child jobs can be created to be added to work orders at a later time. 

To create an unassigned child job: 

· Select a work order from the work order list. 
· Use the mouse and right click over the job selected in the work order list. A pop up 

menu will appear directly over were you clicked the mouse. 
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· Select "New Child" from the pop up menu. This will create an unassigned child job 
based off of the work order selected. 

10.76 Creating weekly schedules 

An annual schedule may have up to 12 weekly shift schedules defined and associated with it. 
A 'none' weekly schedule always appears at the top of the Weekly Schedules List. It is used 
for clearing out or 'un-assigning' a weekly schedule previously assigned to a yearly schedule. 

To create a weekly schedule: 

· Go to the Shift Schedule window. 
· Move the cursor to the Work Center field. Choose the work center desired. 
· Move the cursor to the Year field. Choose the annual schedule desired. Any defined 

weekly schedules for the selected work center and year appear in the Weekly 
Schedules list, located in the upper left corner. 

· Move the cursor to the Weekly Schedules list. 
· If you want to edit an existing work schedule, click on it. The Work Schedule Chart 

located below the Schedules list displays running and idle periods for the selected 
weekly schedule. 

· To change a shift time, move the cursor to the appropriate field, click, and type over 
any existing time. 

· If you want to create a new work schedule, click on a row in the Weekly Schedules 
list that is 'unused'. Click again to set the insertion point. Enter a new name over the 
unused title. Use the DELETE key to erase any unwanted characters. 

· Move the cursor to the shift name fields. These names default to 1,2,3,4,5,6, Idle, 
and End Idle. You can change the shift names, which can be up to 4 characters 
long. 

· Move the cursor to the desired time fields on the Weekly Schedule Chart and click. 
Type in new times. 

· Click on the Save button. 

10.77 Creating work center schedules 

Work center schedules are created from the Shift Schedule window. A work center schedule 
consists of one or more annual schedules and one or more weekly work schedules. 

· Go to the Shift Schedule window. 

· If there is no work center schedule for the current year, click on the New button to 
create a current year work center schedule. Each time the New button is selected, it 
checks to see what the latest, existing year schedule for the selected work center is. 
The New button increments the year by one each time it is pressed. 

· Move the cursor to the Weekly Schedules List field. If a work center schedule existed 
for a previous year, the Weekly Schedules list contains the previous year's weekly 
schedules. Define any new weekly schedules for the new year or change any existing 
weekly schedules. 

· Assign weekly schedules to all or some of the week blocks on the Calendar. 
· Click on the Save button when all weekly schedules are assigned to the new year 

schedule. 

· A new work center schedule is created. 

10.78 Creating work centers 
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To create a work center: 

· Click on the New button. 
· Type in the new work center's name and any comments you wish. 
· After entering your information, click on the Update button to temporarily store your 

changes. 

· Click on the Save Session command under the File menu. 

10.79 Creating work orders 

Work Orders are essentially jobs that have been defined but not yet scheduled. In order to 
schedule jobs, you must first create a work order. A work order consists of a set of job 
parameters. These parameters define the job. They include such things as the number of 
pieces required and the standard rate at which the pieces will be produced. 

A work order may be created manually by entering the parameters or by loading in a product 
standard. Work Orders can be created from the Work Orders or Job Schedule Board 
windows. 
 
From the Work Orders window: 

· Click on the New button. 

· Select a machine from the machine field. 
· Move the cursor to the Value column for each desired parameter. Directly type in 

parameter values. If default information is displayed, edit it as desired by typing over it. 
· Click on the Apply button to save the new work order after all relevant job parameters 

have been entered. Once a work order is saved for a machine, an asterisk appears 
next to the machine in the machine field. This asterisk signifies that a work order 
exists for the specific machine and product combination. 

From the Job Schedule window: 

· Click on the  button. The Edit Job Parameters window appears which looks 
similar to the Work Orders window. 

· Move the cursor to the Value column for each desired parameter. Directly type in 
parameter values. If default information is displayed, edit it as desired by typing over it. 

· Click on the Commit button  on the Job Schedule window to save the 
changes to the Job Schedule Board. If this step is not done, the changes will not be 
permanent or sent down to the shop floor. 

10.80 Customizing the work order list 

For ease of use, the work order list can be partially customized in two ways: 

· The work order list can be restricted to show only certain work orders. 

· The type of work order information displayed is selectable. 

Selecting the Type of Information Displayed:  
 
The work order list has two columns. The first column displays the work order name, or 
product name depending on the user preferences selected. The second column displays any 
of the following based upon your selection: 
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· Job Name  

· Product name  
· Tool name  

· Material formula  
· Required by date  
· Free text 1,2,3 or4 

· Comment  

To select what to display in the second column, click on the list box to the right of the work 
order list. Highlight your selection by clicking with the mouse. 

Customizing the Work Order List:  
 
The work order list can be filtered, providing a way to limit what is displayed. For example, if 
only work orders for a specific product are desired, a filtering mechanism enables you to 
specify which product. 
 
To list specific work orders: 

· Click on the list box to the right of the work order list. 
· Move your cursor down the selection list to the desired filter item. Click again. 
· Move your cursor down to the text field located directly below the list box. 
· Type in the desired search criteria. Press the ENTER key. 

NOTE: How the search is performed depends upon the searching method defined on the User 
Preference window. Searching methods can be left matching, embedded matching, exact 
matching, and case sensitive. If left matching has been designated on the User Preference 
window, then entering the word 'poly' (if material formula was chosen as the search criteria) 
would find work orders that use 'polypropylene' and 'polyurethane'. If embedded matching is 
designated, then entering the word '285' would find work orders using 'polyurethane 285 Black' 
and 'Acrylic V285-100 Clear'. Exact matching means that searching for 'polypropylene' would 
only find work orders that are using 'polypropylene'. 

10.81 Deleting a comm processor 

A window's Delete button deletes information from PlantStar's database. Depending upon the 
window, a reason set, boot set, work center, display group, communications processor, 
machine or DCM will be deleted. 

To delete: 

· Select the reason set, boot set, or work center, etc. you wish to delete. 

· Click on the Delete button. 
· Click on the Save Session button under the File menu to immediately transfer your 

changes to the shop floor. 

10.82 Deleting a custom report from PlantStar 

To delete a report: 

· Click on the arrow to the left of the Report field. Select a report by moving the cursor 
down the list to the desired item and click. The report's description and filename 



242 SYSCON-PlantStar Help System 

 

 

appears. 
· Click on the Delete button. 

10.83 Deleting a DCM 

· Select the DCM. you wish to delete. 

· Click on the Delete button. 
· Click on the Save Session button under the File menu to immediately transfer your 

changes to the shop floor. 

10.84 Deleting a labor category 

· Click on the "Labor Categories" tab located at the top of the window. 
· Select the Labor Category you wish to delete. 
· Clear out the Labor Category name. Only Labor Categories with names will 

appear in Labor Category list. 

10.85 Deleting a labor record 

Employee records can be permanently removed from labor history. 

To delete an employee’s labor record: 

· Select the employee record to delete. 
· Using the mouse or cursor, check the delete check box on the left side of the employee 

record 

NOTE: Once saved, the employee labor record will no longer exist in the Plantstar system. 

NOTE: The employee record will not be deleted until you save your changes. The Delete 
Employee Record check box only flags the employee record for deletion. 

10.86 Deleting a scheduled report 

· Select a scheduled report. Scheduled reports are listed on the right-hand side of the 
window. 

· To select one for deletion, move the cursor over to the list and click on the desired 
report. 

· Upon clicking, the selected report is highlighted. 

· Click on the Delete button. 
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10.87 Deleting an employee 

· Click on the "Employees" tab located at the top of the window. 
· Select the Employee you wish to delete. 
· Click on the Delete button. 

10.88 Deleting display groups 

The Delete button deletes a display group. 

To delete a group: 

· Select the group you wish to delete from the work center and display group field. For 
example, select a work center from the work center list. Next, select a display group 
from the display group list. 

· Click on the Delete button. 
· Select the Save Session command under the File menu. 

10.89 Deleting jobs from the schedule board 

Queued jobs can be deleted from a machine's job queue and work orders can be deleted 
from the work order list. 

To delete a job: 
· Position the cursor over the job you wish to delete. Click on the job to highlight it. 

· Click on the Delete  button. 

· Click on the Commit  button. 

NOTE: A current job cannot be deleted, it can only be replaced. 

10.90 Deleting machines 

To delete a machine: 

· Go to the Machine Setup window. 
· Select the machine to delete by clicking on the arrow to the right of the Machine field. 

Move your cursor to the appropriate machine and click again. 
· Click on the Delete button. 
· To send your changes to the shop floor, select the Save Session command under the 

File menu. 

NOTE: Once a machine has been deleted, the same machine can never exist again. If a new 
machine is created with the same name, it is not considered the same machine. Because of 
this rule within PlantStar, a machine with historical job records should be deleted only if it is to 
be permanently removed from the system. If its future is uncertain, the machine should not be 
deleted. It should be disabled so that it can be reactivated later. 
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10.91 Deleting process variables 

To delete a process variable: 

· Choose the Shop Floor menu on the main Shop Floor Configuration window. 

· Choose the Machine Setup option. 
· Select a machine on the window. 
· Click on the edit process option button, located on the left hand side of the window. A 

list of defined process variables displays. 

· Select the process variable index and name that you want to delete. 
· Blank out the process variable name field. 
· Move your cursor to the Source field and select the 'None' usage option for the process 

variable. 

· Click on the Update button. 

· Select the Save Session command under the File menu. 

10.92 Deleting profile variables 

To delete an existing profile: 

· Choose the Shop Floor menu on the main Shop Floor Configuration window. 

· Choose the Machine Setup option. 
· Select a machine on the window. 

· Click on the edit profile option button, located on the left hand side of the window. A 
list of defined profiles displays. 

· Select the profile that you want to delete by moving your cursor to the variable index 
field. Click on the arrow to the right of this field and slide your cursor down the list to the 
desired index. Click again. 

· Blank out the variable name field. 
· Move your cursor to the Source field and select the 'None' usage option for the profile. 

· Click on the Update button. 
· Select the Save Session command from the File menu to transfer the deletion to the 

shop floor. 

10.93 Deleting reason sets 

A window's Delete button deletes information from PlantStar's database. Depending upon the 
window, a reason set, boot set, work center, display group, communications processor, 
machine or DCM will be deleted. 

To delete: 

· Select the reason sets you wish to delete. 
· Click on the Delete button. 
· Click on the Save Session button under the File menu to immediately transfer your 

changes to the shop floor. 
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10.94 Deleting REUs 

The Delete button deletes an REU. 

· Select the REU you wish to delete. 
· Click on the Delete button. 
· Click on the Update button. 
· Click on the Save Session button under the File menu. 

10.95 Deleting schedules 

Existing shift schedules may be deleted from the Shift Schedule window. Deleting a yearly 
schedule deletes not only the selected year schedule but all the year's weekly schedules as 
well. 

To delete a work center schedule: 

· Go to the Shift Schedule window. 
· Move the cursor to the Work Center field. Choose the work center desired. 
· Move the cursor to the Year field. Choose the year schedule targeted for deletion. 

· The weekly schedules associated with the selected year schedule appear. 
· Click on the Delete button. 

· The work center schedule is deleted. 

10.96 Deleting unassigned child jobs 

Unassigned child jobs can be removed permanently from the system. 

To delete an unassigned child job: 
 

· Select an unassigned child job from the child list. 
· Use the mouse and right click over the child list. 
· Select "Delete Child" from the pop up menu. This will remove the child job from the child 

list. 

10.97 Deleting users 

The Delete button on the User Accounts window deletes an existing user. To delete a user: 

· Select the user from the User Name list box. 
· Click on the Delete button. 

· To permanently delete the user, click on the Save Session command under the File 
menu. 

10.98 Deleting work centers 

A window's Delete button deletes information from PlantStar's database. Depending upon the 
window, a reason set, boot set, work center, display group, communications processor, 
machine or DCM will be deleted. 

To delete: 

· Select the work center you wish to delete. 
· Click on the Delete button. 
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· Click on the Save Session button under the File menu to immediately transfer your 
changes to the shop floor. 

10.99 Deleting work orders and product standards 

· Select a work order or product standard to delete from the list, on the left hand side. 
· Click on the Delete button. 

· After answering "Yes" to the confirmation message, the work order or product standard 
will be deleted. 

10.100 Discarding a schedule 

The Discard button    on the Job Schedule Board restores the job schedule back to the last 
time you committed (saved). Click on this button to restore all information. 

10.101 Displaying standard spc statistics 

Standard SPC Statistics can be viewed by pressing the  icon, on the Process 
Trend/SPC and SPC History windows. 
 

 

 

To close the pop up window, click on this icon  again. The Standard SPC 
statistics are: 

· X-Bar Upper Control Limit 
· X-Bar Lower Control Limit 
· Range Upper Control Limit 
· Range Lower Control Limit 
· X-Bar Mean 
· Range Mean 
· Upper Specification 
· Lower Specification 
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10.102 Editing child parameters 
 

 

· Use the tab key or mouse to select the child job to edit. 
· Move the cursor to the desired job parameter. 
· Type in a new value in the Value column for the job parameter. 

NOTE: Child Jobs cannot be added or removed from a current job or queued job. They can 
only be added when the job is a work order. In other words, once scheduled, the number of 
child jobs assigned to a job cannot be changed. 

10.103 Editing employee records 
 

 

The Employees tab lets you add, change or delete Employees for a given work center.  
Defining an Employee is necessary before that employee can be logged in or out.  
 
Where can you find it? 

 Choose the Labor menu on the main Shop Configuration window. 
 Choose the Labor Setup option. 
 Choose the Employees tab 
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What do you want to know about? 

 Adding an Employee  

 Updating an Employee 

 Assigning an Employee to a Labor Category 

 Deleting an Employee  

10.104 Editing jobs from the schedule board 

· Highlight the job by selecting it on the Job Schedule Board. 
· Double-click on the yellow box surrounding the desired queued job. The Edit Job 

Parameters window appears. 
 
or – 
 

· Click on the Edit Button           on the tool bar. 
· Move the cursor to the desired job parameter. Type in a new value in the Value 

column for the parameter. 
· Click on the Apply button. You will be returned to the Job Schedule Board window. 

· Click on the Commit Button    on the tool bar to save the changes to the Job 
Schedule Board. If this step is not done, the changes will not be permanent or sent 
down to the shop floor. 

10.105 Editing labor categories 
 

 

The Labor Category window lets you add, change or delete Labor Categories for a given work 
center. Defining Labor Categories is optional although this parameter offers you a way to 
group labor requirements for Labor Forecasting. 

Where can you find it? 

 Choose the Labor menu on the main Shop Configuration window. 

 Choose the Labor Setup option. 

 Choose the Labor Categories tab 

What do you want to know about? 
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 Adding a Labor Category  

 Updating a Labor Category 

 Deleting a Labor Category  
 

10.106 Editing labor manning factors 
 

 

One primary reason for setting labor manning factors is to track and schedule labor for a job or 
shift. In order to track labor, you need to enter labor manning factors for the job. Editing of 
these parameters is, however, optional. 

To edit labor manning factors: 

· Click on the Labor tab located in the top of the window. 
· A list of labor categories and their corresponding forecast types appears. 

· Type in a new manning factor in the appropriate column. 
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10.107 Editing machine parameters 
 

 

· Move the cursor to the machine parameters grid, which is under the child job 
parameters. 

· Type in a new value in the Value column for the machine parameter. 

10.108 Editing parent parameters 
 

 

· Move the cursor to the job parameter grid, which is under the job parameters label. 
· Type in a new value in the Value column for the parameter. 

NOTE: SPC Subgroup Size cannot be changed for current jobs. 
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10.109 Editing process and profile limits 
 

 

One primary reason for setting variable parameters is to track process variable exceptions for 
a job. In order to track exceptions, you need to enter the higher limit and lower limit for each 
process variable. Editing of these parameters is, however, optional. 

To edit a parameter: 

· Click on the Limits tab located in the top of the window. 
· A list of process variables and their corresponding parameters appears in the top grid. 
· A list of profiles and their corresponding parameters appears the bottom grid. 
· An undefined parameter is represented by four asterisks. 
· Type in any new values in the appropriate column and process variable row -- over 

striking the asterisks. 

Primary process parameters are: 

· Higher Limit - Enter a value that is higher than the normal operating range of the process 
variable. 

· Lower Limit - Enter a value that is lower than the normal operating range of the process 
variable. 

· Trigger Delay - This field is used to override the existing trigger delay as entered in 
the Machines Setup window. Leave the asterisks if you want to keep the existing 
delay. 

Primary profile parameters are: 

· Trigger Delay - This field is used to override the existing trigger delay as entered in 
the Machines Setup window. Leave the asterisks if you want to keep the existing 
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delay. 
· Duration - This field is used to override the existing duration as entered in the Machine 

Setup window. Cycle times for different jobs may vary, requiring a longer or shorter 
duration. The sum of the trigger delay and the duration must be less than the cycle 
time. Leave the asterisks if you want to keep the existing duration. 

10.110 Editing process variables 
 

 

· Choose the Shop Floor menu on the main Shop Floor Configuration window. 
· Choose the Machine Setup option. 
· Select a machine on the window. 
· Click on the Edit process option button, located on the left hand side of the window. 
· Click on the arrow to the right of the Variable index field. Choose from the list by 

sliding the pointer down the list to the appropriate line. Release the mouse button. 
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10.111 Editing production parameters 
 

 

The Production tab lets you add, change or delete production parameters for a 
given job. 
 
Where can you find it? 

 Production parameters can be edited from the Current/Queue Job, Work 
Orders, Product Standards, and Job Schedule Board windows. 

 Select a job to view. 
 Choose the Production tab 

What do you want to know about? 

 Editing Parent Parameters  

 Editing Child Parameters  

 Editing Machine Parameters  

 Adding/Editing Multiple Materials 
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10.112 Editing profile variables 

· Choose the Shop Floor menu on the main Shop Configuration window. 
· Choose the Machine Setup option. 
· Select a machine on the window. 
· Click on the Edit profile option button, located on the left hand side of the window. 
· Select the profile you wish to view by positioning your mouse over the arrow to 

the right of the variable index field, located on the left hand, bottom side of the 
Machine Setup window. 

· Slide the cursor down the list to the desired profile and click again. 

10.113 Editing report definitions 

· Click on the arrow to the left of the Report field. Select a report by moving the cursor 
down the list to the desired item and click. The report's description and filename 
appears. 

· If you wish to edit the report's description or its name, go to step 3. If you wish to 
edit a report's fields, titles, or view the report definitions, go to step 4. 

· Enter the new name or description. Click on the Save button. An informational message 
appears stating that reports definition file cannot be found. Click the OK button. This 
message appears only when the name or description of a report is being changed. 

· Click on the Load button. The Load button opens up the Crystal Reports 
application. Edit any desired report definitions and save the changes within 
Crystal Reports. 

· Upon returning to the Custom Reports Manager program, click on the Save button. 
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10.114 Editing setup sheets 
 

 

Setup Sheet information can be added to product standards, work orders or currently running 
jobs. There are two types of setup sheet information -- product portion and machine portion. 
Both types are sent to the DCM. 

To add setup information: 

· Click on the "Setup Sheets" tab located in the top of the window. 

· The setup sheets appear, allowing the entry of setup sheet information. 
· Select the setup sheet to edit, product or machine, by tabbing to the "Product 

Portion" or "Machine Portion" text fields. 
· Type in setup sheet information directly into this field. 

NOTE: When typing, the text field wraps words. The DELETE or BACKSPACE keys can be 
used to erase characters. A maximum of 2600 characters can be typed in. This limit is for the 
sum of the text in both the product and machine portions. 

10.115 Enable a DCM 

By clicking on the Enable Radio button you are allowing the DCM to communicate with the 
host. While a DCM is disabled no communication with the host occurs and no data for any 
machine defined for this DCM is collected. Some setup features like the number of machines 
require that the DCM be disabled before changing. 

10.116 Enabling a RIO on a machine 
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In order for a machine to be able to collect data from the RIO the check box next to the 
machine number must be selected. Once selected, the machine will retrieve all process 
variables and profile data including cycle time from the RIO unit. 

To enable a RIO on a machine, check the checkbox next to the selected machine. 

10.117 Exporting data 

Graph and table values may be written and stored in a file in the following windows: 
· Labor Status  
· Production Summary 
· Job Summary  
· Machine Log  
· Overlay Profile  
· Process Trend/SPC  
· Process Summary  
· Labor Forecasting  
· SPC History  
· Material Lot Tracking  

To write values to a file: 

· Enter the appropriate window and click on the appropriate button. 
· The File Selection window appears. 
· Move the cursor to the file name field. Type in the name of a file to save the graph 

values. The default disk drive is the one you entered PlantStar from. 
· You may change the disk drive by moving the cursor to the drives field. Click on the 

desired drive. 
· Click on the OK button when finished identifying the file name. 

NOTE: Process Trend/SPC and Machine Log - These windows have two options:      

which writes one process variable to a file or    all process variables for the machine and 
job. 

Depending upon the window selected, the ASCII file created has several formats. 
 
Process variable information is in the following format: 

· Machine  
· Job 
· product  
· Process Variable name (if the window allows variable selection) 

· Time Stamp 

· Values 

The SPC History window has the following format: 
· Job name  
· Machine  

· product  
· Process Variable  
· SPC Subgroup Size  
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· Time stamp 
· X-bar Value 
· Range  
· SPC values -- The number of values is based upon the SPC Subgroup Size. 

The Profile window has the following format: 
· Machine  
· Job  
· Product  
· Profile Name 
· Time Stamp 
· Number of SPC points included 
· X, Y coordinate (Each coordinate is on a separate line.) 

10.118 Forcing a machine down 

A machine can be forced into a down state from the Down Select field. Click on the arrow to 
the right of this field. A list of down reasons appears. Select the desired reason by clicking 
on its name. The machine will go down within the next machine cycle. 

When a machine enters a forced down state, its associated DCM may or may not continue to 
count parts and monitor process variable information. The action taken depends upon how 
the down reason which triggered the "forced down" is defined in terms of its force down and 
ignore cycles flags. These flags are set on the Down Reason Sets window. 

10.119 Freezing profiles 

Freezing the profile window stops data updates to the graph. The graph will not change 
until the 'freeze' option is canceled. 

To freeze the profile: 

1. Click on the  button. 
2. Once selected, this button appears 'depressed' into the background of the window. 
3. To cancel this feature, click on the icon again. It should appear not selected. 

10.120 Getting a voice file 

To get a new voice file: 

· Click on the Get File button. 
· The File Selection window appears. 

· Move the cursor to the file name field. 
· Type in the name of a file to retrieve. The default disk drive is the one you entered 

PlantStar from. 
· You may change the disk drive by moving the cursor to the drives field. Click on the 

desired drive. 

· Click on the OK button when finished identifying the file name. 

10.121 Identifying machines with Product Standards 

For a selected job or work order, machines with matching product standards are identified with  
 the button. 
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· Click on the  button. 
· Select a current job or queued job on the job board by moving the cursor over the job. 

Click on the job. The job's rectangle will turn yellow. 

· If a standard was written for the designated machine and product, a  symbol 
appears next to the machine name. 

10.122 Ignore criteria in a report 
This feature is used to schedule a report that does not include a selection criterion. For 
example, to schedule a "Job Queue" report at shift change, choose "Ignore Criteria", since the 
shift is not criteria for the "Job Queue" report. 

· Move the cursor down the report list to the desired choice. 

· To temporarily disable a report, check the "Ignore Criteria" field to the right of the 
"Report" field. 

10.123 Including boot files from a boot set 

Boot sets can consist of multiple boot files. PlantStar provides a list of default boot files from 
which to choose to make up a boot set. 

To specify which boot files to include in a boot set: 

· Go to the Boot Sets window. 

· Position your mouse over the box to the left of the boot file you want to include in the 
set. 

· Click on the box. An 'x' appears in the box if it is included in the boot set. 
· To exclude the boot file from the set, click on the box again. The 'x' in the box 

disappears. 

· Click on the Update button to save your changes. 
· Select the Save Session command under the File menu to transfer the new 

information to the shop floor. 

10.124 List All product standards 

Retrieves all existing product standards. 
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10.125 Logging in an employee 

Users can login an Employee from the Labor Status screen, as well as the shop floor DCM's. 
To login an Employee, click the Login button at the bottom of the screen. Once clicked, you 
will be presented the following login dialog:  

 

From this dialog, enter a valid employee id. Employees are defined in the Shop Floor 
Configuration program. If the employee id was invalid, the users would be presented with a 
pop up message "Invalid Employee". Once a valid employee id was entered, you will be 
prompted for a machine that you wish to log into. 

 

From this dialog, you can select a machine from the drop down list. The drop down list 
consist only of the machines which belongs to the work center an employee is assigned. 
Employee-Work Center relationships are defined at the Labor Setup window in the Shop 
Floor Configuration program. Once a machine is selected, you will be prompted for a labor 
category you wish to log into. 
 

 

From this dialog you can select a labor category from the drop down list. The drop down list 
consists only of the categories that have been assigned to the Employee Id entered. 
Employee-Labor Category definitions are defined in the Shop Floor Configuration program. 
Once a labor category has been selected, you can click the "Finish" button which will log you 
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into the system. 

NOTE: To Cancel out of the login process, click the "Cancel" button. 

NOTE: No matter what shift is currently displayed in the shift selection, the employee will 
always be logged into the current shift. Employees can only be added to previous shifts 
from the Labor History window. 

10.126 Logging out an employee 

Users can logout an Employee from the Labor Status screen, as well as the shop floor DCM's. 

To logout an Employee, click the record, in the grid, that contains the employee record to be 
logged out. Once the record is selected, the entire row will change to a black background with 
white text. Click the logout button, at the bottom of the screen. This will logout the selected 
employee. 

NOTE: The Logout button is only enabled when the shift selected is "Current Shift: Logged 
In" and a row containing an employee record is selected. When other shifts or empty rows 
are selected, the logout button is disabled. 

10.127 Moving jobs around the schedule board 

The Job Schedule Board window lets you rearrange jobs in a machine's job queue or 
move queued jobs from one machine to another. A 'drag and drop' method is used for 
scheduling. 

When moving jobs around the job board, the job movement default which is defined on the 
User Preference window is very important. It determines what information is moved with a 
job when it is re-assigned to different machines. There are two methods offered: 

· Keep the standard of the original machine - When a queued job is moved from one 
machine to another, the machine-related job parameters defined for the queued job on 
the originating machine are moved to the new machine. No changes are made. 

· Keep the standard of the new machine - When a queued job is moved from one 
machine to another, the machine-related job parameters defined for the queued job are 
changed to match the job parameter values defined on the original product standard 
created for the destination machine. 

Once selected, the "default drag and drop" is activated as follows: 

· Position the cursor over the job to re-schedule and click. The job rectangle becomes 
yellow. 

· Holding down the mouse button, drag the job rectangle to the new location on the job 
board. 

· Release the mouse button. The job automatically appears in the new location unless 
you have moved a queued job to a current job position. If you are scheduling a 
current job, a message appears if a job was previously scheduled in that position. 
Click on the Current button or Queue button. If Current is clicked, you must decide 
whether you want to suspend or end the currently running job. If you suspend a job, a 
work order is created. The pieces to go of the suspended job will be transferred into 
the Pieces Required field of the newly created work order. 

· Click on the Commit button to save the new schedule. 
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NOTE: The non-default job movement method is activated by holding down the SHIFT 
key while dragging and dropping the job. 

10.128 Ordering machines in the list 

The up and down buttons enable you to put each machine within a display group into 
any desired order. This order is used on all multiple machine windows. 

· Select a machine from the Machines in Group list by clicking on it. 
· Click on the up or down arrow button. 

10.129 Playing an announcement 

All existing or newly-created announcements can be played within the Voice 
application. 

To play an announcement: 

· Open the desired configuration window under the Configure menu. 
· Click on the Play command button. 

10.130 Printing a report to the screen 

· Select a report. 
· Click on the View button. 
· If any criteria windows appear, select the desired criteria fields. 
· Always click on the OK button when finished selecting all desired parameters. 
· A window appears displaying the selected report. 

· To close the report window, click on the close button located in the upper right corner of 
the window. 

10.131 Rebuilding the display 

This window is not updated every machine cycle. To view a forecast using the latest job 
information, click on the Build button. Once clicked, PlantStar retrieves the most recent job 
and shift information. A forecast is then provided based upon the retrieved information. Re-
click the Build button each time an up-to-date forecast is desired. 

10.132 Recalling profiles 

Recalls profiles saved from the Save Profile window. When the Recall button is clicked, a 
second window appears. This window enables you to select a saved profile for display. Also, 
when the Recall button is clicked, a new button appears -- the Clear button. The Clear button 
clears the recalled profile from the graph area. 
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10.133 Recording an announcement 
 

 

· Click on the Record command button. The Record Voice File window appears. 

· Turn on your microphone. 
· Click on the Record command button. Begin speaking. 
· When finished, click on the Stop button. 

10.134 Refreshing the display 

Users can use the Refresh button to force an update to the window as the data is static 
once the window is opened. 

10.135 Refreshing the lists 

The work order and product standard lists are not updated automatically. At times, there 
may be two or more people editing work orders and product standards. Newly created work 
orders and product standards by one person will not necessarily be seen in another 
person's lists. The Refresh button updates the lists, with the most recently created work 
orders and product standards. Click on this button anytime you wish an updated the list. 

10.136 Removing child jobs from a product standard 

Child Jobs can be deleted from either work orders or product standards. 

To remove a child job from a product standard, select the "Delete Child" button at the 
bottom of the screen. This will remove the child job from the product standard. 

NOTE: Product Standards cannot be saved with only one child job. This would be 
considered a non- family job. To save, you will need to delete the last child job or add 
another child job to continue. 

10.137 Removing child jobs from a work order 

Child Jobs can be deleted from either work orders or product standards. 

To remove a child job from a work order: 
· Use the mouse and right click over the work order list or the child parameter grid. 

· Select "Remove Child" from the pop up menu. This will remove the child job from the 
work order. 

NOTE: Work Orders cannot be saved with only one child job. This would be considered 



Functions 263 

 

 

a non- family job. To save, you will need to delete the last child job or add another child 
job to continue. 

10.138 Removing machines from a display group 

The Remove button enables you to delete machines from an existing display group. 

· Select a machine from the Machines in Group list by clicking on it. 
· To select several machines next to each other, keep the mouse button pressed down 

and move the mouse up or down. Then let go. 
· To select several machines that are not next to each other in the list, press the 

CTRL button, in combination with the mouse button, over each desired machine. 
· Click on the Remove button. 
· Click on the Update button. 
· Select the Save Session command under the File menu. 

10.139 Removing machines from a REU list 

The Remove button enables you to delete machines from the list of accessible machines on 
an REU. A machine can always be added back later. 

· Select a machine from the Selected Machines list by clicking on it. To select several 
machines next to each other, keep the mouse button pressed down and move the 
mouse up or down. Then let go. To select several machines that are not next to each 
other in the list, press the CTRL button, in combination with the mouse button, over 
each desired machine. 

· Click on the Remove button. 
· Click on the Update button. 
· Click on the Save Session command under the File menu. 

10.140 Renaming a reason set 

You can change the name of a reason set by simply typing over the existing name. The 
name can be up to 20 characters in length. 

· Click on the set name field. 
· Type the new set name over the existing set name. 

· Click on the Update button to save your changes temporarily. 
· Click on the Save Session button under the File menu to immediately send your 

changes to the shop floor. 

10.141 Resizing columns 

Columns on this display can be adjusted to fit the desired width. 

This can be done by: 

· Move the mouse over the column heading to resize. 

· When the mouse cursor changes to a drag bar, press and hold the mouse button. This 
will drag the column border. 

· When the column border is in the appropriate place, release the mouse button. 

10.142 Retrieve default product standard 

Retrieves the existing default product standard. 
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NOTE: Once retrieved, the default product standard can be edited and saved again as 
the default product standard. 

10.143 Saving process variables 

To save your process variable information: 

· Choose the Shop Floor menu on the main Shop Floor Configuration window. 
· Choose the Machine Setup option. 
· Select a machine on the window. 
· Click on the process option button, located on the left hand side of the window. A 

list of defined process variables displays. 
· Select the process variable from the variable index field. 

Click on the arrow to the right of this field. 

· Select the desired variable from the list by clicking again. 
· Type over or change any information you desire. 
· Click on the Update button to save your changes. 

· Select the Save Session command under the File menu. 

10.144 Saving profile variables 

To update your profile variable information: 

· Choose the Shop Floor menu on the main Shop Floor Configuration window. 

· Choose the Machine Setup option. 
· Select a machine displayed in the window. 
· Click on the edit profile option button, located on the left hand side of the window. A 

list of defined profile variables displays. 
· Select the desired variable index and variable name. To select a profile index, click on 

the arrow to the right of the variable index field. 
· Slide the cursor down the list to the appropriate index and click again. The 

profile's name and related information appears on the window. 
· Type over or change any information you desire. 
· To send your changes to the shop floor, select the Save Session command under the 

File menu. 

10.145 Saving reason sets 

The Update button changes an existing reason set or boot set's information. 
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To update a set: 

· Select the reason or boot set to update. 
· After changing your information, click on the Update button. 
· To send your changes to the shop floor immediately, click the Save Session button 

under the File menu. 

10.146 Saving your changes-Apply 

Click on the Apply button in the bottom right hand corner. Alternatively you can click the OK 
button and you will be prompted to save your changes. After saving, any necessary 
adjustments will be sent to the DCM and other PlantStar clients. 

10.147 Saving your changes-Update 

Click on the Update button in the bottom right hand corner. 

NOTE: In the Shopfloor Configuration Program, the Update button does not send the new 
changes to the DCM or Communications Processor. (All changes are sent to the database 
and the shop floor from the Save Session command under the File menu.) 

10.148 Scheduling jobs by due date 

· Make sure that the due date scheduling method is active. This method is activated by 
clicking on the  icon. 

· If a vertical line marker  , appears on the top of the Job Schedule Board, then the 
"schedule by due date" method is active. 

· The marker indicates the point in time when job scheduling by due date should begin. 
Jobs which are scheduled to start to the right of this marker (on the job board) are 
scheduled by due date. Jobs which start to the left of this marker are scheduled by the 
earliest possible time -- immediately upon completion of the previous job. The marker 
can be moved back and forth along the job board's time line. To move the marker, click 
on the marker and hold down the left mouse button. Drag the marker to any desired 
point along the time line. Release the mouse button. Upon release, all jobs to the right 
of the marker will be re-estimated and re-scheduled according to job due dates. 

· To schedule a new work order onto the job board, move the cursor to the work 
orders list box, located on the bottom, left of the window. 

· Click and hold down the left mouse button on the desired work order. Drag the work 
order rectangle to its new location on the job board. 

· Release the mouse button. The work order automatically appears in the new location. 

· Click on the Commit  button. 

10.149 Scheduling jobs by earliest start date 
· Make sure that the three due date scheduling icons                     are not active : 

· If a marker    appears on the top of the job board, then the "schedule by due date" 
method is active. 

· Click on the    button to turn this scheduling method off. 
· Move the cursor to the work orders list box, located on the bottom, left of the window. 
· Click and hold down the left mouse button on the desired work order. Drag the work 

order rectangle to its new location on the job board. 
· Release the mouse button. The work order automatically appears in the new location. 
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· Click on the Commit  button. 
·  

10.150 Scheduling selected jobs by due date 

This button       changes the scheduling method of a highlighted job between the earliest 
possible start method or the due date method. Once a job is highlighted (clicking on the job 
highlights it and turns its job rectangle yellow), use this button to switch the job between the 
two scheduling methods. 

NOTE: The right click button on the mouse may be substituted for clicking the    button (i.e. 
it provides the same function). 

NOTE: This button only works when the       button is selected at the same time. Also, in 
order to schedule a job by due date, the job must start to the right of the scheduling marker. 

10.151 Search Product Standards 

Retrieves any existing product standards using the job or product fields. If no job or product 
name is provided, the Search button retrieves all existing product standards. 

NOTE: As of PlantStar v4.10, this search no longer requires the key fields to match the 
case of the expected result. In other words, the search is no longer case sensitive. 
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10.152 Searching for a job 

 

 

 

The Job Schedule Search window lets you quickly locate a specific job on the Job 
Schedule Board window. Once the desired job is found, it is highlighted on the Job 

Schedule window. This can be invoked by clicking the  button on the menu bar. 

An existing job or work order may be found by: 

· Searching for a job or work order by job name 
· Searching for a job or work order by product name 

· Searching for a job or work order by material name 
· Searching for a job or work order by tool name 
· Searching for a job or work order by Due Date Before 

· Searching for a job or work order by Due Date After 
· Searching for a job or work order by Free Text  
· Searching for a job or work order by Comment  

· Searching for a job or work order by any 4 combinations of the above 
· Listing all scheduled jobs and work orders  

The searching method for this window is defined by the User Preference window. Exact 
matching, left matching, or embedded matching schemes are available. Once a search is 
initiated, any matching job's location (on which machine it is scheduled), its product name 
and job name are displayed. 

A job or work order can be found by initiating a search. Four different fields may be used in 
the search -- Only one field is required. 
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To initiate a search: 
· Select a field to search on from the drop down list. 
· Enter a search string. 
· Click on the Search button. 
· A list of jobs that match the given key(s) appears. 
· Select from the list by clicking on a job. 
· Click on the OK button. 

How a search is performed depends upon the searching method defined on the User 
Preference window. Searching methods can be left matching, embedded matching, exact 
matching, and case sensitive. If left matching has been designated on the User Preference 
window, then entering the word 'poly' (if material was chosen as the search criteria) would find 
jobs that use 'polypropylene' and 'polyurethane'. If embedded matching is designated, then 
entering the word '285' would find jobs using 'polyurethane 285 Black' and 'Acrylic V285-100 
Clear'. Exact matching means that searching for 'polypropylene' would only find jobs using 
'polypropylene'. 

10.153 Searching material lots 

The Search button enables you to scan the database for specific material tracking 
information. Searching keys are provided for narrowing your search. 

The following keys are availible for search: 

· Tote ID  
· Machine  

· Job 
· Product  
· Tool 

· Material  
· From Date 
· To Date 

· Free Text 1  
· Free Text 2 

· Free Text 3 
· Free Text 4 

To search for material lot information: 
· Type in the desired search criteria. If you want all information to be retrieved, leave 

the searching keys blank. 
· Click on the Search button. 
· The lower half of the window lists all material lots matching the search keys. 

10.154 Selecting a machine state 

Select a machine state by clicking on the circle to the left of the desired state. The Monitor 
window immediately displays any machines currently running in that state. The list of 
machines may change with each machine cycle as machines go in and out of a selected 
state. 

NOTE: The All selection displays all machines within the selected display group, 
regardless of their machine state. 

10.155 Selecting a period interval 
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A variety of scheduling options are available: 

Daily Reports 
· Go to the period field. Select the Daily choice from its selection list. 
· Go to the shift field. Select a desired shift from its selection list. 

Weekly Reports 
· Go to the period field. Select the Weekly choice from its selection list. 
· Go to the day of the week field. Select a desired day from its selection list. 

· Go to the shift field. Select a desired shift from its selection list. 

End-of-Shift Reports 
· Go to the period field. Select the By Shift choice from its selection list. 

End-of-Job Reports 

· Go to the period field. Select By Job from the selection list. 

10.156 Selecting a time scale 

Five different time scales are available for viewing a machine's job schedule: 

· 1-Hour 

· 8-Hour 
· Day 
· Week 

· Month 

To select a time scale: 

· Locate the time scale field is located in the middle of the Job Schedule Board's tool bar. 
· Click on the arrow to the right of this field. Position the mouse pointer over the time scale 

field. 

· Choose the new time designation by sliding the pointer down the selection list to the 
appropriate line and clicking again. 

10.157 Selecting a year 

Every work center schedule has multiple annual schedules. To select a specific year's 
schedule and its work schedule assignments: 

· Once on the Shift Schedule window, position the cursor on the arrow to the right of the 
Year field. 

· Choose the new year by sliding the pointer down the selection list to the appropriate line 
and click. 

· Upon selection, the Calendar and Weekly Schedules List reflects the work schedule 
assignments for the visible work center and year. 

10.158 Selecting criteria for a report 

Report Criteria designate what type of information is included in a report. For example, a 
job history report can include all jobs for a certain product or one specific job. A custom 
report can be set up to include only information for a certain time period or for a certain 
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machine. 

Criterion fields are set up from the View and Print program. 

To select criteria when printing a report: 

· Select a report for printing. 
· Click on the Print button. 
· For each field that is designated as criteria for the custom report, a window appears. 

· For each window, use the mouse pointer to select from the display lists. Always click 
on the desired item. If more than one item is desired in a list, click on each item. 
Selected items are highlighted. 

· Click on the OK button. 

NOTE: Each selection criteria is independent. The list of choices in the second criteria window 
is not dependent of the first criteria of choices. 

10.159 Selecting current/queue jobs 

Current jobs and Queue jobs can be edited from the Edit Current\Queue Job 
window. 

To edit a Current Job: 

· Click on the first job in the job list labeled "Current Job". The job list is located on the 
left side of the window. 

To edit a Queue Job: 

· Click on the queue in the job list. This would be every job in the list, except the first job. 
The first job is the current job, which is labeled "Current Job". The job list is located on 
the left side of the window. 

NOTE: These jobs can also be edited through the Job Schedule window. 

10.160 Selecting display groups from the schedule board 

· The display group field is located in the middle of the Job Schedule Board's tool bar. 

· Click on the arrow to the right of this field. 
· Slide the pointer down the selection list to the appropriate display group. Click. 

· Only those machines in the display group are listed on the job board. 

NOTE: If the All display group is selected, and there is more than one work center 

defined with different shift schedules, then the Display Shift Schedule button   
is disabled. 

10.161 Selecting forecast intervals 

The forecast interval field restricts the number of jobs displayed on the Tool Change window 
to those that are estimated to be completed by the selected interval. For example, if the 1 
Day interval is chosen, jobs that are estimated to be complete within 1 day from "now" are 
listed in the table. 

10.162 Selecting jobs from the schedule board 
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A job may be selected, from the Job Schedule Board, in several ways: 

· Position the mouse cursor over the desired job on the job board and click. The box 
surrounding the job turns yellow when selected. 

- or - 

· Click on the machine on which the job is running or scheduled to run. A small 
selection window appears. Click on the desired job name. The box surrounding the 
job turns yellow when selected. 

NOTE: Use the job board's scroll bars to find the job if you cannot see it. A small time scale 
may make the queued job not initially visible. Change the time scale, if desired. 

10.163 Selecting product standards 

· Load the product standard list by clicking the "Refresh" button in the bottom right hand 
corner. The Product Standard list is located on the left side of the window. 

· Click on the desired standard in the Product Standard list. 

- or - 

· Click on the Load Std button. 

· The Select Product Standard window appears. 
· From this screen, you can search or scroll through the list of product standards. 
· Once a child has been selected, click the "OK" to select the product standard. 

· Alternatively, you can select the default product standard by clicking the 
"Default" button and selecting "OK". 

Once selected, the Product Standard window reappears with the job parameters of the 
selected standard. 

10.164 Selecting Report Criteria 

Allows database fields to be designated as report criteria; Criteria designate what type of 
information is included in a report. The fields selected as criteria must be actually used on the 
report. 

10.165 Selecting specific machines 

The Selected List option enables the list of machines on the top right-hand side of the 
window. Choosing machines from this list makes a Monitor window change its list of 
machines to match your selection. 

To select several machines next to each other, keep the mouse button pressed down and 
move the mouse up or down. Then let go. To select several machines that are not next to 
each other in the list, press the CTRL button, in combination with the mouse button, over 
each desired machine. 

10.166 Selecting users 

You can view all users in the PlantStar system if you have administrator privileges: 

· Select the User Accounts menu option from the User menu on the main Shop Floor 
Configuration  window. 

· To select a user to view, position your mouse pointer over the User Name field. Click 
on the arrow to the right of the field. Choose the new user you want by sliding your 



272 SYSCON-PlantStar Help System 

 

 

pointer down the selection list to the appropriate line. Click again. Upon selection, all 
privileges will be displayed for the selected user. 

The User Name field enables you to change the user name. If you desire, just type over the 
name of the user that is currently selected. Click on the Save button to temporarily save the 
new name for the selected user. Click on the Save Session command under the File menu 
to permanently save all user changes. 

10.167 Selecting/viewing tote details 

Once a child job record has been selected in the "Job Detail" grid, the "Tote Detail" grid will 
contain the tote boxes that were generated for the selected child job. 

10.168 Sending a report to the printer 

· Select a report. 
· Click on the Print button. 
· If any criteria windows appear, select the desired criteria fields. Always click on the OK 

button when finished selecting all desired parameters. 
· A window appears displaying the selected report. 

· To print a report, click on the print.bmp button at the top of the window. The report is 
routed to your default Windows printer. 

10.169 Set report to display in HTML format 

A report can be set to display in HTML format: 

· Move the cursor down the report list to the desired choice. 

· Check the "HTML" field to the left of the "File Name" field. 

10.170 Setting down reason flags 

There are four flags which can be set for each down reason: 

· Force Down 

· Ignore Cycle 
· Auto Clear 
· Force Scrap 

To set flags for a down reason: 

· Click on a flag field for the desired down reason. 
· Type in either 'Y' or 'N'. 
· Click on the Update button. 

· To send your changes to the shop floor, select the Save Session command under the 
File menu. 

10.171 Setting report criteria 

· Click on the arrow to the left of the Report field. Select a report by moving the cursor 
down the list to the desired item and click. The report's description and filename 
appears. 

· Click on the Criteria button. This button brings up a second window which displays a list 
of PlantStar tables from which criterion fields can be selected. 

· Clicking on a table name displays its list of possible criteria. Select as many fields as 
desired by clicking on the field name. Note that for each field selected, a window 
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appears during the report printing process. These windows provide field selection lists. 
For example, the job field is designated as a criterion for a report. When printing the 
report, a user will be asked to select which specific production jobs to print. If start date 
is also designated as a report criterion, a second window appears during the printing 
process asking for a valid start date. 

· Click on the OK button when finished selecting report criteria. 

· Upon returning to the main window, click on the Save button. An informational 
message appears stating that reports definition file cannot be found. Click the OK 
button. 

Criteria can also be set up for a report from within the Crystal Reports program. If fields are 
also designated as criteria from the Custom Reports Manager program, then the affected 
report is based upon BOTH sets of criteria. 

NOTE: When selecting a report's criteria, i.e. what type of information will be included in the 
report, the fields selected as criteria must be actually used on the report. For example, if a 
report is designed to print job history information, it is invalid to select field information from 
the shift history tables. 

10.172 Sorting columns 

Columns on this display can be sorted so that you can view the data displayed based on 
the selected column. 

· To sort the column, click once on the column heading that you wish to sort. This will 
sort the column in an ascending order. 

 
- also – 
 

· To sort the column in a descending order, click the same column heading again. 
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10.173 Storing profiles 

Storing a displayed profile saves the graph snapshot onto the window. Future snapshots of 
data points are then overlaid onto the 'stored' profile graph. 

To store the profile: 

· Click on the  button. 
· Once selected, this button appears 'depressed' into the background of the window. 
· To cancel this feature, click on the icon again. It should appear not selected. 

10.174 Toggling auto size and normal size 

Auto Text Size forces all fields on a window to fit within the window's boundaries. If there is 
a long list of machines within a display group, sometimes the text on this window is not 
readable. The Switch to AutoSize button changes the size of the window's text -- making it 
more readable. 

To change between normal and auto text size on a window, click on the       

       Switch To Autosize button. This button acts like a toggle. Click on it 
again to return to the previous text size. 

10.175 Toggling Process and Profile view 

Displays a machine's associated profiles and process variables. The profiles and process 
variables display on the bottom of the window, directly below this button. 

10.176 Toggling tool change view 

Tool change information can be viewed for all jobs or just those jobs where there are tooling 
changes from one scheduled job to the next. To view all scheduled job changes, click on the 
circle to the left of the All Job Changes field. This field is located directly under the table. 

To select only those jobs where there are tooling changes, click on the circle to the left of 
the Tool Change Only field. 

10.177 Undoing your changes 

Click on the Restore button to undo any changes made on the window since the last save. 

10.178 Updating a comm processor 

The Update button saves any changes made on a window so that other shop configuration 
windows can access the new information. The Update button does not send the new 
changes to the DCM or Communications Processor. (All changes are sent to the database 
and the shop floor from the Save Session command under the File menu.) 

· Select the Communications Processor you wish to update. 

· Change all desired information. 
· Click on the window's Update button. If new information has been added, other shop 

floor windows will reflect the change. 
· To send your changes to the shop floor, select the Save Session command under the 

File menu. 

10.179 Updating a DCM 
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The Update button saves any changes made on a window so that other shop configuration 
windows can access the new information. The Update button does not send the new 
changes to the DCM or Communications Processor. (All changes are sent to the database 
and the shop floor from the Save Session command under the File menu.) 

· Select the DCM you wish to update. 

· Change all desired information. 
· Click on the window's Update button. If new information has been added, other shop 

floor windows will reflect the change. 
· To send your changes to the shop floor, select the Save Session command under the 

File menu. 

10.180 Updating default Product Standard 

To update the default product standard based upon the job on the previous window, 
click on the Default button. 

The Default button replaces the default product standard with the job parameters from the 
previous window. Once the update is complete, the Save As Product Standard window 
immediately returns you to the previous window. 

NOTE: Altering the default product standard affects the future creation and import of work 
orders. 

NOTE: A family job cannot be saved as the default product standard. If a family job has been 
selected, the Default button will be disabled. 

10.181 Updating existing standards 

To update an existing standard based upon the job on the previous window, click on 
the Update button. The steps are: 

· Highlight an existing standard in the Standards list box. 
· Click on the Update button. 

The Update button replaces the existing standard's parameters with the job parameters from 
the previous window. Once the update is complete, the Save As Product Standard window 
immediately returns you to the previous window. 

10.182 Updating machines 

The Update button saves any changes made on a window so that other shop configuration 
windows can access the new information. The Update button does not send the new 
changes to the DCM or Communications Processor. (All changes are sent to the database 
and the shop floor from the Save Session command under the File menu.) 

· Select the machine you wish to update. 
· Change all desired information. 

· Click on the window's Update button. If new information has been added, other shop 
floor windows will reflect the change. 

· To send your changes to the shop floor, select the Save Session command under the 
File menu. 

10.183 Updating schedules 
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Many different types of changes can be made to a work center schedule from the Shift 
Schedule window. Possible changes are: 

· Assign a different shift schedule to a specific week on the Calendar; 

· Change a start time, idle, or end idle time in a weekly schedule; 
· Unassign a weekly schedule for a specific week on the Calendar; 
· Change the name of a weekly schedule. 

To make a change: 

· Go to the Shift Schedule window. 
· Move the cursor to the Work Center field. Choose the work center desired. 
· Move the cursor to the Year field. Choose the year schedule desired. 

· The weekly schedules, associated with the selected yearly schedule, appear in 
the Weekly Schedules list. 

· Make any necessary changes by referring to the appropriate on-line help section listed 
below: 

· Assign a different weekly schedule to a specific week Calendar week; Refer to the 
“Assigning Weekly Schedules For A Year” help topic. 

· Change a start, idle, or end idle time in a weekly schedule; Refer to the “Creating 
Weekly Schedules” help topic. 

· Unassign a work schedule for a specific week block on the Calendar; Refer to the 
“Assigning Weekly Schedules To The Calendar Board” help topic. 

· Change the name of a weekly schedule to change a schedule name, simply type over 
the existing schedule name in the “Weekly Schedules List” field. 

· Click on the Save button. 
· The work center schedule is updated. 

10.184 Updating users 

The Save button changes a user's privileges. 

To change a user's information: 

· Go to the User Accounts window. 
· Select the user from the User Name list box. 
· Make your desired changes by clicking on the desired privilege boxes or change the 

password by clicking on the Password button. 
· Click on the Save button. 
· Select another user for updating, if desired. Repeat steps 3 - 4. 
· To permanently save all user changes, click on the Save Session command under the 

File menu. 

NOTE: If a user is currently logged into PlantStar when changes are made to his/her 
privileges, he/she must log out and then log back in for any changes to take affect. 

 
10.185 Viewing job summary information 
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Job Summary information can be viewed from the Job Schedule Board 

window. Summary information includes: 

· Job 
· Tool 
· Product  
· Material  
· Required by Date  
· Estimated Completion Time  
· Hours To Go  
· Child Count  
· Pieces Required for each child job 
· Comment  

To view the job summary: 

· Move the cursor to the job board and click on a job. 

· Click on the Summary button      on the menu bar. 
· To close the summary information window, click on the Summary button again. 

Alternate Method: 
If you are already viewing a list of jobs on a machine, highlight a job by clicking the mouse. 
Then click on the Summary button. 

10.186 Viewing machine detail 

Several windows are directly accessible from the Machine Status window. These are 
accessible by double-clicking on a machine's rectangle to open the windows. The specific 
window that is opened depends upon the current selected machine's running state and is 
outlined in the following list: 
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State Window  
Assist State Assist Pareto Window  
Down State Down Pareto Window  
Fast State Job Summary Window  
Idle State Machine Exception Window 
Off-line State Machine Exception Window 
Process Exception Process Summary Window  
Production Exception Job Summary Window  
Reject Exception Reject Pareto Window  
Slow State Job Summary Window  
Running State Job Summary Window  

10.187 Viewing machine exceptions 

You can access the Machine Exception window from the Exception Summary 
window. To view detailed information about a machine's current exception states, 
double-click on the machine name or anywhere within a machine's row of information. 

10.188 Viewing machine status 

The Machine Status window is accessible from the Display Group Status window. Double-
click on a display group's rectangle. The Machine Status window opens. It displays all 
machines within the selected display group. 

10.189 Viewing min and max values 

To view the minimum value:  

· Click anywhere on the far left-hand side of the window, outside of the graph borders, 
but within the top and bottom lines of the desired graph. 

To view the maximum value on any graph window: 

· Click anywhere on the far right-hand side of the window, outside of the graph borders 
but within the top and bottom lines of the desired graph. 

10.190 Viewing production hours 

· Production hours can be displayed on the job board by clicking on the      button, 
located on the window's tool bar. 

· On the job board, production hours appear in parentheses next to the job name. For 
jobs, production hours are calculated the same way as estimated completion time. 
Calculation of production hours for slack time (the gray rectangles between 
scheduled jobs which only appear if due date scheduling is active) are based upon 
the current shift schedule and any idle periods that are defined. 

NOTE: This button acts like a toggle. Click on it again to hide production hours. 

10.191 Viewing the shift schedule 

The shift schedule for a selected display group can be viewed on the job board. Click on the 

  button to display the shift schedule time line. The schedule appears at the top of 
the Job Schedule Board directly below the time scale. Click again on the button to hide the 
time line. 

 
NOTE: The shift schedule time line can only be viewed if all the machines in the selected 
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display group belong to the same work center. Also, the shift schedule time line does not 
appear when the time scale for the job board is set for weeks and months. 

10.192 Zooming selected profiles 

A section of a profile can be exploded or "zoomed". 

To zoom in: 

· Select the zoom area by moving the mouse pointer to the beginning of the desired 
profile section. 

· Click and hold down the left mouse button while dragging the pointer to the ending 
point of the desired zoom area. Once the ending point is reached, release the left 
mouse button. The area to be zoomed is highlighted in black. 

· The graph area automatically changes to display the desired profile section for all 
displayed profiles. 

To zoom out: 

· Once in a "zoomed" state, click on either the           or         button to resume normal 
mode viewing. 
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11 Glossary 
11.1 Actual multiplier 

Job parameter which defines the number of pieces currently produced per machine cycle. 
The range is from 0 up to the value of the standard multiplier. See also actual shot weight. 

11.2 Actual rate 

The actual number of net pieces (good pieces) produced per hour. The actual rate can be 
calculated over a single shift or an entire job. 

Actual Rate = (net pieces) / (Up Time) 

11.3 Actual setup time 

The actual time it took to set up a job to run on a machine. Setup time is accumulated 
under a machine's down reason #2, which when selected at a DCM usually puts the 
machine into a down state. Actual setup time is displayed in terms of hours and 
minutes (hhh:mm). The range is 0:00 to 500:00. 

11.4 Actual shot weight 

Machine-based parameter which indicates the total amount of plastic currently used to fill a 
single shot. Generally, if the actual multiplier changes on a job, the actual shot weight also 
changes. This field's range is from 0.000 up to the value of the 999999.9. 

11.5 ADC option 

DCM parameter which configures the DCM for 0, 16, or 32 analog channels. A DCM may 
only be configured for analog channels if the optional analog to digital board was purchased 
and installed. Set this value to zero if the unit does not have an A to D card. 

11.6 Administration privilege 

This privilege grants users the ability to edit any user's account and privileges. 

11.7 Analog filter 

Digital filter setting used to reduce noise on an analog channel. 

Filter Value: 
0 = No Filtering 
1 = Light filter, pressure transducers 
2 = Moderate filter, position transducers 
3 = Heavy filter 
4 = Maximum filter, thermocouples 

The recommended maximum value for pressure transducers is 2. The recommended 
maximum value for temperature is 4. 

11.8 Analog inputs 

Analog inputs are electrical inputs that use variable voltages to model changes in real-world 
conditions. 

11.9 Announce flag 
Flag that identifies the down reason, assist reason, machine state, or process variable which 
should be announced. A check mark in the flag field turns on the specified announcement. For 
process variables, the flag identifies which variable should be announced when it exceeds the 
higher or lower limit. For down reasons, assist reasons, and machine states, the flag indicates 
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an announcement should be made when the specified condition exists. To set this flag, click on 
the box associated next to the desired item. 

11.10 Announce machine flag 

If the announce machine flag is checked on the machine announcement window, the 
machine is marked for announcing. 

11.11 Announcement delay 

The amount of time to wait before re-announcing the same message. The range is 1 to 99 
minutes. 

11.12 Assist state 

Selection of an assist reason by an operator at a DCM triggers the assist state for a 
selected machine. 

11.12.1 Assist period 

The number of times (frequency) a machine entered an assist state. Assist periods are 
recorded by specific reason. 

11.12.2 Assist reason 

Specific reasons available to the operator for requesting assistance. Assist time and 
frequency are accumulated for each assist reason. Reason names can be up to 20 
characters in length. 
Sets of assist reasons are a user configurable feature. On keypad DCMs, only the first 9 
characters are displayed. On EL DCMs, the first 7 characters are displayed. 

11.12.3 Assist state colors 

This button's image will change depending upon whether the machine is in the assist state. 
Pressing this button, regardless of the current state, will display the Assist Select page in 
the main frame of the browser screen. 

 

Machine is not currently in the assist state. 

 

Machine is in the assist state. 

11.12.4 Assist time 

The total number of hours an operator waited for assistance at a machine. Assist time is 
recorded by specific reason. Format is hhh:mm. 

11.13 Auto clear flag 

Flag which determines whether the selection of a down reason automatically clears after a 
machine has 3 consecutive up cycles; 
 
If a machine enters a down state by the selection of a specific down reason, and that down 
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reason has the auto clear flag enabled, then the down selection is automatically cleared after 
the machine has been up for three (3) consecutive cycles. Valid choices for this field are 'Yes' 
or 'No'. 

11.14 Auto logout 

When set to 'yes' this setting automatically logs a person out of a DCM at shift change or 
the start of an idle period. 

11.15 Available triggers 

The number of trigger events remaining. This count is based upon the types of process 
variables defined for the displayed machine. The maximum number of trigger events for a 
machine across all process variable source types is 50. 

11.16 Average cycle 

Average of some set of actual machine cycle times. Average cycle is computed several 
ways. The current incomplete cycle is never included. 

Job-to-date Average Cycle (includes current, incomplete shift):  

Average Cycle = (UP TIME for the job) / (UP CYCLES for the job) 

Shift-to-date Average Cycle 

Average Cycle = (UP TIME for the shift) / (UP CYCLES for the shift) 

Moving Average Cycle:  

If cycle window = 0, then 
Average Cycle = AVERAGE CYCLE 

Else 
Average Cycle = (CYCLE TM1 +.. .+ CYCLE TMn) 
/ N where N = cycle window 

The moving average cycle is compared to the standard cycle to determine machine state. A 
machine is slow if the Average Cycle is: 

Average Cycle > (Standard Cycle) + ((Cycle Tolerance) * (Standard Cycle) / 100)  

A machine is fast if the Average Cycle is: 

Average Cycle < (Standard Cycle) - ((Cycle Tol) * (Standard Cycle) / 100) 

11.17 Average value 

Mean value of a process variable. This value can be calculated for the current shift or 
historical shift. 

Average Value = (Total Value) / (Total Cycles) 

11.18 Backup internet path 

The backup path to a communications processor if a redundant network path exists. It is 
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also an alternative path name for the primary internet path, if necessary. This path name 
can be up to 20 characters in length. 

11.19 Base model 

DCM parameter which refers to the model type and/or number of the hardware installed in the 
DCM. 

11.20 Baud 

This field refers to the speed at which information can be transferred through a COM (serial) 
port. It is used for Engel, BetaMux, HPM CMD, JSW uPACS, Maco 4000, Maco 8000, 
CAMAC, Netstal, RKC F900, Square D, Unilog 9000B, A & D Scale, Toshiba and Toyo 
source types. For Toshiba PLCs, the baud rate should be set to 4800. For RKC F900 source 
types, the baud rate should be set to 9600. For MACO 8000 sources, the baud rate should be 
set to 9600. Unilog 9000B sources cannot be set higher than 9600 baud. 

11.21 Bias 

Zero offset used to convert analog and serial inputs or any received value into engineering 
units. Bias and scale are used in the following formula to convert transducer output voltage 
to engineering units. 

Value = (Voltage * Scale) + Bias 

To compute bias, use the following formula: 

Bias = (High Value) - (Scale * (High Voltage)) 

Bias is displayed to 4 decimal places and can be positive or negative. Bias should be 
0.0000 for all time duration variables. For Simulated sources, the bias is applied to the 
simulated signal. 

11.22 Bits 

Configuration parameter which defines the serial interface being used. The bits field consists 
of three parts: 

Data bit - 7 or 8 
Parity - None, Odd or Even 
Stop Bit - 1 or 2 

For Toshiba PLCs, the bits field must be set at 8-even-2. For Engels, the data bit should be 7 
with even parity. For RKC F900 sources, the bits field should be set at 8-None-1. For MACO 
8000 sources, the bits field should be set at 8-None-2. Unilog 9000B sources must be set at 8 
data bits. Stop bits and parity can be selected in the control unit. 

11.23 Block number 

Block number for the process variable being monitored. For valid block numbers, refer to the 
JSW Process Monitoring Parameters to Host Computer of uPACS-5000 & uPACS-5000D 
manual. 

11.24 Boolean set 

This field is the name of the Boolean equation set assigned to a machine. Each machine 
has at least one contact input. This set defines how the system interprets these digital 
inputs. 
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11.25 Boot files 

Binary files distributed with your system which contain software modules used by 
DCMs and communications processor. These files are not used in the RTL/CIM 
style DCMs. 

11.26 Boot set 

A group of boot files defined for a DCM or Communications Processor which are 
downloaded upon coldstart. For a DCM or Communications Processor to function correctly, 
its associated boot set must contain the appropriate boot files for all hardware and software 
options installed. These files are not used in the RTL/CIM style DCMs. 

11.27 Calendar board 

The upper, middle part of the window displays a yearly calendar for the work center and year 
visible in the upper right-hand corner. Each month is divided into weeks. One block 
represents one week of the month, with the first Monday of each week displayed. Each block 
is color-coded. The color represents the work schedule in effect for that week. The color code 
is set in the Weekly Schedules field. 

11.28 CAMAC address 

This field is primarily used with CAMAC source types. It refers to a machine address. For 
VLC controllers, this address is set at the VLC panel. For VSX controllers, this address is 
set at the VSX panel. For XTL controllers, this address is set at the XTL panel. For 486 
controllers, this address is set at the 486 panel. For most CAMAC sources, it is usually set 
to 1. 

11.29 Case sensitive matching 

Searching methods are used on the Job Schedule and Job Schedule Search windows to 
quickly find jobs and work orders. The case sensitive matching distinguishes between upper 
and lower case when doing searches. For example, searches for the word "BATTERY' are 
not the same as searches for the word "battery". If case sensitive matching is not turned on, 
then case is ignored. The words "BATTERY" and "battery" are considered the same. 
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11.30 Channel 

Hardware path on which a DCM receives process variable and profile data. For analog 
channel and thermocouple source types, the channel field refers to the analog channel 
where the input signal is physically connected. The channel must match the analog channel 
number (inside the DCM) where this input is connected. For Engels, this field refers to the 
valid channel number for the Engel group being used. For simulated source types, the 
channel field refers to the type of signal to be simulated. For BetaMux sources, the channel 
field refers to the channel on the Gage Multiplexer which is currently selected. 

11.31 Child count 

The number of child jobs that are associated with a particular job. This value may range 
from 1 to 12. 

NOTE: A job with a child count of 1 is considered to be a non-family job. 

11.32 Child job 

A child job represents a sub-section of a multi-part job. This can be a particular cavity type 
in a multi- cavity mold, or a particular die in a multi-die press operation. The number of child 
jobs (child count) may range from 1 to 12. 

NOTE: A one child job is not valid. When creating a work order or product standard, jobs 
with only one child job cannot be saved. You will be prompted to either add another child 
job or remove the current child job before saving. 

11.33 Column number 

The column number which corresponds to the process variable being monitored; Column 
numbers refer to the location of the process variable within a Unilog 9000B output table. 
Output tables can be customized so refer to your site's output file format. 

11.34 Comm port 

A serial port used to communicate with an exterior device. 

11.35 Comm option 

DCM parameter which refers to the number of communication ports available on the DCM. 
Set this value to 5 if the optional 4 port serial card was purchased and installed. 

11.36 Comment 

Parameter used for general descriptive text. The comment field can be up to 50 characters 
in length. In terms of job scheduling, this field is used by PlantStar to report an error if a 
failure occurs. 

11.37 Communications processor 

Communications processors create a link between DCMs on the production floor and the 
system's host computer. The "cp" ensures proper message routing and control between the 
shop floor network and the TCP/IP network. The Communications processor field is an 
alphanumeric that can be up to 20 characters in length. Only the first 6 characters will be 
sent down to the attached DCM. 

At least one communications processor must, therefore, be defined for the shop floor. A 
communications processor can be linked to many DCMs, although a DCM must have one 
and only one associated communications processor. Changes made to a communications 
processor setup can affect each of its attached DCMs. In the case of the RTL-based DCM, 
each RTL-DCM will also be its own Communications Processor and therefore there will be a 
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Communications Processor defined for each DCM. 
 
The Communications processor should be one of the first elements of the shop floor which is 
defined. 
 
Recommended steps are: 

1.) Create Boot Sets. These files are not used in the RTL/CIM style DCMs. 
2.) Configure the communications processor 
3.) Create Reason Sets  
4.) Create Work Centers  
5.) Configure DCMs  
6.) Configure Machines  
7.) Configure process variables on each machine if option purchased 
8.) Configure profiles on each machine if option purchased 
9.) Define display groups  

11.38 Component percent 

Product-based parameter indicating the percentage, by weight, of raw material used to 
produce a product on a job. The total component percent for all materials used on one job 
should equal 100. If there is only one material assigned for a job, then the component 
percent is automatically set to 100. The range is 0.0 to 200.0. 

11.39 Contact duration 

Contact refers to the digital equation name or the number of the contact input used to 
measure duration. The duration is the amount of time that this input remains closed. Up to 
20 characters are available. 

11.40 Contact input 

A digital input used to mark the occurance of an exterior event. Contact input #1 is always 
the cycle event of the machine. 

11.41 CONV_VEC# 

This field is primarily used for CAMAC VSX source types. The CONV_VEC number refers 
to the location of the data to be monitored. Refer to the CAMAC Host Computer 
Information Manual to select the correct CONV_VEC number. Type in the number 
corresponding to the appropriate description. 

11.42 Convert index 

This field refers to the conversion index to be used for correct scaling of a monitored item. It is 
used with CAMAC and Netstal process variables. For Netstal source types, refer to the Netstal 
PLC Interface Table to select the desired index. 
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11.43 Cost per hour 

This field associates a dollar value to a labor category. This value is then used in labor 
forecasting to estimate job costs. 

11.44 Cp 

Capability Index which indicates how well a process can do if it is centered midway between 
the defined specification limits. The index is the ratio of the specification range to the process 
capacity. In PlantStar, the CP is calculated only over the range of subgroups that are 
currently displayed on a window's graph. 

Cp = (Upper Spec - Lower Spec) / (6 * Standard Deviation) 

11.45 Cpk 

Index which reflects the relative probability of making a part outside of defined specification 
limits -- i.e. the expected level of defects for a given part. In PlantStar, the Cpk is calculated 
only over the range of subgroups that are currently displayed on a window's graph. The 
calculation is: 

Min ((X-bar Mean - Lower Spec), (Upper Spec - X-bar Mean)) 

3* Standard Deviation 

11.46 Critical process variable 

When a critical process variable falls outside of its defined limits, a critical process exception is 
flagged. This flag can be used in digital equations to close an output contact or activate a light. 

11.47 Current job 

The job that is currently running on a machine. The current job is the first job listed on 
the job schedule for each machine. 

11.48 Current shift 

The shift that is currently running, as defined in the Shift Schedule window. 

11.49 Currently running jobs privilege 

This privilege gives users the ability to edit job parameters for currently-running jobs 
from the Job Schedule or Edit Current Job windows within the PlantStar Monitor 
program. 

11.50 CV 

Abbreviation for Coefficient of Variation. This statistic is a measurement of precision that 
does not depend upon any scale of measurement. In PlantStar, the CV is calculated only 
over the range of subgroups that are currently displayed on a window's graph. 

11.51 Cycle time 

The measured length of time between consecutive closures of the primary contact. For 
production data, cycle time is recorded to one tenth of a second and must be in the range of 
0.5 sec to 248 days. For process data, cycle time has a selectable range and accuracy up 
to one hundredth of a second. 

11.52 Cycle tolerance 

Parameter indicating the percent deviation from standard cycle time that is normal for a 
job. See average cycle for a complete description. The range is 0.0 to 100.0 percent. 
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11.53 Cycle window 

Product-based parameter defining the number of cycles used to compute average cycle 
time. Cycle window can be set from 0 to 50. See average cycle for a complete description. 

11.54 Data number 

The data number refers to the item to be monitored for Toshiba source types. Refer to the 
Toshiba PLC Information manual to select the item to be monitored. Type in the number 
corresponding to the appropriate description. 

11.55 Date range scheduled usage 

The Date Range Scheduled Usage is the scheduled machine usage during the given 
date range. 

The date range is "12:00:00am" on the start date to "11:59:59pm" of the end date. 

· To change the date range, type in a beginning or end date from which to search. 
· Date format is in the form of "dd mmm yyyy" (i.e. "01 Jan 2003"). 

11.56 Date range usage 

The Date Range Scheduled Usage is the machine usage during the given date range. 

The date range is "12:00:00am" on the start date to "11:59:59pm" of the end date. 

· To change the date range, type in a beginning or end date from which to search. 
· Date format is in the form of "dd mmm yyyy" (i.e. "01 Jan 2003"). 

11.57 DCM 

A Data Collection Module (DCM) describes the physical microprocessor-controlled unit which 
is attached to a machine or group of machines. The DCM collects and monitors Real-Time 
data such as machine state, rejected parts, and process variable values. This data is 
transferred to the host database for display. 

The DCM also provides an interface for the machine operator through either a Keypad (KP) 
or Electroluminescent/Touch Screen (EL/TS) display, TouchPanel display (RTL-DCM), or 
browser based interface. These options enable manipulation and/or viewing of various 
machine operations. 

DCMs are self-contained units. The DCM can operate independently of the host computer for 
some period of time by maintaining its own copy of job queues and historical production 
records in battery backed RAM. Some DCM configurations have communications processor 
functionality built in and do not require a physical, external communications processor. This 
includes all RTL-DCM type modules. 

The DCM browser interface is available from any networked computer that has an 
appropriate web browser installed. 

11.58 DCM base address 

This address is the name of the base address of the DCM, which is a combination of the 
communications processor and the address of the DCM. This value must match the address 
entered at the DCM unit. Valid values are 1 through 250. 

For RTL type DCM’s the base address is automatically set to 1 and cannot be changed. 

11.59 Debounce 
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Number of ticks (1 tick = 1 tenth of a second) that a signal change will be ignored so that 
bounce can be eliminated. This is used primarily to reduce false signals generated by line 
noise. 

11.60 Decimals 

Specifies where to put the decimal point in a sampled value prior to applying a scale factor 
and bias. For example, when the implied decimal position = 3, the inputs 0.4102, 0.410 and 
0.41 are interpreted as 0.410. Valid decimal positions can be from 0 to 4. 

For Netstal source types, the decimal value for the desired Parameter Number and 
Convert Index must be obtained from Netstal's PLC Interface Table. 
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Netstal PLC Interface Table 

S19 4 0 1.00 1 

S11 5 0 1.00 1 
T11 6 3 1.00 1 
T02 7 3 1.00 1 
T34 8 3 1.00 1 
S00 9 0 1.00 1 
T21 10 3 1.00 1 
TH11 11 2 1.00 0 
TH12 12 2 1.00 0 
TH13 13 2 1.00 0 
TH15 14 2 1.00 0 
TH16 15 2 1.00 0 
TH17 16 2 1.00 0 
TH25 17 2 1.00 0 
TH26 18 2 1.00 0 
P21 19 0 1.00 0 
P22 20 0 1.00 0 
P23 21 0 1.00 0 
P24 22 0 1.00 0 
N21 23 2 1.00 0 
N22 24 2 1.00 0 
N23 25 2 1.00 0 
N24 26 2 1.00 0 
V01 27 2 1.00 0 
V02 28 2 1.00 0 
V03 29 2 1.00 0 
V04 30 2 1.00 0 
V05 31 2 1.00 0 
S01 32 2 1.00 1 
S02 33 2 1.00 1 
S03 34 2 1.00 1 
S04 35 2 1.00 1 
S05 36 2 1.00 1 
P12 37 3 10.00 0 
P13 38 3 10.00 0 
P14 39 3 10.00 0 
P15 40 3 10.00 0 
T12 41 3 1.00 1 
T13 42 3 1.00 1 
T14 43 3 1.00 1 
T15 44 3 1.00 1 
T39 45 3 1.00 1 
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11.61 Delay Timer 

The delay timer is used at the DCM in the Material Lot screen to specify the amount of time 
in minutes that should elapse before a raw material change is to take effect on a job. The 
default timer value is set to zero. 

The timer does not begin counting down until the "RUN" button is pressed on the Material 
Lot screen. A material change goes into effect when the timer value counts down to zero. 
The "PAUSE" button can be used to temporarily stop the timer count down. When the time 
expires, the current materials are replaced with the new materials and the event will be 
recorded in the audit trail. 

11.62 Derivative 

Order of the derivative taken, with respect to time, of a profile channel. The first order 
derivative of a position channel would result in a velocity profile. The second order 
derivative would result in an acceleration profile. Select "none" if you do not want a 
derivative. 

11.63 Derivative smoothing 

This is the size of the smoothing window used by the derivative algorithm. Values range from 
1 to 8. A value of 1 gives a simple, point-to-point difference. A value of 8 gives maximum 
noise damping, but also damps rapid (real) signal changes. Values of 2 or 3 are 
recommended. 

11.64 Descriptor 

The parameter descriptor of the Maco-8000 source type; 

11.65 Device address 

Unique address of the unit being accessed; for Square D source types, the device address 
refers to the unique address of the target Circuit Monitor. For RKC F900 sources, the device 
address must be set to the 485 physical address and must match the address set on the 
F900. Addresses are numeric integers. 

11.66 Digital inputs 

Electrical inputs that have two-states, high and low, to model changes in real-world 
conditions. 

11.67 Display group 

A user-defined group of machines used to filter monitoring information on Monitor 
windows. A machine can belong to any number of display groups. Each machine within 
a display group must belong to the same work center. 
 
Display groups are used as a way to customize what machines are shown on all monitoring 
and historical windows. All machines that are attached to an enabled DCM are monitored. A 
machine may not appear on a window, though, if it is not in the selected display group. Each 
time a different display group is selected, the choice of machines offered by a window also 
changes. 

A machine can belong to more than one display group. An All display group exists even if 
no display groups have ever been defined. This display group includes all defined 
machines. It is automatically set up by the Shop Floor Configuration program. It cannot be 
modified or deleted. 

11.68 Display option 
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DCM parameter which refers to the type of DCM display. If an optional electro-luminescent 
touch screen was purchased, choose EL/TS. Choices for RTL based DCMs are 10", 12", 15" 
touch screens and none for a blind CIM. 

11.69 Display type 

The particular display type that has been installed on the DCM. The range of values 
varies with the particular model type of the DCM. 

11.70 Down state 

A machine enters a down state when its current cycle time exceeds its established down 
threshold. The down state ends when the current cycle time is once again less than the 
down threshold 

The down state can also be entered if the operator selects a down reason which is 
configured to force a machine down. 

11.70.1 Down cycles 

Number of machine cycles counted while the machine is in a down state. A machine is 
considered down whenever its cycle time is above the down threshold. 

11.70.2 Down period 

The number of times a machine has entered the down state. Down Frequency is recorded by 
specific reason. 

11.70.3 Down reason 

Specific reasons available to the operator for classifying down time. Down time and down 
frequency are accumulated for each down reason. Reason names can be up to 20 characters 
in length.  Sets of down reasons are a user configurable feature. On keypad DCMs, only the 
first 9 characters are displayed. On EL DCMs, the first 7 characters are displayed. On 
browser screens only the first 10 characters are displayed. 

11.70.4 Down state colors 

This button's image will change depending upon whether the machine is down, or if a down 
reason is selected. Pressing this button, regardless of the current state, will display the Down 
Select page in the main frame of the browser screen. 

 

Machine is not currently down. 

 

Machine is either down with no reason selected, or running with a reason selected. 
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Machine is down and a reason has been selected. 

11.70.5 Down threshold 

Machine-based parameter which determines when a machine is considered down. Set this 
to a value greater than the cycle time. When the cycle time of a machine exceeds the down 
threshold, the machine is classified as down. The machine continues in the down state until 
it completes a cycle below the down threshold. The range is 0.5 to 3276.7 seconds. 

11.70.6 Down time 

The total number of hours a machine has been in the down state. Down time is recorded by 
specific reason. 

11.71 Drag and drop options 
Determines what happens when a job or work order is moved from one machine to another 
machine on the Job Schedule window. The option selected as the default is automatically 
enforced. To activate the other option on the Job Schedule window, use the "drag/drop 
method" in conjunction with the SHIFT key. 
 

· Keep the standard of the original machine - Each queued job or work order has its own 
set of product-related and machine-related job parameters. When a job or work order is 
re-scheduled from one machine to another, these parameters move with them. If this 
method is the default, then all job parameters are based upon the originating machine. 
They are not modified to accomodate the new machine. 

 
· Use the standard of the new machine - When this method is used as the default for 

moving jobs or work orders, machine-related job parameters are verified. If the 
destination machine has different values for any of the machine-related parameters, 
they are replaced. For example, the originating machine's standard cycle is 30 seconds. 
The destination machine's standard cycle is 15 seconds. The standard cycle parameter 
for the re-scheduled job is automatically changed from 30 to 15. 

11.72 Duration 

The length of time in seconds that a profile will be collected. The sum of the trigger delay 
and the duration must be less than the cycle time. Up to 1000 samples can be taken 
during a collection period. 
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11.73 Element number 

Allen Bradley data table files contain multiple elements. The element number identifies which 
element corresponds to the process variable being defined. 

11.74 Embedded matching 

Searching methods are used on the Job Schedule and Job Schedule Search windows to 
quickly find jobs and work orders. The embedded matching search method finds jobs or work 
orders that have the specified string of characters somewhere in the name. For example, if 
the letters "an" were entered in the product name field on the Job Schedule Search window, 
PlantStar would find the following: 

· flange 
· handle 
· ankle brace 
· paint can 

11.75 Employee id 

A unique numeric code used to identify an employee. 

11.76 Employee name 

A name that corresponds to a selected employee id. This field is 30 characters and may 
contain letters and numbers. 

11.77 End date 

Precise time at which the system stopped monitoring the task selected. End date is 
formatted as dd/mmm/yy. 

11.78 End time 

Precise time at which the system stopped monitoring the task selected. End time is 
formatted as dd/mmm/yy hh:mm. 

11.79 Estimated completion time 

Time estimated to finish a job. The job is complete when total net pieces for the job equals the 
pieces required. The estimated completion time is computed using the shift schedule and 
hours to go to determine the estimated date and time the job will end. 

If the shift schedule does not include any idle period, the estimated completion time would be: 

· Estimated Completion Time = Current Date and Time + Hours to Go  

If the shift schedule does include idle periods, the estimated completion time would be: 

· Estimated Completion Time = Current Time + Hours to Go + Scheduled Idle Time  
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11.80 Event type 

The type of event to display on the window. Events types are: 

· Job 
· Shift 
· Down state  
· Assist state  
· Process exception  

· Employee login and logout 
· Material  

To select an event type, click on the arrow to the right of the Event field. Slide the mouse 
down to the desired event type and click again. 

11.81 Exact matching 

Searching methods are used on the Job Schedule Board's search windows to quickly find 
jobs and work orders. The exact matching search method finds jobs or work orders that 
exactly match the specific string of characters entered. For example, if the product name 
"battery" is entered as a search string, PlantStar would find jobs where the product name is 
"battery". 

11.82 Exception state 

The exception state (or alternately machine state) of a machine is determined by a set of 
exception flags. Each flag indicates one possible exception condition. The exception flags 
are prioritized as follows: 

Most windows show the machine state as the highest priority exception flag which is true. 
Use the Machine Status window to see all exception flags for a machine. 

11.83 Exception time 

The time of day when an exception state was entered. The time is displayed in an hh:mm 
format if it happened within 24 hours. If it happened greater than 24 hours ago, the exact 
day is displayed. 

11.84 Excess material 

The amount of material wasted on a job. If runners and scrap are re-fed on a job, the amount 
of excess material is equal to zero. Otherwise, excess material calculations are based upon 
reject weight or shot size. 

11.85 Exit privilege 

The exit privilege lets a user leave a PlantStar program and return to the Window's desktop. 

11.86 Extended down and reject reasons 

An extended down and reject reason option can be purchased from PlantStar. This will 
extend the down and reject limit to one hundred sixty (160) reasons for each set. 

11.87 Family job 

A job that has two or more child jobs associated with it. 

11.88 Fast state 

The fast, slow, and standard machine states are basic indicators of machine performance. 
For each machine cycle, the cycle tolerance is monitored. The tolerance is the percent 
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deviation of a job from its normal standard cycle time. An average cycle is computed and a 
comparison is made using the cycle tolerance and standard cycle values. If the average 
cycle is less than the resultant value, the machine is considered fast. 

11.89 File number 

The identification number of the Allen Bradley data table file. Only whole numbers are 
acceptable. 

11.90 File type 

One character abbreviation which identifies the format of the data stored in an Allen Bradley 
data table file; Examples are N for integer values or F for floating point values. 

11.91 FN code 

Function Number for the Maco-4000; MACO 4000 functions are identified as follows: 

01H Sequence 
02H Temperature 
03H Hydraulic 
20H Display Handler 
25H Display Processor 
26H Cartridge 
27H Communications Processor 
28H Keyboard Processor 
30H RS-232 Communications 
38H RS-485 Communications 
40H Data Handler 

11.92 Force down flag 

Flag which determines if a down reason forces the machine into a down state. While in 
this forced down state, a machine's attached DCM continues to count parts and monitor 
process variables. All time is accumulated as down time. The machine appears in a down 
state regardless of its actual cycle time. 

11.93 Force scrap flag 

A down reason may be associated with a reject reason via the Force Scrap flag. Valid 
choices for this field are either "No" or the reason index of a reject reason (as defined on the 
Reject Reason Sets window). If a reject reason index is entered, parts are automatically 
rejected and accumulate under the associated reject category. For example, if the Force 
Scrap flag is set to 5 for down reason #2, then whenever down reason number 2 is selected, 
all parts are rejected and accumulate under reject reason #5. 
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11.94 Forecast interval 

The forecast interval field restricts the number of jobs displayed on the Tool Change window 
to those that are estimated to be completed by the selected interval. For example, if the "1 
day" interval is chosen, jobs that are estimated to be completed within 1 day from "now" are 
listed in the table. 

11.95 Forecast types 

Forecast types are used to determine the effect a labor category has on the job to which it 
was assigned. There are two forecast types: setup and production. Setup forecast types 
will only be used during the setup time that was assigned to the job. Production forecast 
types will be used only during the rest of the job, that falls outside of the jobs initial setup 
portion. 

11.96 Free text 

Parameter which contains user-designated information. The PlantStar system provides you 
with up to four customizable fields. The titles of the free text fields can be set up from the 
User Defined Labels window. 
 
The free text fields are also available as descriptive fields for bar coded tote labels. Bar 
code labels are printed in conformance with the AIAG bar code standard. Each free text 
field can be up to 20 characters in length. 

11.97 Full access privilege 

If the Full Access box is checked, a user can add, delete and edit any PlantStar window 
and its information associated with the checked privilege (the privilege located on the 
same row as the Full Access box). 

11.98 Gain 

Multiplier used to amplify or extend the range of an analog signal. Always use the largest 
gain which will keep the signal within the 0 to 10V input range. For example, if a transducer 
generates a 0 - 30 mV signal, use a gain of 300 to amplify the input signal to 0 - 9V for 
digitizing. For simulated sources, the gain is applied to the simulated signal. 

Standard gain factors are 1, 2, 3, 10, 20, 30, 100, 200, and 300. 

11.99 Gross pieces 

The number of total pieces produced on a job, including both net and rejected pieces. 

11.100 High value 

The highest value recorded for a process variable during the current shift. 

11.101 Higher limit 

Highest value of a process or profile variable that is normal for the current job. If a process 
or profile variable exceeds its high threshold, the machine will be in process exception for 
that cycle. 

11.102 Historical job 

A job which has been completed and whose data is available for analysis. 

11.103 Historical shift 

A shift that has been completed and whose data is available for analysis. 

11.104 Hours to go 
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Total hours and minutes estimated to finish a job. The job is complete when total net pieces 
for the job equals the pieces required. Before 5% of the pieces required have been made, 
Hours To Go is calculated as follows: 

Hours to Go = Remaining Setup Time + ((Pieces to Go) / (Standard Rate))  

After 5% of the pieces required have been made, the following formula is 
used:  

Hours to Go = (Pieces to Go) / (Actual Rate) 

For maintenance jobs, Hours To Go is equal to the actual setup time remaining. 

NOTE: If the job scheduled is a family job, the Hours to go will indicate the expected run 
time of the longest running child job. 

11.105 Hours worked 

The total number of hours an employee worked. This is the difference between the 
employee's start and end time. 

11.106 HTML 

Hyper-Text Markup Language – This is the language that web pages are written in. 
They are displayable in a web browser. 

11.107 Identifier 

A three character identification which is associated with a process variable; For HPM CMD 
sources, a list of standard identifiers is available from the HPM CMD manual. For RKC F900 
sources, identifiers are user-defined. 

11.108 Idle period 

The time when the machines are not scheduled to operate. During an idle period, the DCM 
ignores all inputs from the machine. Only idle time will be accumulated. 

11.109 Idle state 

A machine is considered idle if it is following a shift schedule that has an idle period defined 
or if its job is set to idle. A job is idle if its job parameters -- schedule factory and schedule 
now -- are both set to "NO". 

11.110 Idle time 

The time that is accumulated while a machine is idle. See Idle Period. 

11.111 Ignore cycle flag 

Flag which determines whether a DCM ignores the primary contact when in a forced down 
state. 

If a machine is in a forced down state (as set by the Force Down flag), and the Ignore Cycle 
flag is set to "Yes", a machine's attached DCM stops counting parts and monitoring process 
variables. Monitoring is resumed only when the machine exits the down state. 

11.112 Index number (JSW source type) 

Index number within the block which identifies the process variable being monitored; For 
valid index numbers, refer to the JSW Process Monitoring Parameters to Host Computer of 
uPACS-5000 & uPACS-5000D manual. 
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10.113 International support 

 

 

PlantStar uses the Windows regional settings to define valid input on date, currency and 
decimal input controls. All displays and reports will also use the regional settings of the 
computer they are currently running on. Please see the available settings by going to contol 
panel->Regional and Language Options and clicking the customize button. The screen is 
displayed above. 

11.114 IP address 

Logical ethernet/internet address -- this address can be a logical name or in dotted quad 
notation (192.168.100.100). 

11.115 Isolated A to D 

When checked the RIO's boot set will contain the files necessary for use with an isolated 
analog to digital converter card. 

11.116 Job 

A fully specified set of job parameters for monitoring the production of a specific quantity of 
a specific product. The general term "job" is used to describe the current job running on a 
machine, a queued job or a work order. 

11.116.1 Job board 



Glossary 301 

 

 

Displays the current job queues for all machines within a selected display group. Each row 
represents a machine's job queue and each rectangular block is a scheduled job. The first 
rectangular block on each machine is its active job. The remaining jobs form a linear list of 
jobs waiting to be run on the machine. The block length indicates the expected run time for 
the job. Green rectangular blocks indicate that a job is estimated to complete on time. Red 
and orange blocks indicate late completion times. 

11.116.2 Job changes 

Number of times a new job has been started, on the selected machine, during the given time 
period. 

11.116.3 Job history size 

DCM parameter which sets the number of job change records which should be stored locally 
at the DCM. All DCMs have the capability for local data storage. This capability allows the 
DCM to hold data while the host computer is either down or busy -- minimizing data loss. It is 
recommended that the history sizes be set so that three days of history be stored locally. If 
the DCM is in communication with the host then these histories are not used. 

11.116.4 Job key 

Selects existing product standards based upon the entered job name. Partial or complete 
searches can be done. 

NOTE: As of PlantStar v4.10, this search no longer requires the key fields to match the 
case of the expected result. In other words, the search is no longer case sensitive. 

11.116.5 Job name 

A user-defined name that identifies a current job, queued job, work order, or product 
standard. Job name is an alphanumeric string of up to 20 characters. 

11.116.6 Job parameters 

Refers to a collection of parameters which define how to monitor performance and progress 
for a job on a specific machine. Job parameters are made up of product-specific and 
machine-specific information. 

11.116.7 Job primary label 

Determines how the Job Schedule Window displays jobs on its scheduling chart. Jobs 
are either identified by job name or by product name. 

11.116.8 Job start time 

Precise time at which the system started to monitor a job on a machine. Start time is 
formatted as dd/mmm/yy hh:mm. 

11.116.9 Job-to-date 

The data available for a current job from the time that is was started to the present time. 

11.117 Job queue 

A linear list of jobs that are scheduled for a machine. This list does not include the current 
job. The first queue position holds the next job to be run on the machine. 

11.118 Job queue size 

Parameter which sets the size of the DCM's local job queue. There are two “job queue size” 
parameters within your system. This queue size determines the number of jobs that a DCM 
operator can view or start at the DCM. 

The second job queue size parameter is the one defined for the host computer (currently set 
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to 100). It is not editable. 

11.119 Job Summary - graph view 
 

 

The Graph View displays a graph of the selected column in the grid view. There is one 
vertical bar per shift. Bar height represents the column selected. 

11.120 Job Summary - grid view 

 

 

The first row of the table provides shift-to-date information for the current shift and job. The 
middle rows display shift data for up to four completed shifts, depending upon how long a job 
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has been running. The next row provides shift totals for the last four shifts available. Job-to-
date totals for all columns are then calculated in the last row of the table. The color of the 
window background reflects the machine's running state. 

11.121 Labor category 
Labor categories which one or more can be assigned to an employee. 
The PlantStar system provides up to 30 of these customizable fields. The names of the labor 
categories can be set up from the Labor Setup window. When an employee attempts to login, 
they are presented with a list which consist only of the categories to which they have been 
assigned. Employee Labor categories are user-defined employee-Labor Category definitions 
are also defined in the Labor Setup window. 

11.122 Labor data privilege 

Allows this user to view/modify data contained in the Labor Definition Screen. 

11.123 Labor Forecast - graph view 
 

 

The Labor Forecast window is used to accurately forecast, by work center and shift, the 
number of employees needed in a given Labor Category. This forecast is based on current 
jobs and queued jobs scheduled. 

11.124 Labor Forecast - grid view 
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The Labor Forecast window is used to accurately forecast, by work center and shift, the 
number of employees needed in a given Labor Category. This forecast is based on current 
jobs and queued jobs scheduled. 

11.125 Labor history size 

DCM parameter which sets the number of labor history records which should be stored 
locally at the DCM. All DCMs have the capability for local data storage. This capability 
allows the DCM to hold data while the host computer is either down or busy -- minimizing 
data loss. It is recommended that at least three days of history be stored locally. 

11.126 Language 

The language option allows the users to select their language preference. 

11.127 Last value 

The process variable measurement taken during the most recent completed cycle. 

11.128 Left matching 

Searching methods that are used on the Job Schedule and Job Schedule search windows 
to quickly find jobs and work orders. The left matching search method finds jobs or work 
orders that start with a specific string of characters. For example, if the product name 
"battery" is entered as a search string, PlantStar would find the following: 

· battery 

· battery clip 
· battery housing 

If the word "batter" was entered, the left searching method would also find "batteries" in 
addition to the matches above. 
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11.129 Linearization type 

Indicates the type of linearization which is required to condition an analog input channel for 
use as a process variable. Most commonly used to linearize thermocouple inputs. 
However, other non-linear transducers may require a linearization type. 

For pseudo variables, the linearization type may be: 
· the maximum value 
· time that the maximum value occurred 
· the minimum value 
· the time that the minimum value occurred 
· the range (max - min) 
· the mean value 
· the average of the selected profile 
· a value range. 

For thermocouples, the linearization type refers to the type of thermocouple that is 
connected to the DCM. 

If your input device is, a pressure transducer, linear potentiometer or any other linear 
device, select linear transducer. The Newport8005 dewpoint option is a non-linear device 
which is designed to monitor compressed air and plastic air drying systems. 

11.130 Login privilege 

This privilege gives a user access to the PlantStar Monitor, PlantStar Shop 
Configuration, and PlantStar Reports programs. 

11.131 Lot end time 

The time when an active Material Lot ID was either replaced with another lot ID or 
one of the material components changed within the material formula. 

11.132 Lot start time 

The time when a Material Lot ID was entered at the DCM through a bar code reader or a 
touch screen. The start time is recorded upon the expiration of the DCM-entered lot delay 
period. 

11.133 Low value 

The lowest value recorded for a process variable during the current shift. 

11.134 Lower limit 

If a process or profile variable is below its lower limit, the machine will be in process 
exception for that cycle. 

11.135 Lower spec 

The lower control limit assigned to a process variable. When this limit is exceeded the 
machine will enter a process exception state. 

11.136 Machine 

The machine on the shop floor that is being monitored. Each DCM may monitor one or 
more machines. The machine name can be up to 8 characters in length. The name can 
include numbers and characters. 

A machine setup describes the connection of a DCM to a machine on the factory floor. Every 
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machine must 

· have one and only one associated DCM, 

· have a set of down reasons, assist reasons, and reject reasons, 
· be defined, if it is to be monitored, 
· belong to one and only one work center  

The work center in which the machine belongs is important. A machine follows the shift 
schedule of its work center. Scheduling of jobs is done by work center. 

There are several important points that need to be explained about creating and deleting 
machines. Once a machine is created, it is considered the same machine until it is deleted. 
Even if it undergoes a name change, it is still considered the same machine. Once a machine 
has been deleted, the same machine can never exist again. If a new machine is created with 
the same name, it is not considered the same machine. Because of this rule within PlantStar, 
a machine with historical production records should be deleted only if it is to be permanently 
removed from the system. If its future is uncertain, the machine should not be deleted. It 
should be disabled so that it can be reactivated later. 

11.136.1 Machine cycle 

The time duration between closures of the primary contact inputs. The elapsed time is 
measured and identified as cycle time. Window displays are normally updated at least once 
per machine cycle. 

11.136.2 Machine index 

This field is the index of the machine on a DCM. On multiple machine DCMs, this number 
may be as high as 16. For example, a DCM-4 has indices 1 through 4. A single machine 
DCM (DCM-1) has an index of 1. 

11.136.3 Machine parameter 

Refers to a collection of parameters which define how to monitor performance and 
progress for a job on a specific machine. Examples of machine parameters are standard 
cycle, down threshold, and refeed runners. 

11.136.4 Machine running state 

Fast, slow or standard running state. 

11.136.5 Machine state 

The status of how a machine is performing. See the exception state definition for more 
complete details. 

11.136.6 Machine state colors 

All monitoring windows display the state of a machine by color. On machine-specific 
windows, the background color of the window represents the machine state. Monitoring 
windows which list multiple machines displays the machine state for each machine by the 
color of the name’s background. On DCMs, the colored lights represent the machine states. 

A machine's state is determined by a set of exception flags. Each flag indicates one possible 
exception condition. The following table lists each machine state and its associated color. The 
highest priority state determines the color displayed. The states are listed below in order of 
priority, with the highest of importance listed first. 

 



Glossary 307 

 

 

 

A machine can be in one or more states at a time. It can have a process or production 
exception and be in the assist state. Process and production exception states can also co-
exist on the same machine at the same time. The following list provides a general overview of 
machine states and their relationships to each other. 

· The off-line state is mutually exclusive from all other machine states. 
· If a machine is idle, all other states, except off-line, are excluded. 
· If a machine is down, it can still be in assist or have a process and/or production 

exception. 

· A machine can be fast, slow, standard, or down. 

Other combinations not specifically mentioned above are possible. 
 
There are many ways that machines can enter or exit a certain state. Selection of an assist 
reason by an operator at a DCM triggers the respective state for the selected machine. 
Process exceptions occur when a process variable measurement is outside of an assigned 
limit, either high or low. A machine can go in or out of a process exception state with each 
new cycle value. 
 
Production exceptions occur when a machine's “pieces to go” is negative (too many pieces 
have been made) or when its job-to-date percent rejects is greater than its reject threshold for 
the current job. Once these two relationships are no longer true, a machine exits the 
production exception state. 
 
There are two ways a machine can enter an idle state. A machine becomes idle if it is 
following a shift schedule that has an idle period defined. For the duration of the idle period, 
the machine is classified as idle. The second way a machine can become idle is by 
suspending its job. To suspend a job, set the job parameters Schedule Now and Schedule 
Factory both to No. The idle state stays in effect until these job parameters are changed. 

The down state is entered when the average cycle time exceeds the down threshold. The 
down state ends when the average cycle time is once again less than the down threshold. 
The down state can also be entered if the operator selects a down reason which is 
configured to force a machine down. 

The fast, slow, and standard machine states are basic indicators of machine performance. 
For each machine cycle, the cycle tolerance is monitored. The tolerance is the percent 
deviation of a job from its normal standard cycle time. An average cycle is computed and a 
comparison is made using the cycle tolerance and standard cycle values. If the average 
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cycle is greater than the resultant value, the machine is considered to be running slow. If the 
average cycle is less than the resultant value, the machine is considered fast. 

Moving Average Cycle  

The moving average cycle is compared to the standard cycle to determine the fast state/slow 
state of a machine. 

The machine is slow if: 

(Average Cycle) > (Standard Cycle) + ((Cycle Tolerance) * (Standard Cycle) /1 00) 

The machine is fast if: 

(Average Cycle) < (Standard Cycle) - ((Cycle Tolerance) * (Standard Cycle) /1 00) 

The "Your System" Icon  

When your system is iconized, the icon            displays on the bottom of the workstation 
monitor. The top three circles signal exception states for any machine listed on an open 
window. For example, if you open the Machine Performance window and then iconize your 
system, the icon blinks if one of the machines displayed on the window goes into exception. 
Exceptions displayed from the icon are down, assist, production exception, and process 
exception. 

11.136.7 Machine usage 

A percentage indicator of how much the machine was up during the given time period. This 
statistic is calculated for an entire job or a single shift. 

Machine Usage = (Up Time) / (Up Time + Down Time + Idle Time) 

11.137 Maintenance job 

A non-production job which has the job parameters with pieces required = 0 and its standard 
rate = 0. The standard setup time for the job is used to define the duration of the 
maintenance job. The "Setup" down reason (reason #2) should be selected on the DCM for 
the entire duration of the job so that actual setup time can be measured and compared to 
standard setup time. 
 
For maintenance jobs, estimated completion time is equal to the actual setup time remaining. 

11.138 Manning factor 

Manning Factors are a numeric representation of man hours required per shift, for a 
selected job. Manning Factors can be added to product standards, work orders, queued 
jobs or currently running jobs. The manning factors assigned to jobs are used in the 
Labor Forecasting window to generate the labor requirements, by shift, for each labor 
category. 

11.139 Material component 

Parameter which indicates the name of a raw material. All material components must be 
assigned a component percent. Lot IDs can be assigned to material components at the 
DCM. A material name can be up to 20 characters in length. 

11.139.1 Material formula 

The material components that make up a particular material. Material formulas may contain 
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from 1 to 4 components. 

11.139.2 Material lot history size 

DCM parameter which sets the number of material lot history records which should be stored 
locally at the DCM. All DCMs have the capability for local data storage. This capability allows 
the DCM to hold data while the host computer is either down or busy -- minimizing data loss. 
It is recommended that around three days of history be stored locally. 

11.139.3 Material lot ID 

A user or vendor-defined identification number that uniquely specifies a raw material lot. 
Lot IDs are entered at the DCM through a bar code reader or the touch screen. The Lot ID 
is an alpha-numeric string of up to 20 characters. 

11.139.4 Material name 

Parameter which indicates the name of a single material or a material formula. If your 
system's multiple material option has been purchased, up to four raw material components 
can be attached to a material formula. All material components must be assigned a 
component percent. Material names can be up to 20 characters in length. 

11.139.5 Material required 

The estimated weight of a material component necessary to meet the production targets for a 
job. There are three primary formulas for calculating the amount of material required. The 
formulas are dependent upon whether runners and/or scrap are being re-fed for a job. 

· Whenever runners are being re-fed, then the amount of material required is 
based upon the number of pieces remaining. 

· If scrap is being re-fed but not runners, then calculations are based upon the 
number of pieces remaining plus estimated rejects and the amount of excess 
weight per actual shot size. 

· If neither runner nor scrap is being re-fed, then the amount of material required is based 
upon the number of shots remaining plus estimated rejects. 

All calculations take into consideration actual reject percents if a job is current and more 
than 5% complete. There is one exception to this rule, however. If both runners and scrap 
are being re-fed, reject information is not applicable. 

11.139.6 Material used 

The amount of a material component, in weight, which has been used by the current job. If 
runners and scrap are re-fed on a job, the amount of material used is based upon net pieces. 
If only runners are re-fed on a job, then the amount of material used is based upon gross 
pieces. If neither is being re-fed, then shot size is taken into consideration. 

11.140 Max assist time 

The maximum amount of time available for a specific machine, job, shift and 
material lot. 

Max Assist Time = Up Time + Down Time + Idle Time  

11.141 Max cycle time 

The Max Cycle Time field is primarily used with Duration and Cycle Time process variables. It 
sets the maximum time of a machine cycle. It also sets the level of accuracy for cycle time 
values up to one hundredth of a second. For example, 3276.5 seconds means that the 
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maximum time for a machine cycle can be up to 3276.5 seconds and that cycle time values 
should be recorded up to an accuracy of one tenth of a second. 

Note: The higher the maximum cycle time, the lower the level of accuracy. A maximum time 
of 3276.5 seconds sets the level of accuracy to one tenth of a second. A maximum time of 
327.65 sets the level of accuracy to one hundredth of a second. 

11.142 Maximum family size 

Specifies the maximum number of child jobs that a machine, defined for this DCM, may 
have for any one job. 

The range is from 1 to 12 child jobs. 

11.143 Memory 

The amount of memory installed in the DCM. The range of values varies with the particular 
model type of the DCM. 

11.144 Memory area 

Current memory control area; For RKC F900 sources, set the memory area to K0. 

11.145 Memory required 

Displays of the estimated memory required by the DCM with the selected options. If this value 
appears in yellow then the estimated memory exceeds the available memory and 
unpredictable results may occur. This should be used as a guideline. 

11.146 Module address 

The module address containing process variable data. Each module must have an address 
assigned to it. Addresses are assigned by jumpering of Terminals 50 through 53 on the 
module terminal block and by grouping the modules according to function and then 
assigning consecutive addresses within each function group. Refer to the Maco-800 Module 
Installation and Wiring Procedures manual for valid module addresses. The parameter type 
field also offers possible module address data values. 

11.147 Monitor number 

The monitor number refers to the “subject” to be monitored for the Toyo source type. Refer 
to the Toyo Table of Monitor Data to select the desired monitoring subject. Type in the 
number next to the appropriate description. 

11.148 Moving average cycle 

The moving average cycle is compared to the standard cycle to determine the fast state/slow 
state of a machine. 

The machine is slow if: 

(Average Cycle) > (Standard Cycle) + ((Cycle Tolerance)*(Standard Cycle) / 100) 

The machine is fast if: 
(Average Cycle) < (Standard Cycle) - ((Cycle Tolerance)*(Standard Cycle) / 100) 

11.149 Multiple login 

When set to 'yes' this setting allows an employee to login onto more than one machine at a 
time. 

11.150 Net parts counting 
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An alternate method of counting parts produced on a machine. Using this method, all parts 
produced are considered rejects and will be placed in reject reason #2. When a quantity of 
parts are known to be good then a signal is sent to move the net parts multiplier quantity of 
parts, as defined in the job parameters, from reject reason #2 to finished parts. Note that the 
terms "net pieces" and "Net Parts" are used interchangeably. 

11.151 Net parts multiplier 

Job parameter which indicates the number of good (net) parts to be counted each time the 
net parts input contact is closed. If you are not using net parts counting, leave the value at 
zero (0). The range is 0 to 99999. If a value other than 0 is entered then all parts made will 
be put in reject reason #2. (See net parts counting for a full explanation) 

11.152 Net pieces 

The number of good pieces that have been produced on a job. Net Pieces is displayed in a 
variety of forms -- for an entire job, for a single shift, or totaled for all machines on a single 
shift. When Net Pieces is displayed for an entire job, the current, incomplete shift is included. 
The standard method for calculating net pieces is: 

Net Pieces = (Gross Pieces) - (Total Rejects) 

See net parts counting for an alternate method. 

11.153 No access privilege 

If the No Access box is checked, a user may not do whatever is listed under the Privilege 
List in that row. For example, if the no access column is checked for the Change Work 
Order Data privilege, the user will not see the Work Orders window under the Schedule 
menu within the Monitor program. Specifically, no access on the following privileges means 

· Schedule Jobs and Shifts - User will not see the Job Schedule or Shift Schedule 
window within the Monitor program. 

· Change Down/Assist/Reject Data - User will not see the Down Time Editor, 
Assist Time Editor and Parts Count Editor windows within the Monitor program. 

· Configure The Shop Floor - User will not have the Sets, Group, and Shop Floor 
menus available for use within the Shop Floor Configuration program. 

· Clear Process Trend Data - The Clear button on the Process Trend/SPC window 
is disabled within the Monitor program. 

· Change Product Standards Data - User does not have the Product Standards 
window in the Monitor program. 

· Change Work Order Data Privilege - User does not have the Work Order window 
within the Monitor program. 

11.154 Non-family job 

A job that has no child jobs associated with it. 

11.155 Offline state 

A machine is considered offline when its associated DCM is no longer in communication with 
the PlantStar host computer. This does not mean that data is not being collected, unless the 
DCM itself has lost power. It could be a result of network issues between the host and the 
DCM. 

11.156 One RIO for all machines 
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When checked this DCM has one RIO configured and it will communicate with each 
machine. When unchecked this DCM has a single RIO configured for each machine. 

11.157 Operator efficiency 

A percentage indicator of how many good versus rejected parts a selected employee is 
producing. This statistic is calculated for a single shift. 

The formula is: 

(Net Pieces / Gross Pieces) * 100 

For current shift calculations, the total part count for the employee is unknown, so 
"Current Shift" is displayed instead of a percentage. 

11.158 Operator start options 

Specifies what if any job in the job queue the operator may start. The settings are none, any 
job in the queue, idle job only, any job in the queue and idle job. 

11.159 Operator utilization 

A percentage indicator of how many hours a selected employee was logged into the 
machine versus the total number of hours for a shift. This statistic is calculated for a single 
shift. 

The formula is: 

(hours worked / shift length) * 100 

For current shift calculations, the hours worked for the selected employee is unknown, so 
"Current Shift" is displayed instead of a percentage. 

11.160 Ordered histogram 

A histogram is a way of summarizing data that are measured on an interval scale (either 
discrete or continuous). In an Ordered Histogram, bars are displayed from left to right in 
descending order, in effect highlighting the main points. 

11.161 Other status 

Any machine state information other than down, assist, process exception or production 
exception. An example is a machine in an off-line state. 

11.162 Overrun 

A machine is in an overrun state whenever the current job's "pieces to go" is negative (i.e. 
net pieces are greater than pieces required). 

11.163 Parameter number 

This field refers to the item to be monitored; For Netstal sources, refer to the item number in 
the Table of PLC Interfaces. For MACO 8000 sources, refer to the Host Communications 
Protocol manual provided with the MACO 8000 controller documentation from Barber-
Coleman. 

11.164 Parameter type 

The parameter type for the Maco-8000 source. The following list of data items is provided 
courtesy of PlantStar. There are other data values you may want. These will have to be 
researched in the Host Communications Protocol manual provided with the MACO 8000 
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controller documentation from Barber-Coleman: 

 

Variable 
module 

address 

param 

type descriptor 
param 

number 

decimal 

places 

Nozzle Temp 17 0 0 0 0 

Front Temp 17 0 0 1 0 

Center Temp 17 0 0 2 0 

Rear Temp 17 0 0 3 0 

Cycle Time 01 7 0 23 2  

11.165 Part weight 

Job parameter defining the weight of the material required to produce 1 piece of a product. 
The range is 0.000 to 999999.999 units. 

11.166 Parts per minute 

The average number of net pieces (good pieces) produced per minute. The rate can be 
calculated over a single shift or an entire job. 

Parts per Minute = ((Net Pieces) / (Up Time)) / 60 

11.167 Percent down 

Percentage of machines in a display group that are down. 

11.168 Percent process exception 

Percentage of machines in a display group with a process variable exception. 

11.169 Percent production exception 

Percentage of machines in a display group with a production exception. 

11.170 Percent rejects 

Percentage indicator of how many pieces have been rejected across all reasons. This 
value is calculated for an entire job, a single shift, or all machines on a single shift. When 
calculated for an entire job, the current, incomplete shift is included. The formula is: 

((Total Rejects) / (Gross Pieces)) * 100 

11.171 Percent slow cycles 

Indicates the number of slow cycles as a percentage of total cycles. This value is 
calculated for the current shift as: 

Percent Slow Cycles = ((Slow Cycles) / (Total Cycles)) * 100 

11.172 Percent variance 

Amount of random variance that is desired in a simulated signal as a percentage of the 
original signal value. The range is 0 to 100 percent. 

11 .173 Pieces required 

Job parameter which defines the total number of good pieces required to complete a job. The 
range is 0 to 999999999. A value of 0 would normally be used only for a maintenance job. 

11.174 Pieces to go 
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Pieces still required for the job to meet its production target. 

This value is calculated as: 

Pieces To Go = (pieces required) - (net pieces) 

A production exception is triggered when "pieces to go" becomes negative. 

11.175 PLC 

Progammable Logic Controller – This refers to the particular machine controller that the 
DCM will communicate with. 

11.176 Polarity 

The type of setpoint -- unipolar or bipolar; Unipolar values have a range from (0000H) to 
(FFFFH) or (0 to 65535) decimal. Bipolar values have a range from (8001 H) to (7FFFH) or (-
32767 to 32767). Refer to the MACO 4000 RS-232 Digital Communications Instruction 
Manual for further information. 

11.177 Port number 

The DCM communications port to use for monitoring a serial process variable. For simulated 
source types, select an unused port number from the selection list. For Engels, it refers to 
the communications port (on the DCM) where the serial link is connected. For RKC F900 
sources, the port number should typically be set to 1. Port 0 (Zero) only works with Ethernet 
DCMs. 

11.178 Post-down delay 

Amount of time to wait before designating unassigned down time to Down Reason #1. 
The delay period can be from 0-30 minutes. 

When a machine enters a down state, down time is accrued under the down reason selected 
by an operator. At times, a machine enters a down state and no down reason is specified. If 
no down reason is specified and the machine exits the down state, an operator has the 
length of the post-down delay period to assign a reason. If the post-down delay period 
expires and still no down reason has been specified, all accrued down time is allocated to 
Down Reason #1. For example, a machine's post-down delay period is set to 5 minutes. 
While running a job, the machine enters a down state. No reason is given. The machine then 
exits the down state. An operator has 5 minutes from the time the machine started running 
normally to designate a down reason for the "unassigned" down time. If the delay is set to 
zero (0) and an operator does not select a specific reason, down time is automatically 
accrued under Down Reason #1. 

11.179 Primary contact 

The contact used to measure cycle time. A primary contact is required for each 
machine being monitored. 

11.180 Primary internet path 

This is the symbolic name (exactly as it appears in the hosts file) or the Internet address (in 
dot notation) of the Communications Processor or the RTL based DCM. Examples include 
CP3 or 128.0.1.3 This path name can be up to 20 characters in length. 

11.181 Print reports privilege 
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This privilege grants users the ability to print shift-to-date, job-to-date, end-of-shift, end-
of-job, and shop configuration reports via the PlantStar Reports program. 

11.182 Process trend privilege 

This privilege grants users the ability to clear historical process variable data from the 
Process Trend /SPC window within the PlantStar Monitor program. 

11.183 Process variable 

Each machine has a set of process variables and profiles. A process variable is a physically, 
measurable quantity or characteristic that is collected by a DCM. Most process variables are 
collected once during each machine cycle. Examples of cyclic process variables are 
temperatures, pressures, time durations, and PLC readings. Some process variables are not 
directly related to machine cycles. Examples of non-cyclic process variables are manually 
operated scales and gauges. Process variable names can be up to 20 characters in length. 

There are several categories of process variables. A process variable's type is 
determined by the source of its input signal: 

· Cycle Time - Obtained through the primary contact input. Cycle time is the 
time between consecutive closures of this input. This is always the first 
process variable. 

· Analog Channel - Obtained by reading one of the analog channels within a DCM. 
The applied signal may originate from a pressure transducer, linear potentiometer 
or another linear device. 

· Duration - Obtained through an additional contact input. A duration variable measures 
the length of time that a contact input was closed. One example is hold time. 

· Serial Communication - Obtained through a serial communications link with the 
machine's controller. This type of process variable requires a specific software driver. 
An example is an Engel PLC. 

· Pseudo - Obtained by reviewing a profile. This may be the maximum, the time that 
the maximum occurred, the minimum, the time that the minimum occurred, the range 
(max - min), or the average of the selected profile. Examples include peak pressure, 
peak time, stroke, and cushion. 

· Thermocouple - Obtained by reading an analog channel where a J or K thermocouple 
is connected. This is used in temperature measurements. 

A profile is a rapidly changing process variable, such as pressure or position. For a profile, a 
machine's DCM collects a set of up to 500 points per machine cycle. Profiles are mostly 
collected from analog transducers. Some PLC's are capable of collecting and transmitting a 
profile. 

11 .183.1 Process exception 

Indicates that a process variable measurement is outside of the assigned limits, either high or 
low. 

11.183.2 Process exception state colors 

This button's image will change to indicate that a process variable measurement is 
outside of the assigned limits, either high or low. 
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The various states are described below. Pressing this button, regardless of the current 
state, will display the Process Summary page in the main frame of the browser screen. 

 

Normal: All of the machine's process variable measurements are within the assigned limits. 

 

Process exception: At least one of the process variable measurements is outside of the 
assigned limits, either high or low. 

11.183.3 Process index 

A number used to show the number of process variables in exception. The index 
column has no connection with the defined index of a process variable. 

11.183.4 Process log 

Indicates the type of process variables to be included on the Machine Log window within the 
Monitor program and on DCM Log screens. Three options exist -- All, Critical or None. The 
All option reports all process variables for a machine. The Critical option displays only those 
process variables marked as critical. The None option turns off the reporting of process 
alarms. 

11.183.5 Process variable parameter 

An optional job parameter that defines the limits for a process variable. This includes the low 
and high limits, and a trigger delay. The trigger delay will override the default value that was 
entered in the Machine Setup Window. 

11.184 Product 

Job parameter which identifies the product to be manufactured. This parameter can be 
up to 30 characters in length. 

11.184.1 Product parameter 

Refers to a collection of parameters which define how to identify and monitor performance/ 
progress of a specific product. Examples of product parameters are material, part weight, 
standard shot weight, and standard rate factor. 

11.184.2 Product key 

Selects existing product standards based upon the entered product name. Partial or 
complete searches can be done. 

NOTE: As of PlantStar v4.10, this search no longer requires the key fields to match the 
case of the expected result. In other words, the search is no longer case sensitive. 

11.185 Product standard 

A template of parameters which is copied into a work order. A product standard is 
made up of product-specific parameters and machine-specific parameters. 
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11.186 Product standard privilege 

This privilege enables users to create, delete, and edit product standards. 

11.187 Production data 

All data collected by the PlantStar system during a particular job and/or shift. 

11.188 Production efficiency 

A percentage indicator of how well the machine is performing. This statistic is calculated for 
an entire job or a single shift. 

The formula is: 

(((Net Pieces) / (Standard Rate)) * ((Up Time) + (Down Time))) * 100 

For job-to-date calculations the current, incomplete shift is included. 

11 .189 Production exception 

A machine is in the production exception state whenever one or more of the following is 
true: 

· Pieces to go is negative (more pieces have been made than were required); 
· Job-to-date Percent Rejects > Reject Threshold. 

11.189.1 Production exception state colors 

This button's image will change to indicate that a machine is in the production exception 
state. 

The various states are described below. Pressing this button, regardless of the current 
state, will display the Production Summary page in the main frame of the browser 
screen. 

 

Normal: The job still has pieces to make and the reject level is within the specified threshold 
limit. 

 

Production Exception: A job is in production overrun when Pieces To Go is negative (more 
pieces have been made than required). 
A job is in reject exception because Job-to-date percent rejects exceeds the reject threshold. 

11.190 Production performance 

Percentage indicator of how close a machine is running to its standard rate of 
production.  

Production Performance = ((Actual Rate) / (Standard Rate)) * 100 
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Performance is considered standard when this value is 100%. 

11.191 Production time 

Total scheduled runtime that has elapsed for a job. This value is calculated for an entire job 
or a single shift. The formula is: 

Production Time = (Up time) + (Down Time) 

Format is hhhh:mm. 

11.192 Profile 

Rapidly changing process variable, such as pressure or position, for which the DCM 
collects a set of up to 500 points on each machine cycle. The profile name can be up to 20 
characters in length. 

11.192.1 Profile parameter 

An optional job parameter that defines the limits for a profile. This includes a trigger delay 
and duration. The trigger delay and duration set in the job editor overrides the default 
values that were entered in the Machine Setup Window. 

11.192.2 Pseudo end 

A pseudo variable can be defined for an entire machine cycle or a segment of a cycle. The 
end field indicates the event which, after the trigger delay elapses, terminates the collection 
of a profile. The event can be a profile value, duration, trigger event, or the end of the 
profile itself (i.e. the end of the cycle). 

11.192.3 Pseudo start 

A pseudo variable can be defined for an entire machine cycle or a segment of a cycle. The 
start field indicates the event which, after a trigger delay elapses, starts the collection of a 
profile. The event can be a profile value, trigger event, or the start of the profile itself (i.e. the 
start of the machine cycle). 

11.192.4 Pseudo variable 

A process variable that draws its values from the analysis of a profile. The following pseudo 
variables are available: 

· Max Value 
· Time of Max Value 

· Min Value 
· Time of Min Value 
· Value Range 

· Average Value 
· Mean Value 

· Area 

11.193 PVAR History 

Process variable history data is data collected for a particular process variable and stored for 
analysis. 

11.194 Queued job 

The job that is scheduled but not currently running on a machine. The current job is the 
job that is currently running. 
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11.195 RAM size 

DCM parameter which describes the amount of volatile memory in the DCM. The size must 
match the amount of RAM physically installed in the unit. 

11.196 Range 

The difference between the highest and lowest values within the subgroups that are currently 
displayed on a window's graph. 

11.196.1 Range control limits 

Blue dashed lines which mark the extent of range variation in the process variable displayed. 
The extent of variation is based upon the amount that could be expected if only common 
causes of variation were present. Control limits are based upon actual process variation in 
terms of the range of subgroups that are currently displayed on a window's graph. 

11.196.2 Range max 

The highest value which represents the difference between the maximum and minimum 
values in a sample. In your system, the Range Max is calculated over the range of 
subgroups that are currently displayed on a window's graph for a specific process variable. 

11.196.3 Range mean 

The average of all ranges over a set of subgroups. In your system, the Range Mean is 
calculated over the range of subgroups that are currently displayed on a window's graph. 

11.196.4 Range min 

The lowest value which represents the difference between the maximum and minimum 
values in a sample. In your system, the Range Min is calculated over the range of 
subgroups that are currently displayed on a window's graph for a specific process variable. 

11.197 Real-time 

Processing and displaying real world events in a continuous and timely fashion. 

11.198 Reason set 

Down reasons, assist reasons and reject reasons are attached to machines from reason sets. 
A reason set is a group of up to 160 down, 160 reject, or 20 assist reasons that are grouped 
together and assigned as a unit to a machine or to several different machines. Note that a 
single reason set contains only one category type of reason (down, assist or reject). 
Certain down and reject reasons have special meanings attached to them: 

· Down Reason One - The first reason is the default down reason. Time is accrued to 
this reason when a machine is down and the operator has not selected a specific 
reason. A post-down delay period can be set, though, from the Machine Setup window 
that delays the accruing of "unspecified" down time to Down Reason #1. 

· Down Reason Two - The second down reason clocks actual setup time. PlantStar 
compares this time with a job's standard setup time. 

· Reject Reason Two - PlantStar uses the second reject reason to accumulate 
the difference between gross pieces and net pieces when Net Parts Counting is 
in effect. 

The various reasons which are defined may later be selected by an operator at a 
DCM or by automated equipment using contact inputs to a DCM. 
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11.199 Re-feed runners 

Machine-based parameter which indicates whether all runners produced by a job are re-
ground and re- fed at the machine. "Yes" specifies that all runners are reused immediately at 
the machine. "No" specifies that runners produced on a job are not re-fed at the machine for 
a job. 

11.200 Re-feed scrap 

Machine-based parameter which indicates whether rejected pieces produced by a job are 
re-ground and re-fed at the machine. "Yes" specifies that all rejects are reused 
immediately at the machine. "No" specifies that rejects produced on a job are not re-fed at 
the machine for a current job. 

11.201 Register number 

The register number of a Square D source type's Circuit Monitor. Circuit Monitors (CM) have 
two types of registers -- Read-only registers and Write/Read registers. Read-only registers 
contain values calculated on raw data sampled by CMs. Write/Read registers contain user-
defined parameters that are downloaded or changed from a host. Refer to the Square D 
PowerLogic Circuit Monitor manual for register numbers. 

11.202 Reject reason 

Specific reject reason against which the system charges operator entries. Reason names can 
be up to 20 characters in length. On keypad DCMs, only the first 9 characters are displayed. 
On EL DCMs, the first 7 characters are displayed. On browser based DCMs the first 10 
characters are displayed. 

11.202.1 Reject count 

The number of total rejects for a shift or job. 

11.202.2 Reject exception 

A machine state in which the number of rejects as a percentage of total pieces exceeds 
the reject threshold percentage for the current job. 

11.202.3 Reject multiplier 

Product parameter which defines the number of pieces added to the reject count whenever 
a remote reject contact input is closed for a job. Remote rejects are assigned to specific 
reasons based upon the digital equation set. The range is 1 to 9999. 

11.202.4 Reject percent 

Percentage indicator of how many pieces have been rejected across all reasons. This 
value is calculated for an entire job, a single shift, or all machines on a single shift. When 
calculated for an entire job, the current, incomplete shift is included. The formula is: 

((Total Rejects) / (Gross Pieces)) * 100 

11.202.5 Reject threshold 

Product-based parameter which sets the maximum acceptable reject percentage for a job. 
A production exception is triggered if job-to-date rejects exceeds this value. The range is 
0.0 to 100.0 percent. 

11.202.6 Reject state colors 

This button's image will change depending upon whether the machine is in a production 
exception state due to actual rejects exceeding the reject threshold as defined in the 
cuurent job. Pressing this button, regardless of the current state, will display the Assist 
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Select page in the main frame of the browser screen. 

 
The machine is not currently in the Production Exception state due to an excess of rejects. 
 

 

The machine is currently in Production Exception due to an excess of rejects. 

11.203 Required by 

Job parameter which defines the date by which a job must meet its production target. The 
format is mm/dd/yy. Dates up to the year 2050 are acceptable. 

11.204 REU 

An REU is a remote entry unit. This is an independent device which enables the entry of reject 
counts, down time and assist time for up to sixteen (16) machines. As of version 4.10, this 
feature is no longer supported as it has been replaced by the browser based DCMs. 

11 .205 RIO 

Remote Input/Output device. This device is used to collect analog data from a machine. 

11.206 Running state 

This reflects the current state of the machine. If the last cycle of the machine is within 
the cycle tolerance the running state will be normal 

11.206.1 Running state colors 

This button's image will change depending upon the current running status of the machine. 
The various states are described below. Pressing this button, regardless of the current state, 
will display the Job Summary page in the main frame of the browser screen. 

 

Normal: The machine is cycling within the standards defined by the job. 

 
Fast: The machine is running faster than the standards defined by the job. 
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Slow: The machine is running slower than the standards defined by the job. 

 

Idle: The machine is currently set to be in the idle state. 

 
Blank: The machine is currently in the down state and therfore has no running status. 

11 .207 Scale factor 

Multiplier used to convert analog and serial inputs into engineering units. Bias and scale 
are used in the following formula to convert transducer output voltage to engineering units: 

Value = (Voltage * Scale) + Bias 

To compute the scale factor, use the following formula: 

Scale = (High Value - Low Value) / (High Voltage - Low Voltage) 
where voltage must be in the range of 0 to 10. 

This field requires an input value significant to three decimal places. Values can be positive 
or negative. For Netstal source types, the scale factor for the desired Parameter Number and 
Convert Index must be obtained from Netstal's PLC Interface Table. For simulated sources, 
the scale factor is applied to the simulated signal. For Engels, the scale factor is applied to 
the received value. 

11.208 Schedule factory 

The schedule now and schedule factory parameters work in conjunction. The 
following table represents the possible combinations of values and the effect they 
have on the job when it is scheduled to run. 
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Schedule Now Schedule Factory Result 

No No The job is set to idle. 

No Yes The job runs according to the shift schedule. 

Yes No 
The job ignores the shift schedule and 24-hour 

production is assumed. 

Yes Yes 
The job runs according to the shift schedule. 

(Schedule now is ignored) 

 

11.209 Schedule jobs and shifts privilege 

This privilege grants users the ability to schedule jobs via the Job Schedule window and to 
create shift schedules via the Shift Schedule window. 

11.210 Schedule now 

The schedule now and schedule factory parameters work in conjunction. The 
following table represents the possible combinations of values and the effect they 
have on the job when it is scheduled to run. 

 

Schedule Now Schedule Factory Result 

No No The job is set to idle. 

No Yes The job runs according to the shift schedule. 

Yes No 
The job ignores the shift schedule and 24-hour 
production is assumed. 

Yes Yes 
The job runs according to the shift schedule. 
(Schedule now is ignored)  

11.211 Schedule reports privilege 
This privilege grants users the ability to schedule end-of-shift and end-of-job reports via the 
PlantStar Reports program. If scheduled, these reports print automatically at the user-
designated time. 

11.212 Schedule selected job by due date 

This button changes the scheduling method of a highlighted job between the earliest possible 
start method and the due date method. Once a job is highlighted (clicking on the job 
highlights it and turns its job rectangle yellow), use this button to switch the job between the 
two scheduling methods. The right click button on the mouse may be substituted for clicking 
the button (i.e. it provides the same function). 

NOTE: This button only works when the   button is selected at the same time. Also, in 
order to schedule a job by due date, the job must start to the right of the scheduling marker. 
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11.213 Scheduled idle time 

The amount of idle time assigned within the Shift Schedule window, for a given date range. 

11.214 Scheduled jobs 

Work orders that have been assigned to the job queue of a specific machine. Scheduled 
jobs wait in the job queue until they are started by the machine operator or from the monitor 
job schedule board. 

11.215 Scheduled machine usage 

A percentage indicator of how much the machine was up during the given time period. This 
statistic is calculated for an entire job or a single shift. 

Scheduled Machine Usage is computed much like machine usage, except it ignores the 
scheduled idle time during the given time period. 

Scheduled Machine Usage = (Up Time) / (Scheduled Up Time) 

11.216 Scheduled up time 

The amount of up time assigned within the Shift Schedule window, for a given date range. 

11.217 Set name 

The name for the group of reasons. Up to 20 reasons can be in any given set. If the 
extended down and reject option is enabled then the down and reject reasons can number 
up to 160 with the up to 20 assist reasons. There is no limit to the number of sets. 

11.218 Setup sheet 

Setup sheet information can be added to product standards, work orders, queued jobs or 
currently running jobs. Setup sheets can be printed in reports, viewed at a workstation, or 
viewed at the DCM. 

Setup sheets consist of two parts -- a general product portion and a specific machine 
portion. For all jobs, the maximum number of characters allowed for instructions is 2600 
combined, as both portions are sent to a DCM as a single instruction sheet. 

A free form field is used for typing in information on the Setup Sheet window. On browser 
based DCMs the setup sheet can contain HTML code and will be displayed as such. This 
allows the insertion of hyperlinks and other html objects in the setup sheet. 

11.219 Setup time 

The length of time required to prepare the machine to run a particular job. This time is 
ignored by the machine usage calculations. 

Setup Time information can be added to product standards, work orders, queued 
jobs or currently running jobs. 

11.220 Shift 

Shifts define the start and end times of work periods. Shifts can be defined within the Shift 
Schedule window. 

NOTE: Defining shifts within PlantStar is not required but it does provide the flexibility to 
control part of the job process. If shifts are not defined, all jobs are assumed, by PlantStar, to 
run 24 hours a day 7 days a week. 

11.220.1 Shift count 
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The number of shift records PlantStar should attempt to retrieve for the given selection 
criteria. 

NOTE: If the shift count exceeds the number of actual shift records, PlantStar will only return 
the actual shift records found. 

11.220.2 Shift history size 

DCM parameter which sets the number of shift history records which should be stored locally 
at the DCM. All DCMs have the capability for local data storage. This capability allows the 
DCM to hold data while the host computer is either down or busy -- minimizing data loss. It is 
recommended that at least three days of history be stored locally. 

11.220.3 Shift ID 

Name assigned to a daily shift. Each weekly shift schedule has 6 shifts available for 
scheduling each day. The shift name can be up to four characters in length. 

11.220.4 Shift idle period 

The time scheduled, during a shift, when the machines are not scheduled to operate. 
During an idle period, the DCM ignores all inputs from the machine. Only idle time will be 
accumulated. 

11.220.5 Shift length 

The length of the shift is the total working hours in the shift, as setup in the Shift 
Schedule window. Idle times scheduled during the shift, are not counted in the total 
working hours. 

11.220.6 Shift schedule 

Shift schedules define the start and end times for work shifts, idle times for holidays or 
weekends, and any other events when jobs should not be running or have special needs. 
Shift schedules are not required but they do provide the flexibility to control part of the job 
process. If shift schedules are not created, all jobs run all the time. 

Shift schedules are created for a work center. Each work center has multiple schedules -
- one for each year desired. Each year’s schedule may have up to 12 different weekly 
work schedules. 

The Shift Schedule window is used to create, assign, delete and change work center 
schedules. 

11.220.7 Shift-to-date 

The data available for a job from the time the current shift started to the present time. 

11.221 Shop floor privilege 

This privilege grants a user access to defining shop floor configuration parameters such as 
machine definitions, DCMS, work centers, and down reasons. Specifically, all windows under 
the Sets, Groups, and Shop Floor menus are affected. 

11.222 Shot size 

The weight of all materials used in a single cycle of the machine. This number should 
include both parts and runners. 

11 .223 Shuttle boot set 

When selected the RIO's boot set will include the files necessary for use with a shuttle type 
machine. 
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11.224 Slow state 

The fast, slow, and standard machine states are basic indicators of machine performance. 
For each machine cycle, the cycle tolerance is monitored. The tolerance is the percent 
deviation of a job from its normal standard cycle time. An average cycle is computed and a 
comparison is made using the cycle tolerance and standard cycle values. If the average 
cycle is greater than the resultant value, the machine is considered slow. 

11.225 Source 

This field defines the source of the data or analog signal. 

To set the source: 

· Click on the Edit Process field. 
· Select the number of the desired process variable/profile via the Variable field. 

· Position your cursor on the Source field. Choose from the selection list by clicking the 
arrow to the right of the list. Slide your pointer down the list to the appropriate line. 
Release your mouse button. 

· Click on the Update button. 
· Select the Save Session command under the File menu to send process variable 

definitions to the shop floor. 

11.226 SPC 

Abbreviation for Statistical Process Control. There are two levels of SPC support. The basic 
SPC option supports SPC collection by DCMs, Real-Time SPC alarms, and real-time SPC X-
Bar and Range Charts. The extended SPC option supports advanced SPC capability studies, 
including normal, non-normal, and multi-variate analysis. 

11.226.1 SPC alarms 

SPC Alarm abbreviations (n = SPC History Size): 

XCL - Last X-bar value not within control limits RCL - Last Range value not within control limits 

INC - Last 8 X-bar values were continuously increasing DEC - Last 8 X-bar values were 
continuously decreasing ABV - Last 8 X-bar values where above the mean. 

BLW - Last 8 X-bar values were below the mean. UTR - Last n X-bar values show an 
upward trend. 

DTR - Last n X-bar values show a downward trend. 

RSM - Within the last n X-bar values, a RUNSUM exceeded 4. 

11.226.2 SPC Graph Area 

The window displays a line chart of the SPC values collected for a specific process variable. 
It includes two graphs. The top graph is a plot of X-bar values and the bottom is a plot of the 
associated range values. The X-axis is the time at which the SPC values were recorded. The 
number of values graphed may be a subset of the total collected. 

To view the maximum value for a graph, click anywhere on the far right-hand side of the 
window, outside of the graph borders but within the top and bottom lines of the desired 
graph. To view the minimum value of a graph, click anywhere on the far left-hand side of 
the graph, outside of the graph borders. To view actual values, click in the middle of the 
graph area. 

11.226.3 SPC history size 
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DCM parameter which defines the number of SPC samples to be stored locally at the DCM. 

11.226.4 SPC interval 

Job parameter which defines the minimum time between SPC samples. Individual sample 
intervals may be longer if enough valid process data has not been collected for a complete 
SPC subgroup. The range is 0 to 500 minutes. A value of 0 disables SPC collection. 

11.226.5 SPC subgroup 

The number of data points collected during a specified length of time. This length is 
defined in the SPC Interval. This value ranges from 0 to 8. 

11.226.6 SPC subgroup size 

Job parameter which defines the number of process data points required to make an SPC 
sample. Because the statistical methods used in SPC do not support variable subgroup 
size, this parameter cannot be changed once a job has been started. The range is 0 to 8. 
A value of 0 disables SPC collection for the entire job. 

11.227 Specification limits 

The highest and lowest values accepted by Engineering Standards. In your system, 
specification limits are equivalent to the high limits and lower limits for a job. 

11.228 Standard completion time 

The total amount of hours and minutes required to finish a job given the standard 
production rate. Before 5% of the job is completed, standard completion time is 
calculated as follows: 

Standard Completion Time = Remaining Setup Time + ((Pieces To Go) / (Standard Rate)) 

After 5% of the pieces required have been made, the following formula is used: 

Standard Completion Time = (Pieces To Go) / (Standard Rate) 

For maintenance jobs, standard completion time is equal to the setup time remaining. 

11.229 Standard cycle 

Machine-based parameter defining the normal machine cycle time for a job. When a 
machine is up, your system uses cycle tolerance and standard cycle to determine whether 
the red (signifying slow cycles), green (signifying normal cycles), or yellow (signifying fast 
cycles) performance light should be on. See Average Cycle for more details. The range is 
0.5 to 3276.7 seconds. 

11.230 Standard deviation 

A measure of the spread of individual values around the mean of a sample or the average 
amount of variation from one part to the next. In your system, the standard deviation is 
calculated over the range of subgroups that are currently displayed on a window's graph. 

11.231 Standard multiplier 

Product parameter defining the maximum number of pieces produced per machine cycle for a 
job. The value of the actual multiplier cannot exceed the value of the standard multiplier. The 
range is 0 to 9999. 

11.232 Standard production time 

Calculation indicating the expected amount of time to produce the required number 



328 SYSCON-PlantStar Help System 

 

 

  

of pieces. 

Standard Production Time = Pieces Required / Standard Rate  

11.233 Standard rate 

Calculation which defines the number of good pieces normally produced per hour. This value 
reflects the expected long term average rate of gross production and rejects. 

Standard Rate = ((Standard Rate Factor * Standard Multiplier) / Standard Cycle) * 3600 

11.234 Standard rate factor 

Product parameter indicating the ratio of good pieces expected to be produced per hour as 
compared to the theoretical maximum for a job. The range is 0.0 to 100 percent. 

11.235 Standard setup time 

Machine-based parameter defining the expected time necessary for setting up a job to 
run on a machine. Standard setup time is compared with actual setup time for 
reporting purposes. This parameter is displayed as hours and minutes (hhh:mm). The 
range is 0:00 to 500:00. 

11.236 Standard shot weight 

Machine-based parameter which indicates the total amount of plastic used to fill a single shot 
for a job. The range is from 0.000 to 999999.9. 

11.237 Start date 

Precise date at which the system started monitoring the task selected. Start date is 
formatted as dd/mmm/yy. 

11.238 Start time 

Precise time at which the system started monitoring the task selected. Start time is 
formatted as dd/mmm/yy hh:mm. 

11.239 Suspend 

The current job may be suspended when another job is started. The suspended job becomes 
a work order and the remaining pieces to go for the job becomes the pieces required for the 
work order. A job that is in overrun may not be suspended as the pieces required are 
negative. 

11.240 Switch code 

To allow a BetaMux to send DCM information for more than one process variable. A selector 
switch must be connected to the DCM's contact inputs. The selector switch must be a binary 
coded switch. This type of switch will have five connections. Four of the five contacts should 
be marked 1, 2, 4 and 8. The fifth is a common. The following is an example of how to 
connect a selector switch to the contact inputs. 

Selector Switch DCM 
Switch #1 IN5+ 
Switch #2 IN6+ 
Switch #4 IN7+ 
Switch #8 IN8+ 
Common IN5- 

The selector switch contacts #1, 2, 4 and 8 must connect to four consecutive contact inputs. 

11.241 System icon 
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When the PlantStar system is minimized, the            icon displays on the bottom of the 
workstation monitor. The top three circles signal exception states for any machine listed on an 
open window. For example, if you open the Machine Performance window and then minimize 
the program, the icon blinks if one of the machines displayed on the window goes into 
exception. Exceptions displayed from the icon are down, assist, production exception, and 
process exception. 

Moving from left to right, each circle represents the following when blinking: 

· First Circle (Flashes Magenta) - Production Exception or Process Exception 

· Second Circle (Flashes Blue) - Down State  
· Third Circle (Flashes Yellow) - Assist State  

11.242 Tool 

Job parameter which identifies the molding tool to be used. This parameter can be up to 20 
characters in length. 

11.243 Total cycles 

Total number of machine cycles counted by a DCM over the job or shift. This includes both 
up cycles and down cycles. 

11.244 Total rejects 

The total number of pieces rejected on a machine, regardless of reason. This value is 
displayed for an entire job, a single shift, or all machines on a single shift. When displayed for 
an entire job, the current, incomplete shift is included. 

11.245 Tote box 

A tote box is a set number of parts that are traceable as a unit. 

11.245.1 Tote box size 

Product-based parameter defining the number of pieces in a tote box. This field 
provides two capabilities: 

· When a job's tote count is equal to the tote size, tote label printing can be generated. 

· A DCM can be configured to generate a contact output each time a job's tote size 
number of pieces has been made. To disable this capability (i.e. disable the contact 
output), set the tote box size to 0. 

This field's range is 0 to 99999. 

11.245.2 Tote end time 

The time of day when a job's tote box count became equal to its tote box size or when an 
operator pressed the tote change button at the DCM. 

11.245.3 Tote history size 

DCM parameter which sets the number of tote history records which should be stored locally 
at the DCM. All DCMs have the capability for local data storage. This capability allows the 
DCM to hold data while the host computer is either down or busy -- minimizing data loss. It is 
recommended that about three days of history be stored locally. 

11.245.4 Tote ID 

An identification number that is assigned to a tote box. Once a tote box is full, ie. a job's tote 
count is equal to its tote box size; a new ID is assigned for the next tote box. An operator 
pressing the tote change button at the DCM also triggers the creation of a new Tote ID for 
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the next tote box. 

Tote IDs are unique to a single machine and are automatically generated by your system. 
They can be used for the tracking of material component lots to a specific tote box. 

11.245.5 Tote pieces 

The number of pieces in a tote. Each tote is identified by a unique tote id. 

11.245.6 Tote reject 

Product-based job parameter which indicates whether to subtract rejected pieces from a job's 
current tote count. Both manually and automatically rejected parts will be subtracted. Valid 
choices are 'Yes' or 'No'. 

11.245.7 Tote start tim 

The time of day when a tote box started to be filled. 

11.246 Trigger delay 

The amount of time to wait after the trigger event before collecting a process variable or 
initiating the collection of a profile. The range is 0.0 to 999.9 seconds. 

11.247 Trigger event 

The event which, after trigger delay elapses, starts the collection of a process variable or 
initiates the collection of a profile. The value can be the name of a digital equation or the 
number of a contact input. 

For analog channels, thermocouples, and simulated process variables, this field refers to 
a contact which triggers the reading of a process variable. Up to 20 characters is 
available. 

11.248 Ty-Decimal 

Upper and lower type codes. These codes identify specific values, setpoints, control relays, 
or ASCII strings for MACO 4000 data transmission. The three left-most digits should be 
selected from the following list and are defined as the Type Upper Byte: 

OxH is a value 
1XH is a Setpoint 
2XH is a Control 
Relay 4XH is an 
ASCII string 

The two right-most digits of this field are associated with the Type Lower Byte. Refer to 
the MACO 4000 RS-232 Digital Communications Instruction Manual for valid choices. 

11.249 Unassigned child jobs 

A child job that has not been assigned to a family job. 

Unassigned child jobs can be imported through the "Work Order Import" program or 
created in the Work Orders window. 

NOTE: These jobs must be assigned to a work order before they can be run on a machine. 

11.250 Units 

Name of the engineering units to which a process variable or profile variable has been 
scaled. All duration variables are measured in seconds. Temperature is usually measured in 
degrees F (DEG F), pressure in pounds per square inch (PSI), speed in centimeters per 
minute (CPM), and flow in gallons per minute (GPM), to name a few examples. 
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11.251 Up cycles 

Number of machine cycles counted while the machine is up (i.e. not down or idle). 

11.252 Up time 

The total number of hours a machine has been running (i.e. not down or idle). 

11.253 Upper spec 

The upper control limit assigned to a process variable. When this limit is exceeded the 
machine will enter a process exception state. 

11.254 User name 

The name of a user that will be used as a login name for your system. A user name can be 
up to 20 characters in length and can include characters or numbers. 

11.255 Value 

The exact point at which the collection of a pseudo variable is initiated or terminated. 

11.256 Variable long name 

Long text name of the process variable or profile being defined. This name can be up to 20 
characters in length. 

11.257 Variable short name 

Short text name of the process variable or profile being defined. This name can be up to 8 
characters in length. The short name is used on various graphs and on DCMs. 

You can change the short name any time you wish just by typing over the current name in the 
field. 

11.258 View only privilege 

If the View Only box is checked, a user can view but not edit any PlantStar window 
associated with the activity of the privilege (the privilege located on the same row as the View 
Only box). For example, if View Only privileges are granted for the Schedule Jobs and Shifts 
privilege, a user may open the Job Schedule and Shift Schedule windows within the Monitor 
program, but they may not edit anything. 

11.259 Voice file name 

A standard Windows wave form message file which contains an announcement 
message. The file name is 8 characters in length with a .wav extension. 

11.260 Weekly schedules list 

The Weekly Schedules List identifies the weekly schedules that have been or can be 
defined for a calendar year and work center. Each year schedule can have up to 12 
different weekly work schedules. Each work schedule is color-coded to identify it on the 
Calendar table. The 'none' work schedule is always listed first. 

11.261 Weekly shift chart 

When a weekly schedule is highlighted in the Weekly Schedules list, its running and idle 
times are displayed in this area. Up to six work shifts can be defined. Their start times are 
displayed in columns 1 through 6. The last four columns show two possible sets of idle 
periods. 

Times and shift titles are changeable. Times are on a 24 hour clock. Shift names can be 
up to 4 characters in length. 
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11.262 Weight per part 

Job parameter defining the weight of the material required to produce 1 piece of a product. 
The range is 0.000 to 999999.999 units. 

11.263 Work center 

User-defined groups of machines which share the same shift schedule. Since a machine 
can only execute one shift schedule, it can only belong to one work center. Machines in the 
same work center always appear together on the same End-of-Shift reports. 

11.264 Work order 

Work Orders are essentially jobs that have been defined but not yet scheduled. In order to 
schedule jobs, you must first create a work order. A work order consists of a set of job 
parameters. These parameters define the job. They include such things as the number of 
pieces required and the standard rate at which the pieces will be produced. 

11.265 Work order privilege 

This privilege enables users to create, delete, and edit work orders. 

11.266 X-axis 

The horizontal axis of a graph. 

11.267 X-axis Value 

The X-axis Value appears at the bottom right and left hand corner of the Process/Trend 
SPC window. The X-axis Value represents: 

· The X-axis Value in the bottom left hand corner displays the time of the oldest 
process or SPC value. 

· The X-axis Value in the bottom right hand corner displays the time of the most 
recent process or SPC value 

11.268 X-bar 

Blue dashed lines which mark the extent of average variation in the process variable 
displayed. The extent of variation is based upon the amount that could be expected if only 
common causes of variation were present. Control limits are based upon process variation in 
terms of the range of subgroups that are currently displayed on a window's graph. 

11.268.1 X-bar Control Limits 

Blue dashed lines which mark the extent of average variation in the process variable 
displayed. The extent of variation is based upon the amount that could be expected if only 
common causes of variation were present. Control limits are based upon process variation in 
terms of the range of subgroups that are currently displayed on a window's graph. 

11.268.2 X-bar Max 

The highest value of the mean values in a sample. In your system, the X-bar Max is 
calculated over the range of subgroups that are currently displayed on a window's graph for 
a specific process variable. 

11.268.3 X-bar Mean 

The average of the mean values in a sample. In your system, the mean is calculated only 
over the range of subgroups that are currently displayed on a window's graph. 

11.268.4 X-bar Min 

The lowest value of the mean values in a sample. In your system, the X-bar Min is calculated 
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over the range of subgroups that are currently displayed on a window's graph for a specific 
process variable. 

11.269 Y-axis 

The vertical axis of a graph. 
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12 Release Notes 

For each major and minor release, PlantStar has release notes. 

These release notes include: 

· new features within the current version 
· bug fixes 
· known problems 

·  

************************************************************************************************** 
************************************************************************************************** 

V E R S I O N 4 . 2 0 
************************************************************************************************** 
************************************************************************************************** 

V4.20 Installation 

 

PlantStar v4.20 can be installed as a new system or as an upgrade to 
PlantStar v4.10 or later. Data compatibility with earlier systems requires 
the host computer be upgraded to PlantStar v4. 10 prior to installation of 
v4.20 as a maintenance release. 

NOTE: For those users that have installed Windows 2000, or XP the 
operating system login MUST be set to have administrative privileges in 
order to install ANY PlantStar client programs. In addition, we have a 
known issue in regards to .dll registration on some systems that require 
the administrator account to run the client software and open all screens 
at least once to insure proper .dll registration. This issue is under 
investigation and a methodology is being prepared to eliminate this 
inconvenience in the future. 

 

V4.20 New Features 

 

Browser - Process Journaling 
 
This interface allows operators and shop floor people to record problems and corrective 
actions. 

DCM - Flash Drives 
 
The RTL based data collection modules now come in a diskless version. This feature uses 
flash memory cards instead of a hard drive. 

DCM - Journaling File System 
 
This new file system will automatically restore itself to its previous state in the event of an 
uncontrolled shutdown. 



340 SYSCON-PlantStar Help System 

 

 

Host - E-mail 
 
We have added a new feature to our host that allows us to send e-mails from any program 
running on the server. 

Host - Import/Export 
 
We now provide multiple machine specific standards to be imported in any one import file. 
Our end-of-shift export utility can now notify you of any machines that have failed to report 
the end-of-shift event. Our export utility can now be set to perform an incremental export. 

Automated Archiving - 
 
The archiver program can be set-up to automatically store data over a given interval at a 
specified time. 

Labor Required Displayed on the Schedule Board - 
 
The total labor hours required for a given shift can be displayed on the job schedule board. 
This option can be enabled from the User Preferences screen in the Monitor program. 

Maco 6000 Host Interface - 
 
This protocol uses 485 based serial communications to collect process data direct from the 
Maco 6000 controller. 

International Support - 
 
The date, currency, and decimal numeric fields used for input and display in all PlantStar 
monitor screens and reports now use the locale settings that have been configured in 
Windows control panel. 

Crystal Reports v11.0 - 
 
All PlantStar reports have been updated to the latest version of Crystal Reports. 

Voice Program - 
 
PlantStar's voice program has been modified to eliminate delays in making 
announcements. Now when any event occurs that requires a voice announcement, the 
response will be immediate. 

V4.20 Bug Fixes 

 

No bugs have been reported since the release of 4.10r11. 

 

V4.20 Features No Longer Supported 

 

As of 4.20 PlantStar will no longer support the os9 style M-CIMs. This 
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includes EL/TS, keypads, and REU units. If you have these style units then 
the hardware will need to be upgraded before 4.20 can be applied to your 
system. Contact you sales representative for further information. 

************************************************************************************************** 
************************************************************************************************** 

V E R S I O N  4.10r11 

************************************************************************************************** 

************************************************************************************************** 

 

V4.10r11 Installation 

 

PlantStar v4.10r11 has been released as a minor revision to make feature 
enhancements and bug fixes available to PlantStar customers. 
The upgrade path is the same as v4.10 in that a customer must be 
at v4.00 before upgrading to this version. 

NOTE: For those users that have installed Windows NT, 2000, or XP the 
operating system login MUST be set to have administrative privileges in 
order to install ANY PlantStar client programs. In addition, we have a 
known issue in regards to .dll registration on some systems that require the 
administrator account to run the client software and open all screens at 
least once to insure proper .dll registration. This issue is under 
investigation and a methodology is being prepared to eliminate this 
inconvenience in the future. 

 

V4.10r11 New Features 

Monitor - Job Schedule Board 
 
The job schedule board's search functionality has been expanded to search on all of the 
fields contained in the filter function. This allows for greater flexibility in searching for 
specific jobs with the schedule board and work order list. 

Monitor - Multiple Material Formula 
 
For users with the multiple materials option, the work order/job material formula fields will 
allow up to 1 decimal place to be used. 

Host - Backup 
 
The maintenance backup will now optimize the database. 

Host - Backup 
 
The backup script will now disconnect any ODBC connections to the database before 
running. This eliminates deadlock and resource conflicts associated with backing up the 
PlantStar database. Any program that connects via ODBC will need to have its connection 
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re-established after the backup is complete. PlantStar recommends waiting at least 1 hour 
from the time backup starts until the ODBC program attempts to reconnect. 

Host - Import 
 
Work order import has an option added that prevents the current job from being modified. 
Product standard import now allows more than 2600 product standards to be imported at any 
one time. It now allows the importation of multiple machine specific product standards. 

Host - Export 
 
Production export now has an option to eliminate a parent record of a family job from the 
export if its data is not related to production. 

DCM - Shot Tracker 
 
A cycle logging option has been created that will timestamp and log information from the 
DCM for each cycle. This data is being placed into a .csv file to ease importation into most 
pc based spreadsheet and/or database programs. The logging files are located on the 
DCM’s hard drive and named with the following convention, machine_name_day_shiftID.csv. 
This convention allows for the recording of data for the previous week to remain on the 
harddrive. Users can use an ftp client, or other related program to retrieve these files from 
the DCM’s harddrive for importation and review. 

DCM - Xtreem interface 
 
An interface to the Cincinnati-Milacron Xtreem controller has been added to our already 
extensive collection of machine interfaces. This interface requires a Windows based pc to 
proxy the data between the machine controller and the PlantStar DCM. This was due to the 
fact that Cincinnati- Milacron uses a Windows based Active-X control to access its Xtreem 
controller. 

DCM - OPC client 
 
An OPC client has been added to collect process variables from OPC compliant machine 
controllers and auxiliary devices. The OPC client requires a Windows based pc to proxy the 
data between the OPC Server and the PlantStar DCM. 

Browser - Job Update screen 
 
In response to customer's requests the Job Update browser screen at the DCM now 
allows for the editing of the reject multiplier as well as the editing of the actual multiplier. 
This gives the user one screen to adjust the cavitation of the mold in the event of a cavity 
no longer being used. 

Browser - Reject Screen 
 
The reject browser screen has been modified so that weights of less than 1 can be entered 
when rejecting parts based on their part weight instead of by part count. 
 

V4.10r11 Bug Fixes 
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Monitor - General 
 
An error that allowed for multiple pop-up message windows to be displayed and causing a 
run-time error #400 to occur has been corrected. 

Monitor - Tool Change / Material Forecast 
 
An error opening the tool change or material forecast screens when more than 200 records 
are being displayed has been corrected. 

Monitor - OEE 
 
The down time was being used both in the availability and productivity portions of the OEE 
calculation resulting in a double adjustment when a machine was down. Down time has 
been removed from the performance factor in calculating OEE. 

Monitor - Job Schedule Board 
 
Many non-critical errors in the schedule board were being ignored by the program causing 
unexpected results. These errors will now be reported by a pop-up window when 
encountered. If this occurs, a screen capture should be taken and forwarded to PlantStar 
customer support so that the underlying cause can be determined and corrected. 

Monitor - Work Order 
 
An invalid default required by date has been fixed. 

Host - Product Standard Import 
 
A fix has been made to properly update or insert machine specific portions of the product 
standard when imported. 
A problem associated with fixed length fields when parsing an import file has been corrected. 

Host - Work Order Import 
 
During import disabled, machines are no longer checked when attempting to find matching 
jobs in the current job or queued jobs. 
A problem associated with fixed length fields when parsing an import file has been corrected. 

DCM - General 
 
A memory corruption of the job queue has been found and corrected. This bug was related 
to unexpected/missing rejects being displayed and as the next job on the Job Summary 
browser page displaying a large number of "ÿÿÿ" characters. 

DCM - RIO2 Driver 
 
The driver for the RIO2 analog card has been rewritten to correctly reload the card with the 
proper gain and offset settings if a communication error occurs. This was seen by users as 
erroneous data being captured for analog process variables and as a flattening of the profile 
curves. In addition, an error displaying a spike in the first reading of the profile has been 
corrected. 
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DCM - Tote Count 
 
The tote count field is now saved so that the count can be recovered in the event of a power 
loss or a cold start of the DCM. 

************************************************************************************************** 

***************************************************************************************************
V E R S I O N  4.10 

************************************************************************************************** 
************************************************************************************************** 

 

V4.10 Installation 

 

PlantStar v4.10 can be installed as a new system or as an upgrade to 
PlantStar v4.00 or later. Data compatibility with earlier systems requires 
the host computer be upgraded to PlantStar v4.00 prior to installation of 
v4.10 as a maintenance release. 

NOTE: For those users that have installed Windows NT, 2000, or XP the 
operating system login MUST be set to have administrative privileges in 
order for that workstation to install and run the View and Print Application. 

V4.10 New Features 

General 
 
Although there have been a number of minor changes, the focus of V4.10 is 
Family Tooling and Labor Tracking. 

Family Tooling is designed to allow the collection and tracking of data by 
child tool. Management will receive a much more detailed picture of 
production, reject, history, and pieces made for each family tool. Family 
Tooling allows up to twelve child jobs running, at one time, on a machine. 

Labor tracking is designed to forecast, collect, and report labor hours 
by machine, job, shift, or employee. Labor is collected and tracked by 
personnel logging in and out at a DCM. The same person or people 
can be logged onto one or many machines at the same time 
depending on the work being done. For these reasons, it is not a time 
and attendance system. It will provide a window to where and how 
labor is used on the shop floor. Management will receive a much more 
detailed picture of the time spent on setup, maintenance, idle time, 
wait time and other assigned labor categories. It can also report time 
spent, at the machine, by support personnel. As a job history is 
developed the job history labor reports can be used to forecast staffing 
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requirements on a shift or weekly basis. 

Monitor - Machine Status 
 
Machine Status displays all of the child jobs on a rotating basis. The 
child job displayed will start at the first child job and rotate to the next 
child job, with each end of cycle. All data displayed, in the machine 
cell, would be for the current child job. If no child jobs are found, the 
data displayed would not rotate. It would always display the parent 
jobs information. The machine cell would turn cyan if the current child 
job was in production exception. 

Monitor - Production Summary 
 
Production summary displays one line of summary for each child job. 
If child jobs are not present, the data displayed is based on the 
parent job. 

Monitor - Material Usage 
 
The “Pieces To Go” displayed is a summary of all the child jobs. If 
child jobs are not present, the data displayed is based on the parent 
job. 

Monitor - Job Summary 
 
A drop down has been added underneath machine for selecting child jobs. 
Job data displayed is a summary for the child job selected. If no child job is 
present, the child drop down displays "No Family Data Defined" and the 
data displayed is based on the parent job. 

Monitor - Reject Pareto-Pie 
 
A drop down has been added underneath machine for selecting child jobs. 
Reject data displayed is a summary for the child job selected. If no child 
job is present, the child drop down displays "No Family Data Defined" and 
the data displayed is based on the parent job. 

Monitor - Job Schedule Board 
 
The schedule bars now represent the length of time for the child that 
will take the longest time to complete. If the job is a non-family job, the 
calculations are based on the parent job. Job Summary displays the 
pieces to go for each child job. A set of "Child Jobs" tabs were added 
to the Job Parameter Editor. 
The Job Parameter Editor allows the editing of jobs opened from the Job 
Schedule Board. It also added the ability to assign a labor category and 
manning to each job. Manning factor is the number of man hours needed 
to complete the job for the selected labor category. These can be entered 
into a job by selecting the new labor button at the top of the job parameters 
screen. 

Monitor - Edit Current Job 
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"Child Jobs" tabs added for the editing of child jobs. Reformatted screen 
for enhanced usability. Moved machine parameters onto their own grid. 
Now allows the editing of queue jobs as well as current jobs. Added the 
ability to assign a labor category and manning factors to each job. Added 
a new field "Idle". This is a field that allows for setting of a jobs idle state 
from the PC Client. 

Monitor - Edit Work Order 
 
"Child Jobs" tabs added for the editing of child jobs. Reformatted screen 
for enhanced usability. Moved machine parameters onto their own grid. 
Added the ability to assign a labor category and manning to each job. 
Added a new field "Idle". This is a field that allows for setting of a jobs 
idle state from the 
PC Client. 

Monitor - Edit Product Standard 
 
"Child Jobs" tabs added for the editing of child jobs. Reformatted screen for 
enhanced usability. Moved machine job parameters onto their own grid. 
Added Add/Delete Child buttons for the adding/removal of child records 
from a product standard. NOTE: Child records can only be added or 
removed from a product standard. The number of child records cannot be 
changed once created as a Work Order, Job Queue, or Current Job. Added 
a product standard list that displays all of the product standards on the left 
hand side of the screen. This allows for easier navigation among product 
standards. Enhanced the search performance for product standards. 
Product Standard searches can now be done in a much shorter period of 
time. Added the ability to assign a labor category and manning to each job. 
Added a new field "Idle". This is a field that allows for setting of a jobs idle 
state from the PC Client. 

Monitor - Tool Change 
 
Pieces To Go and Estimated Completion Time are based on the child job 
that will take the longest time to complete. If the job is a non-family job, 
the calculations are based on the parent job. 

Monitor - Historical Reject Pareto Pie 
 
A drop down has been added underneath machine for selecting child jobs. 
Reject data displayed is a summary of the child job selected. If no child 
job is present, the child drop down displays "No Family Data Defined" and 
the data displayed is based on the parent job. 

Monitor - Part Count Edit 
 
A drop down has been added underneath machine for selecting child 
jobs. Part count data displayed is a summary of the child job selected. If 
no child job is present, the child drop down displays "No Family Data 
Defined" and the data displayed is based on the parent job. 
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Monitor - Material Lot Tracking 
 
Material Lot Tracking has been modified to show tote part and tote 
totals for each child job. 

Monitor - Labor Status 
 
Labor Status is a new screen that allows the viewing of current employees 
logged in. Selecting a work center from the drop down, in the upper left 
hand corner, will fill the grid with a list of current employees logged in, for 
the selected work center. The grid displays the employees name, 
machine, labor category, login date, login time, and hours worked. An 
additional feature of the labor status screen is the ability to logout an 
employee. To logout an employee, use the mouse to select the employee 
from the grid and click the logout button at the bottom. 

Monitor - Labor Forecast 
 
Labor Status is a new screen that displays the calculated man-hours 
needed per shift. The calculations are based off the manning factors 
assigned to the job scheduled to run in the selected time frame. The 
Labor Forecasting screen is split into two views: Grid View and Graph 
View. The Grid View displays one cell for each shift and labor category. 
For a given shift and labor category the cell displays the required 
manning factor. The Graph View graphs the man hours required for a 
given labor category. There is one point on the graph for each shift in the 
selected date range. 

Monitor - Labor History 
 
Labor History is another new screen that allows the viewing, modification, and deletion of 
labor records for shifts that have already completed. Labor history records are by work center, 
machine, job, and shift. These are selected from drop downs at the top of the screen. Once a 
valid selection has been made, the grid will display the employee records for the selection. 
The grid displays the employee name, labor category, date/time logged in, date/time logged 
out, down time, reject count, and part count. All fields can be edited, except for employee 
name. To delete an employee record, select the delete check box, in the grid, on the desired 
record. Changes are not saved until the <Save> button has been selected. To disregard 
changes, select the <Restore> button. 

Configuration - DCM Configuration 
 
A new field was added to DCM Configuration called "Max. Family Size". 
This allows the modification of the maximum number of child jobs allowed 
running on a machine, at the same time. The range is from 1 to 12. Also, a 
new field was added to show memory used with current configuration. This 
modification will limit saving of data to data that does not exceed installed 
memory of the DCM. The calculations for memory use do not include bin 
sets. Memory overrun may still occur if the bin set used is very large. 

Configuration - Labor Configuration 
 
The Work Center screen was updated. A tabbed grid control was added to 
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allow for the entry of Labor category and employee information. Note 
clicking on the command buttons on the bottom of this screen affects the 
work center not the individual employees or labor categories. (i.e. New, 
Delete, Restore, etc.) Also, the DCM set-up screen was updated. A tabbed 
grid control was added to aid in the setting up of DCMs correctly. A tab for 
COM port setup was added as well as a tab to allow for editing contact 
inputs. Modifications to the DCM set-up screen were also made to enhance 
error correction in the configuration process. 

View & Print Reports 
 
All reports now support family tooling. Reports display totals based 
on both parent and child information. 

New Labor Reports: 
 

1. Labor by Job--Labor history by job. Selection by job and job 
ending date range 

2. Labor by Shift--Labor history by shift. Selection by display 
group and shift starting date range. 

3. Labor Definitions--Labor category and employee definitions 
for all work centers. 

Host - Import 
 
All import programs now support the new field "Family Name". "Family 
Name" should be assigned to each family set of records to distinguish 
them as a family. Also, the "Family Name" should be the job name of 
the parent record. "Family Name" must be included in import files that 
wish to import family jobs. Also, all import programs now support the 
new field "manning factor", as it applies to jobs. Added a new 
employee import program to import employees’ definitions. 

Host - Export 
 
All import programs now support the new field "manning factor", as it 
applies to jobs. Job Que export will export manning factors. Labor 
categories, as it exports data for shift history, will also export labor 
history for all valid “end-of-shift”. For this 115 has to be specified with -f 
option (as we specify 111 for exporting shift history data) 

DCM - RTL 
 
The DCM-RTL now has the ability to view and track each individual child 
tool production. Also, the DCM-RTL now has a popup display for entry 
and viewing of Labor related data (Login, Logout, etc.). The DCM-RTL can 
also obtain login/logout data from a barcode scanner. 

DCM – EL Menu 
 
Also, the EL DCM's now has a popup display for entry and viewing of 
labor related data (Login, Logout, etc.). The DCM-RTL can also 
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obtain login/logout data from a barcode scanner. 

Browser - Job Summary screen 
 
Defaults to showing a family view of a job. This view gives a summary 
display of each child in the family with color details. Added button to 
allow selection of a specific child to view its details. 

Browser - Job Update 
 
For family jobs a new button was added to select each child. When 
child is displayed you can modify its actual multiplier. 

Browser - Reject Update 
 
Button was added to select individual children. When selected each child's rejected 
parts can be modified. The reject numbers are now entered through two dropdown 
menus instead of a keypad, works similar to the Job Update screen. This allows for 
greater compatibility with various browser software. 

Browser - Job Summary, Machine Summary and Job Queue 
 
Pieces required displayed in a job summary format will display 
'Family' for all family jobs. 

V4.10 Bug Fixes 

Browser – Job Summary 
 
Job Summary was modified to show number of parts in red when job or 
child in overrun. Reject percent displays in red when percent of rejects 
exceeds limits. 

Browser – Job Setup 
 
Job Setup was modified to allow for more than 80 columns in a 
single line. Embedded links now work correctly when a 'T' is placed 
within the link. 

Browser - Down, Assist, Reject 
 
Button text was modified to improve alignment and consistency with 
previous versions. 

V4.10 Notes 

Monitor - Job Summary 
 
Job Summary does not change to previous shift automatically. For 
example, if you entered reject parts into Part Count Editor, your 
changes would not be displayed until you press the "Build" button at the 
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bottom. All changes to the current shift are updated by Job Summary 
automatically, without a screen rebuild. 

V4.10 Features No Longer Supported 

DCM – Keypad and EL Menu 
 
Keypad and EL Menu's do not support family tooling jobs. 

Host - Reports 
 
Host Reports are no longer supported. 

REU 
 
REU are not supported in this release. 

************************************************************************************************** 
************************************************************************************************** 

V E R S I O N  4.05 

************************************************************************************************** 

************************************************************************************************** 

 

V4.05 Installation 

PlantStar v4.05 can be installed as a new system or as an upgrade to PlantStar 
v4.02. Data compatibility with earlier systems requires the host computer be 
upgraded to PlantStar v4.00 prior to installation of v4.02 as a maintenance release. 

This upgrade uses a method to significantly lower the impact on shop floor data 
collection in larger systems. The older v4.00 - v4.02 software is compatible enough 
with the new v4.05 system that data collection can continue on the shop floor 
during the upgrade. The last step of the upgrade is to reload each DCM in turn with 
the new software. Overall this may take several hours but it results in each DCM 
loosing only 5 minutes of data collection time. No backups, job schedule changes 
or shift schedule changes should be made during this process. The low impact 
method will not be available on all future upgrades but will be used whenever 
possible. 

 

V4.05 New Features 

General 
 
Although there have been a number of minor changes the focus of V4.05 is 
labor tracking and management. Labor tracking is designed to forecast, 
collect, and report labor hours by machine, job, shift, or employee. Labor is 
collected and tracked by personnel logging in and out at a DCM. The same 
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person or people can be logged onto one or many machines at the same 
time depending on the work being done. For these reasons, it is not a time 
and attendance system. It will provide a window to where and how labor is 
used on the shop floor. Management will receive a much more detailed 
picture of the time spent on setup, maintenance, idle time, wait time and 
other assigned labor categories. It can also report time spent at the 
machine of support personnel. As a job history is developed the job history 
labor reports can be used to forecast staffing requirements on a shift or 
weekly basis. 

Client - Labor Scheduling 
 
Added the ability to assign a labor category and manning to each job. 
Manning factor is the number of man hours needed to complete the job 
for the selected labor category. These can be entered into a job by 
selecting the new labor button at the top of the job parameters screen. 

Client - Labor Status 
 
Labor Status is a new screen that allows the viewing of current logged in 
employees. Selecting a work center from the drop down, in the upper left 
hand corner, will fill the grid with a list of current logged in employees, for 
the selected work center. The grid displays the employees name, 
machine, labor category, login date, login time, and hours worked. An 
additional feature of the labor status screen is the ability to logout an 
employee. To logout an employee, use the mouse to select the employee 
from the grid and click the logout button at the bottom. 

Client - Labor History 
 
Labor History is another new screen that allows the viewing, 
modification, and deletion of labor records for shifts that have already 
completed. Labor history records are by work center, machine, job, and 
shift. These are selected from drop downs at the top of the screen. Once 
a valid selection has been made, the grid will display the employee 
records for the selection. The grid displays the employee name, labor 
category, date/time logged in, date/time logged out, down time, reject 
count, and part count. All fields can be edited, except for employee 
name. 
To delete an employee record, select the delete check box, in the grid, on the desired record. 
Changes are not saved until the <Save> button has been selected. 
To back out changes, select the <Restore> button. 

Client - Labor Configuration 
 
The Work Center screen was updated. A tabbed grid control was added to 
allow for the entry of Labor Category and Employee information. Note 
clicking on the command buttons on the bottom of this screen affects the 
work center not the individual employees or labor categories. (i.e. New, 
Delete, Restore, etc.) Also, the DCM set-up screen was updated. A tabbed 
grid control was added to aid in the setting up of DCMs correctly. A tab for 
COM port setup was added as well as a tab to allow for editing contact 
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inputs. Modifications to the DCM set-up screen were also made to enhance 
error correction in the configuration process. 

Client - View & Print Reports 
 
New Reports: 
1. Labor by Job--Labor history by job. Selection by job and job 

ending date range 
2. Labor by Shift--Labor history by shift. Selection by display 

group and shift starting date range. 
3. Labor Definitions--Labor category and employee definitions 

for all work centers. 

Host - Import 
 
All import programs now support the new field "manning factor", as it 
applies to jobs. Added a new employee import program to import 
employees’ definitions. 

Host - Export 
 
All import programs now support the new field "manning factor", as it 
applies to jobs. Job Queue Export will export manning factors and labor 
categories. It also will export labor history for all valid “End-of-Shift”, as 
it exports data for shift history. For this 115 has to be specified with -f 
option (as we specify 111 for exporting shift history data) 

Host - Reports 
 
The labor definitions (Labor Category, Forecast Type, Auto Logout, 
Multiple Login, and Labor Cost) are shown for all the work centers in 
Host Full-Reports. The manning factor for each labor category is 
shown for all the jobs in the Host Full-Reports. (Manning factor is 
reported only when it is greater than Zero).The summary reports 
remain as before. 

Host - Archiving 
 
The archive utility will now support archiving to a CD-R, CD-RW, or an 
external file. 

DCM - EL & LCD 
 
The DCM-EL and DCM-LCD now have a display screen for entering and 
viewing Labor data. This screen allows login/logout and viewing the current 
workforce on a machine by machine basis. The DCMs also support login/logout 
using a barcode scanner. 

DCM - RTL 
 
The DCM-RTL is capable of serving web-pages containing its job data to any client 
PC running a standard browser. The data shown on the DCM-RTL is available for 
viewing nearly anywhere. Along with this comes the ability (on the 12" RTL-DCM) 
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to place links in the Job Setup Sheet that point to web-based data of any kind 
(Documents, pictures, video, etc). The DCM-RTL now has a popup display for entry 
and viewing of Labor related data (Login, Logout, etc). The DCM-RTL can also 
obtain login/logout data from a barcode scanner. 
 

V4.05 Bug Fixes 

Client - View & Print Reports 
 
The Current Job Parameters Summary Report and the Job Queue Job 
Parameters Summary Report were corrected for a problem of printing 
multiple rows of the same data for machines defined in multiple display 
groups. 

Host - Work Order Import 
 
Fixed a problem with the work order import where it would occasionally 
create duplicate work order for records that were not in the system. 

Host - Archiving 
 
The archive utility would exit with errors when it encountered incomplete job data. 
The utility has been made more robust to handle missing or unexpected SPC, 
shift, tote, and material lot records. 

DCM 
 
Setup sheets for the current job or next job were sometimes not available 
for viewing at the DCM. The DCM would ignore auto-reject inputs on a 
“net parts” job if the rejects would cause the shrinkage category to go 
negative. This is now permitted to better handle the resets which occur at 
job and shift change. 

V4.05 Known Problems 

Archiving 
 
The archive utility will not export labor history. Also, there is a limitation to 
archiving the first 2000 records for each record type (e.g. SPC, material 
tracking, and tote snap shots) that are associated with a job. The 
remaining records will not be archived and will remain in the database. 

************************************************************************************************** 
************************************************************************************************** 

V E R S I O N 4.02 

************************************************************************************************** 

************************************************************************************************** 
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V4.02 Installation 

 

PlantStar v4.02 can be installed as a new system or as an upgrade to 
PlantStar v4.00 or v4.01. Data compatibility with earlier systems requires 
the host computer be upgraded to PlantStar v4.00 prior to installation of 
v4.02 as a maintenance release. 

This upgrade uses a new method to significantly lower the impact on 
shop floor data collection in larger systems. The older v4.00/4.01 
software is compatible enough with the new v4.02 system that data 
collection can continue on the shop floor during the upgrade. The last 
step of the upgrade is to reload each DCM in turn with the new software. 
Overall this may take several hours but it results in each DCM loosing 
only 5 minutes of data collection time. No backups, job schedule changes 
or shift schedule changes should be made during this process. The low 
impact method will not be available on all future upgrades but will be 
used whenever possible. 

 

V4.02 New Features 

General 
 
A completely updated edition of the Spanish language translations for 
the client PC, DCM, and host reports has been incorporated. 

Installation of the client software, including View & Print, on Windows 
2000 and Windows Millennium Edition has been tested and is now 
supported. 

The Screen Shot utility will no longer be distributed or supported. If you already 
have Screen Shot installed from a previous release, you may continue to use it 
for as long as it works in your environment. For new PC's we recommend 
getting one of the many shareware or commercial screen printing products. 
ClipTrakker (www.cliptrakker.com) is a full featured shareware program. 
PrintScreen32 (www.surf.to/provtech) is a bare bones screen printing program. 

SnapShot (v2.02) systems have been enhanced to support licensing of 
up to 8 users and 50 machines. Also SnapShot now supports a wider 
variety of DCM hardware. 

When forecasting the completion or duration of a queued job the 
PlantStar algorithms now use actual multiplier instead of standard 
multiplier to estimate the production rate. This allows scheduling 
personnel to account for a known condition that will prevent all cavities 
in a mold from being used. 

Job Scheduler 
 

http://www.cliptrakker.com
http://www.surf.to/provtech)
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The "justify all" button has been changed to toggle left and right 
like the "justify 1" has always done. 

The four user text fields have been added to the job summary popup window. 

Machine Status Display 
 
The machine status display now uses larger fonts in the machine status blocks 
when showing only the machine name. This was done to make large display 
screens on the plant floor easier to read from a distance. 

Import / Export 
 
A special utility has been developed for sending PlantStar production 
data to the Data Technical Research (DTR) TMM business system. This 
is an optional utility which is available for a licensing fee. 

A new command line option (-a) has been added to the work order import 
utility (woimp). When this option is used only new work orders are 
processed from the import file. Any existing work orders (either running, 
queued, or unscheduled) will not be updated. This option can be helpful 
when there are a lot of suspended jobs (where the pieces required gets 
changed to pieces remaining) and change orders to outstanding jobs are 
infrequent. 

Another command line option (-u) has been added to the work order 
import utility (woimp). This option is used when importing job queues to 
specific machines and queue positions. When this option is used and the 
specified queue position for a job is zero, the current job on the 
associated machine will be stopped and the new imported job will be 
started as the current job. This option should be used with caution. In 
most cases the work order import is run automatically once per day. New 
jobs will be started at the DCM as per the import file regardless of what 
product is actually running at the machine. In nearly all cases it is best for 
the operator to do routine job changes at the machine to confirm what the 
machine is actually doing. 

DCM 
 
The new color touchscreen DCM-RTL has been fully integrated for 
production tracking into the basic operation of the system. Many 
additional features and improvements will be developed over the 
coming months. 

On the DCM-RTL-10 and DCM-RTL-12 the touch screen calibration item 
under the "diag" menu is now available to update touchscreen calibrations. 

V4.02 Bug Fixes 

General PC Client 
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Some of the display screens, including Machine Utilization and Job 
Summary, would be cut off when maximized at certain resolutions. 

In V4.01 the Pieces to Go field on some workstation screens were 
incorrectly changed to show 0 when the job was in overrun. These have 
been restored to show the amount of overrun produced as a negative 
number. 

Server Reports 
 
Machines were occasionally reported missing off end-of-shift production 
reports. This only applied to the server-generated text reports (not to 
View & Print reports). 
The Shop Floor Reports program would exit with an error when 
attempting to generate a detailed product standards report. 

View & Print Reports 
 
View & Print would exit with run time error 6 when an internal sequence 
number got larger than was expected. 
 
View & Print would exit with run time error 6 when automatic reports 
were still scheduled after a display group had been deleted. 

Import/Export 
 
European date formats were not being handled correctly on the work 
order import utility. 

The work order import utility had several problems relating to the use of 
the clear-and-replace (-c) option. The behavior of this feature was 
changed enough that the original lower case option (-c) was changed to 
an upper case letter (-C). This was done to force all installations using 
clear-and-replace to inspect and re-evaluate how the option works in 
their environment. 

It was discovered that the work order import utility would not always 
match the correct machine specific details when filling out an imported 
work order. 

Job Scheduling 
 
The job queue estimation program, which updates estimated completion 
times for export purposes, had several related problems which kept it from 
generating accurate and timely estimates under certain conditions. 

The Job Schedule Board would sometimes not refresh itself correctly after 
committing changes to the schedule. All changes would have been saved 
correctly and upon exiting and re-entering the schedule board everything 
would appear normal. 

In the Job Schedule Board the length of individual job bars would not 
always change length when the time scale was changed. 
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A problem was fixed which would occasionally allow a hidden space 
character to be included at the beginning of the job name. This would 
cause errors when the job parameters were exported to other computers 
at the end-of-shift. 

In the various screens where job parameters could be edited there was a 
problem with values from one field being transferred to another field when 
the job was saved. This most often with the material name field where the 
word "Yes" would overwrite the material name or the material name would 
overwrite another field. 

Voice 
 
Several customers have had problems with portions of their voice 
announcements not playing. This problem turned out to be an 
incompatibility between wave file formats as PC sound has evolved from 8- 
to 16- and 32-bit sound cards. Wave files recorded with more recent sound 
card drivers cannot be merged with older files. This problem has been 
solved by playing each file separately in sequence rather than trying to 
merge them into one continuous file for playing. Newer workstations are 
fast enough to handle this without pause. There is one other side-effect 
which some customers may experience. Wave files recorded with different 
hardware and drivers often play back at different volumes. Some may find 
that portions of an announcement are too loud or too quiet compared to 
the rest. The only remedy for this is to re-record the entire announcement 
set using the same hardware and sound drivers. 

V4.02 Known Problems 

A last minute problem was found in the job schedule board when a large 
number of jobs are placed in the queue of a single machine. The normal 
limit is 100 jobs per machine on the job schedule board. However, a fatal 
exception would occur in the program before this limit was reached. As a 
temporary patch for v4.02 the limit has been reduced to 75 jobs per 
machine. This problem will be corrected and the limit restored to 100 in the 
next release. 

Under, as yet undetermined conditions. some of the process thresholds on 
a job can be set to 0. This can happen to thresholds that were set for alarm 
as well as ones that had no limit set. The cause of this problem is still under 
investigation. 

All events which occur at the DCM are logged and show up in the DCM 
machine log display as they should. But sometimes a few of them do not get 
transferred to the server database and hence do not show up on workstation 
displays. The cause of this problem is still under investigation. 
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************************************************************************************************** 

V E R S I O N 4.01 

************************************************************************************************** 

************************************************************************************************** 

 

 

V4.01 Installation 

PlantStar v4.01 can be installed as a new system or as an upgrade to 
PlantStar v4.00. Data compatibility with earlier systems requires the host 
computer be upgraded to PlantStar v4.00 prior to installation as a 
maintenance release. 

Since the DCM cold end offset between isolated and non-isolated A/D 
converter has been standardized, users with the isolated A/D cards that 
upgrade from v4.00 to v4.01 will require the corresponding hardware 
modification to their isolated A/D cards. 

View & Print and Design Manager have been upgraded to support Crystal 
Reports 7.0. Since some of the functionality has been dropped, Crystal 
Reports 6.0 can not be supported. It is recommended that users of Design 
Manager should upgrade all their custom report templates to avoid any 
adverse affects. 

 

V4.01 New Features 

 

Job Scheduler 
 
Reload button has confirmation prompt prior to discarding changes and 
reloading schedule. 

View & Print 
 
Vies & Print now allows multi-select on criteria. Added work center 
and display group criteria for selection of machines. Date criteria 
dialog boxes now default to current date. Templates are reloaded 
from host when a report is run to allow easier viewing of new 
templates. 

Report Definitions 
 
Standard reports templates have upload options as part of PC install 
program and do not require reloading of Ingres or View & Print. 
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DCM 
 
When the 'Down' menu is selected the DCM automatically jumps to the 
group of 20 down reasons which has the current selected down reason. 

V4.01 Bug Fixes 

DCM 
 
Blank down reasons at DCM after cold boot has been corrected. 
Off-line DCM could cause a com failure on CP units. The host has been 
adjusted to allow for this situation. 

DCM cold end offset between isolated and non-isolated A/D converter 
has been standardized. This upgrade coincides with a hardware change 
requirement to isolated A/D cards. 

If a machine is down at shift change the DCM display doesn't update to 
show the piece counters reset to 0. This has been corrected so the 
display always updates at shift change. 

General PC Client 
 
Machines that are idle and down will no longer show up on displays 
that are filtering to view down machines. 

"Version mismatch" when specifying INI file on command line has been fixed. 

Saving a job as a product standard would give an invalid standard error 
on the first try, and then work on the second try. This has been fixed. 

The Shop Floor Monitor program was much slower than previous 
versions and had noticeable hesitations when entering data. The program 
has been re-optimized to increase speed and reduce hesitation. 

The quick load option caused a "No jobs are scheduled for any 
machines" error when opening the tool change screen. 

The user definition window prompts to save changes on close even if the 
update button was pressed. 

The Shop Floor Monitor would occasionally exit with "Run-time Error 5". 
The vertical scroll bar on setup sheet edit windows was missing. 

Some of the real-time display screens would immediately roll up the 
machine or process selection list after it was dropped down, not allowing 
enough time to select a different item. 

The CAMAC-486/VSX pvar definition was expanded to allow a Convert 
Index of between 0-79. Previously, its maximum value was 29. Also, 
some annoying text entry problems were cleaned up with that particular 
field. 

Job Schedule Board 
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Job Schedule Board now displays machines in alphabetic order when 
selecting the "<all Machine>" option. 

Job Schedule Board has been improved for error recovery and 
number of work orders. 

Job Schedule Board shift patterns are displayed correctly after an idle period. 

The Job Schedule Board dividing bar between work orders and machine 
schedule would return to its default setting after editing job parameters. 
Customer setting will now be remembered. 

Improvements in the Job Schedule Board were made to handle 
scheduling by multiple personnel. 

A 'required by date’ in a prior year for which the shift schedule had been deleted caused 
problems in Job Schedule Board. It displayed an error message saying the "job will be 
scheduled in 1890". This has been fixed. 

Resize handles were missing on the job summary popup window. 

The title on the job list popup box was not showing the correct machine name. 

When a work order was scheduled and then found in the job search dialog 
it would still be listed as a work order instead of scheduled on a machine. 

Job Schedule Board did not auto-scroll or smooth scroll. 

A security hole has been corrected in the Job Schedule Board. A user 
with view-only permission could change display groups and be prompted to 
commit changes. 

View & Print 
 
View & Print as well as the standard report templates have been 
extensively re-worked to correct multiple report problems. This includes 
the handling of suspended jobs and shift breaks. 

View & Print will now allow database backup and maintenance to proceed 
without interference. 

Installation 
 
Ingres can now run in a directory other than the default (C:\OPING). 

The installation program will now retain monitor's user preferences during upgrade. 

The free disk space checks during PC installation did not take into 
account browsing to a different drive. 

Voice 
 

file://172.19.40.1/../OPING
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The voice application work center is preserved during upgrade installation. 

The shortcuts created for the voice application in the Start menu do not 
have the home folder as the working path. This causes a failure when 
looking for the wave files. This problem has been fixed. 

Backups 
 
Communication problem on host computer after short backups have been resolved. 

After a backup the host computer only ejects CD-R disks. Prior 
software also ejected the CD-RW disks. 

Archiver 
 
The archiver program has been fixed for date range problem and Y2K issue 
where every date was within the 6-month cutoff time. 

The archiver program was getting fatal errors on Material Lot and 
Tote Box History. This problem has been fixed. 

V4.01 Known Problems 

Screen Shot on Windows NT systems does not function when minimized or in the 
background. To use with Windows NT, keep it normal size and visible 
on the screen. 

When View & Print displays a report on screen, printing of the report 
causes the screen not to be re-painted when scrolling. This is a problem 
within Crystal Report. Workaround is to view the report prior to printing. 

************************************************************************************************** 
************************************************************************************************** 

V E R S I O N 4.00 

************************************************************************************************** 

************************************************************************************************** 

 

V4.00 New Features 

General 
 
PlantStar is now an entirely 32-bit application, and as a consequence 
will no longer run under Windows 3.x. PlantStar relinquishes focus 
during long operations (such as logging in) and allows the user to go 
to other open applications and work until the process is done. 

PlantStar is now multi-lingual (for the Monitor and Reports programs) and 
supports English, French and German. At this time the Voice option and 
the Shop Floor Configuration program are available only in English. 
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New Monitor Screen 
 
Machine Utilization Summary 
 
A new screen has been added under the monitor menu which displays a 
summary of machine utilization for both a given date range and for any shifts 
started within 24 hours of the start time for the last completed shift. Machine 
utilization is defined as up time divided by the sum of up time, down time and 
idle time. Scheduled utilization is a similar calculation, only idle time is 
excluded. Thus it is derived by dividing the up time by the sum of the up time 
and down time. The date range can be changed and the screen will be 
updated when the Build button is pressed. The current machine state is also 
displayed and updated in real time. A print button on this screen allows the 
summary to be printed to a Windows printer. The machines displayed can be 
filtered by display group, exception type, or by machine name. 

Multilingual Monitor 
 
INI file specification for language 
 
The PlantStar Monitor now supports not only the English language, but 
French and German as well. To accomplish this, the user can go to the 
"Preferences" screen and choose the language that will be used by the 
monitor program. Simply changing the "English" value to "French" or 
"German" will cause the PlantStar program to reload those language 
definitions (if they are not already present) the next time that the program 
starts up. The user will have to restart the program once the language files 
have been loaded, as the program will be unable to use most of the strings 
until it gets the definitions from the database. 
 
After the restart, the new language should be intact. A message box will 
pop up alerting the user of the need to restart the program after a 
language change. 

DCMs 
 
Idle job start from DCM 
 
The operator is now able to start an idle job at the DCM (for such things as 
scheduled maintenance). To enable this option, the machine must be 
setup in the Shop Floor Configuration to allow this activity. Once 
enabled, the operator has only to go to the "Queues" screen and press the 
"Start Idle Job" button. A warning message will come up to make sure that 
this operation is the intended one, and then the current job will be either 
suspended or ended (depending on operator choice). 

Utilities 
 
Export programs now have AS/400 support 
Both f2kexp and f2kjqexp now support the -r option, which will right 
justify all non-text fields in the output. This was designed for 
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customers that require fixed numerical format from within a fixed-
width formatted export. This feature will not pad the numerical output 
with zeros, however. Also, any text field is still left-justified. 

A Note on older export templates 
 
In one of the previous 2.3x versions, a new field was added to the 
database to distinguish between varying types of exports. If you are 
using exports that were written prior to PlantStar 2.30 or Portrait 1.00, 
you will need to contact SYSCON Customer Service and have them 
update your export templates for you. If you experience any problems 
with your imports or exports after the upgrade, contact SYSCON 
Customer Service as soon as possible. 

Multiple Logins 
 
INI file specification via Command Line 
 
PlantStar now supports running multiple copies of the Monitor program 
simultaneously. This allows users on WAN's to be logged in to multiple 
hosts concurrently. For multiple host login, a new INI file should be 
created in the WINDOWS directory for each host to be accessed 
remotely. Each of these INI files should have the following entry placed 
into the "main" section: 

multi_instance=yes 

The multiple instance capability is OFF by default. Each new INI file 
should also have its "hosts" entry set to the proper IP address or host 
name. To run PlantStar for a remote host, the name of the proper INI 
file should then be specified on the command line. 

Add-On Features 
 
New Custom Reports Option 
 
A custom reports feature is now available within PlantStar. This new 
option provides the ability to create custom reports using Seagate 
Crystal Reports 7.0 and 6.0 formats and share those reports among 
PlantStar workstations. This option provides for a centralized location 
for all of your customized reports. This feature augments the Standard 
Reports program. 

Delta Type Process Variable 
 
A new type of process variable has been introduced which allows one 
process variable to represent the difference between two other process 
variables. 

Monitor Quick-load Feature 
 
Quick-load is a feature that bypasses some of the initialization for 
screens that take quite some time to load, such as the Job Schedule 
Board and the Machine Utilization Screen. If the "Enable Quick 
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Load" option is selected in the Monitor's "Preferences" screen, the 
following screens will load without any information selected: Job 
Schedule Board, Machine Utilization and Tool Change. To get 
them to calculate information, the user must select either a display 
group, a work center, or a valid date range. These actions will cause 
the respective form to reload their data. 

Thermocouple Scale 
 
A scale was added to the Thermocouple Process Variable configuration 
screen that will account for a level shift on the thermocouple. 

Print & View Refresh Button 
 
A "Refresh" button was added to the report list screen to allow the user 
to check for changes made via the Design Manager without logging out 
of Print & View and reopening the application. 

DCM Screen Saver Enable/Disable 
 
There is now a selection on the DIAGS menu of the DCM/EL that will 
allow the user to disable/enable the screen saver. 

 

V4.00 Bug Fixes 

 

SPC histories from ended jobs were showing 0 for the upper and lower 
spec limit values. They had non-zero values when the job was current, 
but went to 0 (not *) when the job ended. This has now been fixed, and all 
upper and lower limits are retained after the job is committed to history. 

The date format on the Machine Log screen has been changed to an 
internationally ambiguous format, to account for overseas customers. 

Editing a job by double-clicking it from the Schedule Board, after 
scrolling to the right one screen, causes the shift legend to recalculate 
incorrectly. The shift legend was that of the initial screen, not the 
current one. This has been fixed. 

When the time changes, due to Daylight Savings Time, the REU's were 
not getting updated with the new time. This has now been remedied. 

The Work Order screen now automatically refreshes after a new work 
order is saved, to eliminate the problem of a new work order 
overwriting the previously selected work order if the Refresh button 
was not pressed. 

The Process Summary screen now clears leftover color bars that were 
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orphaned when viewing a machine with fewer process variables than the 
previously viewed machine, and that previous machine had some out-of-
range values. 

If a user creates a second work order by copying the previous work 
order, and that previous work order was created from a product 
standard, and the user changes the selected machine, they are asked 
if they would like the machine portion overwritten from the product 
standard. However, instead of overwriting the machine portion only, the 
entire work order is overwritten. This is no longer the case. Only the 
machine-specific portion will get overwritten. 

The backup.f2k script now handles command line typing errors in a more 
robust manner. An error message is now output. 

The free_check.sh script has been updated to properly monitor space on 
a 2-disk system. 

The work order import and product standard imports are now fully Y2K compliant. 

The archiver program now only allows the user to archive data that is 
older than 6 months. This was to remedy a problem that was leaving 
partial job records in the database, leading to inconsistent data. This 
also remedies a problem with the archiver purging the entire history if the 
"jobs finishing prior to" date was set to 01-01-2000. 

When configuring an REU, pressing the "New" button clears all the 
fields, instead of retaining the data from the previously defined 
REU. 

All DCM programs now have adequate stack space, and all stack-related 
program exits have been taken care of. 

The user is now able to use the command button functionality of the main 
Monitor window in the event that the "Host is not Available". Previously, 
only the File->Exit option would allow the user to close the program. 

The KP70 bin set now has the proper sequence number in the database. 

 

V4.00 Known Problems 

 

Currently it is possible to include SPC information for an individual job on 
a machine that has an SPC History Size of 0. The Process Trend/SPC 
screen will return a value of "No Data Available" and no SPC data will be 
returned, even though it is asked for by the job parameters. 

On Windows 95/98 when using a file server login scheme that 
overwrites the AUTOEXEC.BAT file upon every successful login, the 
Ingres/Net Client will fail to operate correctly. This is due to the fact that 
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the Ingres/Net Client relies on path statements put in the 
AUTOEXEC.BAT file at installation time. A remedy can be 
accomplished by modifying the "main" AUTOEXEC.BAT file that gets 
copied to every system. For Novell-specific fixes, please contact 
SYSCONPlantStar Customer Service for assistance. 
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13 Technical Support Contact 

If you have a question about your system, look through the System Administrator's Guide 
or consult on-line help. If you cannot find an answer, please contact Customer Service. 

If you call, please be at your computer and have the appropriate product documentation at 
hand. Be prepared to give the following information: 

· The version number of your system that you are using 
· The type of hardware you are using, including network hardware 
· The exact wording of any messages that appeared on your workstation 
· What happened and what you were doing when the problem occurred 
· How you tried to solve the problem 

Our Support Phone Number is: 574-232-3900 Ext. 265 

For additional contact information please visit us on the web at www.syscon-intl.com 

Email can be sent to: 
Information Requests - marketing@syscon-intl.com 
Support Requests - support@syscon-intl.com 

 

http://www.syscon-intl.com
mailto:marketing@syscon-intl.com
mailto:support@syscon-intl.com
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